C166/ST10 v8.7

CrossView Pro Debugger
User’s Manual
The information in this document has been carefully reviewed and is believed to be accurate and reliable. However, Altium assumes no liabilities for inaccuracies in this document. Furthermore, the delivery of this information does not convey to the recipient any license to use or copy the software or documentation, except as provided in an executed license agreement covering the software and documentation.

Altium reserves the right to change specifications embodied in this document without prior notice.
TABLE OF CONTENTS
# OVERVIEW

1.1 Introduction ................................................. 1-3  
1.2 CrossView Pro’s Features ................................. 1-3  
1.3 Source Level Debugging ................................. 1-8  
1.4 How CrossView Pro Works ................................. 1-9  
1.5 C166/ST10 Program Development ..................... 1-11  
1.6 Getting Started ............................................. 1-13  
1.6.1 Before Starting ........................................... 1-13  
1.6.2 Setting Up the Execution Environment ............ 1-14  
1.6.3 Starting CrossView Pro ................................. 1-15  
1.6.3.1 CrossView Pro Target Settings .................. 1-16  
1.6.3.2 Configuring CrossView Pro ....................... 1-24  
1.6.3.3 Loading Symbolic Debug Information ............ 1-25  
1.6.4 Executing an Application ............................. 1-28  
1.6.5 Debugging an Application ............................ 1-30  
1.6.6 CrossView Pro Output ................................. 1-32  
1.6.7 Exiting CrossView Pro ................................. 1-33  
1.6.8 What You May Have Done Wrong .................... 1-34  
1.6.9 Building Your Executable ............................ 1-35  
1.6.9.1 Using EDE ............................................. 1-35  
1.6.9.2 Using the Control Program ....................... 1-42  
1.6.9.3 Using the Makefile .................................. 1-45  

# SOFTWARE INSTALLATION

2.1 Introduction ................................................. 2-3  
2.2 Note about Filenames ...................................... 2-3  
2.3 Configuring the X Windows Motif Environment ........ 2-3  
2.4 Using X Resources ........................................... 2-4  

# COMMAND LANGUAGE

3.1 Introduction ................................................. 3-3  
3.2 CrossView Pro Expressions ............................... 3-3  
3.3 Constants ................................................... 3-4
### 3.4 Variables ................................. 3-7
### 3.5 Formatting Expressions ..................... 3-13
### 3.6 Operators ................................. 3-17
### 3.7 Special Expressions ....................... 3-18
### 3.8 Conditional Evaluation ..................... 3-19
### 3.9 Functions ............................... 3-20
### 3.10 Case Sensitivity .......................... 3-20

### USING CROSSVIEW PRO 4-1

#### 4.1 Introduction ............................. 4-3
#### 4.2 Using the CrossView Pro Interface .......... 4-3
#### 4.3 Starting CrossView Pro .................... 4-4
#### 4.4 Startup Options ............................ 4-5
#### 4.4.1 What You May Have Done Wrong .......... 4-11
#### 4.5 The CrossView Pro Desktop ................. 4-12
#### 4.5.1 Menus .................................. 4-14
#### 4.5.1.1 Local Popup Menus ..................... 4-15
#### 4.5.2 Window Operation .......................... 4-15
#### 4.5.3 Dialog Boxes ............................ 4-17
#### 4.5.4 Customizing CrossView Pro ............... 4-18
#### 4.5.5 CrossView Pro Messages .................. 4-20
#### 4.6 CrossView Pro Windows ..................... 4-21
#### 4.6.1 Command Window ......................... 4-22
#### 4.6.2 Source Window ........................... 4-24
#### 4.6.3 Register Window ......................... 4-27
#### 4.6.4 Memory Window ........................... 4-28
#### 4.6.5 Data Window ............................. 4-30
#### 4.6.6 Stack Window ............................ 4-33
#### 4.6.7 Trace Window ............................. 4-34
#### 4.6.8 Terminal Window .......................... 4-35
#### 4.6.9 Data Analysis Window ..................... 4-37
#### 4.6.10 Pop-Up Windows ......................... 4-38
#### 4.7 Control Operations for CrossView Pro ....... 4-39
#### 4.7.1 Echoing Commands ....................... 4-39
### CONTROLLING PROGRAM EXECUTION

5.1 Source Positioning .............................................. 5-3
5.1.1 Changing the Viewing Position ................................. 5-4
5.1.2 Changing the Execution Position ............................... 5-5
5.1.3 Synchronizing the Execution and Viewing Positions .... 5-7
5.2 Controlling Program Execution ................................. 5-8
5.2.1 Starting the Program ........................................... 5-8
5.2.2 Halting and Continuing Execution ............................. 5-9
5.2.3 Single-Step Execution .......................................... 5-9
5.2.4 Stepping through at the Machine Level ..................... 5-12
5.3 Notes About Program Execution ................................. 5-14
5.4 Searching through the Source Window ......................... 5-14
5.4.1 Searching for a Function ...................................... 5-14
5.4.2 Searching for a String ........................................ 5-15
5.4.3 Jumping to a Source Line .................................... 5-16

### ACCESSING CODE AND DATA

6.1 Introduction ....................................................... 6-3
6.2 Accessing Variables ............................................. 6-3
6.2.1 Viewing Variables, Structures and Arrays .................. 6-3
6.2.2 Changing Variables ............................................ 6-7
6.2.3 The l Command ................................................ 6-10
6.3 Expressions ....................................................... 6-10
6.3.1 Evaluating Expressions ....................................... 6-11
6.3.2 Monitoring Expressions ....................................... 6-12
6.3.3 Formatting Data ............................................... 6-14
6.3.4 Displaying Memory ............................................ 6-15
6.3.5 Displaying Memory Addresses ................................. 6-17
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4</td>
<td>6.4.1</td>
<td>Displaying Disassembled Instructions</td>
<td>6-18</td>
</tr>
<tr>
<td>6.4</td>
<td>6.4.1</td>
<td>Intermixed Source and Disassembly</td>
<td>6-19</td>
</tr>
<tr>
<td>6.5</td>
<td>6.5.1</td>
<td>The Stack</td>
<td>6-20</td>
</tr>
<tr>
<td>6.5</td>
<td>6.5.2</td>
<td>How the Stack is Organized</td>
<td>6-20</td>
</tr>
<tr>
<td>6.5</td>
<td>6.5.3</td>
<td>The Stack Window</td>
<td>6-21</td>
</tr>
<tr>
<td>6.5</td>
<td>6.5.4</td>
<td>Listing Locals and Parameters of a Function</td>
<td>6-23</td>
</tr>
<tr>
<td>6.5</td>
<td>6.5.4</td>
<td>Low-level Viewing the Stack</td>
<td>6-23</td>
</tr>
<tr>
<td>6.6</td>
<td>6.6.1</td>
<td>Trace Window</td>
<td>6-25</td>
</tr>
<tr>
<td>6.6</td>
<td>6.6.1</td>
<td>Trace Window Setup</td>
<td>6-25</td>
</tr>
<tr>
<td>6.7</td>
<td>6.7.1</td>
<td>Register Window</td>
<td>6-27</td>
</tr>
<tr>
<td>6.7</td>
<td>6.7.1</td>
<td>Register Window Setup</td>
<td>6-27</td>
</tr>
<tr>
<td>6.7</td>
<td>6.7.2</td>
<td>Editing Registers</td>
<td>6-29</td>
</tr>
</tbody>
</table>

**BREAKPOINTS AND ASSERTIONS**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>7.1.1</td>
<td>Introduction to Breakpoints</td>
<td>7-3</td>
</tr>
<tr>
<td>7.1</td>
<td>7.1.2</td>
<td>Code Breakpoints</td>
<td>7-3</td>
</tr>
<tr>
<td>7.1</td>
<td>7.1.3</td>
<td>Data Breakpoints</td>
<td>7-7</td>
</tr>
<tr>
<td>7.1</td>
<td>7.1.3</td>
<td>Listing and Jumping to Breakpoints</td>
<td>7-8</td>
</tr>
<tr>
<td>7.2</td>
<td>7.2.1</td>
<td>Setting Breakpoints</td>
<td>7-8</td>
</tr>
<tr>
<td>7.2</td>
<td>7.2.1</td>
<td>Data Breakpoints over a Range of Addresses</td>
<td>7-11</td>
</tr>
<tr>
<td>7.2</td>
<td>7.2.2</td>
<td>Temporary Breakpoints</td>
<td>7-12</td>
</tr>
<tr>
<td>7.2</td>
<td>7.2.3</td>
<td>Breakpoint Names</td>
<td>7-13</td>
</tr>
<tr>
<td>7.2</td>
<td>7.2.4</td>
<td>Setting the Count</td>
<td>7-14</td>
</tr>
<tr>
<td>7.2</td>
<td>7.2.5</td>
<td>Sequence Breakpoints</td>
<td>7-15</td>
</tr>
<tr>
<td>7.3</td>
<td>7.3.1</td>
<td>Deleting Breakpoints</td>
<td>7-16</td>
</tr>
<tr>
<td>7.4</td>
<td>7.4.1</td>
<td>Enabling/Disabling Breakpoints</td>
<td>7-17</td>
</tr>
<tr>
<td>7.5</td>
<td>7.5.1</td>
<td>Breakpoint Commands</td>
<td>7-19</td>
</tr>
<tr>
<td>7.5</td>
<td>7.5.2</td>
<td>Attaching Conditionals to a Breakpoint</td>
<td>7-21</td>
</tr>
<tr>
<td>7.5</td>
<td>7.5.3</td>
<td>Attaching Macros to a Breakpoint</td>
<td>7-21</td>
</tr>
<tr>
<td>7.5</td>
<td>7.5.3</td>
<td>Attaching Strings to a Breakpoint</td>
<td>7-22</td>
</tr>
<tr>
<td>7.6</td>
<td>7.6.1</td>
<td>Suppressing Breakpoint Messages</td>
<td>7-22</td>
</tr>
<tr>
<td>7.7</td>
<td>7.7.2</td>
<td>Up-level Breakpoints</td>
<td>7-23</td>
</tr>
<tr>
<td>7.8</td>
<td>7.8.1</td>
<td>Patches</td>
<td>7-25</td>
</tr>
<tr>
<td>7.8</td>
<td>7.8.1</td>
<td>Patching Code out of a Program</td>
<td>7-25</td>
</tr>
</tbody>
</table>
### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.8.2</td>
<td>Patching Code into a Program</td>
<td>7-26</td>
</tr>
<tr>
<td>7.8.3</td>
<td>Replacing Code in a Program</td>
<td>7-26</td>
</tr>
<tr>
<td>7.9</td>
<td>Diagnostic Output and Statistical Information</td>
<td>7-27</td>
</tr>
<tr>
<td>7.10</td>
<td>Assertions</td>
<td>7-28</td>
</tr>
<tr>
<td>7.10.1</td>
<td>Assertion Mode</td>
<td>7-28</td>
</tr>
<tr>
<td>7.10.2</td>
<td>Defining an Assertion</td>
<td>7-29</td>
</tr>
<tr>
<td>7.10.3</td>
<td>Editing an Assertion</td>
<td>7-31</td>
</tr>
<tr>
<td>7.10.4</td>
<td>Activating and Suspending Assertions</td>
<td>7-31</td>
</tr>
<tr>
<td>7.10.5</td>
<td>Deleting Assertions</td>
<td>7-32</td>
</tr>
<tr>
<td>7.10.6</td>
<td>Using Assertions</td>
<td>7-33</td>
</tr>
<tr>
<td>7.10.7</td>
<td>Gathering Statistics with Assertions</td>
<td>7-35</td>
</tr>
</tbody>
</table>

## DEFINING AND USING MACROS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1</td>
<td>CrossView Pro Macros</td>
<td>8-3</td>
</tr>
<tr>
<td>8.2</td>
<td>Defining Macros</td>
<td>8-3</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Listing Macros</td>
<td>8-5</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Redefining a Macro</td>
<td>8-5</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Saving Macro Definitions to a File</td>
<td>8-6</td>
</tr>
<tr>
<td>8.2.4</td>
<td>Loading Macro Definitions from a File</td>
<td>8-7</td>
</tr>
<tr>
<td>8.2.5</td>
<td>Deleting Macros</td>
<td>8-8</td>
</tr>
<tr>
<td>8.3</td>
<td>Macro Parameters</td>
<td>8-9</td>
</tr>
<tr>
<td>8.4</td>
<td>Redefining Existing CrossView Pro Commands</td>
<td>8-10</td>
</tr>
<tr>
<td>8.5</td>
<td>Using the Toolbox</td>
<td>8-11</td>
</tr>
<tr>
<td>8.5.1</td>
<td>Opening the Toolbox</td>
<td>8-11</td>
</tr>
<tr>
<td>8.5.2</td>
<td>Connecting Macros to the Toolbox</td>
<td>8-11</td>
</tr>
<tr>
<td>8.5.3</td>
<td>Removing a Macro Connection</td>
<td>8-12</td>
</tr>
</tbody>
</table>

## COMMAND RECORDING & PLAYBACK

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1</td>
<td>Recording Commands</td>
<td>9-3</td>
</tr>
<tr>
<td>9.1.1</td>
<td>Entering Comments</td>
<td>9-4</td>
</tr>
<tr>
<td>9.1.2</td>
<td>Suspend Recording</td>
<td>9-5</td>
</tr>
<tr>
<td>9.1.3</td>
<td>Resume Recording</td>
<td>9-5</td>
</tr>
<tr>
<td>9.1.4</td>
<td>Check Recording Status</td>
<td>9-6</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>9.1.5</td>
<td>Close File for Recording</td>
<td>9-6</td>
</tr>
<tr>
<td>9.1.6</td>
<td>Command Recording Example</td>
<td>9-7</td>
</tr>
<tr>
<td>9.2</td>
<td>Playing Back Command Files</td>
<td>9-8</td>
</tr>
<tr>
<td>9.2.1</td>
<td>Setting the Type of Playback</td>
<td>9-9</td>
</tr>
<tr>
<td>9.2.2</td>
<td>Calling Other Playback Files</td>
<td>9-9</td>
</tr>
<tr>
<td>9.2.3</td>
<td>Quitting Playback Mode</td>
<td>9-10</td>
</tr>
<tr>
<td>9.3</td>
<td>Command Line Batch Processing</td>
<td>9-10</td>
</tr>
<tr>
<td>9.4</td>
<td>Logging</td>
<td>9-12</td>
</tr>
<tr>
<td>9.4.1</td>
<td>Setting up Logging</td>
<td>9-13</td>
</tr>
<tr>
<td>9.4.2</td>
<td>Recording Commands and Logging Screen Output</td>
<td>9-15</td>
</tr>
<tr>
<td>9.4.3</td>
<td>Command Window Log File Example</td>
<td>9-15</td>
</tr>
<tr>
<td>9.4.4</td>
<td>Suspending and Resuming Output Log</td>
<td>9-15</td>
</tr>
<tr>
<td>9.4.5</td>
<td>Closing the Output Log File</td>
<td>9-17</td>
</tr>
<tr>
<td>9.5</td>
<td>Startup Options</td>
<td>9-18</td>
</tr>
<tr>
<td>9.6</td>
<td>CrossView Pro Command History Mechanism</td>
<td>9-19</td>
</tr>
</tbody>
</table>

**I/O SIMULATION**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>Introduction</td>
<td>10-3</td>
</tr>
<tr>
<td>10.2</td>
<td>I/O Streams</td>
<td>10-3</td>
</tr>
<tr>
<td>10.2.1</td>
<td>Setting Up File I/O Streams</td>
<td>10-4</td>
</tr>
<tr>
<td>10.2.2</td>
<td>Redirecting I/O Streams</td>
<td>10-6</td>
</tr>
<tr>
<td>10.3</td>
<td>File System Simulation</td>
<td>10-7</td>
</tr>
<tr>
<td>10.3.1</td>
<td>File System Simulation Libraries</td>
<td>10-8</td>
</tr>
<tr>
<td>10.4</td>
<td>Debug Instrument I/O</td>
<td>10-9</td>
</tr>
<tr>
<td>10.5</td>
<td>The Terminal Window</td>
<td>10-10</td>
</tr>
<tr>
<td>10.5.1</td>
<td>Terminal Window Keyboard Mappings</td>
<td>10-10</td>
</tr>
</tbody>
</table>

**SPECIAL FEATURES**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.1</td>
<td>Transparency Mode</td>
<td>11-3</td>
</tr>
<tr>
<td>11.2</td>
<td>RTOS Aware Debugging</td>
<td>11-4</td>
</tr>
<tr>
<td>11.3</td>
<td>Coverage</td>
<td>11-6</td>
</tr>
<tr>
<td>11.4</td>
<td>Profiling</td>
<td>11-8</td>
</tr>
<tr>
<td>11.4.1</td>
<td>Function Profiling</td>
<td>11-9</td>
</tr>
</tbody>
</table>
### Table of Contents

11.4.2 Code Range Profiling .................................. 11-10
11.5 Data Analysis ........................................... 11-11
11.5.1 Supplied Data Analysis Window Scripts .......... 11-13
11.6 Program a FLASH Device ................................. 11-19
11.7 Background Mode ......................................... 11-23
11.7.1 Configuration ......................................... 11-23
11.7.2 Manual Refresh ........................................ 11-24
11.7.3 Entering Background Mode ............................ 11-25
11.7.4 Leaving Background Mode .............................. 11-26
11.7.5 The Stack in Background Mode ....................... 11-27
11.7.6 Local and Global Variables ......................... 11-27
11.7.7 Refresh Limitation .................................... 11-27
11.7.8 Assertions .............................................. 11-28

**DEBUGGING NOTES** 12-1

12.1 Debugging Assembly Language ......................... 12-3
12.2 Debugging Multiple Programs ......................... 12-3

**COMMAND REFERENCE** 13-1

13.1 Conventions Used in this Chapter ....................... 13-3
13.2 Commands: Summary ........................................ 13-4
13.2.1 Viewing Commands .................................... 13-4
13.2.2 Code And Data Monitoring ............................ 13-5
13.2.3 Data Analysis ......................................... 13-7
13.2.4 Execution Control Commands ....................... 13-8
13.2.5 Record & Playback ..................................... 13-11
13.2.6 Macros ................................................. 13-12
13.2.7 Input/Output Simulation .............................. 13-13
13.2.8 File System Simulation ............................... 13-14
13.2.9 Target System Control ............................... 13-14
13.2.10 Save and Restore Target State ..................... 13-15
13.2.11 Help Commands ....................................... 13-15
13.2.12 Search Commands .................................... 13-16
### Table of Contents

#### 13.3 Commands: Detailed Descriptions

- **ERROR MESSAGES**
  - 14.1 What this Chapter Covers
  - 14.2 Error Messages

- **GLOSSARY**
  - 15.1 What this Chapter Covers
  - 15.2 Glossary Terms

- **INTERPROCESS COMMUNICATION**
  - 1 COM Interface
    - 1.1 Introduction
    - 1.2 Using the COM Object Interface
      - 1.2.1 Run-Time Environment
      - 1.2.2 Command Line Options
      - 1.2.3 Startup Directory
    - 1.3 COM Interfaces
      - 1.3.1 Activating the COM object
      - 1.3.2 Methods
      - 1.3.3 Implementation Details
    - 1.4 Events
    - 1.5 COM Examples
      - 1.5.1 Python Examples
      - 1.5.2 Visual Basic Examples
      - 1.5.3 WORD Examples
      - 1.5.4 Excerpt of the MIDL Definition
    - 2 DDE Server Interface
      - 2.1 Introduction
      - 2.2 DDE Items and Topics
      - 2.3 DDE Events
      - 2.3.1 Packet Format
### CrossView Pro DDE Specific Options and Commands

- **2.4 CrossView Pro DDE Specific Options and Commands**
  - A-28

#### 2.4.1 Command Line Options
- A-28

#### 2.4.2 Commands
- A-28

### Examples

- **2.5 Examples**
  - A-29

#### 2.5.1 Evaluating an Expression
- A-29

#### 2.5.2 Reading Target Memory
- A-30

#### 2.5.3 Writing Into Target Memory
- A-31

#### 2.5.4 Requesting Current File and Line Number
- A-32

#### 2.5.5 Using CrossView Pro as Pure Server
- A-32

### CROSSVIEW EXTENSION LANGUAGE (CXL)

#### 1 Introduction
- B-3

#### 2 The Syntax of CXL
- B-4

##### 2.1 Variables
- B-6

##### 2.2 Base Types
- B-6

##### 2.3 Compound Types
- B-7

##### 2.4 Pointers
- B-7

##### 2.5 Constants and Expressions
- B-8

#### 2.6 Operators
- B-8

#### 2.7 Functions
- B-9

##### 2.8 File Inclusion
- B-9

#### 3 Predefined Functions
- B-10

##### 3.1 Mathematical functions
- B-10

##### 3.2 Array and String functions
- B-11

##### 3.3 I/O functions
- B-11

##### 3.4 Graph functions
- B-13

##### 3.5 Miscellaneous functions
- B-17

### SOUND SUPPORT (MS-Windows)

- C-1
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>Mon-3</td>
</tr>
<tr>
<td>Executable Name</td>
<td>Mon-3</td>
</tr>
<tr>
<td>General Operation</td>
<td>Mon-3</td>
</tr>
<tr>
<td>Restrictions</td>
<td>Mon-4</td>
</tr>
<tr>
<td>The RAM and ROM Debug Monitor</td>
<td>Mon-5</td>
</tr>
<tr>
<td>Monitor Configurations</td>
<td>Mon-5</td>
</tr>
<tr>
<td>5.1.1 RAM Debug Monitor</td>
<td>Mon-5</td>
</tr>
<tr>
<td>5.1.2 ROM Debug Monitor Using Dual Vector Table</td>
<td>Mon-11</td>
</tr>
<tr>
<td>5.1.3 ROM Debug Monitor Using Memory Switch</td>
<td>Mon-13</td>
</tr>
<tr>
<td>5.2 Resources used by the Debug Monitors</td>
<td>Mon-14</td>
</tr>
<tr>
<td>5.3 Rebuilding the Debug Monitors</td>
<td>Mon-16</td>
</tr>
<tr>
<td>5.3.1 Debug Monitor Configuration Parameters</td>
<td>Mon-18</td>
</tr>
<tr>
<td>5.4 Debug Monitor Interface Description</td>
<td>Mon-21</td>
</tr>
<tr>
<td>5.4.1 Initialization</td>
<td>Mon-21</td>
</tr>
<tr>
<td>5.4.2 Conventions</td>
<td>Mon-21</td>
</tr>
<tr>
<td>5.4.3 Command Set</td>
<td>Mon-23</td>
</tr>
<tr>
<td>The Target Configuration File</td>
<td>Mon-35</td>
</tr>
<tr>
<td>Building your Application</td>
<td>Mon-40</td>
</tr>
<tr>
<td>Connecting to the Target Board</td>
<td>Mon-41</td>
</tr>
<tr>
<td>8.1 RS-232</td>
<td>Mon-41</td>
</tr>
<tr>
<td>8.2 CAN (Windows Only)</td>
<td>Mon-43</td>
</tr>
<tr>
<td>8.3 CAN Interface Messages</td>
<td>Mon-45</td>
</tr>
<tr>
<td>8.4 Connection Process Messages</td>
<td>Mon-47</td>
</tr>
<tr>
<td>8.5 Connection Problems</td>
<td>Mon-49</td>
</tr>
<tr>
<td>Troubleshooting the Debug Monitor</td>
<td>Mon-50</td>
</tr>
<tr>
<td>10 Target Board Application Notes</td>
<td>Mon-52</td>
</tr>
<tr>
<td>10.1 Ertec EVA165, EVA167 and EVA167AA</td>
<td>Mon-55</td>
</tr>
<tr>
<td>10.2 Rigel RMB-165, RMB-167, RMB-167SR and RMB-167CRI</td>
<td>Mon-56</td>
</tr>
<tr>
<td>10.3 I+ME C167C Board</td>
<td>Mon-56</td>
</tr>
<tr>
<td>10.3.1 Debug Monitors</td>
<td>Mon-56</td>
</tr>
<tr>
<td>10.3.2 Connection</td>
<td>Mon-56</td>
</tr>
<tr>
<td>10.4 PHYTEC MM-165, MM-167CR and MM-167CW</td>
<td>Mon-57</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>10.4.1</td>
<td>Boot Program</td>
</tr>
<tr>
<td>10.4.2</td>
<td>Connection</td>
</tr>
<tr>
<td>10.5</td>
<td>PHYTEC KC-161, KC-163, KC-164 and KC-167</td>
</tr>
<tr>
<td>10.6</td>
<td>TQ-Components STK16X/STK16XU Starter Kits</td>
</tr>
</tbody>
</table>

**SIMULATOR**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>Sim-3</td>
</tr>
<tr>
<td>2</td>
<td>Executable Name</td>
<td>Sim-3</td>
</tr>
<tr>
<td>3</td>
<td>Supported Features</td>
<td>Sim-3</td>
</tr>
<tr>
<td>3.1</td>
<td>Mapping Memory</td>
<td>Sim-3</td>
</tr>
<tr>
<td>4</td>
<td>Peripheral Simulation</td>
<td>Sim-4</td>
</tr>
<tr>
<td>4.1</td>
<td>Peripheral Support</td>
<td>Sim-4</td>
</tr>
<tr>
<td>4.2</td>
<td>Scenario Scripting Using CXL</td>
<td>Sim-6</td>
</tr>
<tr>
<td>4.3</td>
<td>Peripheral Examples</td>
<td>Sim-8</td>
</tr>
<tr>
<td>5</td>
<td>Target Configuration File</td>
<td>Sim-9</td>
</tr>
<tr>
<td>6</td>
<td>Restrictions and Implementation Details</td>
<td>Sim-11</td>
</tr>
</tbody>
</table>

**ON-CHIP DEBUG SUPPORT**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>OCDS-3</td>
</tr>
<tr>
<td>2</td>
<td>Supported Hardware</td>
<td>OCDS-3</td>
</tr>
<tr>
<td>3</td>
<td>Additional System Requirements</td>
<td>OCDS-3</td>
</tr>
<tr>
<td>4</td>
<td>Installation</td>
<td>OCDS-4</td>
</tr>
<tr>
<td>4.1</td>
<td>Hardware Installation OCDS via the Parallel Port</td>
<td>OCDS-4</td>
</tr>
<tr>
<td>4.2</td>
<td>Hardware Installation OCDS via DAS</td>
<td>OCDS-4</td>
</tr>
<tr>
<td>4.3</td>
<td>Software Installation</td>
<td>OCDS-4</td>
</tr>
<tr>
<td>4.4</td>
<td>Configuring CrossView Pro</td>
<td>OCDS-5</td>
</tr>
<tr>
<td>5</td>
<td>OCDS Breakpoints</td>
<td>OCDS-5</td>
</tr>
<tr>
<td>6</td>
<td>The Target Configuration File</td>
<td>OCDS-6</td>
</tr>
<tr>
<td>7</td>
<td>Infineon Board OCDS Interface Circuit</td>
<td>OCDS-9</td>
</tr>
<tr>
<td>7.1</td>
<td>The Infineon JTAG connector</td>
<td>OCDS-11</td>
</tr>
<tr>
<td>7.1.1</td>
<td>The connector Layout</td>
<td>OCDS-11</td>
</tr>
<tr>
<td>7.1.2</td>
<td>Implementation Considerations</td>
<td>OCDS-13</td>
</tr>
</tbody>
</table>
MANUAL PURPOSE AND STRUCTURE

PURPOSE

This manual is aimed at users of the CrossView Pro debugger for the C166/ST10 microcontroller family. It assumes that you are familiar with programming the C166/ST10.

MANUAL STRUCTURE

Related Publications
Conventions Used In This Manual

CHAPTERS

1. Overview
   Highlights specific CrossView Pro features and capabilities, and shows how to compile code for debugging.

2. Software Installation
   Describes how to install CrossView Pro on your system.

3. Command Language
   Details the syntax of CrossView Pro’s command language.

4. Using CrossView Pro
   Describes the basic methods of invoking, operating, and exiting CrossView Pro.

5. Controlling Program Execution
   Describes the various means of program execution.

6. Accessing Code and Data
   Describes how to view and edit the variables in your source program.

7. Breakpoints and Assertions
   Describes breakpoints and assertions.
8. Defining and Using Macros
   Describes how to simplify a complicated procedure by creating a "shorthand" macro which can be used to execute any sequence of CrossView Pro or C language commands and expressions.

9. Command Recording & Playback
   Describes the record and playback functions of CrossView Pro.

10. I/O Simulation
    Describes how to simulate your input and output using File System Simulation (FSS), File I/O (FIO) or Debug Instrument I/O (DIO).

11. Special Features
    Describes special features of CrossView Pro, such as the Transparency Mode, RTOS Aware Debugging, Coverage, Profiling and the Background Mode.

12. Debugging Notes
    Contains some notes about debugging in special situations.

13. Command Reference
    An alphabetical list of all CrossView Pro commands. Consult this chapter for specifics and the exact syntax of any CrossView Pro command.

14. Error Messages
    Contains CrossView Pro error messages and gives advice for correcting them.

15. Glossary
    Defines the most common terms used in embedded systems debugging.
APPENDICES

A. Interprocess Communication  
   Contains a description of the COM interface and the DDE interface.

B. CrossView Extension Language (CXL)  
   Contains a description of the syntax of CXL scripts.

C. Sound Support (MS–Windows)  
   Describes how to add sound to CrossView Pro events under MS–Windows.

ADDENDUM

Execution Environment  
Contains information specific to your particular type of target system.
RELATED PUBLICATIONS

- ANSI X3.159-1989 standard [ANSI]
- C166/ST10 Cross-Assembler, Linker/Locator, Utilities User’s Manual [TASKING, MA019-000-00-00]
- C166/ST10 C Cross-Compiler User’s Manual [TASKING, MA019-002-00-00]
- C166/ST10 C++ Compiler User’s Manual [TASKING, MA019-012-00-00]
- C166 User’s Manual [Infineon Technologies]
- C167 User’s Manual [Infineon Technologies]
- ST10 Family Programming Manual [STMicroelectronics]
- C166S v2.0 / Super10 User’s Manual [Infineon Technologies / STMicroelectronics]
- Evaluation board Manuals [Miscellaneous vendors]
CONVENTIONS USED IN THIS MANUAL

Notation for syntax

The following notation is used to describe the syntax of command line input:

**bold** Type this part of the syntax literally.

*italics* Substitute the italic word by an instance. For example:

    filename

    means: type the name of a file in place of the word *filename*.

{ } Encloses a list from which you must choose an item.

[] Encloses items that are optional.

| Separates items in a list. Read it as OR.

... You can repeat the preceding item zero or more times.

For example

    command [option]... filename

This line could be written in plain English as: execute the command *command* with the optional options *option* and with the file *filename*.


**Illustrations**

The following illustrations are used in this manual:

- This is a note. It gives you extra information.
- This is a warning. Read the information carefully.
- This illustration indicates actions you can perform with the mouse.
- This illustration indicates keyboard input.
- This illustration can be read as “See also”. It contains a reference to another command, option or section.
CHAPTER 1

OVERVIEW
1.1 INTRODUCTION

This chapter highlights many of the features and capabilities of CrossView Pro, including an Introduction to Source Level Debugging and the C166/ST10 Development Environment.

This chapter also contains the section *Getting Started*, which shows you how to compile a program to work with the debugger.

1.2 CROSSVIEW PRO'S FEATURES

CrossView Pro is TASKING’s high-level language debugger. CrossView Pro is a real-time, source-level debugger that lets you debug embedded microprocessor systems at your highest level of productivity. Its powerful capabilities include:

- Multi-Window Graphical User Interface
- C and Assembly level debugging
- C Expression Evaluation including Function Calls
- Breakpoints (both hardware and software)
- Probe Points
- Assertions (software data breakpoints)
- C-trace, Instruction Trace
- I/O Simulation (IOS)
- Data Monitoring
- Single Stepping
- Coverage
- Profiling
- Macros
- Flexible Record & Playback Facilities
- Real-Time Kernel Support
- On-line context sensitive Help
- Documentation
**Multi-Window Interface**

This interface uses your host's native windowing system, so that you already know how to open, close and resize windows. With windows you can keep track of information concerning registers, the stack, and variables. CrossView Pro automatically updates each window whenever execution stops.

You have great freedom in designing a suitable display. You can hide and resize the various windows if you choose.

**Statement Evaluation**

You can enter C expressions, CrossView Pro commands or any combination of the two for CrossView Pro to evaluate. You may also call functions defined in your source code from the command line. Expression evaluation is an ideal way to test subroutines by passing them sample values and checking the results.

**Breakpoints**

Breakpoints halt program execution and return control to you. There are several types of breakpoints: code, data, instruction count, cycle count, timer and sequence.

Code breakpoints let you halt the program at critical junctures of program execution and observe values of important variables.

You may place data breakpoints to determine when memory addresses are read from, written to, or both. With data breakpoints, you can easily track the use and misuse of variables.

An instruction count breakpoint halts the program after a specified number of instructions have been executed; a cycle count breakpoint stops the program after a number of CPU cycles; a timer breakpoint stops the program after a number of micro seconds or ticks and sequence breakpoints stop the program when a number of breakpoints are hit in a specified sequence.

Data breakpoints, instruction count breakpoints, cycle count breakpoints and timer breakpoints are not available for all execution environments, please check the Addendum.
**Probe Point Breakpoints**

A breakpoint can be treated as a probe point. When a probe point breakpoint is hit, the associated commands are executed and program execution is continued. Probe points are used with File I/O simulation and sequence breakpoints.

**Assertions**

A powerful assertion mechanism lets you catch hard-to-find-errors. An assertion is a command, or series of commands, executed after every line of source code. You may use assertions to test for all sorts of error conditions throughout the entire length of your program.

**C-Trace**

CrossView Pro has a separate window that displays the most recently executed C statements or machine instructions. This feature uses the execution environment’s trace buffer along with symbolic information generated during compilation. This feature is depending on the execution environment.

**I/O Simulation (IOS)**

With I/O simulation you can debug programs before the actual input and output devices are present. CrossView Pro can read input data from the keyboard or a file, or can send output to a window or a file. You can view the data in several formats, including hexadecimal and character. You can have an unlimited number of simulated I/O ports, which can be associated with the screen and displayed in windows.

**Data Monitoring**

You may place variables and expressions in the Data window, where CrossView Pro updates their values when execution stops.

**Single Stepping**

With CrossView Pro, you can single step through your code at source level or at assembly level, into or over procedure calls. Running your program one line at a time lets you check variables and program flow.
**Coverage**

When a command such as StepInto or Continue executes the application, CrossView Pro traces all memory access, i.e. memory read, memory write and instruction fetch. Through *code coverage* you can find executed and non-executed areas of the application program. Areas of unexecuted code may exist because of programming errors or because of unnecessary code. It may be that your program input, your test set, is incomplete; It does not cover all paths in the program. *Data coverage* allows you to verify which memory locations, i.e. which variables, are accessed during program execution. Additionally, you can see stack and heap usage. The availability of this feature depends on the execution environment.

**Profiling**

Profiling allows you to perform timing analysis on your software. Two forms of profiling are implemented in CrossView Pro.

*Function profiling*, also called cumulative profiling, gives you timing information about a particular function or set of functions. CrossView Pro shows: the number of times a function is called, the time spent in the function, the percentage of time spent in the function, and the minimum/maximum/average time spent in the function. The timing results include the time spent in functions called by the profiled function.

*Code range profiling* presents timing information about a consecutive range of program instructions. CrossView Pro displays the time consumed by each line (source or disassembly) in the Source Window. Next to this, the Profile Report dialog shows the time spend in each function. The timing results do not include the time consumed in functions called by the profiled function.

The availability of profiling depends on the execution environment. Function profiling can be supported if the execution environment provides a clock that starts and stops whenever execution starts and stops. Code range profiling heavily relies on special profiling features in the execution environment. Normally code range profiling is only supported by instruction set simulators.
Macros

Macros let you store and recall complex commands and expressions with a minimal number of keystrokes. You can store macros in a "toolbox", making it possible to execute complex functions with the touch of a mouse button. You can also place macros in command lists of breakpoints and assertions. You can use flow control statements within macros, and macros can call other macros, allowing you to construct arbitrarily complex sequences. Macros can accept multiple parameters, be saved and loaded from files and can even rename existing CrossView Pro commands.

Record & Playback

At any time, you can record the commands you type, and optionally their output, to a file. You can also play back files of commands all at once or in a single-step playback mode. These functions are helpful for setting up standardized debugging tests or to save results for later study or comparison.

Kernel Support

CrossView Pro supports RTOS (Real-Time Operating System) aware debugging for various kernels. Since each kernel is different, the RTOS aware features are not implemented in the CrossView Pro executable, but in a library that will be loaded at run-time by CrossView Pro. The amount of windows and dialogs and their contents is kernel dependent.

On-Line Help

When you click on a Help button or when you press the F1 function key in an active window, the CrossView Pro help system opens at the appropriate section. From this point, you can also access the rest of the help system.

Documentation

CrossView Pro has a comprehensive set of documentation for both new and experienced users. The manual includes an installation guide, description of debugging with CrossView Pro, error messages, and a command reference section. The documentation tries to cover a wide range of expertise, by making few assumptions about the technical experience of the reader.
1.3 SOURCE LEVEL DEBUGGING

CrossView Pro is a source level debugger. Source level means that debugging works on the actual C code or assembly code. CrossView Pro can deal with global and local variables that are both statically and dynamically allocated variables. Therefore, it can deal with compiled addresses of variables that move around the stack. CrossView Pro knows the compiler's addressing conventions for variables of any type.

The Debugging Environment

All debugging configurations follow a similar pattern. There is a host system where the debugger runs, and a target system (usually an execution environment), where the program being debugged runs. There may also be a probe that can plug into the actual hardware of the embedded system being designed.

CrossView Pro provides a high-level interface between you, the user, working at the host system and a program running at the target system (execution environment). This means that you may issue commands that refer directly to the variables, source files, and line numbers as they appear in the source program. You can do this because CrossView Pro uses symbol information generated during compilation to translate the high-level commands that you type into a series of low level instructions that the target system understands. Using Generic Debug Instrument (GDI) calls towards a shared library for the simulator, or using a connection between the host and target, CrossView Pro finds out information about the state of the target program and then tells the target to perform the requested actions.

A host-target arrangement can perform functions beyond the reach of traditional software-based debuggers. Since the target contains the actual chip, CrossView Pro can observe its operations without interfering. The existence of CrossView Pro and the host is invisible to the target program. This means that the program under debug runs exactly the same as the final program will in a real embedded system (except for real-time situations like timings).
With CrossView Pro, you may also take advantage of any advanced capabilities of your target hardware through *emulator mode* (transparency mode). In transparency mode you can communicate with the target as if the host system were a terminal directly connected to the target. You can enter and leave transparency mode freely without restarting the debugger or the target system. CrossView Pro therefore does not interfere with the normal operation of the target hardware. Thus the debugger is a powerful accessory to the machine-level debugging that you might do with the target system alone. The transparency mode is not available for all execution environments (such as an evaluation board).

### 1.4 HOW CROSSVIEW PRO WORKS

Although it is not necessary to know how CrossView Pro performs its debugging, you may be curious how CrossView Pro works.

Whenever you enter a debugger command, CrossView Pro obtains information from or controls the execution environment by sending appropriate commands over the host-target link. A typical session may go something like this:

1. Highlight *initval* and click on the **Show Expression** button in the Source Window.

![Figure 1-1: Show selected source expression](image_url)
2. CrossView Pro converts this action into a command. Depending on preferences you have set, the variable is shown in the Data Window or the Expression Evaluation dialog is shown.

3. CrossView Pro consults the symbol table to deduce the type and address of \texttt{initval}. Suppose \texttt{initval} is a variable of type \texttt{int} which lies at absolute location 100.

4. The debugger forms a command asking the target system to read two bytes starting at address 100 (the size of an \texttt{int} equals 2).

5. CrossView Pro then transmits the command to the target system and receives the response.

6. CrossView Pro interprets the response, and for example determines that \texttt{initval} equals 17.

7. CrossView Pro then displays \texttt{initval=17} since it knows \texttt{initval}'s type.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{crossviewቲ-

\textit{Figure 1-2: CrossView Pro Command Output}

This is a simplified example, many CrossView Pro commands require several complex transactions, but all take place without you being aware of them.
1.5 C166/ST10 PROGRAM DEVELOPMENT

The CrossView Pro debugger package is part of a toolchain that provides an environment for modular program development and debugging. The figure below shows the structure of the toolchain. The toolchain contains the following programs:

**cc166** The control program can build an absolute loadable file starting with an input file of any stage. With a C source file as input, **cc166** calls **c166**, **a166** and **l166** with the appropriate command line arguments.

**cp166** The C++ compiler which translates C++ source into C source suitable for the C compiler. Must be ordered separately.

**c166** The C cross-compiler which translates a C source program into a highly optimized assembly source file.

**m166** A string-macro preprocessor allowing macro substitution, file inclusion and conditional assembly, according to the Macro Preprocessor Language.

**a166** The assembler program which produces an object file from a given assembly file.

**l166** A linker/locator combining objects and object libraries into tasks or several tasks into one target load file.

**ar166** A librarian program, which can be used to create and maintain object libraries.

**d166** A utility to disassemble absolute object files and relocatable object files.

**dmp166** A dumper utility to report the contents of an object file.

**mk166** A program builder which uses a set of dependency rules in a 'makefile' to build only the parts of an application which are out of date.
Figure 1-3: C166/ST10 development flow
Overview

1.6 GETTING STARTED

1.6.1 BEFORE STARTING

Before using CrossView Pro, there are several things that you must do:

- Install the CrossView Pro software. Directions for your particular system are found in the Software Installation chapter.
- Configure your execution environment as described in the Execution Environment addendum.
- Compile the program that you want to debug. A brief description of this process is outlined in the section Building Your Executable later in this chapter.

For the purpose of getting you started quickly, we have supplied you with a demo program that you can debug. The demo program is demo.abs.
1.6.2 SETTING UP THE EXECUTION ENVIRONMENT

The following only applies to ROM monitor and emulator versions of CrossView Pro.

In order for the host and execution environment to communicate, a proper connection must exist between the two machines. Here are some important considerations:

- Use the correct kind of RS-232 cable. Note there are at least two types of cables, null modem and direct. Consult the execution environment’s manual for the correct type.

- Make sure the execution environment is configured to communicate with the host at the baud rate that CrossView Pro expects. Evaluation boards usually have an auto baud rate detection. The highest possible baud rate for the PC is 19200 baud. The default baud rate is 9600.

- Use the correct ports on both the execution environment and host. Many machines have two ports. If you use a different port on the host than the default (COM1 for PC), you will have to use a special startup switch, \texttt{-D}. See the startup options of the Using CrossView Pro chapter.

- See the addendum for details on the connection to the execution environment.

From EDE you can select an execution environment in the Execution Environment page of the CrossView Pro entry in the Project | Project Options dialog.
1.6.3 STARTING CROSSVIEW PRO

To invoke CrossView Pro, select it from the Windows Start menu or click on the Debug application button from EDE. CrossView Pro starts up and opens the command window, source window and other windows.

![Figure 1-4: Command Window]

- Breakpoint
- Toggle
- Local Toolbar
- Menu Bar
- Main Toolbar
- Source Window
- Status Bar
- Toolbars
- Main Status Bar
- Local Toolbars
CrossView Pro can be passed the name of an execution (*.abs) file. When you invoke CrossView Pro from EDE, EDE automatically passes the name of the absolute file (project.abs) of the current project. If do not use EDE you can do this from a command line, but the native windowing system often provides alternatives. Usually this involves dragging the program to be debugged onto the CrossView Pro executable from the Windows Explorer, and dropping it there or associating CrossView Pro to be the application to start when double-clicking an .abs icon. CrossView Pro will start and load the symbol information from that file.

1.6.3.1 CROSSVIEW PRO TARGET SETTINGS

You can specify specific CrossView Pro startup settings in the Target Settings dialog.

To open the Target Settings dialog:

- From the **Target** menu, select **Settings...**

  The Target Settings dialog box appears as shown in figure 1-5.

![Target Settings Dialog](image)

*Figure 1-5: CrossView Pro Target Settings*
You can set the following items in this dialog:

- Select a target configuration containing some target specific configuration items. See the text below for more information.
- Select the CPU type (optional).
- Specify the source directories for CrossView Pro. Click on the Configure... button to change the list of source directories.

**Target Configuration**

The available targets are described by the target configuration files (*.cfg in the etc subdirectory). These targets include evaluation boards, emulator boards or instruction set simulators (sim*.cfg). The target configuration files are text files and can be edited with any text editor.

Empty lines, lines consisting of only white space are allowed. Comment starts at an exclamation-sign ('!') and ends at the end of the line.

An information line has the following synopsis:

```
![comment] field: [subfield =] field-value
```

- **field**: one of the keywords described below
- **subfield**: the usage of this part depends on the value of field, see below
- **field-value**: the value assigned to the field
- **comment**: optional comment
The *fields* listed in the configuration file are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of the Target Settings dialog.</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the CPU present on the target board. CrossView Pro knows four types of CPUs, 167, 167mac, ext2mac and ext22mac. '167' represents the extended architecture, like the C161, C163, C164, C165 and C167 families. '167mac' represents the extended architecture including the MAC coprocessor, like the ST10x262 and ST10x272 families. 'ext2mac' represents the second extended architectures like the XC16x and Super10. 'ext22mac' represents the enhanced Super10 architectures.</td>
</tr>
<tr>
<td>register_file</td>
<td>The filename of the register file (* .def) to be used for the CPU on the target. When this field is omitted CrossView Pro uses the default reg .def as register file. This register file contains debug information for CrossView Pro like which (E)SFR registers are present and at which location.</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging: 'disim166' for the instruction set simulator, 'dieva166' for a target board connection using a serial or CAN interface, 'diocds166' for target boards that use the OCDS interface via the parallel port and 'gdi2das' for target boards that use the OCDS interface via DAS.</td>
</tr>
<tr>
<td>radm</td>
<td>The name of the Debug Instrument (using KDI) used for RTOS aware debugging. (optional).</td>
</tr>
</tbody>
</table>
For FLASH programming support the following items can be added to this list:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flash_monitor</td>
<td>The filename of the FLASH programming monitor, used for flashing files (for example a ROM monitor) in an EPROM.</td>
</tr>
<tr>
<td>flash_direct_access</td>
<td>When set to TRUE, CrossView Pro performs flash operations using target memory read/write accesses. When FALSE, CrossView Pro downloads a FLASH programming monitor to the target and executes this program to perform the flash operations.</td>
</tr>
<tr>
<td>flash_device_num</td>
<td>The FLASH device number.</td>
</tr>
<tr>
<td>flash_workspace</td>
<td>The code address where the FLASH programming monitor must be loaded.</td>
</tr>
<tr>
<td>flash_vendor0</td>
<td>The name of the FLASH device vendor.</td>
</tr>
<tr>
<td>flash_chip0</td>
<td>The name or type of FLASH device.</td>
</tr>
<tr>
<td>flash_width0</td>
<td>The width (in bits) per FLASH device.</td>
</tr>
<tr>
<td>flash_chips0</td>
<td>The number of FLASH devices used.</td>
</tr>
<tr>
<td>flash_base_address0</td>
<td>The start address of the memory range that will be covered by the FLASH device.</td>
</tr>
</tbody>
</table>

For the instruction set simulator (ISS) the following items can be added to this list:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| map_iram | The range where the simulator should simulate internal RAM memory. Multiple ranges can be separated by commas ','.
| map_sfr  | The range where the simulator should simulate the SFRs and/or ESFRs. Multiple ranges can be separated by commas ','.
| map_ram  | The range where the simulator should simulate external RAM memory. Multiple ranges can be separated by commas ','.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>map_rom</td>
<td>The range where the simulator should simulate external ROM memory. Multiple ranges can be separated by commas ','.</td>
</tr>
<tr>
<td>psm_dll_name</td>
<td>The name of the peripheral simulation module: ‘psm166’.</td>
</tr>
</tbody>
</table>

For the ROM monitor the following items can be added to this list:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bslack</td>
<td>The bootstrap loader identification byte of the CPU on the board. When CrossView Pro receives this byte from the board when making connection, it starts the bootstrap sequence. Please check your chip manual, chapter ‘Bootstrap loader’ for the definition of this identification byte. You can specify multiple identification bytes, by separating them with commas.</td>
</tr>
<tr>
<td>boot</td>
<td>The filename of the boot program for target boards using a bootstrap loader. CrossView Pro searches the boot program in the etc directory of the product or in the current working directory. The field can be omitted when the ROM Monitor is placed in ROM or FLASH. When this field is omitted, CrossView Pro will issue an error when the target board requests bootstrap loading.</td>
</tr>
<tr>
<td>monitor</td>
<td>The filename of the monitor program for target boards using a RAM debug monitor to be downloaded on the board using a bootstrap program. CrossView Pro searches the monitor program in the etc directory of the product or in the current working directory. The field can be omitted when the ROM Monitor is placed in ROM or FLASH. When this field is omitted, CrossView Pro will issue an error when the target board requests bootstrap loading.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>syscon</td>
<td>The initialization value for the SYSCON register. This entry is here for backwards compatibility only. The SYSCON register can now be initialized using <code>init.syscon</code>.</td>
</tr>
<tr>
<td>init</td>
<td>Initialize the register specified in the <code>subfield</code> with the value specified in <code>field-value</code>. The register name in <code>subfield</code> must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','.</td>
</tr>
<tr>
<td>einit</td>
<td>Initialize the register specified in the <code>subfield</code> with the value specified in <code>field-value</code> before the EINIT instruction is executed. Up to 6 registers can be initialized before EINIT. The register name in <code>subfield</code> must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','.</td>
</tr>
<tr>
<td>reserve</td>
<td>The reserved memory ranges (from - to) for monitor resources. EDE uses this field to generate RESERVE MEMORY locator controls. You can specify multiple ranges by separating them with commas ','.</td>
</tr>
<tr>
<td>reset_period</td>
<td>A period in milliseconds to hold the reset level at the required level.</td>
</tr>
<tr>
<td>rs232_reset_pin</td>
<td>The name of the RS232-pin to reset the target, for example RTS.</td>
</tr>
<tr>
<td>rs232_reset_level</td>
<td>The level when the reset is active.</td>
</tr>
<tr>
<td>rs232_reset_hold_level</td>
<td>The hold level when the reset is active.</td>
</tr>
<tr>
<td>rs232_bootstrap_pin</td>
<td>The name of the RS232-pin to set the target in bootstrap mode, for example DTR.</td>
</tr>
<tr>
<td>rs232_bootstrap_level</td>
<td>The level when the BSL pin is active.</td>
</tr>
<tr>
<td>rs232_bootstrap_hold_level</td>
<td>The hold level when the BSL pin is active.</td>
</tr>
</tbody>
</table>
For the JTAG/OCDS connection via parallel port, the following items can be added to this list:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor</td>
<td>The filename of the monitor program for target boards using a JTAG/OCDS debug interface. When this field is omitted, CrossView Pro will issue an error. For the C165UTAH board this is the file m167ocds.sre.</td>
</tr>
<tr>
<td>JtagDriver</td>
<td>The filename of the JTAG API interface. This interface communicates with the CrossView Pro 'diodcs166' Debug instrument (DI) on one side and the actual JTAG driver (installed as a service) on the other side. This driver actually communicates with target board via the parallel port.</td>
</tr>
<tr>
<td>RegisterFile</td>
<td>The filename of the register list file (*.dat) to be used for OCDS interface. This register file contains register information for the Debug Instrument like which (E)SFR registers are present and at which location. This file must be used along with the register_file entry which contains the register information for CrossView Pro.</td>
</tr>
<tr>
<td>init</td>
<td>Initialize the register specified in the subfield with the value specified in field-value. The register name in subfield must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','.</td>
</tr>
<tr>
<td>PeripheralsStop</td>
<td>When set to 1, peripherals will be stopped when hitting a breakpoint. By default, peripherals will not be stopped upon a breakpoint. For the C161U/C165UTAH you should also specify the suspending peripherals within the clock control registers S0CLC, SSCCLC, GPTCLC, RTCCLC, EPECCLC, USBCLC, IOMCLC. For the XC16x you should specify the suspending peripherals in the OPSEN register.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ResetDelay</td>
<td>A delay in milliseconds for CrossView Pro after a target reset. When you use OCDS, CrossView Pro resets the target. However, CrossView Pro cannot detect if the reset is released when a capacitor is used inside the reset circuit on the board.</td>
</tr>
<tr>
<td>Cable</td>
<td>JTAG cable number to the chip where the OCDS module is located. The value should always be 0.</td>
</tr>
<tr>
<td>ChipReset</td>
<td>By default the OCDS interface performs a Chip Reset with the reset pin (RSTIN) of the chip. You can disable this by setting the value to zero.</td>
</tr>
<tr>
<td>ClientValue</td>
<td>JTAG I/O mode OCDS module number. The value should always be 2.</td>
</tr>
<tr>
<td>reserve</td>
<td>The reserved memory ranges (from – to) for OCDS monitor resources. EDE uses this field to generate RESERVE MEMORY locator controls. You can specify multiple ranges by separating them with commas ','.</td>
</tr>
</tbody>
</table>

For OCDS via DAS the following items can be added to this list:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RegisterFile</td>
<td>The filename of the register list file (*.dat) to be used for OCDS interface. This register file contains register information for the Debug Instrument like which (E)SFR registers are present and at which location. This file must be used along with the register_file entry which contains the register information for CrossView Pro.</td>
</tr>
<tr>
<td>init</td>
<td>Initialize the register specified in the subfield with the value specified in field-value. The register name in subfield must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ResetDelay</td>
<td>A delay in milliseconds for CrossView Pro after a target reset. When you use OCDS, CrossView Pro resets the target. However, CrossView Pro cannot detect if the reset is released when a capacitor is used inside the reset circuit on the board.</td>
</tr>
<tr>
<td>DASserver</td>
<td>The name of the used DAS server, which must be run and/or installed on the connected host.</td>
</tr>
<tr>
<td>AccessPort</td>
<td>The connection to the device. For the USB server USBx means access via x and the USB of the device.</td>
</tr>
<tr>
<td>TerminateServer</td>
<td>When TerminateServer != 0, if a server is started by the debug instrument, this server is also terminated on exit.</td>
</tr>
<tr>
<td>reserve</td>
<td>The reserved memory ranges (from – to) for OCDS monitor resources. EDE uses this field to generate RESERVE MEMORY locator controls. You can specify multiple ranges by separating them with commas ','.</td>
</tr>
</tbody>
</table>

Notes:
- Fields not required for the target can be omitted.
- CrossView Pro searches for the *.cfg files in the current directory and in the etc directory.

1.6.3.2 CONFIGURING CROSSVIEW PRO

You may have to configure CrossView Pro to talk to the emulator or ROM monitor. If you have a simulator version this step is not needed and the associated menu item is grayed. To configure CrossView Pro:

- From the **Target** menu, select **Communication Setup**...
  The Communication Setup dialog box appears as shown in figure 1-6.
Figure 1-6: Setting up CrossView Pro Communications

- Adjust the communication parameters (baud rate and I/O port) to match your hardware configuration.
- Close the dialog box by clicking on the OK button.
- The settings in this dialog (and other dialogs) will be saved on exiting CrossView Pro, when the Save desktop and target settings check box in the Save tab of the Options dialog is set. This dialog always appears on exiting CrossView Pro.

From EDE you can set the communication parameters in the RAM/ROM Monitor Communication Setup page of the CrossView Pro entry in the Project | Project Options dialog.

1.6.3.3 LOADING SYMBOLIC DEBUG INFORMATION

You must tell CrossView Pro which program that you want to debug. To do this:

- From the File menu, select Load Symbolic Debug Info...
The Load Symbolic Debug Info dialog box appears, as shown in figure 1-7.
- Type in the path and file name of the program that you want to debug, or click on the Browse... button to bring up a file selection dialog box. In our example we are using demo.abs. Note that in most cases you will want to set the code bias field to 0x0000.
• If your program accepts command line arguments you can enter them as a comma separated list.

• Set the **Download image too** check box by clicking on it, if you want to download the image of your absolute object file to the target. You can decide to postpone downloading to the target. In that case you can select **Download Application...** from the **File** menu any time afterwards.

• Set the **Reset target system** check box if you want to reset the target system to its initial state. You can decide to postpone resetting the target. In that case you can select **Reset Target System** from the **Run** menu afterwards.

• Set the **Goto main** check box if you want to execute the startup code. This automatically enables the **Reset application** check box. You can decide to postpone going to the **main** function. In that case you can execute a high-level single step afterwards.

• When you click on the **Communication setup...** button (if available), the Communication Setup dialog box appears as shown in figure 1-6. With the **Target Settings...** button you can open the Target Settings dialog. Please check the information in these dialogs before downloading an application.

• When you click on the **Load** button, the program’s symbol file will be loaded into the debugger and, if you have set the **Download image too** check box, the image of your absolute object file will be downloaded.

• Clicking on **Cancel** ignores all actions.
CrossView Pro remembers all previously saved settings. In this case, the Load Symbolic Debug Info dialog already contains the previously saved configuration, so you only have to click the Load button to perform your actions.

Figure 1-7: Loading Symbolic Debug Information

**Compare Application / Verify download**

You can use the File | Compare Application... dialog to check if a file matches the downloaded application. This can be useful when your program has changed some of your code. If you enable the Verify download check box in the Load Symbolic Debug Info dialog, CrossView Pro does this comparison automatically after a download.
1.6.4 EXECUTING AN APPLICATION

To view your source while debugging, the Source Window must be open. To open this window,

- From the View menu, select Source | Source lines

Before starting execution you have to reset the target system to its initial state. The program counter, stack pointer and any other registers must be set to their initial value. The easiest way to do this is:

- Set the Reset target system check box and the Goto main check box in the Load Symbolic Debug Info dialog box. (See the previous section) Goto main automatically enables the Reset application check box.

Depending on your execution environment a target system reset may have undesired side effects. For this reason, the target system is reset before the code is downloaded to the target.

If you have not checked these items:

- From the Run menu, select Reset Target System
- From the Run menu, select Reset Application
- Execute a high-level single step (either into or over) using the toolbar in the Source Window (or F11/F10).

The first single step executes the startup code and stops at the first line of code in main(). You should see your program’s source code.

Another way of getting there is:

- Set a breakpoint at the entry of in main() by clicking on a breakpoint toggle at the left side of the text in the Source Window. See figure 1-8.

Start the application with Run | Reset Application and Run.

To set a breakpoint:

- Click on a breakpoint toggle (as shown in figure 1-8) to set or to remove a breakpoint. A green colored toggle shows that no breakpoint is set. A red colored toggle shows that a breakpoint is installed. An orange colored toggle shows that an installed breakpoint is disabled.
Due to compiler optimizations it is possible that a C statement does not translate in any executable code. In this case you cannot set a breakpoint at such a C statement. No breakpoint toggle is shown in this case.

Now it is time to execute your program:

- From the Run menu, select Run

In the Source Window the current execution position (the statement at the address identified by the current value of the program counter) is highlighted in blue. As a result, when execution stops, the line you set a breakpoint on is highlighted. You can now single step through your program using the Step Into and Step Over buttons in the Source Window. Or you may choose to execute the rest of the program (or at least until the next breakpoint) with the Run button.

At any point you can interrupt the emulator and regain control by clicking on the Halt button in either the Source Window or the Command Window.

For more information on executing a program, see the chapter Controlling Program Execution.
1.6.5 DEBUGGING AN APPLICATION

When debugging your application you probably want to see the calling sequence of your program, and inspect the contents of variables and data structures used within your program.

To see the calling sequence of your program the Stack Window must be open. The stack window shows the functions that are currently on the stack. To open the stack window,

- From the View menu, select Stack

To see the value of the local variables of a function,

- From the View menu, select Data | Watch Locals Window

![Figure 1-9: Watch variables](image)

Figure 1-9: Watch variables
To inspect the value of global variables and data structures,

- Double-click on the variable name in the Source Window.

Depending on preferences you have set, the variable is shown in the Data Window as shown in figure 1-9 or the dialog displayed in figure 1-10 is shown.

**Figure 1-10: Expression evaluation**

Pointers, structures and arrays displayed in the data window have a compact and expanded form. The compact form for a structure is just `<struct>`, while the expanded form shows all the fields. The compact form of a pointer is the value of the pointer, while the expanded form shows the pointed-to object. The compact form is indicated by putting a '+' at the start of the display (i.e., the object is expandable), while a '-' indicates the expanded form (i.e., the object is contractible). Nesting is supported, so structures within structures can likewise be expanded, ad infinitum.

To expand a pointer, structure or an array:

- Double-click on the '+' in the Data Window
1.6.6 CROSSVIEW PRO OUTPUT

Nearly every CrossView Pro command can be given using the graphical user interface. These commands and the debugger’s response is logged in the Command Output Window which is the upper part of the Command Window. Alternatively, CrossView Pro commands can be entered directly (without using the menu system) in the command edit field of the command window.

To open the Command Window:

- From the View menu, select Command | CrossView

Figure 1-11 shows an example of the Command Window. Commands can be typed into the command edit field (bottom field) or selected from the command history list (middle field) and edited then executed. The top field is referred to as the Command Output Window. Each command, echoed from the command edit field, is displayed with a ‘>’ prefix. CrossView’s response to the command is displayed below the command.

You can choose to clear the command edit field after executing a command. From the File menu, select Options... and select the Desktop tab. Enable the Clear command line after executing command check box. You can use the clear command to clear the Output Window.
1.6.7 EXITING CROSSVIEW PRO

To quit a debugging session:

- From the File menu, select Exit or close the Command Window.
- In the Options dialog that appears, select in the Save tab the options you want to be saved for another debug session.
- Click on the Exit button in the Options dialog.

If you selected one or more items in the Options dialog, your settings will be saved in the initialization file xvw.ini. This file is located in the startup directory.

Workspace files

If you have set the Save desktop and target settings check box in the Save tab, CrossView Pro will create a workspace file (.cws) for each debugged or loaded application. The settings will be restored in a following debug session. If CrossView Pro cannot find a workspace file for a loaded application it uses the default workspace file xvw.cws in the etc directory.

A CrossView Pro workspace file contains:

- Window positions and sizes
- Local toolbars status
- Main toolbar configuration
- Monitored variables in Data windows
- Memory window settings
- Terminal window settings
- Coverage and profiling display settings in the Source window
- Color settings
1.6.8 WHAT YOU MAY HAVE DONE WRONG

Most problems in starting up CrossView Pro for a debugging session stem from improperly setting up the execution environment or from an improper connection between the host computer and the execution environment. Some targets will require you to enter transparency mode to set the execution environment for a debugging session. Check the notes for your particular execution environment.

Here are some other common problems:

- Specifying the wrong device name when invoking the debugger.
- Specifying a baud rate different from the one the execution environment is configured to expect.
- Not supplying power to the execution environment or an attached probe.
- Using the wrong kind of RS-232 cable.
- Plugging the cable into an incorrect port on the execution environment or host. Some target machines and hosts have several ports.
- Installation of a device driver or resident application that uses the same communications port on the host system.
- The port may already be in use by another user on some UNIX hosts, or being allocated by a login process.
- Specifying no or an invalid CPU type with the \texttt{C} option.
1.6.9 BUILDING YOUR EXECUTABLE

The subdirectory xvw in the examples subdirectory contains a demo program for the C166/ST10 toolchain.

In order to debug your programs, you will have to compile, assemble, link and locate them for debugging using the TASKING C166/ST10 tools. You can do this with one call to the control program or you can use EDE, the Embedded Development Environment (which uses a project file) or you can call the makefile from the command line.

If you want to build a complete C166/ST10 executable application, the module containing the C function main() is treated like a reset task and therefore must be linked with C startup code. All tasks must be linked with a library, that contains, among run time routines, functions such as printf(). The C startup code is included in the C libraries delivered with the c166 compiler package for all memory models supported. In this case, we are using the small model, because this is the default memory model of c166. See the C166/ST10 C Cross-Compiler User’s Manual for detailed information on memory models and startup code.

1.6.9.1 USING EDE

EDE stands for “Embedded Development Environment” and is the Windows oriented Integrated Development Environment you can use with your TASKING toolchain to design and develop your application.

To use EDE on the demo program, located in the subdirectory xvw in the examples subdirectory of the C166/ST10 product tree, follow the steps below.

A detailed description of the process creating the sample program demo.abs is described below. This procedure is outlined as a guide for you to build your own executables for debugging.

How to Start EDE

You can launch EDE by double-clicking on the EDE shortcut on your desktop.
The EDE screen provides you with a menu bar, a toolbar (command buttons) and one or more windows (for example, for source files), a status bar and numerous dialog boxes.

How to Select a Toolchain

EDE supports all the TASKING toolchains. When you first start EDE, the correct toolchain of the product you purchased is selected and displayed in the title of the EDE desktop window.

If you have more than one TASKING product installed and you want to change toolchains, do the following:

1. From the **Project** menu, select **Select Toolchain**...

   *The Select Toolchain dialog appears.*
2. Select the toolchain you want. You can do this by clicking on a toolchain in the Toolchains list box and click OK.

If no toolchains are present, use the Browse... or Scan Disk... button to search for a toolchain directory. Use the Browse... button if you know the installation directory of another TASKING product. Use the Scan Disk... button to search for all TASKING products present on a specific drive. Then return to step 2.

How to Open an Existing Project

Follow these steps to open an existing project:

1. From the Project menu, select Set Current ->.

2. Select the project file to open. For the demo program select the file demo.pjt, located in the subdirectory xvw in the examples subdirectory of the C166/ST10 product tree. If you have used the defaults, the file demo.pjt is in the directory installation-dir\examples\xvw.

How to Load/Open Files

The next two steps are not needed for the demo program because the files addone.asm and demo.c are already open. To load the file you want to look at:

1. From the Project menu, select Load Files...
2. Choose the file(s) you want to open by clicking on it. You can select multiple files by pressing the <Ctrl> or <Shift> key while you click on a file. With the <Ctrl> key you can make single selections and with the <Shift> key you can select everything from the first selected file to the file you click on. Then click OK.

This launches the file(s) so you can edit it (them).

**Check the directory paths**

1. From the **Project** menu, select **Directories**...

   The **Directories** dialog appears.

2. Check the directory paths for programs, include files and libraries. You can add your own directories here, separated by semicolons.
3. Click **OK**.

**How to Build the Demo Application**

The next step is to compile the file(s) together with its dependent files so you can debug the application.

Steps 1 and 2 are optional. Follow these steps if you want to specify additional build options such as to stop the build process on errors and to keep temporary files that are generated during a build.

1. From the **Build** menu, select **Options**...

**The Build Options dialog appears.**

![Build Options Dialog](image)

2. Make your changes and press the **OK** button.

3. From the **Build** menu, select **Scan All Dependencies**.

4. Click on the **Execute 'Make' command** button. The following button is the execute Make button which is located in the toolbar.

If there are any unsaved files, EDE will ask you in a separate dialog if you want to save them before starting the build.
How to View the Results of a Build

Once the files have been processed you can inspect the generated messages.

You can see which commands (and corresponding output captured) which have been executed by the build process in the Build tab:

```
TASKING program builder vx.y rz Build nnn SN 00000000
Compiling and assembling demo.c
Preprocessing addone.asm
Assembling addone.src
Preprocessing start.asm
Assembling start.src
Linking and locating to demo.out
Converting demo.out to demo.abs in IEEE-695 format
```

How to Start the CrossView Pro Debugger

Once the files have been compiled, assembled, linked, located and formatted they can be executed by CrossView Pro.

To execute CrossView Pro:

1. Click on the Debug application button. The following button is the Debug application button which is located in the toolbar.

CrossView Pro is launched. CrossView Pro will automatically download the compiled file for debugging.

How to Start a New Project

When you first use EDE you need to setup a project space and add a new project:

1. From the File menu, select New Project Space...

   The Create a New Project Space dialog appears.

2. Give your project space a name and then click OK.

   The Project Properties dialog box appears.

3. Click on the Add new project to project space button.

   The Add New Project to Project Space dialog appears.
4. Give your project a name and then click **OK**.

*The Project Properties dialog box then appears for you to identify the files to be added.*

5. Add all the files you want to be part of your project. Then press the **OK** button. To add files, use one of the 3 methods described below.

   - If you do not have any source files yet, click on the **Add new file to project** button in the Project Properties dialog. Enter a new filename and click **OK**.
   - To add existing files to a project by specifying a file pattern click on the **Scan existing files into project** button in the Project Properties dialog. Select the directory that contains the files you want to add to your project. Enter one or more file patterns separated by semicolons. The button next to the **Pattern** field contains some predefined patterns. Next click **OK**.
   - To add existing files to a project by selecting individual files click on the **Add existing files to project** button in the Project Properties dialog. Select the directory that contains the files you want to add to your project. Add the applicable files by double-clicking on them or by selecting them and pressing the **Open** button.

The new project is now open.

6. From the **Project** menu, select **Load Files**... to open the files you want on your EDE desktop.

EDE automatically creates a makefile for the project. EDE updates the makefile every time you modify your project.
1.6.9.2 USING THE CONTROL PROGRAM

A detailed description of the process creating the sample program demo.abs is described below. This procedure is outlined as a guide for you to build your own executables for debugging.

In order to debug your programs, you will have to compile, assemble, link and locate them for debugging using the TASKING c166 compiler package following the procedure outlined below:

1. Compile your modules with -g (generate debug symbols).
2. Assemble your modules with DEBUG (generate debug symbols).
3. Locate with the RESERVE MEMORY control for the specific execution environment.
4. Format the output of the locate stage into IEEE-695 format.
5. Download image part of absolute IEEE-695 file to the target, usually as an CrossView Pro command line option (-i).

The program is now ready to be debugged with CrossView Pro.

You can do this with one call to the control program.

1. Make the subdirectory xvw of the examples directory the current working directory.
2. Be sure that the directory of the binaries is present in the PATH environment variable when you work from a command prompt instead of from EDE.
3. Compile, assemble, link and locate the modules using one call to the control program cc166:

```
cc166 -s -g -Ot -ieee demo.c addone.src demo.ilo -o demo.abs
```

The -s option puts the C source text as comments into the output assembly source files.

The -g option instructs the compiler to generate symbolic debugging information. This option must always be specified when debugging with CrossView Pro.
The `-Ot` option is needed only to demonstrate the deliberate bug in `demo.c`. Normally you can omit this option.

The `-ieee` option specifies the IEEE Std. 695 format.

The `-o` option specifies the name of the output file.

To compile for the C167 also specify the `-x` option. This enables all features of the C167.

The command in step 3 generates the object files `demo.obj` and `addone.obj`, the locator map file `demo.map` and the absolute output file `demo.abs`. The file `demo.abs` is in the IEEE Std. 695 format, and can directly be used by CrossView Pro. No separate formatter is needed.

Now you have created all the files necessary for debugging with CrossView Pro using one call to the control program.

If you want to see how the control program calls the compiler, assembler, linker and locator, you can use the `-v0` option or `-v` option. The `-v0` option only displays the invocations without executing them. The `-v` option also executes them.

```
cc166 -s -g -Ot -ieee demo.c addone.src
demo.ilo -o demo.abs -v0
```

The control program shows the following command invocations without executing them (UNIX output):

```
demo.c:
+ c166 demo.c -o /tmp/cc6825c.src -e -s -g -Ot
+ a166 /tmp/cc6825c.src TO demo.obj NOPR

addone.src:
+ a166 addone.src TO addone.obj NOPR
+ l166 LNK TO /tmp/cc6825e.lno demo.obj addone.obj 166/c166s.lib
  166/fp166s.lib 166/rt166s.lib
+ l166 LOC TO /tmp/cc6825f.out /tmp/cc6825e.lno PR(demo) @demo.ilo
+ ieee166 /tmp/cc6825f.out demo.abs
```

The `-e` option removes output files after errors occur. The NOPR assembler control suppresses list file generation. The TO control has the same function as the `-o` option of the other tools, and specifies the output filename. The PR control of the locator specifies the basename of the map file.
The demo.ilo file contains the following locator invocation controls:

```
RESERVE MEMORY
{
  00200h to 00FFFh ; Monitor code and data
  0FCC0h to 0FCDFh ; Monitor register bank
  0FD00h to 0FD4Bh ; Monitor data
}
SECSIZE( C166_US( +40 ) )
NOCHECKCLASSES ; No classes check
```

The RESERVE control reserves areas used by the several debug monitors. The SECSIZE control increases the user stack size because the demo program contains a recursive function. The NOCHECKCLASSES control tells the locator not to check if all classes have a CLASSES control.

The memory regions 0200h to 0FFFh, 0FCC0h to 0FCDFh and 0FD00h to 0FD4Bh must be reserved by the locator, because this area is used by several debug monitors. See the addendum for more details on the execution environment.

As you can see, the tools use temporary files for intermediate results. If you want to keep the intermediate files you can use the -tmp option. The following command makes this clear.

```
cc166 -s -g -Ot -ieee demo.c addone.src
demo.ilo -o demo.abs -v0 -tmp
```

This command produces the following output:

```
+ c166 demo.c -o demo.src -e -s -g -Ot
+ a166 demo.src TO demo.obj NOPR
addone.src:
+ a166 addone.src TO addone.obj NOPR
+ l166 LNK TO demo.lno demo.obj addone.obj 166/cl66s.lib 166/fp166s.lib
166/rt166s.lib
+ l166 LOC TO demo.out demo.lno PR(demo) @demo.ilo
+ ieee166 demo.out demo.abs
```

As you can see, if you use the -tmp option, the assembly source files and linker output file will be created in your current directory also.

Of course, you will get the same result if you invoke the tools separately using the same calling scheme as the control program.

As you can see, the control program automatically calls each tool with the correct options and controls.
1.6.9.3 USING THE MAKEFILE

The subdirectories in the `examples` directory each contain a `makefile` which can be processed by `mk166`.

To build the demo example follow the steps below. This procedure is outlined as a guide for you to build your own executables for debugging.

1. Make the subdirectory `xvw` of the `examples` directory the current working directory.

   This directory contains a makefile for building the demo example. It uses the default `mk166` rules.

2. Be sure that the directory of the binaries is present in the `PATH` environment variable.

3. Compile, assemble, link and locate the modules using one call to the program builder `mk166`.

   ```
   mk166
   ```

   This command will build `demo.abs` for the C16x/ST10 architecture using the file `makefile`.

   To see which commands are invoked by `mk166` without actually executing them, type:

   ```
   mk166 -n
   ```

   This command produces the following output:

   ```
   TASKING C166/ST10 program builder vx.yrz Build nnn
   Copyright years Altium BV Serial# 00000000
c166 -w183 -x -s -g -Ot demo.c
   a166 demo NOPR
   m166 addone
   a166 addone NOPR EXTEND
   l166 LINK demo.obj, addone.obj, ext/c166s.lib, ext/rt166s.lib TO demo.lno
   l166 LOCATE demo.lno TO demo.out @demo.ilo
   ieee166 demo.out demo.abs
   ```

   The `-x` option, the EXTEND control and the extended library in the makefile are used to specify the C16x/ST10.

   To remove all generated files type:

   ```
   mk166 clean
   ```
CHAPTER 2

SOFTWARE INSTALLATION

TASKING
2.1 INTRODUCTION

This chapter describes additional notes for running the CrossView Pro debugger under the X Windows environment on UNIX.

Installation of the TASKING CrossView Pro debugger is part of the installation of the TASKING C Compiler/Assembler toolchain, which is described in chapter Software Installation of the C Cross-Compiler User’s Manual.

2.2 NOTE ABOUT FILENAMES

Members of the CrossView Pro family of debuggers use the following name convention for their executables:

xfw166

2.3 CONFIGURING THE X WINDOWS MOTIF ENVIRONMENT

To run the Motif version of CrossView Pro on a Sun, you must define the environment variable LD_LIBRARY_PATH to where the library file libMrm.a resides. For example:

LD_LIBRARY_PATH=/usr/dt/lib
export LD_LIBRARY_PATH

CrossView Pro uses a binary resource file for appearance-related specifications for windows, menus, dialog boxes, and strings to be accessed at run-time. The name of the resource file has the same name as the executable but with .uid extension. Be sure that the .uid file is present in one of the following directories:

- the current directory
- the directory specified by the UIDPATH environment variable

The environment variable UIDPATH specifies the path used by Motif to locate the resource (.uid) file. If not set, it is set to a default value. The resource file is installed in the same directory as the associated executable. So, you should set UIDPATH as follows (Bourne shell syntax):

UIDPATH=path_to_uid/%U
export UIDPATH
Replace `path_to_uid` by the path to the directory in which the resource file is installed. The `\$U` is required.

For more details refer to `MrMOpenHierarchy` in the OSF/Motif Programmer's Reference manual.

### 2.4 USING X RESOURCES

X toolkit resources specify GUI object (widget) attributes. Resources are specified in either the `.Xdefaults` file or in application class-specific files.

The `.Xdefaults` file is (typically) loaded into the X server at the start of the session. Any changes take effect only in a new session, or after using `xrdb`. Alternatively, application class resource files may be used. Application resource files have the same name as the executable CrossView Pro version they refer to (first letter NOT capitalized). Application resource files must be present either in the directory specified by the `HOME` environment variable, or in the `app-defaults` directory. The `app-defaults` directory is typically located under `/usr/lib/X11`.

X recognizes various environment variables for specifying paths to the application resource files. For more information, consult the chapter on X resources in O'Reilly's X Toolkit Intrinsics Programming Manual and your system documentation.

The X resource specification allows either global (loosely) bound specifications (`*foreground: black`) or per-widget instance specifications (`*button.foreground: black`).

The following list shows the relevant widgets used by the Motif version of CrossView Pro:

### Windows:

- **TOP-LEVEL**
  - `XmMainWindow` => `XmDrawingArea`
- **CHILD**
  - `XmScrolledWindow` => `XmDrawingArea`

### Dialog:

- **MODAL**
  - `XmBulletinBoard`
- **MODELESS**
  - `XmBulletinBoard`
Menu:

**MENUBAR** - XmMenuShell
**PULLDOWN** - XmCascadeButton

Controls:

**CHECKBOX** - XmToggleButton
**RADIOBUTTON** - XmToggleButton
**TEXT** - XmLabel
**EDIT** - XmText
**LISTBOX** - XmScrolledWindow => XmList
**SCROLLBAR** - XmScrollBar
**PUSHBUTTON** - XmPushButton
**LISTBUTTON** - XmText & XmArrowButton & XmScrolledWindow => XmList
**LISTEDIT** - XmText & XmArrowButton & XmScrolledWindow => XmList
**GROUPBOX** - XmFrame => XmLabel
**ICON** - XmLabel with pixmap
**FILESELECTION** - XmFileSelectionBox
**ERRORPOPUP** - XmMessageBox

CrossView Pro repaints its windows in the default color as specified with the Motif widget resource settings. It is possible to overrule this behavior with a resource setting like: "*XmDrawingArea.background: blue".

CrossView Pro uses a non proportional font in all of its windows. The font size is selected using the "Desktop Setup dialog". You can use the "font" resource (*fontList on Motif) to select the font to be displayed in the menubar and dialogs, it won’t affect the font displayed in the CrossView Pro windows.

The CrossView Pro stack and data windows are implemented using a **XmScrolledWindow** widget on Motif.

The following list show the contents of an example **app-defaults** file intended for Motif environments. Of course you may adjust the colors and font to your preferences. Sample **app-defaults** files are delivered with the product in the etc directory (**app_def.mwm** for Motif).

*fontList: 7x13bold
*foreground: black
*XmMainWindow.background: white
*XmScrolledWindow*background: white
*XmDrawingArea.background: white
*XmBulletinBoard.background: DarkSeaGreen
*XmToggleButton*background: gray
*XmLabel*background: gray
*XmText*background: white
*XmScrollBar*background: gray
*XmPushButton*background: gray
*XmFrame*background: SeaGreen
*XmArrowButton*background: gray
*XmForm.background: SeaGreen
*XmMenuShell*background: DarkSeaGreen
*XmCascadeButton*background: SeaGreen

If you encounter any problems due to incorrect resource settings, like invisible text caused by identical text and background color, clear the RESOURCE_MANAGER. Use the following procedure to clear the RESOURCE_MANAGER:

4. Save a copy of the .Xdefaults file located in your home directory.
5. Install an empty .Xdefaults file.
6. Execute xrdb -all .Xdefaults to actually clear the RESOURCE_MANAGER property.
7. Restart CrossView Pro and check if windows and dialogs are displayed correctly.
8. Now you add the saved resources (one by one) back into the .Xdefaults file and execute xrdb to install them in the server. Restart CrossView Pro and check the influence of the new resource settings. Adapt your saved resources when necessary.
CHAPTER 3

COMMAND LANGUAGE
3.1 INTRODUCTION

The syntax and semantics of CrossView Pro’s command language is discussed here. This language is mainly used to enter textual commands in the command edit field of the Command Window. The mouse and menus allow you to access most actions without knowing the command language, although the command language is more powerful. The command language is also used when evaluating expressions and in commands associated with assertions, breakpoints and macros. For information about specific CrossView Pro commands, refer to Chapter 13, Command Reference.

3.2 CROSSVIEW PRO EXPRESSIONS

There are several methods that you can use to input an expression into CrossView Pro:

It is possible to display both monitored and unmonitored expressions in the Data Window. Monitored expressions are updated after every halt in execution. Unmonitored expressions are just one-shot inspections of the expressions value. Refer to section 4.6, CrossView Pro Windows for a detailed description of the Data Window.

To evaluate a simple expression:

Double click on a variable in the Source window. The result of the expression appears in the data window. Alternatively, depending on the preferences you set in the Data Display Setup dialog, the expression appears in the Evaluate Expression dialog. Click the Add Watch or Add Show button to display the result of the expression in the Data Window. Click the Evaluate button to display the result of the expression in the output field of the Evaluate Expression dialog.

To evaluate a complex expression:

From the Data menu, select Evaluate Expression... and type in any C expression in the Evaluate Expression dialog box. Optionally select a display format. Click the Evaluate button.

Type the expression into the command edit field of the Command Window followed by a return or click the Execute button.
Expressions can be any length in most windows and dialog boxes; CrossView Pro provides a horizontal scroll bar if an expression exceeds the visible length of the entry field.

In CrossView Pro, C expressions may consist of a combination of numeric constants, character constants, strings, variables, register names, C operators, function names, function calls, typecasts and some CrossView Pro-specific symbols. Each of these is described in the next sections.

**Evaluation Precision**

CrossView Pro evaluates expressions using the same data types and associated precision as used by the target architecture when evaluating the same expression.

### 3.3 CONSTANTS

CrossView Pro, like C, supports integer, floating point and character constants.

**Integers**

Integers are numbers without decimal points. For example, CrossView Pro will treat the following as integers:

\[
5 \quad 9 \quad 23
\]

The following number, however, are not treated as integers:

\[
5.1 \quad 9.27 \quad 0.23
\]

Negative integers, if they appear as the first item on a line, must have parentheses around the number:

\[
(-5) \times 4
\]

This is to prevent confusion with CrossView Pro’s own - (minus sign) command.

In addition, CrossView Pro supports standard C octal, hexadecimal and binary notation. You can specify a hexadecimal constant using a leading **0x** or a trailing **H** (or **h**). The first character must be a decimal digit, so it may be necessary to prefix a hexadecimal number with the '0' character. The hexadecimal representation for decimal 16 is:

\[
0x10 \quad \text{or} \quad 10H
\]
For the hexadecimal digits a through f you can use either upper or lower case. The following are all correct hexadecimal representations for decimal 43981:

\[
\begin{align*}
0xabcd & \quad 0xABCD & \quad 0abCdH & \quad 0AbcDh \\
\end{align*}
\]

You can specify a binary constant using a trailing B or Y (or b or y). The following are all binary representations for decimal 5:

\[
\begin{align*}
0101b & \quad 101Y & \quad 00000101B \\
\end{align*}
\]

You can specify an octal constant using a leading '0'. The octal representation for 8 decimal is:

010

You can use an L to indicate a long integer constant. For example, CrossView Pro will recognize the following as long integers:

\[
\begin{align*}
0L & \quad 57L & \quad 0xffL \\
\end{align*}
\]

CrossView Pro uses the same ANSI C integral type promotion scheme as the C compiler.

**Floating Point**

A floating point number requires a decimal point and at least one digit before the decimal point. The following are valid examples of floating point numbers:

\[
\begin{align*}
12.34 & \quad 5.6 & \quad 7.89 \\
\end{align*}
\]

Exponential notation, such as \(1.234e01\), is not allowed. The following are not valid floating point numbers:

\[
\begin{align*}
.02 & \quad 1.234e01 & \quad 5 \\
\end{align*}
\]

As with integers, bracket a negative number with parentheses:

\(-54.321\)

Expressions combining integers and floating point numbers will evaluate to floating point values:

\[
\begin{align*}
2.2 \times 2 & \quad 4.4 \\
\end{align*}
\]
Character

Character constants are single characters or special constants that follow the C syntax for special characters. Examples of valid character constants include:

'\m' 'x' '\n'

Character constants must be a single byte and are delimited by ‘’ (single quotation marks). For instance:

$mychar='m'

Remember not to confuse character constants with strings. A character constant is a single byte, in this example, the ASCII value of m.

Strings

Strings are delimited by “ ” (double quotation marks). In C all strings end with a null (zero) character. Strings are referenced by pointer, not by value. This is standard C practice. In CrossView Pro, you may assign a string literal to a variable which is of type char* (pointer to character):

$ystring = "name"

CrossView Pro supports the standard C character constants shown below:

<table>
<thead>
<tr>
<th>Code</th>
<th>ASCII</th>
<th>Hex</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>\b</td>
<td>BS</td>
<td>08</td>
<td>Backspace</td>
</tr>
<tr>
<td>\f</td>
<td>FF</td>
<td>0C</td>
<td>Formfeed</td>
</tr>
<tr>
<td>\n</td>
<td>NL (LF)</td>
<td>0A</td>
<td>Newline</td>
</tr>
<tr>
<td>\r</td>
<td>CR</td>
<td>0D</td>
<td>Carriage return</td>
</tr>
<tr>
<td>\t</td>
<td>HT</td>
<td>09</td>
<td>Horizontal tab</td>
</tr>
<tr>
<td>\</td>
<td>\</td>
<td>5C</td>
<td>Back slash</td>
</tr>
<tr>
<td>?</td>
<td>?</td>
<td>3F</td>
<td>Question mark</td>
</tr>
<tr>
<td>'</td>
<td>'</td>
<td>27</td>
<td>Single quote</td>
</tr>
<tr>
<td>&quot;</td>
<td>&quot;</td>
<td>22</td>
<td>Double quote</td>
</tr>
<tr>
<td>\ooo</td>
<td></td>
<td></td>
<td>3-digit octal number</td>
</tr>
<tr>
<td>\xhhh</td>
<td></td>
<td></td>
<td>hexadecimal number</td>
</tr>
</tbody>
</table>

Table 3-1: C character codes
Trigraph sequences are not supported.

3.4 VARIABLES

CrossView Pro lets you use variables in the C expressions you type. You may reference two classes of variables: variables defined in the source code and special variables.

Variables defined in your source code fall into two categories: local variables and global variables.

Storage Classes

Variables may be of any C storage class. The size of each class is target dependent. Consult the C Cross-Compiler User's Manual for specific sizes.

You may cast variables from one class to another:

\[(\text{long}) \$\text{mychar}\]

Local Variables

You define local variables within a function; their values are maintained on the stack or in registers. When the program exits the function, you lose local variable values. This means that you can only reference local variables when their function is active on the stack.

Local variables of type \texttt{static} retain values between calls. Therefore, you can reference \texttt{static} variables beyond their functions, but only if their function is active on the stack.

CrossView Pro knows whether the compiler has allocated a local variable on the stack or directly in a register and whether the register is currently on the stack. The compiler may move some local variables into registers when optimizing code.

If a part of your source code looks like this:

\[
\begin{align*}
 x &= 5; \\
 y &= x;
\end{align*}
\]

and you stopped the program after the assignment to \(x\), and set \(x\) to another value, this may not prevent the second statement from setting \(y\) to 5 due to ”constant folding” optimizations performed by the compiler.
Global Variables

Global variables are defined outside every function and are not local to any function. Global (non-static) variables are accessible at any point during program execution, after the system startup code has been executed.

Global variables can be defined static in a module. These variables can only be accessed when a function in this module is active on the stack, or when that file is in the Source Window using the e command.

Specifying Variables in C expressions

The following table specifies how CrossView Pro treats different variables in C expressions. The left column is the variable’s syntax in the expression, the right column is the CrossView Pro semantics.

<table>
<thead>
<tr>
<th>Variable Syntax</th>
<th>CrossView Pro Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>variable</td>
<td>CrossView Pro performs a scope search starting at the current viewing position and proceeding outwards. The debugger first checks locals, local statics and parameters, followed by statics and globals explicitly declared in the current file. Finally, globals in other files are checked.</td>
</tr>
<tr>
<td>function#variable</td>
<td>CrossView Pro searches for the first instance of function. If found, the debugger uses the frame’s address to perform a scope search for variable. Variables are available only if the specified function is active. That is, the stack frame for that function can be found on the run-time stack.</td>
</tr>
<tr>
<td>number#variable</td>
<td>The frame at stack level number is used by the debugger for the scope search. The current function is always at stack level 0. This format is very useful if you are debugging a recursive function and there are multiple instances of a variable on the stack.</td>
</tr>
<tr>
<td>:variable</td>
<td>CrossView Pro searches for a global variable named either variable or _variable, in that order.</td>
</tr>
<tr>
<td>$variable</td>
<td>CrossView Pro searches the list of special variables for $variable.</td>
</tr>
</tbody>
</table>

Table 3-2: Variables in C expressions
### Variables and Scoping Rules

A variable is in scope at any point in the program if it is visible to the C source code. For instance, if you have a local variable `initval` declared in `main()`, and then step (or move the viewing position) into `factorial`, `initval` will be out of scope. You can still find the value of `initval` by typing:

```
main#initval
```

In this case CrossView Pro will search the stack for the function `main()`, then look outwards from that function for the first occurrence of `initval` in scope and report its value. Note that `main()` must be active, that is, program execution must have passed through `main()` and not yet returned, in order for `initval` to have a value.

You can also use the **Browse...** button in the Expression Evaluation dialog box. This dialog box appears when you click the **New Expression** button in the toolbar or select **Evaluate Expression...** from the **Data** menu.

### Special Variables

CrossView Pro maintains a set of variables that are separate from those defined in your program being debugged. These special variables reside in memory on the host computer, not on the target system. They contain the values of the target processor’s registers, information about the debugger’s status, and user-defined values. Special variables are case insensitive. Use the `opt` command to display and set these variables (without using the `$`-sign).

The following is a list of the reserved special variables for CrossView Pro:

<table>
<thead>
<tr>
<th>Reserved Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>$ARG(n)</code></td>
<td>Contains the value of the $n$th int-sized argument of the current function. Allows access to arguments of variable argument list functions without knowing the name of the argument.</td>
</tr>
<tr>
<td><code>$FILE</code></td>
<td>Contains the name of the file that holds the current viewing position.</td>
</tr>
<tr>
<td><code>$IN(function)</code></td>
<td>Contains the value 1 if the current pc is inside the specified function, otherwise 0.</td>
</tr>
<tr>
<td><code>$LINE</code></td>
<td>Contains the line number of the current viewing position. This variable is often used in assertions to monitor program flow.</td>
</tr>
<tr>
<td>Reserved Variable</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>$PROCEDURE</td>
<td>Contains the name of the procedure at the current viewing position.</td>
</tr>
<tr>
<td>$ASMHEX</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the disassembled code as displayed in the assembly window will display hexadecimal opcodes. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$AUTOSRC</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the debugger will automatically switch between the source window and the assembly window display depending on the presence of symbolic debug information at the current location. The value &quot;OFF&quot; prevents the automatic window switching. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$CPU</td>
<td>Contains a string indicating if the current cpu type is 80C166 or C167. Default is 80C166.</td>
</tr>
<tr>
<td>$FP</td>
<td>Contains the value of the frame pointer. (R0: user stack pointer)</td>
</tr>
<tr>
<td>$MIXEDASM</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the disassembled code as displayed in the assembly window will be intermixed with the corresponding source lines. The value &quot;OFF&quot; suppresses this intermixing. Default is &quot;ON&quot;.</td>
</tr>
<tr>
<td>$MORE</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the more output pager is enabled. The value &quot;OFF&quot; disables the more output pager. Default is &quot;ON&quot;.</td>
</tr>
<tr>
<td>$PC</td>
<td>Contains the value of the program counter. (CSP: IP)</td>
</tr>
<tr>
<td>$PIPELINE</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that the pipeline should be displayed in the assembly window. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$register</td>
<td>Contains the value of the specified register.</td>
</tr>
<tr>
<td>$SP</td>
<td>Contains the value of the stack pointer.</td>
</tr>
<tr>
<td>$SYMBOLS</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot; indicating if local symbols and symbolic addresses (e.g. main:56+0x4) or absolute addresses are present in disassembly. Default is &quot;ON&quot;.</td>
</tr>
<tr>
<td>Reserved Variable</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>$SRCLINENRS</td>
<td>Contains a string &quot;ON&quot; or &quot;OFF&quot;. The value &quot;ON&quot; specifies that line numbers should be printed in the source window. The value &quot;OFF&quot; suppresses printing of line numbers. Default is &quot;OFF&quot;.</td>
</tr>
<tr>
<td>$SRCMERGELIMIT</td>
<td>Contains the value for the source merge limit in the assembly window, the number of source lines to be intermixed in the assembly window. Value 0 indicates that there is no limit. Default is 0.</td>
</tr>
</tbody>
</table>

*Table 3-3: Reserved special variables*

**Registers**

You can reference registers and special function registers (SFRs) directly. The format is `$register`. For instance, type:

```
$r1=316
$R1 = 316

$stkov=0xfa40
$STKO = 0xFA40

$dpp3
$DPP3 = 0x3

$rh7=255
$RH7 = 0xFF

$ip
$IP = 0x138A
```

For CrossView Pro, a fixed set of registers is always available. You can add additional C166/ST10 derivative specific SFRs in a `regname.def` file. See the *C Cross-Compiler User’s Manual* for more information.

You can configure which (and in which order) registers must appear in the register window in the Register Window Setup dialog (*Settings | Register Window Setup*...).

It is possible to request the address of an SFR by using the address operator &. The operator may even be used on an SFRBIT for this purpose. In this case, the bit offset and the SFR where it is located in, are displayed. Example:
&$mulip
Location of $MULIP is $PSW.5
Operand for ‘&’ incorrect

&$psw
0xFF10

In addition to the standard register special variables, CrossView Pro supplies the special variables $pc (the program counter, composed of $csp and $ip) and $fp (the current frame pointer, which is $r0 in c166).

The values of Reserved special variables cannot be changed interactively (i.e., on the CrossView Pro command line).

**User-defined Special Variables**

During a debugging session, you may need some new variables for your own debugging purposes, such as counting the number of times you encounter a breakpoint. CrossView Pro allows you to create and use your own special variables for this purpose. CrossView Pro does not allocate space for these variables in target memory; it maintains them on the host computer.

The names of these variables, which must begin with a $ (dollar sign), are defined when they are first used. For instance:

$$count = 5$$

defines a variable named $count of type int with a value of 5. Special variables are of the same type as the last expression they were assigned. For example:

$$name="john"$$

then:

$$name=3*4$$

creates a special variable $name of type (char *). The second statement creates a special symbol $name and assigns it the value of 12 of type int.

Special variables are just like any other variables, except you cannot meaningfully take the address of them.

See the startup options in Chapter 4, *Using CrossView Pro*. 
3.5 FORMATTING EXPRESSIONS

By default, CrossView Pro displays the value of an expression using the appropriate format for the type of expression. CrossView Pro follows several simple rules for displaying variables:

- The defaults are: addresses appear in hexadecimal format, characters as ASCII and integers as decimal.
- There are four possible formats to show one integer value: decimal, hexadecimal, octal, and ASCII.
- There are two different formats to display one floating point value: decimal real and hexadecimal. If the absolute value is either too big or too small (with too many non-significant zeroes), the debugger automatically converts the format to one with fixed decimal point and exponent.
- ASCII is the only format to display a string. Note that you can opt for the array format. Unpredictable characters are output as \xhh, where hh is a hexadecimal value. Control characters are output as ^C.
- All the values in an array appear in the same format. You are free to select this format from the available options.
- If all the values of a structure appear in the same format. You are free to select this format from the available options.

You can determine in which format a variable is displayed. Once the format has been selected, however, you must enter values or change values in the appropriate format. When editing is finished, the debugger interprets all values in terms of the currently selected formats.

You may, however, tell CrossView Pro to display an expression in a particular format other than the default format. The format code follows the variable, in one of two ways:

- The simplest method of specifying display formats is from the Evaluate Expression dialog box. To access this dialog box:
  - From the Data menu, select Evaluate Expression...

- In the Command Window, you can use several format codes shown in the next table to specify the variable display. The format codes can be entered as:

  \( \text{variable}/\text{format} \)
to display the variable in format \textit{format}, or:

\textit{variable}@\textit{format}

to display the variable's address in format \textit{format}.

The structure of the formatting code is:

\[ \text{count \ style \ [size]} \]

\textit{Count} is the number of times to apply the format style \textit{style}. \textit{Size} indicates the number of bytes to be formatted. Both \textit{count} and \textit{size} must be numbers, although you may use \texttt{c} (char), \texttt{s} (short), \texttt{i} (int), and \texttt{l} (long) as shorthand for \textit{size}. Legal integer format sizes are 1, 2, and 4; legal float format sizes are 4 and 8.

Be sure not to confuse CrossView Pro format codes with C character codes, e.g. \texttt{\backslash a}. CrossView Pro uses a forward slash \slash not a backward slash \backslash.

\begin{tabular}{|c|l|}
\hline
\textbf{Style} & \textbf{Description} \\
\hline
(a) & \text{Print the specified number of characters of the character array; any positive \textit{size} is OK. Use the expression's value as the address of the first byte.} \\
\hline
(c) & \text{Print a character; any positive \textit{size} is OK; default \textit{size} is sizeof(char).} \\
\hline
(D) & \text{Print in decimal; needs NO \textit{size} specifier; \textit{size} is sizeof(long).} \\
\hline
(d) & \text{Print in decimal; can have a \textit{size} specifier; default \textit{size} is sizeof(expression).} \\
\hline
(E) & \text{Print in "e" floating point notation; needs NO \textit{size} specifier; default \textit{size} is sizeof(double).} \\
\hline
(e) & \text{Print in "e" floating point notation; the \textit{size} specifier can be sizeof(float) or sizeof(double); default \textit{size} is sizeof(expression).} \\
\hline
(F) & \text{Print in "f" floating point notation; needs NO \textit{size} specifier; default \textit{size} is sizeof(double).} \\
\hline
(f) & \text{Print in "f" floating point notation; the \textit{size} specifier can be sizeof(float) or sizeof(double); default \textit{size} is sizeof(expression).} \\
\hline
(G) & \text{Print in "g" floating point notation; needs NO \textit{size} specifier; default \textit{size} is sizeof(double).} \\
\hline
\end{tabular}
### Table 3-4: Format style codes

For example, typing:

\texttt{initval/4xs}

displays four, hexadecimal two-byte memory locations starting at the address of \texttt{initval}.

The following piece of C-code can be accessed in CrossView Pro using the string format codes:

```c
char text[] = "Sample\n";
char *ptext = text;
```
text  What is the address of this char array
text = 0x8200

text/a  Print it as a string
text = "Sample^J"

ptext  What is the contents of this pointer
string = 0x8200

ptext/s  Print it as a string
string = "Sample^J"

&ptext  Where does ptext itself reside
0x8210

With format codes, you may view the contents of memory addresses on
the screen. For instance, to dump the contents of an absolute memory
address range, you must think of the address being a pointer. To show
(dump) the memory contents you use the C language indirection operator
'*'. Example:

*0x4000/2x4
0x4000 = 0x00DB0208 0x5A055498

This command displays in hexadecimal two long words at memory
location 0x4000 and beyond. Instead of using the size specifier in the
display format, you can force the address to be a pointer to unsigned
long by casting the value:

*(unsigned long *)0x4000/2x
0x4000 = 0x00DB0208 0x5A055498

To view the first four elements of the array table from the demo.c
program, type:

table/4d2
table = 1 1 2 6

This command displays in decimal the first four 2-byte values beginning at
the address of the array table.
3.6 OPERATORS

Standard C Operators

CrossView Pro supports the standard C operators in the ANSI defined order of precedence. The order of precedence determines which operators execute first.

The semicolon character (;) separates commands on the same line. In this way, you may type multiple commands on a single line. Comments delimited by /* and */ are allowed; CrossView Pro simply ignores them.

<table>
<thead>
<tr>
<th>Order of Precedence (in descending order)</th>
</tr>
</thead>
<tbody>
<tr>
<td>() [ ] -&gt; .</td>
</tr>
<tr>
<td>! ~ ++ -- + - * &amp; (type) sizeof</td>
</tr>
<tr>
<td>* // %</td>
</tr>
<tr>
<td>+ -</td>
</tr>
<tr>
<td>&lt;&lt; &gt;&gt;</td>
</tr>
<tr>
<td>&lt; &lt;= &gt; &gt;=</td>
</tr>
<tr>
<td>== !=</td>
</tr>
<tr>
<td>&amp;</td>
</tr>
<tr>
<td>^</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>&amp;&amp;</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>?: = += -= *= /= %= &amp;= ^=</td>
</tr>
</tbody>
</table>

Table 3-5: Order of precedence of standard C operators

The *, – and + operators appear twice since they exist as both unary and binary operators and unary operators have higher precedence than binary.

Division is represented by // (two slashes) not / (one slash). This is to avoid confusion with CrossView Pro’s format specifier syntax.
**Using Addresses**

To specify an address, you may use the & operator. To determine the address of `initval`, type:

```
&initval
```

If you try to use the & operator on a local variable in a register, CrossView Pro issues an error message and tells you which register holds the variable.

### 3.7 SPECIAL EXPRESSIONS

#### String Commands

Whenever CrossView Pro encounters an expression consisting solely of a string by itself, it simply echoes the string. For example:

```
"hello, world\n"
```

Use this technique to place helpful debugging messages on breakpoints. For example, setting the following breakpoint:

```
60 b {"now in for loop\n"; sum; C }
```

this cause CrossView Pro to echo the message `now in for loop`, to display the value of `sum` in the Command Window, and to continue when line 60 is encountered. You can also enter this breakpoint and the associated commands via the Breakpoints dialog box, which you can open by selecting the **Breakpoints**... menu item from the **Breakpoints** menu.

#### The Period Operand

As a shorthand, CrossView Pro supports a special operand, period `.`, that stands for the value of the last expression CrossView Pro calculated. For instance, in the following example, the period in the second command equals the value 11, which is the result of the previous expression:

```
5 + 6
11
4 * .
44
```
The period operand assumes the same size and format implied by the specifier used to view the previous item. Thus if you look at a `long` as a `char`, a subsequent `.` is considered to be one byte. Use this technique to alter specified pieces of a larger data item, such as the second highest byte of a `long`, without altering the rest of the `long`. The period operand may be used in any context valid for other variables.

`.` is the *name* of a location. When you use it, it is dereferenced like any other name. If you want the address of something that is 30 bytes farther on in memory, do not type `.+30` as this takes the contents of dot and adds 30 to it. Type instead `&.+30` which adds 30 to the address of the period operand.

### 3.8 CONDITIONAL EVALUATION

CrossView Pro supports the *if* construct. Use this construct in breakpoints and assertions to alter program flow conditionally. For example, if you reset the following breakpoint:

```c
60 b {if (sum<=5931){C}{sum}}
```

CrossView Pro compares the value of `sum` with 5931 when the program stops at line 60. If `sum` is less than or equal to 5931, CrossView Pro continues. Otherwise, CrossView Pro displays the value of `sum` with 5931 when the program stops at line 60.

You can also use the `exp1 ? exp2 : exp3` C ternary operator for conditional expressions. For example:

```c
$myvar = (5 > 2) ? 1 : -1
```

assigns the value 1 to `myvar`.

3.9 FUNCTIONS

In CrossView Pro expressions, you can include functions defined in the program’s code.

Command line function calls are not supported for the C166/ST10.

You can call functions through the Call a Function dialog box. Note that only the results of the function call are shown. You cannot enter expressions in this field. If you want to use the results of the function call in an expression, then type the expression into the Evaluate Expression dialog box or type in the command into the Command Window (described in the keyboard method below).

- From the Run menu, select Call a Function...
- List all functions by clicking the Browse... button.
- You can place parameters in the Parameters field of the Call a Function dialog box, separated by commas, but without the usual parentheses or select from the drop-down history list.

The Command Window receives the results of the function call.

Type in the expression containing a function call directly into the Command Window.

To execute a function on the target type the function name and the arguments as you would do in your C program. For example,

```
do_sub(2, 1)  or:  a = do_add(3, 4)
```

3.10 CASE SENSITIVITY

The absolute file supplies the case sensitivity information for variable names. It is initially case sensitive for the C language. You may toggle case sensitivity by:

- From the Edit menu, select Search String... to view the Search String dialog box. This dialog contains the Case Sensitive check box.

Typing the (capital) Z command in the Command Window.
CHAPTER 4

USING CROSSVIEW PRO

TASKING
4.1 INTRODUCTION

This chapter and the following 8 chapters give you a comprehensive picture of CrossView Pro’s features. In order to address the broadest range of expertise, the contents range from introductory examples to the more technical aspects and techniques of debugging with CrossView Pro. While it is not necessary for you to read the chapters straight through, you may find it especially helpful to do so. All of the examples are from the sample program demo.c which comes with CrossView Pro. For a complete description of the commands presented in this chapter, consult the Command Reference chapter.

Each CrossView Pro command introduced in the text has a matching box summarizing its syntax and semantics. The command description follows these general rules:

- Items in **bold** font are the actual CrossView Pro commands: **save**, **set**.
- Items in *italics* are names for the things you should type: *filename*, *commands*. In addition, the | symbol means or. For instance, **screen** | *filename* means you can use the word “screen” or a filename in the syntax.

4.2 USING THE CROSSVIEW PRO INTERFACE

This manual uses the word “Windows” to generically refer to the host computer system’s windowing system. On IBM-PCs and compatibles, this is equivalent to Microsoft Windows (XP or 2000). On UNIX workstations, this refers to the X Window System. Generally, this manual makes no distinctions between the various windowing systems unless needed to clarify the discussion.

This manual assumes you possess a basic familiarity with Windows software. For this reason, discussion focuses on how CrossView Pro works, rather than how to use the Window interface. For more information on your Windows system, consult the Windows documentation provided with your host system.

You can execute most CrossView Pro commands using either mouse or textual commands. Mouse commands are executed by means of buttons and pull-down menus in each of the separate CrossView Pro windows. Text commands are typed at the prompt in the Command Window. In most cases, there is no difference in functionality between mouse and text equivalents.
This manual discusses both methods of performing CrossView Pro functions. For a quick-reference guide to all CrossView Pro commands, refer to the Command Reference chapter.

### 4.3 STARTING CROSSVIEW PRO

Once an absolute file has been made it can be executed by CrossView Pro. There are several ways to invoke CrossView Pro.

**From EDE**

To start CrossView Pro from EDE (the Embedded Development Environment), click on the Debug application button.

**From the desktop**

With MS-Windows you can start CrossView Pro through the Start menu. Or in the Windows Explorer you can double-click on an absolute file if the .abs extension is associated with the CrossView Pro executable.

On the PC, CrossView Pro is a Microsoft Windows application. As such, you must invoke it from the Windows environment.

**From the command line**

To begin the debugging session, type the name of the CrossView Pro debugger and optionally the name of the target program (absolute file).

```
xfw166 [absolute-file] [option]...
```
4.4 STARTUP OPTIONS

CrossView Pro allows you to specify several options when you invoke the program. Type these startup options (or switches as they are sometimes called) after the optional basename of the application. The basename can also contain a path specification. In this case, CrossView Pro sets its current directory to the specified path. A minus sign proceeds each option; the options can appear in any order.

Note that some versions of CrossView Pro have different startup options and procedures than the ones described here. Please consult the addendum (at the end of this manual), for precise information about starting up CrossView Pro with your target hardware.

From EDE

You can select the execution environment, setup communication parameters, specify record and playback files and set some maximum values via the CrossView Pro entry of the Project | Project Options... dialog.

From CrossView Pro

You can set many of CrossView Pro’s options by using the dialog boxes called by the Target | Settings... and File | Options... menu items. You can save the options in the xvw.ini file and they are automatically used upon startup.

In Windows XP or Windows 2000 (or higher), add startup options to the program’s property sheet:

- Right-click on the CrossView Pro shortcut icon, shown in your program installation folder.
- Select Properties. The Program Item Properties dialog box appears.
- Enter the startup options after the executable’s name in the Target field of the shortcut.

Use menus to set options. After setting the options in the menus and selecting the appropriate options in the Save Options dialog on exit, CrossView Pro saves the settings in the file xvw.ini for future debug sessions.

To start up CrossView Pro type:

xfw166
When your execution environment itself has a human-oriented ASCII interface, you can use transparency mode with the \texttt{-T} option. In transparency mode you can configure the execution environment’s memory. Check the addendum, the hardware-specific section of this manual. In-circuit emulators generally require you to map the address space, allocating memory ranges to the execution environment and/or the target system. Fortunately, this generally does not mean you need to learn your emulator's command set, just a rote sequence of startup commands. When your CrossView Pro version does not support transparency mode, you do not need to configure the memory, and the \texttt{-T} option is not needed.

If your target system supports serial communication and if the target system is connected to a port other than the default port (see Chapter 1, \textit{Overview}, to determine the default port for your host), you can use the \texttt{-D} option to specify the port name. The default baud rate is 9600. You may use the \texttt{-D} option to specify the baud rate if the execution environment is not the same as the default. For example:

\begin{verbatim}
xfw166 -D rs232,com2,19200
\end{verbatim}

instructs CrossView Pro to use the COM2 port at 19200 baud. Most evaluation boards use an auto baud rate detection mechanism and support 19200 baud. See your execution environment in the addendum of this manual for specific communication information.

When you specify a startup option in CrossView Pro, the option overrules the corresponding value in the current \texttt{xvw.ini} file.

There are many different options you can invoke when starting up CrossView Pro. The listing below gives an overview of all startup options.

There are several startup options having to do with the recording and playing back of CrossView Pro command files. See also Chapter 9, \textit{Command Recording & Playback}. 
<table>
<thead>
<tr>
<th>Startup Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>--a number</code></td>
<td>Sets the maximum number of assertions (the default is 100).</td>
</tr>
<tr>
<td><code>--argcv &quot;arg[,...]&quot;</code></td>
<td>Pass the comma separated string of options as argc/argv argument to the program.</td>
</tr>
<tr>
<td><code>--b number</code></td>
<td>Sets the maximum number of code breakpoints (the default is 200).</td>
</tr>
<tr>
<td><code>--c number</code></td>
<td>Sets the maximum number of instruction trace for the trace buffer (the default is 32).</td>
</tr>
<tr>
<td><code>--C cpu</code></td>
<td>Forces CPU type selection. This option overrules the CPU type selection in both xvw.ini and a target configuration file.</td>
</tr>
<tr>
<td><code>--D device_type,opt1[,...]</code></td>
<td>Selects a device and specifies device specific options, such as communication port and baud rate. The allowed combinations for your execution environment are described in the manual addendum for that specific execution environment. The following combinations are possible:</td>
</tr>
<tr>
<td><code>--D rs232,port,speed</code></td>
<td>Select RS–232 communication.</td>
</tr>
<tr>
<td><code>port</code></td>
<td>For PC this is COM1, COM2, COM3 or COM4. A colon should not be added. For UNIX this is the full path of the RS–232 device driver (e.g., <code>/dev/tty01</code>). By default CrossView Pro uses the first RS–232 port.</td>
</tr>
<tr>
<td><code>speed</code></td>
<td>This is the baud rate used for the specified port. The default is 9600.</td>
</tr>
<tr>
<td>`--D can,baud-rate,identifier,0,time_out</td>
<td>board_seg</td>
</tr>
<tr>
<td><code>baud-rate</code></td>
<td>50, 125, 250, 500, 1000.</td>
</tr>
<tr>
<td><code>identifier</code></td>
<td>Default is 30. This value is the send identifier host=&gt;target); the receive identifier target=&gt;host) is identifier+1.</td>
</tr>
<tr>
<td><code>time_out</code></td>
<td>tx/rx timeout of handle. Define to 0</td>
</tr>
</tbody>
</table>
### Startup Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>board_seg</code></td>
<td>Board segment the interface card is using</td>
</tr>
<tr>
<td><code>hw_index</code></td>
<td>Index of the hardware (slot) (0,1,...)</td>
</tr>
<tr>
<td><code>port_IO_add</code></td>
<td>The memory address used to access the (E)ISA card.</td>
</tr>
<tr>
<td><code>interface_card_ID</code></td>
<td>Vendor specific CAN host adapter. This number, in combination with <code>manufacturer</code>, identifies a unique interface card.</td>
</tr>
<tr>
<td><code>port_id</code></td>
<td>PC I/O port number or I/O channel used for accessing the (E)ISA card.</td>
</tr>
<tr>
<td><code>net_number</code></td>
<td>Logical net number the interface card is using</td>
</tr>
<tr>
<td><code>interrupt_nr</code></td>
<td>Interrupt number the CAN interface card is using</td>
</tr>
<tr>
<td><code>hw_channel</code></td>
<td>Index of the channel (connector) (0,1,...)</td>
</tr>
<tr>
<td><code>manufacturer</code></td>
<td>Name of the manufacturer of the CAN interface card. Together with the <code>interface_card_ID</code>, a unique interface card is defined.</td>
</tr>
</tbody>
</table>

**Note:** The CAN ROM Monitor must be downloaded first using one of the other communication methods.

- **D parallel,port**
  - Select parallel communication.
  - `port` For PC this is LPT1 or LPT2. Do not add a colon. For UNIX this is the full path of the parallel device driver. By default CrossView Pro uses the first parallel port.
### Startup Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-D tcp,host,port</code></td>
<td>Select TCP/IP communication. On UNIX the standard TCP/IP implementation is used. On MS-Windows the <code>WINSOCK.DLL</code> implementation is used.</td>
</tr>
<tr>
<td>host</td>
<td>The name of the host to be accessed via TCP/IP.</td>
</tr>
<tr>
<td>port</td>
<td>The port number on host to be accessed.</td>
</tr>
<tr>
<td><code>-D dev,device-file</code></td>
<td>Use a UNIX device driver as communication channel. For RS-232 devices use the <code>-D rs232</code> option, described above.</td>
</tr>
<tr>
<td>device-file</td>
<td>The full path of the UNIX device file.</td>
</tr>
<tr>
<td><code>-D isa,io-port,address</code></td>
<td>Select communication channel to an (E)ISA interface card in the PC.</td>
</tr>
<tr>
<td>io-port</td>
<td>PC I/O port number or I/O channel used for accessing the (E)ISA card.</td>
</tr>
<tr>
<td>address</td>
<td>The memory address used to access the (E)ISA card.</td>
</tr>
<tr>
<td><code>--easycode</code></td>
<td>Enable EasyCODE support in CrossView Pro.</td>
</tr>
<tr>
<td><code>-f file</code></td>
<td>Read command line options from file.</td>
</tr>
<tr>
<td><code>--fss_root_dir&quot;path&quot;</code></td>
<td>Specify root directory for File System Simulation.</td>
</tr>
<tr>
<td><code>-G path</code></td>
<td>Specify startup directory for CrossView Pro.</td>
</tr>
<tr>
<td><code>-i</code></td>
<td>Has CrossView Pro download the image of the absolute object file.</td>
</tr>
<tr>
<td><code>-L file</code></td>
<td>Keeps a log of CrossView-to-target communications in a file. Not available for all execution environments.</td>
</tr>
<tr>
<td><code>-n address</code></td>
<td>Informs CrossView Pro that the program was loaded into memory at an address other than zero.</td>
</tr>
<tr>
<td><code>--orti=file</code></td>
<td>Specify the name of an OSEK/ORTI file for RTOS aware debugging.</td>
</tr>
<tr>
<td><code>-p file</code></td>
<td>Starts playing back commands from file.</td>
</tr>
<tr>
<td><code>-P file</code></td>
<td>Starts playing back commands from file with commands single step.</td>
</tr>
<tr>
<td><code>-r file</code></td>
<td>Starts recording commands in file.</td>
</tr>
<tr>
<td>Startup Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>-R file</td>
<td>Starts recording screen output in file.</td>
</tr>
<tr>
<td>--radm=file</td>
<td>Same as the radm field in the target configuration file: specify the name of the Debug Instrument (using KDI) used for RTOS aware debugging.</td>
</tr>
<tr>
<td>-RegServer</td>
<td>Register CrossView Pro as COM object.</td>
</tr>
<tr>
<td>-RegServerS</td>
<td>Register CrossView Pro as COM object, without message.</td>
</tr>
<tr>
<td>-s number</td>
<td>Sets the maximum number of special variables (variables independent of the program that CrossView Pro provides for your use). The default is 26.</td>
</tr>
<tr>
<td>-sd directory [:directory]...</td>
<td>Specifies the directories CrossView Pro should search for source files. Relative paths are allowed. When the N command is used to load a new symbol file, the current directory is set to the directory containing the symbol file and CrossView Pro now searches for source files relative to this directory. Directories must be separated by semicolons.</td>
</tr>
<tr>
<td>--single_instance</td>
<td>Prevent multiple instances of CrossView Pro.</td>
</tr>
<tr>
<td>-tcfg file</td>
<td>Specify a target configuration file. This overrules the filename specified in xvw.ini. See section CrossView Pro Target Settings in the Overview chapter.</td>
</tr>
<tr>
<td>--timeout=n_seconds</td>
<td>Start CrossView Pro command line batch operation mode and terminate after n_seconds.</td>
</tr>
<tr>
<td>-T [file]</td>
<td>Starts CrossView in transparency mode if present; if file is given, commands in file are sent to the execution environment.</td>
</tr>
<tr>
<td>-UnregServer</td>
<td>Unregister CrossView Pro as COM object.</td>
</tr>
<tr>
<td>-UnregServerS</td>
<td>Unregister CrossView Pro as COM object, without message.</td>
</tr>
<tr>
<td>-USM</td>
<td>Allow &quot;User Stack Model&quot; debugging.</td>
</tr>
</tbody>
</table>

Table 4-1: CrossView Pro Startup Options
4.4.1 WHAT YOU MAY HAVE DONE WRONG

Most problems in starting up CrossView Pro for a debugging session stem from improperly setting up the execution environment or from an improper connection between the host computer and the execution environment. Some execution environments require you to enter transparency mode to set the execution environment for a debugging session. Check the notes for your particular execution environment and the addendum of this manual.

Here are some other common problems:

- Specifying the wrong device name when invoking the debugger.
- Specifying a baud rate different from the one the execution environment is configured to expect.
- Not supplying power to the execution environment or an attached probe.
- Using the wrong kind of communication cable.
- Plugging the cable into an incorrect port. Some target machines have several ports.
- Installation of a device driver or resident applications that use the same communications port on the host system.
- The port is already in use by another user or login process on some UNIX hosts.
- Specifying no or an invalid cpu type with the -C option.
- Using the CAN interface requires downloading the CAN ROM Monitor first using for example the serial communication method.
4.5 THE CROSSVIEW PRO DESKTOP

The CrossView Pro desktop is the screen background in which all windows, icons and dialog boxes appear (see figure 4-1). Under some windowing systems, the desktop is itself a window that does not contain all other CrossView Pro windows.

The desktop always has the Command Window opened or iconized.

Figure 4-1: CrossView Pro Desktop

At the top of the desktop is the **Menu Bar**, which contains the menus applicable to the currently active window. Below the menu bar is the main **Toolbar**, from which you can execute commands to control program execution as button functions. Except for the Command Window, the desktop can contain other windows as well.

Along the bottom of the desktop there is a **Main Status Bar**. The status bar displays messages such as short “help messages” when you move the cursor over any button in any CrossView Pro window.
Menus
Each CrossView Pro window may have a menu associated with it. Under Microsoft Windows, the active window’s menu is displayed in the menu bar of the desktop.

Depending on your execution environment some menu items are always grayed out. For example, **Communication Setup** is grayed out if your target is an instruction set simulator.

Windows
The debugger supports two types of windows: *primary windows* and *dialog boxes*. Dialog boxes are the windows you access from a primary window. For the remainder of this manual, the term “window” denotes a primary window.

This manual also uses the term *pop-up window*. A pop-up window is a primary window that contains supplemental information such as on-line help.

CrossView Pro Windows are used to display information and to get user input through either buttons, commands typed in input fields, or menu selections. Windows may be moved around the desktop, sized, or iconized. All windows can be opened from the **View** menu. The section on *CrossView Pro Windows* provides more detail about each window.

A window is considered opened even if it is iconized (under Microsoft Windows, this is called minimzed). A window is considered closed if it does not exist on the desktop in any form.

Dialog Boxes
Certain menu items or push buttons may call up a dialog box to complete an action, display information, or get additional data. No other actions can be performed until the dialog box is closed.
4.5.1 MENUS

Each window in CrossView Pro uses the menu as shown in figure 4-2. The method of selection of a menu item varies depending on the windowing system being used. See your Windowing System's manual for details of how to do this.

Each window has a hidden control menu (the icon on the top-left of the window), to manipulate the window. The menu Close command in the control menu closes the current window. Your implementation of the windowing system may have additional features. See your documentation for further details.

![CrossView Pro - Demo.abs](image_url)

*Figure 4-2: CrossView Pro Menus*
4.5.1.1 LOCAL POPUP MENUS

On MS-Windows environments CrossView Pro supports local popup menus. Local popup menus are invoked by clicking the right mouse button. The menu contents is context sensitive. If the mouse pointer is on top of the global (main) toolbar the Configure Toolbar dialog is shown. If the mouse pointer is located in the MDI window (task window or background) the View Menu is shown which allows you to open new windows.

Within the Source Window four different local popup menus may appear. If the cursor is within the display area of the window the Run Menu is shown. The Run Menu contains commands associated with program execution. If your cursor is at a breakpoint indicator, the Breakpoints dialog is shown. If the cursor is on a code coverage marker then the local popup menu contains commands to move the cursor to the next or previous block of (not)covered statements. If your cursor is in the profile column you can change the format of the timing figures. All other windows have their own local popup menu. The exception to the rule is the command window which does not have a local popup. See figure 4-3 for an example of the local popup menu of the Memory Window.

![Figure 4-3: CrossView Pro Local Popup Menu (Memory Window)](image)

4.5.2 WINDOW OPERATION

Windows can be opened, made active, and closed.

**Opening Windows**

The **View** menu of the menu bar lists all windows. Selecting a window name from this list causes the window to open up. Selecting a window that is already open brings that window to the front.
Selecting a Window

At any one time, a particular window is active. Most operations act (by default) on the active window. The active window is distinguished by highlighting the title bar. Only one window may be active at a time. There are several ways to select a window (that is, make a window active).

- Open the window from the View menu. If the window is already open it will be brought to the front.
- Click on the window’s border (or on any portion of the window in some windowing systems). It will be brought to the front.
- Select the window name from the Window menu. The window will be made active and is brought to the front. (This option is available under Microsoft Windows only).

Closing a Window

Windows are closed by selecting Close from the Control menu, or by clicking a Close button, as shown in figure 4-4. Selecting this item from the Command Window will exit CrossView Pro.

![Control Menu Close Button](image)

Figure 4-4: Closing a Window
4.5.3 DIALOG BOXES

The debugger uses dialog boxes to acquire information needed to complete a requested operation. The debugger also uses dialog boxes to display information. If a button or menu item displays an ellipsis (…) after its name, then there is an associated dialog box.

For example, the dialog box shown in figure 4-5 searches for a string. This dialog box uses a list edit field to enter a search string, radio buttons to select the search direction, a check box to specify case sensitivity and push buttons to allow certain functions to be performed.

![Diagram of dialog box](image)

*Figure 4-5: Dialog Box*
4.5.4 CUSTOMIZING CROSSVIEW PRO

You can customize CrossView Pro’s visual appearance and operative parameters to best suit your debugging environment.

Changing the Visual Appearance

Windows can be organized by resizing and moving them around the desktop (see your Windowing System’s manual for details on how to do this). All windows under Microsoft Windows have an additional Window menu item. This menu allows the user to arrange all opened windows in a tiled or cascaded format. In the tiled format, selected by Window | Tile, all windows become the same size. All windows are the visible, the same size and do not overlap. In the cascaded format, selected by Window | Cascade, all open windows are changed to the same size and overlapped in a cascade with a constant vertical and horizontal offset. Iconized (minimized) windows can be automatically rearranged by selecting Arrange Icons from the Window menu.

See the section Using X Resources in the chapter Software Installation for details on changing the visual appearance of CrossView Pro under X Windows.

Changing Operative Parameters

You can adjust the operative parameters for CrossView Pro using the various menus in CrossView Pro.

In the Target menu you will find:

- Settings: Allows you to specify the execution environment and the CPU type, and the source directories for CrossView Pro. The values are processed at CrossView Pro startup before executing commands entered in the Command Window or before the target is accessed as a result of opening a window. So, first edit this dialog when you start CrossView Pro. If you have not loaded a symbol file yet, you do not have to restart CrossView Pro.

- Communication Setup: Allows you to set parameters for communication between CrossView Pro and your target board.
In the **File | Options...** dialog you will find:

- **Desktop**: Allows you to specify color settings for the execution position in the Source Window and the colors used in the Memory Window to show how a memory location has been accessed by the application program. You can also specify font sizes to be used in output windows.

- **Toolbar**: Allows you to configure the main toolbar to your personal preferences.

In the **Tools** menu you will find:

- **Record, Playback**, and **Log**: Allow you to set command recording and playback options.

- **Toolbox Setup**, and **Macro Definitions**: Allow you to define macros, and assign them to a push button in the Toolbox.

In the **Data** menu you will find:

- **Data Display Setup**: Allows you to specify how CrossView Pro displays data. This dialog also determines if the Expression Evaluation dialog box must be bypassed or not.

In the **Settings** menu you will find:

- **Source Window Setup**: Allows you to specify the step mode, symbolic disassembly, automatically switching between source lines and disassembly source to be displayed in the Source Window and display code coverage information.

- **Register Window Setup**: Allows you to specify the registers that appear in the Register Window. And you can set the display format to hexadecimal or decimal.

- **Memory Window Setup**: Allows you to specify the mode and size of the data and the number of data rows and columns to be shown in the Memory Window. It also allows you to automatically refresh the Memory Window and to display data coverage information.

- **Data Analysis Window Setup**: Allows you to configure the graph display of a Data Analysis Window.

- **I/O Simulation Setup**: Allows you to specify the I/O streams to be used in the Terminal Windows.
• **Terminal Window Setup**: Allows you to specify the input and output format of a Terminal Window. You can map linefeeds to carriage-return linefeeds, wrap at the end of a line, specify buffered input or specify that the window must be cleared at system reset and program reset. You can also log the input and output data to a file.

• **Background Mode Setup**: Allows you to specify which windows to automatically refresh when running in background mode. This feature is only available if it is supported by your execution environment.

**Saving Changes on Exit**

If you find yourself using a particular configuration, you may want to save your configuration when you exit CrossView Pro:

- From the **File** menu, select **Exit** or close the Command Window.
- In the **Save** tab of the Options dialog that appears, select the options you want to be saved for another debug session.
- Click on the **Exit** button in the Options dialog.

CrossView Pro exits. If you selected one or more items in the **Save** tab of the Options dialog your settings are saved in the initialization file `xvw.ini`. This file is in the startup directory.

### 4.5.5 CROSSVIEW PRO MESSAGES

CrossView Pro communicates with you in a variety of ways. The command window displays the results of commands. Important messages, such as errors, appear in dialog boxes that pop up.
4.6 CROSSVIEW PRO WINDOWS

The two prominent windows used in CrossView Pro are the Command Window and the Source Window. From the Command Window you can type CrossView Pro and emulator commands, and gain access to all other windows. You can accomplish most global operations from either the menu bar or the Command Window. Only from the Command Window can you accomplish Single step playback. When you close the Command Window, you exit CrossView Pro.

The Source Window focuses on the program being debugged. This window controls most of the commonly-used execution operations, such as breakpoints and searching functions.

Available Windows

You can open all CrossView Pro windows (except for the Data Analysis windows) from the View menu by selecting the name of the window. Selecting a window in this case brings the window to front and makes it the active window. Available windows are:

- **Command Window**: Supports two modes: CrossView or Emulator. Displays all CrossView Pro commands and responses or Emulator commands and responses.
- **Source Window**: Controls the execution of the program and displays the source file or disassembly.
- **Register Window**: Displays the current state of the processor’s registers.
- **Memory Window**: Displays target memory and allows you to change it.
- **Data Window**: Displays the values of data that are being monitored.
- **Data Analysis Window**: Graphically displays signal data for analysis.
- **Stack Window**: Displays the application’s stack trace.
- **Trace Window**: Displays the most recently executed lines.
- **Terminal Windows**: Can be used for I/O simulation of an application.
Improving CrossView Pro Performance

CrossView Pro updates every window that is open (except for the Data Analysis windows), even if it is iconized (minimized). Keeping a window up to date usually involves extra communication with the emulator, slowing CrossView Pro down. For instance, if the Register Window is open, CrossView Pro asks the emulator to dump the contents of all displayed registers after each single step. Thus it is a good idea to keep only those windows open that you need.

4.6.1 COMMAND WINDOW

The Command Window allows you to:

- Enter CrossView Pro and emulator commands from the keyboard.
- View a history of CrossView Pro commands or emulator commands.
- View the result of CrossView Pro commands or emulator commands.
- Execute playback files (in single step mode).

From the View menu you can specify if you want the Command Window to be a CrossView Pro Command Window or an Emulator Command Window. This way you can specify whether CrossView Pro interprets commands or they go directly to the emulator.

Figure 4-6. shows the Command Window. You can type commands into the command edit field (bottom field) or select them from the command history list (middle field), edit and execute them. The command history field displays previously entered commands. You can select and execute one or more commands. The command history list provides you with a clear, comfortable way to re-execute specific commands or sequences of commands by preserving them in a scrollable list.

You can switch between the history list and the command edit field by hitting the <Tab> key. Hitting the <Esc> key (escape) returns you to an empty edit field.

The top field is the Command Output Window or the Emulator Output Window, depending on the type of Command Window you choose. Each command, echoed from the command edit field, appears with a ‘>’ prefix. CrossView Pro displays its response (or the emulator’s response if the window is an Emulator Command Window) to the command immediately following the command. You can use the clear command to clear this window.
The Command Window also has two push buttons that provide rapid access to frequently used actions. The **Execute** button executes the current command (or sequence of commands if more than one command is selected). Note that the `<Enter>` or `<Return>` key is equivalent. Use the **Halt** button to interrupt commands executing in continuous mode, or to stop the emulator. If you right-click on the border of the dialog, a quick access menu opens with entries for searching and setting up.

The Command Window maintains a history of recently executed commands. To re-perform previously executed commands simply double-click on it or select the command(s) from the command history list in the Command Window and press the **Execute** button. By hitting the `<Tab>` key, it is also possible to select one or more entries. Hitting `<Tab>` or `<Esc>` will return you to the command edit field.

The maximum number of lines saved to the CrossView Pro command buffer list is set during debugger startup. The default is 100 lines. To change the default select **Command Window Setup** from the **Settings** menu. This number can also be modified via a startup option. You do not have to restart CrossView pro for these changes to take effect.
4.6.2 SOURCE WINDOW

The Source Window offers most of the debugging functions you will need on a regular basis. It allows you to:

- View the source file (source lines, disassembly or both).
- Set and clear assertions (not in Toolbar).
- Set and clear breakpoints.
- Monitor and inspect variables.
- Search for strings, functions, lines, addresses.
- Control execution.
- Call functions (not in Toolbar) and evaluate expressions.
- View code coverage information.
- View profiling/timing information.

An example of the source window is shown in figure 4-7.

![Figure 4-7: CrossView Pro Source Window](image)

You can specify the step mode, symbolic disassembly and source lines / disassembly with the Source Window Setup dialog box (Settings | Source Window Setup...) or with Run | Step Mode. Alternatively, you can use the drop-down menus in the Source Window’s status bar.
The default step modes are:

- Source lines Window: Source line step
- Disassembly Window: Instruction step
- Source and Disassembly Window: mode of previous window!
  (assumes the step mode of the previous Source Window setting)

The location of the cursor is also the viewing position. The line number and address of the viewing position, appears at the top-left position of the Source Window. This does NOT represent the current execution position ($pc$). The current execution position appears in reverse or blue color. The cursor appears as a dotted line.

On MS-Windows the so-called "quick watch" feature is supported. When you position the mouse cursor over a variable or a function, a bubble help box appears showing the value of the variable or the type information of the function respectively.

A green colored toggle shows that no breakpoint is set. A red colored toggle indicates an installed breakpoint. An orange colored toggle indicates an installed but disabled breakpoint. If code coverage is enabled, coverage markers appear to the right of the breakpoint toggles. If a checkmark appears next to a line, it has been executed. If no checkmark appears next to a line, it has not been executed.

The Source Window provides a local Toolbar containing the following buttons, nearly all of which are shortcuts (using selected text) to operations that you can perform via the menu bar:

- **Stop program or command**
- **Run or continue execution (same as F5)**
- **Run to cursor (same as F7)**
- **Step (over function calls)**
- **Step (into function calls)**
- **Restart application**
- **Find program counter (PC)**
Show selected source expression
Watch selected source expression
Find symbol
Search for a text string
Repeat search for text string
Edit current source file
Edit breakpoint at cursor
Display code coverage
Display profiling

You can toggle the appearance of this local toolbar by selecting **Local Toolbars | Source** from the **View** menu.

**Edit Source**

To edit the current source file in the Source Window, select **Edit | Edit Source** or press the **Edit Source** button. On MS-Windows the Codewright editor will be called with the filename and line number of the file that is currently in the debugger. On UNIX systems the **xvwedit** program will be called with the filename and line number of the file that is currently in the debugger.

The **xvwedit** program is a shell script. You can adapt it to your specific requirements.
4.6.3 REGISTER WINDOW

Figure 4-8 shows the Register Window. This window allows you to view and edit register contents.

![Register Window](image)

*Figure 4-8: CrossView Pro Register Window*

Note that the contents of the Register Window for your particular target may be different from the one shown in figure 4-8.

You can specify which register set definition appears in the Register Window with the Register Window Setup dialog box (Settings | Register Window Setup...). In this dialog you can also specify the display format of values in the Register Window: hexadecimal or decimal.

CrossView Pro supports multiple Register Windows. Register Windows either have the title "Register" or "Register - register set name". The "Register" title indicates the default register set.

In-situ editing allows you to change the registers contents directly by clicking on the corresponding cell.
4.6.4 MEMORY WINDOW

The Memory Window is shown in figure 4-9. This window allows you to view and edit the target memory.

Depending on the setting of the **Automatically refresh** check box in the Memory Window Setup dialog, CrossView Pro updates the displayed values every time the program is stopped or only updates the values by user request. For example, by pressing the **Update Memory Window** button located on the toolbar.

![CrossView Pro Memory Window](image)

*Figure 4-9: CrossView Pro Memory Window*

To edit the target memory, click on a memory cell and type a new value. To display another memory region: click on an address cell and type a new address. CrossView Pro accepts input in symbolic format, so you can enter expressions instead of just values.

CrossView Pro supports multiple instances of the Memory Window. If your target supports multiple memory spaces, the Memory Window supports them all. Refer to the section about memory space keywords to become familiar with the memory space keywords and associated syntax your target system uses.
You can specify the way data appears in the Memory Window by opening the Memory Window Setup dialog. From the Settings menu, select Memory Window Setup... to open this dialog. The memory contents can appear in many formats including ASCII character, hexadecimal, decimal, signed, unsigned, and floating point formats. You can specify the size of the memory window. You specify the number of memory cells that appear within the window. The number of cells is fixed in the sense that if you re-size the window the number of cells does not change.

Besides the current value of memory locations, the Memory Window also displays whether memory locations have been accessed during program execution. This is called 'data coverage'. An application program may read from, write to, or fetch an instruction from a memory location. Of course all combinations may be legal. Although writing data to a memory location from which an instruction has been fetched is suspicious. All types of accesss, read, write, fetch or combinations of these, can be shown using different foreground and background colors. The color combination used to show "rwx" access are specified in the Desktop Setup dialog. Change the background color if instructions are fetched from a memory location, and change the foreground color to show read and write access.

You can display data coverage information in the Memory Window by clicking on the Coverage button in the Memory Window or by setting the Display data/code coverage check box in the Memory Window Setup dialog.

The Memory Window has the ability to highlight memory cells of which the contents have been changed. Click on the Highlight Value Changes button in the Memory Window to see the changed cells. With the Freeze Highlight Reference Values button you can enter a new reference point for highlighting. All the cells that have been changed since that reference point are highlighted.

The Memory Window provides a local Toolbar containing the following buttons:

- Fill memory
- Fill single memory address
- Copy memory
- Find memory
Display data coverage

Highlight changed values

Set highlighted values as reference

Refresh memory window

You can toggle the appearance of this local toolbar by selecting Local Toolbars | Memory from the View menu.

4.6.5 DATA WINDOW

The Data Window is shown in figure 4-10. This window allows you to show the value of monitored expressions and variables.

The Data Window updates the values shown every time the program stops, and after an o command.

It is possible to display both monitored and unmonitored data expressions in the Data Window. CrossView Pro monitors and updates "WATCH" expressions after every halt in execution, and marks them with the text "WATCH" at the start of the display line in the Data Window. "SHOW" expressions, on the other hand, are one-shot inspections of an expression’s value, and CrossView Pro does not update them until you click on the Update Selected Data Item button or Update Old Data Items button. When a "SHOW" expressions is no longer actual, it is marked with the word “OLD”.
Using CrossView Pro

Figure 4-10: CrossView Pro Data Window

To set the default display format of the data shown, select the proper format in the **Data | Data Display Setup...** dialog.

To inspect the value of global variables and data structures, double-click on the variable name in the Source Window. Depending on preferences you set in the Data Display Setup dialog, the variable appears immediately in the Data Window, see figure 4-10, or the Expression Evaluation dialog appears first.

In-situ editing allows you to change the contents of everything in this window by clicking the value you want to change.

If you have set the **Display addresses** check box in the Data Display Setup dialog box the addresses of the variables are also shown.

Pointers, structures and arrays displayed in the data window have a compact and expanded form. The compact form for a structure is just `<struct>`, while the expanded form shows all the fields. The compact form of a pointer is the value of the pointer, while the expanded form shows the pointed-to object. Indicate the compact form by putting a '+' at the start of the display. (i.e., the object is expandable), and indicate the expanded form with (i.e., the object is contractible). Nesting is supported, so you can expand structures within structures ad infinitum.
To expand a pointer, structure or an array, double-click on the ‘+’ in the Data Window.

The Data Window provides a local Toolbar containing the following buttons:

- Show or watch a new expression
- Toggle watch attribute of selected item "on" or "off"
- Reformat selected item
- Update selected data item
- Delete selected data item
- Update old data items
- Delete old data items

You can toggle the appearance of this local toolbar by selecting **Local Toolbars | Data** from the **View** menu.

The auto-watch locals feature may be activated or deactivated. When active, a selected Data Window becomes the "auto-watch" window, and all local variables from the current top-of-stack frame appear in that Data Window. The text “LOCAL” appears at the start of the display for variables displayed in this manner. As the execution position changes, the auto-watch window deletes and adds locals as necessary, so that the locals on the current top-of stack frame always appear.

To see the value of the local variables of a function, Select **Data | Watch Locals Window** from the **View** menu.

CrossView Pro supports multiple Data Windows. Data Windows either have the title "Data Window #n" or "All Local Variables”. The "All Local Variables” title indicates the auto-watch window if it exists (as explained above).
4.6.6 STACK WINDOW

The stack records the return addresses of all functions the application has called, and CrossView Pro can use this information to reconstruct the path to the current execution position. The Stack Window, shown in figure 4-11, displays the function calls on the stack with the values of the parameters passed to them in an easily accessible and understandable form.

The Stack Window can help you assess program execution and allows you to view parameter values. The stack window allows you to:

- View the stack trace which includes information about function names, parameter values, source line numbers and stack level.
- Easily switch to the call statement of a stack level by clicking on it once.
- Set temporary and permanent breakpoints at any level of the stack, by double-clicking on the desired level.

Figure 4-11: CrossView Pro Stack Window with Toolbar
The Stack Window provides a local Toolbar containing the following buttons:

- Set stack breakpoint after call to function
- Set stack breakpoint at function entry point
- Show local variables in selected stack frame
- Watch local variables in selected stack frame
- Find call site

You can toggle the appearance of this local toolbar by selecting the Local Toolbars | Stack from the View menu.

### 4.6.7 TRACE WINDOW

The Trace Window, shown in figure 4-12, allows you to:

- Display the most recently executed lines of code.

CrossView Pro automatically updates the Trace Window each time you halt execution, as long as the window is open, allowing you to check the progress and flow of your program throughout the debugging session.

The Trace Window is only supported if your execution environment supports the trace facility.

![Figure 4-12: CrossView Pro Trace Window](image-url)
4.6.8 TERMINAL WINDOW

The Terminal Windows, shown in figure 4-13, let you observe and test the input and output of your program.

The CrossView Pro Terminal windows provide an interface to exchange data with the application on the target. This I/O facility can be implemented in various ways. Using standard I/O stream function calls like printf() in your source, you can test I/O to and from the target system or simulator.

The File System Simulation feature redirects I/O to a Terminal Window if the filename \texttt{FSS\_window:window\_name} is used in the "open" call, \textit{window\_name} is the name of a Terminal Window.

A terminal window can be connected to multiple I/O streams of various types. For example, streams 0, 1 and 2 can be mapped to one terminal window. An I/O stream, however, can be mapped to one terminal window only. Each terminal window must have a unique name.

\textit{Figure 4-13: CrossView Pro Terminal Windows}
You can specify the characteristics of the Terminal Window by opening the Terminal Window Setup dialog. From the Settings menu, select Terminal Window Setup... to open this dialog, or click with the right mouse button in the Terminal Window to bring up a popup menu and select Setup.... You can specify the input and output format of the terminal window. The input format can be a VT100-like terminal. The output format can be a VT100 terminal, display control codes, decimal, octal or hexadecimal. You can map linefeeds to carriage-return linefeeds, wrap at the end of a line, specify buffered input or specify that the window must be cleared at system reset and program reset. You can also log the input and output data to a file.

The default size of a terminal window is 24 lines of 80 characters. Everything that scrolls outside this window is lost. The visual window size can be smaller (scroll-bars are shown). You can specify another size in the Terminal Window Setup dialog.

Each terminal window has a local popup menu, which you can activate by clicking the right mouse button.

![Terminal Window Local Popup Menu](image)

**Figure 4-14: Terminal Window Local Popup Menu**

**Reset** clears the contents of the terminal window and it also clears all attributes set with escape sequences. A **Clear** just clears the contents of a terminal window. **Reverse** changes the foreground and background colors and **Local echo** enables echoing back of typed characters in a terminal window. **Setup...** opens the Terminal Window Setup dialog.

You can connect an I/O stream to a terminal window in the Connections tab of the Settings | I/O Simulation Setup... dialog box.
## 4.6.9 DATA ANALYSIS WINDOW

CrossView Pro incorporates an advanced signal analysis interface designed to enable developers to monitor signal data more critically and thoroughly. This feature is useful when developing signal processing software for application areas such as communication, wireless and image processing.

Contrary to the other CrossView Pro windows the Data Analysis window (as shown in figure 4-15) is not opened from the View menu, but is opened as result of processing a data analysis script (or from the Settings menu). Most other CrossView Pro windows are updated whenever the target application stops execution due to, for example, a breakpoint. The Data Analysis window is only updated on user request. This is done because a large set of data is shown in the Data Analysis window and this set of data must be available and complete at the time the window is updated. Therefore, the user normally constructs a complex breakpoint to trigger the update of the Data Analysis window.

![CrossView Pro Data Analysis Window](image)

**Figure 4-15: CrossView Pro Data Analysis Window**

The Data Analysis Window provides a local Toolbar containing the following buttons:

- ![Zoom in horizontally](image)
- ![Zoom out horizontally](image)
The graph displayed in the Data Analysis window is constructed by processing a CXL script. Refer to the CXL syntax specification in Appendix B, *CrossView Extension Language (CXL)*, for details. TASKING provides scripts for standard signal analysis such as FFT. However, the programmer can write CXL scripts and process the data in the format he desires.

See section 11.5, *Data Analysis*, for more details on data analysis.

**4.6.10 POP-UP WINDOWS**

Finally, two more windows can appear in certain situations:

**Help Window:** Activated with function key **F1** or when a **Help** button is pressed inside a dialog.

**Toolbox:** This window contains user defined buttons.
4.7 CONTROL OPERATIONS FOR CROSSVIEW PRO

All control operations can take place in any CrossView Pro Window. You can select and save startup options. You can record and play back playback files. You can define macros and assign them a button in the toolbox (allowing you to configure up 16 buttons).

4.7.1 ECHOING COMMANDS

The Command Window echoes every command given to CrossView Pro. CrossView Pro translates most button actions and menu selections into the CrossView Pro keyboard command equivalents. The Command Window echoes the equivalent commands just as if you had typed them there.

4.7.2 MOUSE/MENU/COMMAND EQUIVALENTS

Actions in CrossView Pro are performed by using keyboard commands typed into the Command Window, selecting a menu item, by clicking on a push button and sometimes by direct manipulation of objects with the mouse. Many actions can be accomplished several ways. For instance there are three different ways to set a breakpoint. You can:

1. Use the `line b` command in the command entry field.
2. Click on a breakpoint toggle in the Source Window.
3. From the Breakpoints menu, select Breakpoints... to open up the Breakpoints dialog box.
4.8 USING THE ON-LINE HELP

CrossView Pro has an extensive on-line help system to aid you. Help topics cover all CrossView Pro Windows, commands, and dialog boxes.

4.8.1 ACCESSING ON-LINE HELP

You can access help in several ways:

1. Click the Help button on a dialog box

   Opens the help system with information about how to perform the task or about the meaning of the dialog.

2. Click on the question mark in the upper right corner of a dialog, then click the element in the dialog you want help on.

   A yellow box briefly explains the element you asked help on.

3. Select the Help | Help menu item or press the F1-key.

   Opens the help system with information about the active window.

4. Hover the mouse pointer over a toolbar button.

   A yellow box shows the title of the button. A more complete description is shown in the status bar at the bottom of the screen.

4.8.2 USING MS-WINDOWS HELP

You enter help at a topic that explains the current window or dialog. By clicking on links, you can follow different paths. To return to your starting point click the Back button or open the Options | Display History Window and click on the node that you want to return to.

The Contents tab displays a list of main subjects. The Index tab displays a list of keywords that relate to certain topics. When you click the Find tab, you can search for a string pattern.

To save time, you can iconize the Help Window and maximize it when necessary.
5.1 SOURCE POSITIONING

When you have the Source Window open and it displays a source file, there are two points of reference to keep in mind: the execution position and the viewing position.

The execution position refers to the line of source at the Program Counter address. This line is always the next statement or instruction to be executed. When you load a file into the Source Window, CrossView Pro automatically displays the portion of the source code that contains the execution position.

The viewing position (also called 'cursor') is the line currently being examined in the displayed source file. Since many Source Window operations act on this line, you can think of the viewing position as the 'current line'. For instance, if you set a breakpoint without specifying a line number, CrossView Pro sets the breakpoint at the line marked by the viewing position. Please note that it is the viewing position that appears to the left of the Source Window (NOT the execution position!).

The execution position and the viewing position refer to the same line when a source file is first loaded into the Source Window. You can then change the viewing position, if you wish.

The execution position and the viewing position appear different to distinguish them from the rest of the source code. The execution position line appears in the execution position highlight colors, while the viewing position appears as a broken-line frame, also called the cursor. Note that a line containing a breakpoint appears in the breakpoint highlight colors.

A combination of execution position, cursor and breakpoint (all of which are potentially active on the same line) appear accordingly.
5.1.1 CHANGING THE VIEWING POSITION

When a program is active the viewing position is always visible in the Source Window. You can change the viewing position to move throughout the source file. Usually, whenever the execution position changes, the viewing position automatically follows suit. But you may easily change the viewing position without affecting the execution position.

To change the viewing position use any of the following possibilities:

- Use the vertical scroll bar to move a line or a page at a time. The viewpoint stays on the same line until it is no longer visible. It then stays on the first or last line of the display, depending on the direction of scrolling.
- Click on the desired, unmarked source line.
- From the Edit menu, select Find Line... to specify to which particular line you wish to move.

In the upper-left corner of the Source Window, there are two text fields. These fields show the line number of the current viewing position and the address of the first machine instruction for that line. CrossView Pro updates the Line and Address values each time the viewing position changes.

You can change the viewing position to the first executable line of a particular function with the e command. For instance:

```
e main
```

will make the first executable line of `main()` the current viewing position and display it in the Source window. You may also use the stack depth as an argument, if you place it before the e:

```
1 e
```

This will change the viewing position to stack depth 1, that is, the line that called the current function.

---

FUNCTION: Change the viewing position.

COMMAND: 
`stack e`
`e function`
To change the viewing position to a specified address, you can use the `ei` command. This command is useful for viewing some code in the assembly window, without changing the program counter, since the execution position is not changed.

**FUNCTION:** Change the viewing position to address.

**COMMAND:** \texttt{address \ ei}

### 5.1.2 CHANGING THE EXECUTION POSITION

There may be times when you want to start or resume execution at a different line than the one marked by the current execution position.

Exercise caution when changing the execution position. Often each line of C source code compiles into several machine language instructions. Moving the program counter to a new address in the middle of a series of related assembly instructions is sometimes risky. Moreover, even though you change the program counter, registers and variables may not have the expected values if you bypass parts of the code.

In the Source Window you can change the execution position to the viewing position with the menu entry \textbf{Run | Jump to Cursor}. This menu entry is disabled in Source file window mode to prevent problems by skidding pieces of C code which are required to be executed. See also the \texttt{g} and \texttt{gi} commands below.

When the program halts, you can change the execution position with the \texttt{g} command in the Command Window. The \texttt{g} command moves the execution position, but does not continue the program. To resume execution from your new execution position, use the \texttt{C} command.

Although risky, the \texttt{g} command does have its uses, especially in conjunction with breakpoints to patch code. Refer to the \textit{Breakpoints and Assertions} chapter for more information.

For example, to change the execution position from the current line, 54, to line 62, enter:

\texttt{g 62}
When you resume execution in this program, it is from line 62 instead of line 54.

FUNCTION: Change the execution position to a specified C source line
COMMAND: `g line_number`

You can also change the execution position to a specified address directly, although the same warnings apply. To do so, use the `gi` command. For instance:

`0x800 gi`

FUNCTION: Change the execution position to address.
COMMAND: `address gi`

Of course, moving the program counter (`gi` command) is even more potentially reckless than using the `g` command. Use both with caution especially when debugging a program which has instructions re-ordered due to optimizations.

To determine the address of a line of source, use the `P` command:

`80 P`

`80:(0x1486): sum = sum + 1;`

The hexadecimal number in parentheses is the instruction address for line 80.

FUNCTION: Print a source line and its instruction address.
COMMAND: `line_number P`
5.1.3 SYNCHRONIZING THE EXECUTION AND VIEWING POSITIONS

Each time you stop execution, the position of the program counter (PC) is visible in the source window. However, it may disappear from the window when scrolling through the source or when you loaded a new program. To find the program counter again:

- Click on the Find PC button in the Source Window or select Find PC from the Edit menu.
- From the Command Window, use the L command.

**The L Command**

The L command is shorthand for 0 e. It synchronizes the viewing and the execution positions, adjusting the viewing position if the two are different. The L command never affects the execution position. The L command is useful if you have changed your viewing position and do not remember where your execution position is.

**FUNCTION:** Synchronize viewing and execution position.

**COMMAND:** L
5.2 CONTROLLING PROGRAM EXECUTION

Using the mouse in the Source Window, you can direct the execution of your source programs. Among your options are:

- Starting execution from the first instruction or from the current execution position.
- Manually stopping execution whenever you want.
- Executing the program a single line at a time.
- Executing functions by calling them directly.

5.2.1 STARTING THE PROGRAM

To restart a program from its first instruction:

Click on the Restart program button in the Source Window.

or:

- From the Run menu, select Reset Application
- From the Run menu, select Run, or click on the Run/Continue button.

Type the R command from the Command Window.

This is NOT a target system reset. Refer to the rst command for information about side effects that may be introduced due to a target system reset.

After restarting a program, you can stop execution only by a breakpoint, an assertion or a halt operation from the user.

FUNCTION:  Reset program; run program.

COMMAND:  R
5.2.2 HALTING AND CONTINUING EXECUTION

To stop or continue execution:

- Click on the Halt button in the Source Window to stop execution. Click on the Run/Continue button to resume execution.
- From the Run menu select Halt to stop execution. Select the Run menu item to resume execution.
- Use the C command or function key F5 to resume execution.

When you halt the program, all the active windows update automatically to reflect the program's current status. For instance, if you have any expressions monitored in the Data Window, their current value appears.

Note that when you use any of the above methods to stop the program, CrossView Pro halts at the machine instruction that was on when interrupted. While this is a convenient way to stop the program, it is hardly an accurate one — you may stop execution in the middle of a C source statement.

To stop a program at a precise line of C source code, set a breakpoint. For more about breakpoints see the Breakpoints and Assertions chapter.

When continuing, CrossView Pro resumes execution as if the program had never stopped.

FUNCTION: Continue execution from the current execution position.
COMMAND: C

5.2.3 SINGLE-STEP EXECUTION

When the program stops, you can continue execution, or you can step through it one line or instruction at a time. This is called single-step execution.
Single-stepping is a valuable tool for debugging your programs. The effect is to watch your programs run in stop motion. You can observe the values of variables, registers, and the stack at a precise point in a program’s execution. You can catch many potential bugs by watching a program run line by line.

When you single step, CrossView Pro normally executes one line of your source and advances to the next sequential line of the program. If you single step to a line that contains a function call, however, you have two options: step into the function or step over the function call.

**Source Single-Step Into**

There are several methods you can use to single step into:

1. Click on the **Step Into** button in the Source Window or select **Step Into** from the **Run** menu.

2. Press function key **F8** or type the **s** command in the Command Window. You have the option of setting the number of lines you want to execute. For example, to execute 2 lines of the program, type: `2 s`.

   **FUNCTION:** Step through a program one source line at a time.
   **COMMAND:** `number s`

**Stepping Into Functions**

Stepping into a function means that CrossView Pro enters the function and executes its prologue machine instructions, halting at the first C statement. When you reach the end of the function, CrossView Pro brings you back to the line after the function call and continues with the flow of the program. The debugger changes the source code file displayed in the Source Window, if necessary.

If you accidentally step into a function that you meant to step over, you can select **Return from Function** from the **Run** menu to escape quickly.

For example, suppose you are at line 59 of a file, which contains a call to the function `factorial()`:

```
main#59:   table[ loopvar ] = factorial(loopvar)
```
By performing one **Step Into** action, you can step into the source code for `factorial()`. Your Execution and viewing position change to:

```
factorial#103:  char locvar = 'x';
```

CrossView Pro shows you the current function and line number and the C source code for the current execution position.

**Source Single-Step Over**

To step *over* a statement or a function call:

- Click on the **Step Over** button in the Source Window or select the **Step Over** from the **Run** menu.
- Press function key **F10** or enter the **S** command in the Command Window.

You have the option of setting the number of lines you want the debugger to execute. For example, to execute three lines of source, single stepping over functions, enter: **3 S**.

---

**FUNCTION:** Single step, but treat function calls as single statements.

**COMMAND:** `number S`

---

**Stepping over Functions**

Stepping over a function means that CrossView Pro treats function calls as a single statements and advances to the next line in the source. This is a useful operation if a function has already been debugged or if you do not want to take the time to step through a function line by line.

For example, suppose you reach line 59 in `demo.c`, which calls the function `factorial()`, as in the example above. If you give a **Step Over** command, the execution position moves to line 60 of the source code in the `main()` function immediately, without entering the source code for `factorial()`. CrossView Pro has executed the function call as a single statement.
If you try to step over a function that contains a breakpoint or that calls another function with a breakpoint, CrossView Pro halts at that breakpoint. Once execution stops, the step over command is complete. Therefore, if you resume execution by clicking on the Run button or with the C command, you do not regain control at the entrance to the function with the breakpoint. You can either single step through the rest of the function, or select the Run | Return from Function menu item to return to the line after the point of entry.

5.2.4 STEPPING THROUGH AT THE MACHINE LEVEL

While single stepping through code at the source level is informative, you might need a lower level approach. CrossView Pro can step through a program at the assembly language instruction level.

While more time-consuming than a source level step-through, an instruction level step-through allows you to examine how your code has been compiled. As you advance through the assembly instructions, notice how CrossView Pro translates data addresses to variable names, and correlates branch addresses to points in the source code. This makes it much easier to follow the source at the instruction level.

The default step modes are:

Source lines Window: Source line step
Disassembly Window: Instruction step
Source and Disassembly Window: mode of previous window!
(assumes the step mode of the previous Source Window setting)

Mouse and menu actions:

- The Step Into and Step Over buttons, and Run | Step Over and Run | Step Into menus can be set to step by instructions by selecting Run | Step Mode | Instruction step from the menu bar.
- To change back to stepping by source lines, select Run | Step Mode | Source line step.
- Another way to set the step mode is to select the Source line step or Instruction step radio button in the Settings | Source Window Setup dialog box.
To control this function from the Command Window, use the `Si` and `si` commands. The `Si` and the `si` commands are analogous to the `S` and `s` commands, `Si` will treat function calls (more precisely, jump to subroutine instructions) as single statements, while `si` will enter the function.

**FUNCTION:** Single step at instruction level. Step into functions.
**COMMAND:** `number si`

**FUNCTION:** Single step at instruction level. Step over functions.
**COMMAND:** `number Si`

As an example of stepping through instruction level code, restart the program. Then select **Run | Step Mode | Instruction step**. Once it stops at the breakpoint you installed, advance execution one assembly language instruction at a time by using the **Step Over** and **Step Into** buttons. Or give the `Si` or `si` commands.

CrossView Pro will display disassembly of the next machine instruction that forms part of the C code in the Command Output Window:

```
main#47+0x4:  disassembled instruction
```

Different types of targets, of course, have different assembly code, so debugging at the assembly level is hardware dependent.

Notice that a single C statement is usually compiled into several, sometimes many, machine instructions.

CrossView Pro supports debugging on machine instruction level using the **Intermixed or Assembly** mode of the Source Window.
5.3 NOTES ABOUT PROGRAM EXECUTION

If you stop the program in a module without debug symbols, then an S or s command attempts to step to a module with symbols. CrossView Pro does this by searching the run-time stack for a return address in a module with symbols, then setting a temporary breakpoint there, and running. This process relies on two assumptions: that the stack layout is uniform, and that each function eventually returns. In the unlikely event that these assumptions are violated, the program may run away when you attempt to single step.

5.4 SEARCHING THROUGH THE SOURCE WINDOW

CrossView Pro can search for addresses and functions in the entire application and for line numbers, and strings in the current source file. A string search starts from the current viewing position and "wraps around" the end (or begin) of the current source file. The string search ends when a matching string is found or when it returns to the starting point.

5.4.1 SEARCHING FOR A FUNCTION

There are several ways to find a function:

Using the mouse:

- From the Edit menu, select Find Symbol... to open the Find Symbol dialog box. Select the function you are looking for.
- Click on the Find Symbol button in the Source Window to open the Find Symbol dialog box.
- Select a function in the Stack Window (double-click) to show the line that called it.

From the Command Window, you can either specify e followed by the function name, or a stack position followed by e. For example:

```
e main     Find the function main().
le          Find the line that called the current function.
```

CrossView Pro searches through all the relevant source code files to find the one containing the body of the function. The part of the file containing the function appears in the Source Window.
5.4.2 SEARCHING FOR A STRING

CrossView Pro allows you to search for a particular string in the current source file. CrossView Pro searches the Source Window from the current viewing position. If it finds the string, it moves the viewing position to the corresponding line. This does not affect the execution position.

To find a string:

Open the Search String dialog box by clicking on the Find Text String button, or select Search String... from the Edit menu. Click on the Case Sensitive check box to turn case sensitivity on or off.

You can also highlight a text fragment in the source code and click on the Find Next Text String button to find that fragment again.

In the Command Window, use the / or ? commands. The / command searches forwards and the ? command searches backwards. For example, to find the string initval, enter:

```
/initval  Search forward for the string "initval"
```

CrossView Pro’s searches "wrap around" beyond the top or bottom of the file if necessary.

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Search forward for a string.</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td>/ string</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Search backward for a string.</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td>? string</td>
</tr>
</tbody>
</table>

If no string is supplied to the / or ? command, or if you hit carriage return, or press the function key F3 or select the Search Next String from the Edit menu item, CrossView Pro searches again for the last string requested.
5.4.3 JUMPING TO A SOURCE LINE

As mentioned earlier in the Changing the Viewing Position section, you can use the scroll bar to scroll through the source code or use the arrow keys or the + and - keys. To find a specific line, you can use one of several methods:

⚠️ From the Edit menu, select Find Line... to open the Find Line dialog box.

After you enter a line number (or select one from the history list) in this dialog box and click on the Find button, CrossView Pro will change the viewing position to the indicated line number. At the first use, the Find Line dialog box contains no line number, but on subsequent invocations it will show the line number you entered before.

⚠️ Enter the line number on the command line.
6.1 INTRODUCTION

This chapter discusses topics related to viewing and editing the variables in your source program and execution environment, including accessing variables and registers, viewing and modifying the data space, using monitors, viewing the source file, and disassembling code.

6.2 ACCESSING VARIABLES

This section describes how to view and edit your program variables using the debugger. You can monitor data so that every time you stop the program, CrossView Pro updates the current value.

The Data Window displays the values of variables and expressions. As long as the this window is open, CrossView Pro automatically updates the display for each monitored variable and expression each time the program stops.

Uninitialized variables will not have meaningful values when you first start the debugger, since your program’s startup code has not been executed. Also note that global data is initialized at load time. Re-running a program may produce unexpected results. To guarantee that global data is initialized properly, download the program again.

6.2.1 VIEWING VARIABLES, STRUCTURES AND ARRAYS

You may view variable values, and change them, from the Source Window and the Command Window. CrossView Pro returns the variable in the format `var_name = value` in the Command Window.

It is possible to display both monitored and unmonitored expressions in the Data Window. After every halt in execution, CrossView Pro updates monitored expressions. Unmonitored expressions are just one-shot inspections of the expressions value. Refer to section 4.6, CrossView Pro Windows for a detailed description of the Data Window.

To set the default display format of the data shown, select the proper format in the Data | Data Display Setup... dialog.
To show the contents of a variable or to show the type information of a function:

Position the mouse cursor over a variable or a function in the Source Window. A bubble help box appears showing the value of the variable or the type information of the function, respectively.

To evaluate a simple expression:

Double-click on a variable in the Source window. The result of the expression is shown in the Data Window. Alternatively, depending on the preferences you set in the Data Display Setup dialog, the expression appears in the Evaluate Expression dialog. Click the Add Watch or Add Show button to display the result of the expression in the Data Window. Click the Evaluate button to display the result of the expression in the output field of the Evaluate Expression dialog.

To evaluate a complex expression:

From the Data menu, select Evaluate Expression... and type in any C expression in the Evaluate Expression dialog box. Optionally select a display format. Click the Evaluate button.

Type the expression into the command edit field of the Command Window followed by a return or click the Execute button.

For example, to find the value of initval in demo.c type:

```
initval
```

and CrossView Pro will display:

```
initval = 17
```

FUNCTION: Display the value of a variable.

COMMAND: variable’s name

For variables having the same name as an CrossView Pro command, use /n as format style code.
Any expression that can be typed into the Command Window can also be typed in the Expression field of the Expression Evaluation dialog box. Throughout this discussion, expressions can be typed in either location, depending on what is convenient.

**Viewing Structures**

You can also view structures.

By using any of the methods described above, you can print out the entire structure. For example:

```plaintext
recordvar
```

and CrossView Pro prints out the structure of `recordvar` and values of `recordvar`'s fields in correct C notation:

```plaintext
recordvar = struct rec_s {
    a = -1;
    b = 0x1028 "TASKING";
    c = 987654321;
    color = blue;
} recordvar
```

**Displaying Individual Fields**

Similarly, you can instruct the debugger to print the value of an individual field.

In the Source Window, highlight `recordvar.color` and click the Show Expression button. Or, in the Expression edit field of the Expression Evaluation dialog box or in the Command Window, type the structure name followed by a period and the field name. For instance, to see the field `color` for the structure `recordvar`, enter:

```plaintext
recordvar.color Command
color = blue       Output
```

Note that CrossView Pro returns the value in the form `field_name = value`. CrossView Pro also displays enumerated types correctly.

Variables will not have meaningful values when you first start CrossView Pro, since your program's startup code has not been executed.
Displaying the Address of an Array

If you enter the name of an array in the Expression Evaluation dialog box or in the Command Window, the debugger returns its address. For instance, to find the address for the array table, select `table` from the browse list in the dialog box or type the name in the Command Window:

```
Command
```
```
table = 0x200
```
```
Output
```
```
table = 0x200
```

Note that CrossView Pro returns the address in the form `array_name = address`.

The debugger can also display the address and value of an individual element of an array. Enter the name of the array and the number of the element in brackets. For instance, to find the address and value of the third element of array `table`, enter:

```
Command
```
```
table[3] = 0
```
```
Output
```
```
0x20C = 0
```

Note that CrossView Pro returns the information in the form `address = value`.

Displaying Character Pointers and Character Arrays

The following piece of C code can be accessed in CrossView Pro using the string format codes:

```
char text[] = "Sample\n";
char *ptext = text;
```
```
text = 0x8200
```
```
text/a
```
```
text = "Sample^J"
```
```
ptext = 0x8200
```
```
ptext/s
```
```
string = "Sample^J"
```
```
&ptext
```
```
0x8210
```

What is the address of this char array

Print it as a string

What is the contents of this pointer

Where does ptext itself reside
**Sizing Structures**

With structured variables, it is especially useful to know the size of a variable.

In the Command Window, you can determine the size of a variable with the `sizeof()` function. For instance, to determine the size of the structure `recordvar`, enter:

```
sizeof(recordvar)
```

24

### 6.2.2 Changing Variables

With CrossView Pro, you can not only view your variables, but change them. This function allows you to easily test your code by single-stepping through the program and assigning sample values to your variables. For instance, to set the variable `initval` to 100, enter:

```
initval=100
```

and CrossView Pro confirms `initval`'s new value:

```
initval = 100
```

Note that CrossView Pro returns the values of variables with the syntax: `var_name = value`, with any right-hand side expression evaluated to a single value.

**Changing variables in the Data Window**

To change a variable in the Data Window, follow these steps:

- In the Data Window, double-click on the variable you wish to edit. In-situ editing will be activated.
- Specify the new value in the edit control and hit the Enter key.

When in-situ editing is active, you can use the Tab key to move the edit field to the next variable value or use the Shift+Tab key combination to move the edit control to the previous variable.
Assigning Structures

CrossView Pro also allows you to assign whole structures to one another.

You can use a simple equation to assign the structures. For instance, to assign `statrec` to `recordvar`, enter:

\[
\text{statrec} = \text{recordvar}
\]

Assigning Pointers

Assigning to and evaluation of pointers requires some extra attention. When requesting a pointer variable, its `near`, `far` or `huge` attribute is taken into account and the variable is evaluated accordingly. For example, bits 14-15 in a near pointer indicate which DPP register contains the data page value:

```plaintext
\text{pn/t}
\text{global short near *pn}

\text{pn}
\text{pn} = \text{0x4106}

\text{pn/1x2}
\text{pn} = \text{0x106}

\text{$dpp0$}
\text{$DPP0} = \text{0x1}

\text{$dpp0=10$}
\text{$DPP0} = \text{0xA}

\text{pn}
\text{pn} = \text{0x28106}
```

As you can see, using a display format allows you to see how the pointer is actually stored in memory. When the value of the indexed DPP is changed to 10, pointer `pn` evaluates to to an address in data page 10.
When assigning to pointers, you do not have to bother with the memory storage representation. You can specify the address the pointer should evaluate to when assigning a new value:

```
pf/t
  global short far *pf

pf = 0x123456
pf = 0x123456

pf/2x2
pf = 0x3456 0x0048
```

When assigning to a near pointer, CrossView Pro checks if the given address is in one of the pages indicated by the DPP registers and stores the index of the matching DPP in bits 14–15 of the pointer. If a page is designated by more than one DPP, the lowest DPP index is used. If the address is in none of the indicated pages, CrossView Pro issues an error message.

In addition to the standard set of basic types, CrossView Pro supports the type `bit`. All variables declared `bit` or `sfrbit` in your program have this type. When you request the address of such a variable both the address and the bit offset are shown. For example:

```
bvar/t
  global bit bvar

bvar
bvar = 1

&bvar
0xFD4E.0
```

To show the address as it is stored in memory, use the display format option:

```
&bvar/1x2
0x270
```
6.2.3 THE l COMMAND

CrossView Pro’s windows contain a great deal of information about the current debugging session. Occasionally, however, you have a few closed windows, or wish the information to appear in the Command window (for instance, when you are recording output). Using the l (list) command, you can find out all sorts of things about the current state of the debugger and have the information appear in the Command window.

<table>
<thead>
<tr>
<th>Arguments of the l Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>a  assertions</td>
</tr>
<tr>
<td>b  breakpoints</td>
</tr>
<tr>
<td>d  directory</td>
</tr>
<tr>
<td>f  files (modules)</td>
</tr>
<tr>
<td>g  globals</td>
</tr>
</tbody>
</table>

For configurations that support real-time kernels the l k command can have additional arguments. See the description of the l command in the Command Reference for details.

You may for example view the contents of the registers:

```
l r
```

Or the list of procedures (that is, functions):

```
l p
```

a complete list of global variables:

```
l g
```

The l f command (list files) also shows the address where CrossView Pro placed the first procedure in the module. If the module is a data module then the address reflects the first item’s placement.

With all of these l commands you can specify a string:

```
l g record
```

and CrossView Pro searches the globals for a match with the same initial characters; in this case global variables that begin with record.
6.3 EXPRESSIONS

6.3.1 EVALUATING EXPRESSIONS

CrossView Pro expressions use standard C syntax, semantics, and allow special variables. You can calculate and show the values of expressions in CrossView Pro by using a variety of methods:

It is possible to display both monitored and unmonitored expressions in the Data Window. CrossView Pro updates monitored expressions after every halt in execution. Unmonitored expressions are just one-shot inspections of the expressions value. Refer to section 4.6, CrossView Pro Windows for a detailed description of the Data Window.

To evaluate a simple expression:

Double-click on a variable in the Source window. The result of the expression appears in the data window. Alternatively, depending on the preferences you set in the Data Display Setup dialog, the expression appears in the Evaluate Expression dialog. Click the Add Watch or Add Show button to display the result of the expression in the Data Window. Click the Evaluate button to display the result of the expression in the output field of the Evaluate Expression dialog.

To evaluate a complex expression:

From the Data menu, select Evaluate Expression... and type in any C expression in the Evaluate Expression dialog box. Optionally select a display format. Click the Evaluate button.

CrossView Pro calculates the result and displays the value in the appropriate format. For details about expression formats see the section Formatting Expressions in the chapter CrossView Pro Command Language.

Type the expression in the Command Window.

Expressions can contain variable names as arguments. For instance, if the variable initval has a value of 17 and you enter:

\[ \text{initval} \times 2 \]

CrossView Pro displays:

34
The expression can contain names of variables, constants, function calls with parameters, and so forth; anything that you can write directly at the Command Window, you can use in the Evaluate Expression dialog box. For more information on expressions and the CrossView Pro command language, refer to the section *CrossView Pro Expressions* in the *Command Language* chapter.

**The Dot Operand**

Using the dot shorthand "." can save you some typing. The dot stands for the last value CrossView Pro displayed. For instance:

```plaintext
initval
initval = 17
```

Now you can use the value 17 in another expression by typing:

```
. * 2
34
```

The value is the result of the new expression.

Naturally, using the dot operand saves you from retyping complex expressions.

### 6.3.2 Monitoring Expressions

CrossView Pro allows you to monitor any variable or expression. Monitoring means that the debugger evaluates a particular expression and displays the result each time the program stops. If you are in window mode, CrossView Pro displays the values of the monitored variables and expressions in the Data window.

**Monitor Set Up**

To set up a monitor you can:

- From the **Data** menu, select **Evaluate Expression**... or double-click on a variable in the Source Window, or click on the **Watch Expression** button to view the Expression Evaluation dialog box. From this dialog box, you can enter an expression and monitor (watch) its value in the Data Window. You can skip the Expression Evaluation dialog if you activate the **Bypass Expression Evaluation dialog** check box in the Data Display Setup dialog.
Alternatively, click on the New Expression button in the Data Window.

The Data Window must be open to display the result. Otherwise CrossView Pro does not monitor the expression. Therefore, CrossView Pro opens the Data Window automatically when you choose to show or watch an expression.

Type the m expression command in the Command Window.

To place the variable initval in the Data window type:

m initval

initval remains in the Data window. You may run the program, step through it, and the display updates continually. Even if you are not in window mode, CrossView Pro still displays the value of initval after every CrossView command.

FUNCTION: Monitor an expression or variable.
COMMAND: m expression

Similarly, if you want twice the value of initval you could type:

m initval*2

And the expression initval*2 is monitored.

Monitored expressions are evaluated exactly as if you had typed them in from the command line; therefore, if you are monitoring a variable, say R, identical to an CrossView Pro command, use the /n format, in this example R/n.

Monitor Delete

To remove a monitored expression you can:

Select the item in the Data Window and click on the Delete Selected Data Item button from the Data Window, or select Data | Delete | Item.

To remove all expressions from the Data Window, select Data | Delete | All.

Type the number m d command in the Command Window.
To remove `initval` from your Data Window #1, type the number of the expression (first item of the Data Window has number 0) and `md` (monitor delete):

```
0 md
```

and CrossView Pro removes `initval` (in this case, assuming it is the first variable listed in the window) from the Data Window.

**FUNCTION:** Remove an expression from the Data Window

**COMMAND:** `number md`

Since local variables have no meaning beyond their range, CrossView Pro issues error messages if you try to evaluate local variables beyond their scope. Some variables also become invisible when the program call another function. For instance, if you are in `main()`, monitoring `sum`, and `main()` calls `factorial()`, the unqualified name `sum` is no longer visible inside `factorial()`. You can get around this problem, however, by monitoring `main#sum` instead.

### 6.3.3 FORMATTING DATA

When you display a particular variable, CrossView Pro displays it in the format the symbolic debug information defines for it. You may, however, easily specify another format using dialogues or keyboard commands. See the section *Formatting Expressions* in the chapter *CrossView Pro Command Language*.

**Examples**

To print the value of `initval` in hexadecimal format, enter

```
initval/x
```

Be sure not to confuse CrossView Pro format codes with C character codes. CrossView Pro uses a `/` (forward slash) not a `\` (backward slash).
Don’t worry about trying to memorize the list, you probably won’t have occasion to use all these formats. Notice, however, that the /t format code give information about a particular value. For instance, if you wanted to find out what the type of initval is, type:

```
initval/t
global long initval
```

Please note that the displayed type may not seem to be the same type as you declared in your source file:

- The c166 compiler supports keywords bitword, sfr and sfrbit. These keywords indicate special cases of the basic types unsigned int and bit respectively. For the debugger, these special cases are not distinct. When requesting the type of variable declared with one of the above keywords, CrossView Pro will show the basic type.
- The near, far and huge keywords are essential attributes to pointers. The chosen memory model designates the default pointer attribute. When the type of a pointer variable is requested in CrossView Pro, the attribute is shown explicitly, because CrossView Pro does not know about memory models.

You can also take more low-level actions, such as finding out which function contains the hexadecimal address 0x100.

```
0x100/P
main
```

CrossView Pro tells you that address 0x100 is in the function main().

### 6.3.4 DISPLAYING MEMORY

CrossView Pro supports several methods to display memory contents. The Memory Window provides a very user-friendly yet powerful way to display the raw contents of the target memory.

Refer to section 4.6.4 for a description of the Memory Window.

Format codes also give you control over the number and size of multiple pieces of data to display beginning at a particular address. The debugger accepts format codes in the following form:

```
[count] style [size]
```
Count is the number of times to apply the format style style. Size indicates the number of bytes to be formatted. Both count and size must be numbers, although you may use c (char), s (short), i (int), and l (long) as shorthand for size. Legal integer format sizes are 1, 2, and 4; legal float format sizes are 4 and 8.

For instance:

```
initval/4xs
```

displays four, hexadecimal two-byte memory locations starting at the address of initval.

With format codes, you may view the contents of memory addresses on the screen. For instance, to dump the contents of an absolute memory address range, you must think of the address being a pointer. To show the memory contents you use the C language indirection operator ‘*’. Example:

```
*0x4000/2x4
0x4000 = 0x00DB0208 0x5A055498
```

This command displays in hexadecimal two long words at memory location 0x4000 and beyond. Instead of using the size specifier in the display format, you can force the address to be a pointer to unsigned long by casting the value:

```
*(unsigned long *)0x4000/2x
0x4000 = 0x00DB0208 0x5A055498
```

To view the first four elements of the array table from the demo.c program, type:

```
table/4d2
table = 1 1 2 6
```

This command displays in decimal the first four 2-byte values beginning at the address of the array table.

By typing the a space followed by a carriage return you can advance and see the succeeding values in the same format:

```
[Enter]
0x11 = 24 120 720 5040
```

You may recognize that the array table contains the factorials for the integers 0 through 7.
Displaying memory in this way is particularly effective when you have two-dimensional arrays. In this case you can display each row by specifying the appropriate count. For instance, if `myarr` is defined as `int myarr[5][8]`:

```
myarr/8ds
```

displays the values for the eight elements in the first row of `myarr`. Typing the carriage return repeatedly then display subsequent rows in the same format.

To scroll back in memory, type the `^` (caret) sign:

```
^ 0x9 = 1 1 2 6
```

**FUNCTION:** Display value(s) at previous memory location.

**COMMAND:** `^`

## 6.3.5  DISPLAYING MEMORY ADDRESSES

The `f` command lets you specify in which notation CrossView Pro displays memory addresses. It takes the same arguments as the `printf()` function in C.

```
FUNCTION: Specify memory address notation.
COMMAND:  f ["printf-style-format"]
```

For instance, if you wish to display all memory addresses in octal, type:

```
f "%o"
```

Now all addresses appear in octal. To return to the default hexadecimal, type:

```
f "%x"
```

Using the `f` command without an argument also returns to hexadecimal address display.
### 6.4 DISPLAYING DISASSEMBLED INSTRUCTIONS

To show disassembled instructions:

> From the **View** menu, select Source | Disassembly to open the Disassembly Source Window.

> Use the `/i` format switch to display disassembled code in the Command Window.

By using an address and the `/i` format it is possible to display disassembled code at any point. Suppose you wish to see how the `factorial()` function has been compiled. One method would be to examine the instructions displayed as you single step through a program at the assembly language level. There is however a quicker method that does not require you to execute the instructions. Type:

```
factorial/10i
```

This command displays the first ten assembly language instructions of `factorial()`. Remember that in C a function’s name is also its address. Thus `factorial` is the address of the function `factorial()`.

Note that CrossView Pro keeps track of variable and function names for you in the disassembled code. You can also disassemble from the current execution position by using the program counter:

```
$pc/5i
```

This command disassembles five assembly language instructions from the current execution line.

You can display disassembled code for any function:

```
main#56/7i
```

disassembles seven instructions from line 56.

See also the **ei** command for displaying disassembly in a window.

**Labels in Disassembly**

To show labels in disassembly:

> From the **Settings** menu, select the Source Window Setup... to open the Source Window Setup dialog box and enable the **Symbolic disassembly** check box.

---

**Note:** The `factorial()` function example assumes a C language environment. The disassembly commands are specific to CrossView Pro and may differ in other environments.
Turn the `$symbols` special variable "ON" by typing the following command in the Command Window:

```
opt symbols=on
```

### 6.4.1 INTERMIXED SOURCE AND DISASSEMBLY

To show intermixed source and disassembly:

1. From the **View** menu, select **Source | Source and Disassembly** to open the Source and Disassembly Window.
2. Use the `/I` format switch to display intermixed C and disassembled code in the Command Window.

The `/I` format works exactly as the `/i` format, except CrossView Pro intermixes the pseudo-assembly listing with the original C source. This feature is often helpful in displaying long portions of code.

**Auto Switch between Source and Disassembly**

To automatically switch between source and disassembly window depending on the presence of symbols:

1. From the **Settings** menu, select the **Source Window Setup...** to open the Source Window Setup dialog box.
2. Enable the **Show assembly when SDI is missing** check box.
3. Turn the `$autosrc` special variable "ON" by typing the following command in the Command Window:

```
opt autosrc=on
```
6.5 THE STACK

During debugging, you frequently find yourself lost or unable to pinpoint your location through a series of function calls. The **system stack** helps you with the problem by recording the return addresses of all functions you have passed through. CrossView Pro can use this information to reconstruct the path to your current location.

The following diagram shows the structure of the stack.

![Stack frame layout diagram](image)

*Figure 6-1: Stack frame layout*

### 6.5.1 HOW THE STACK IS ORGANIZED

c166 maintains two types of stack: the system stack and the user stack.
The system stack is used for return addresses (CALL/RET instructions) and can be accessed via PUSH/POP instructions (using the SP register). Because the system stack can be very small (internal memory for the C166/ST10), **c166** tries to avoid it as much as possible. Code generator temporaries are pushed on the user stack. Via the **-Ou** option it is even possible to let a task switch (interrupt) use the user stack instead of the system stack. You must specify the size of the system stack size in the system startup code (SYSCON register), which is the system stack size for all tasks (the whole application). For the behavior of the C166S v2.0 and Super10 architectures please refer to their respective user’s manuals.

The user stack is the so called 'C-stack'. **c166** uses R0 as 'User Stack Pointer' and the [-R0]/[R0+] addressing modes perform push/pop sequences. If data paging is used (medium and large memory model), the user stack is limited to 16K (one page). In these models, **c166** uses DPP1 as 'user-stack page number'. The locator combines the user stack areas of each task to one global user stack area (with cumulated size). A context switch inherits the user stack pointer (R0) value in the new registerbank and DPP1 remains unchanged.

### 6.5.2 THE STACK WINDOW

The Stack Window shows the current contents of the stack after the program has been stopped. This window helps you assess program execution and allows you to view program values. You can also set breakpoints for different stack levels from this window, as described in the chapter *Breakpoints and Assertions*.

The Stack Window displays the following information for each stack level:

- The name of the function that was called
- All parameters specified to the function
- The line number in the source code from which the function was called

Each stack level shown in the Stack Window is displayed with its level number first. The levels are numbered sequentially from zero. That is, the lowest/last pushed level in the function call graph is always assigned zero.
When you first see stack information, the lowest level appears against a darker background than the other lines in the window. The marked line in the Stack Window is the **selected stack level**, meaning that this line is selected for window operations. You can change the selected stack level by clicking on a different line.

**Checking the Stack from the Command Window**

The stack information is also accessible from the Command Window with the `t` and `T` commands. The `t` command reconstructs the program’s calling path. For instance, if you stepped into the function `factorial()` and issue a `t` (trace) command:

```
t
```

CrossView Pro displays:

```
0 factorial(num=0) [demo.c:105]
1 main() [demo.c:59]
```

The numbers to the left indicate the depth of each function on the stack. The function at the zero stack level is your current function. CrossView Pro tells you the line number where the function was called ([`demo.c:line_nr`]) and the value of the argument passed (num=value). With this information it is fairly easy to reconstruct your calling path, and see what parameter values your functions have received.

---

**FUNCTION:** Trace stack to reconstruct program’s calling path.

**COMMAND:** `t`

---

There is a slight variation on the `t` command called the `T` command. The two are identical, except that the `T` command also displays the local variables for each function. For instance:

```
T
0 factorial(num=0) [demo.c:105]
   locvar = 'x'
1 main() [demo.c:59]
   loopvar = 0
   sum = 0
   cvar = '\xff'
```
FUNCTION: Trace stack and display local variables.

COMMAND: T

6.5.3 LISTING LOCALS AND PARAMETERS OF A FUNCTION

As mentioned in the previous section, CrossView Pro displays all parameters of a function. You can view the local variables and parameters of any single function active on the stack. To do this:

Follow these steps:

- Open up the Expression Evaluation dialog box by clicking on the New Expression button from the toolbar or selecting Evaluate Expression... from the Data menu.
- Click on the Browse... button.

In the Command Window, use the l (lowercase L) command.

For example, assuming you are still in factorial(), issue an l command:

```
l factorial
num = 0
locvar = 'x'
```

You can accomplish the same task by specifying the stack depth instead of a function name:

```
l 0
```

6.5.4 LOW-LEVEL VIEWING THE STACK

You can directly view the contents of the user stack. Although CrossView Pro provides several high level methods of tracing functions on the user stack, you can view its contents directly with the frame pointer special variable, $fp (which equals R0). For instance, the command:

```
$fp[0]/4x1
```
displays the four one-byte values in hexadecimal to which the frame pointer points. Notice that the stack frame is not really an array, but by pretending it is, you can display the memory much as you did with the `table` array. Refer to the Accessing Variables section in this chapter for more information.
6.6 TRACE WINDOW

C level trace is not available for all execution environments. Please check the Addendum for details.

The Trace Window displays the most recently executed lines of code each time program execution stops. CrossView Pro automatically updates the Trace Window each time execution halts, as long as the window is open.

For each executed line of code, the Trace Window displays:

- The name of the source file
- The name of the function
- The line number and corresponding source code
- The window shows all the code executed since the last time the program halted.

6.6.1 TRACE WINDOW SETUP

The Trace Window’s only function is to display the contents of the emulator’s/ simulator’s trace buffer. The only operation you can perform in this window that directly affects the contents is to set the maximum number of instructions in the display.

To set the displaying limit, select Trace Setup... from the Settings menu. You can change the maximum number of C-Trace machine instructions to fetch from the execution environment’s trace buffer and the maximum number of trace output lines in the Trace Window.

To view the most recently executed source statements from the Command Window, use the ct command preceded by the number of machine instructions you want to list. For example, to view the last source lines corresponding to the last ten machine instructions, enter:

10 ct

FUNCTION: Display in the Command window the most recently executed C statements.

COMMAND: number ct
To activate the source level trace window:

From the View menu, select Trace | Source Level to view the Trace Source Window.

You can view the last machine instructions executed with the ct i command. For example:

\[15 \text{ ct i}\]

displays the last 15 machine instructions in disassembled form in the Command Window.

FUNCTION: Display the most recently executed machine instructions.
COMMAND: \(number \; ct \; i\)

To activate the instruction level trace window:

From the View menu, select Trace | Instruction Level to view the Trace Instructions Window.

You can view a raw trace with the ct r command. For example:

\[20 \text{ ct r}\]

displays the last 20 trace frames in the Command Window.

FUNCTION: Display a raw trace.
COMMAND: \(number \; ct \; r\)

To activate the raw trace window:

From the View menu, select Trace | Raw to view the Trace Raw Window.
6.7 REGISTER WINDOW

The Registers Window shows you the values of internal registers on your target processor.

You can create multiple Register Windows and each Registers Window contains the names and contents of all currently selected registers in the selected register set definition. Values are displayed in hexadecimal format. As long as the window is open, the debugger automatically updates the values when the program stops.

To show the list of current registers and their contents in the Command Window, enter the list registers command (l r).

CrossView Pro also supplies the following special variables:

\[
\begin{align*}
ssp & \text{ stack pointer} \\
spc & \text{ program counter} \\
sp & \text{ current frame pointer}
\end{align*}
\]

for all targets. For more information, refer to the Command Language chapter.

6.7.1 REGISTER WINDOW SETUP

You can configure which register set definition with which (and in which order) registers must be displayed in the Register Window; using the Settings | Register Window Setup... dialog. Since you can have more than one Register Window, the last active Register Window will be configured when you select this menu item.
To configure a Register Window follow these steps:

- Select a Register Window.
- From the Settings menu, select Register Window Setup... to view the Register Window Setup dialog box.

The dialog will show the active register set definition and the list of available and selected registers for this particular register set definition.
• You can create a new register set definition by entering an unique register set definition name in the **Name** edit field and using the **Add** button.

• You can delete a register set definition by selecting an item from the defined register set definition list and using the **Delete** button. Note that when you delete a register set definition, any Register Window displaying a deleted register set will be closed.

• You can select a register set definition by selecting an item from the defined register set definition list. The list of available and selected registers will be updated according to the configuration of the selected register set definition.

Once you have selected a register set definition, follow these steps to configure this register set definition:

• You can add registers to the list of selected registers by selecting registers from the list of available registers by highlighting those registers in the left list box and using the **Add->** or **Add All** button or by double-clicking on the register you want to add.

• You can remove registers from the list of selected registers by highlighting those registers in the right list box and using the **Remove <−** or **Remove All** button, or by double-clicking on the register you want to remove.

• By using the **Move Up** and **Move Down** buttons you can change the display order of the selected registers in the Register Window.

CrossView Pro automatically updates all Register Windows and places the registers in each Register Window starting at the top-left position on one line, wrapping to the next line if the next register does not fit.

### 6.7.2 Editing Registers

CrossView Pro lets you change the contents of registers in a simple and direct manner.

Follow these steps:

• In the Register Window, click on the register value you wish to edit. In-situ editing will be activated.

• Specify the new value in the edit control and hit the **Enter** key.

If the edited value is not acceptable, the debugger will emit an error message and reset the old value.
When in-situ editing is active, you can use the Tab key to move the edit field to the next register value or use the Shift+Tab key combination to move the edit control to the previous register. Use the Esc key to cancel in-situ editing. When a register is not in view the contents of the Register Window will be updated automatically.

You can enter any expression in the Registers Window.

Registers which can be edited symbolically have a special marker just before the register name. You can click on this marker to activate the Assign Register Symbolically dialog.

To access registers from the Command Window, use the $ designation and the register name in the format:

\[ \$register = value \]
You can use breakpoints to stop program execution at specified locations and return control to the user. An assertion is a number of statements executed by the debugger each time the target executes a program line. Use assertions to track down bugs, the cause of which is very hard to find.

### 7.1 Introduction to Breakpoints

Breakpoints halt program execution and return control to you. There are several types of breakpoints: code, data, instruction count, cycle count, timer and sequence. A code breakpoint halts the program on a particular statement or instruction; a data breakpoint stops the program when a particular memory address (or range of addresses) is accessed; an instruction count breakpoint halts the program after a specified number of instructions have been executed; a cycle count breakpoint stops the program after a number of CPU cycles; a timer breakpoint stops the program after a number of micro seconds or ticks and sequence breakpoints stop the program when a number of breakpoints are hit in a specified sequence.

Data breakpoints, instruction count breakpoints, cycle count breakpoints and timer breakpoints are not available for all execution environments, please check the addendum.

#### 7.1.1 Code Breakpoints

A **code breakpoint** is set on a line in the code and makes the program halt exactly before that line executes. When you define a code breakpoint, you can include four elements:

- A *count*, which is the number of times the breakpoint must be encountered before it stops the program (default is 1).
- A *reset count*, which is the value assigned to the *count* after the program has stopped on a breakpoint (default is 1).
- A *name*, which is the symbolic name you can associate with a breakpoint.
- A list of commands, which will be executed when the program hits the breakpoint.
Color Marking of Breakpoints

In the Source Window, a green colored toggle shows that no breakpoint is set. A red colored toggle shows that a breakpoint is installed. An orange colored toggle indicates an installed but disabled breakpoint.

If coverage is enabled, coverage markers are present to the right of the breakpoint toggles. An executed line is marked and not executed lines are not marked.

Permanent/Temporary Code Breakpoints

Code breakpoints can be: permanent or temporary. A permanent breakpoint exists until explicitly deleted. A temporary breakpoint only exists until it stops the program once.

Probe Points

A breakpoint can be treated as a probe point. When a probe point is hit, the associated commands are executed and program execution is continued. Probe points are used with File I/O simulation and sequence breakpoints.
How CrossView Pro Sets Code Breakpoints

CrossView Pro depends on the symbol table for information about how machine instructions map to lines of source. In general, the C compiler issues line symbols at the start of each statement or line, whichever comes first. This can lead to some surprising results. If you look carefully, you can tell on which line CrossView Pro set the breakpoint, since CrossView Pro tells you on which line the program stopped, a line that may be different from the one you expected. To find out what happens if you install a code breakpoint, use single stepping and watch the order in which the source lines print out.

Multiple Statements on a Single Source Line

If you frequently include multiple statements on a single line in your source code, you may have difficulties setting code breakpoints at certain locations. For instance, suppose you have a source line containing:

\[
\begin{align*}
    a &= 0; \quad b = 1
\end{align*}
\]

Suppose you want to halt execution after the assignment to \(a\) and before the one to \(b\). A normal code breakpoint does not work here, because execution stops at the first instruction of the source line. CrossView Pro provides you with the capability of disassembling the code and inserting breakpoints at the machine level. You can use the Assembly Source Window or the Intermixed Source Window to spot the right location.

For more information on machine level breakpoints, see below.

Setting Breakpoints for Multi-line Statements

Code breakpoints have a special behavior for multiple-line statements, such as a multiple-line if. In an if clause, a line symbol is generated at the beginning of the list of conditions, and the other lines of the conditions are generally associated with the first line of the clause. In an if-then-else construct, the \{\} character before the else is associated with the branch-around to the end of the statement.

Consider the following example:

\[
\begin{align*}
    22: & \text{ if } ((a == b) \&\& (c == d)) \{ \\
    23: & \quad x = 2; \\
    24: & \} \text{ else } \{ \\
    25: & \quad y = 3; \\
    26: & \} \\
\end{align*}
\]
If you try to set a code breakpoint at line 23, CrossView Pro sets the breakpoint on the preceding statement. If you try to set a breakpoint on line 22, CrossView Pro highlights line 23. If you set a breakpoint on line 25, it hits after the assignment to \( x \), but before the jump to line 27. Notice that it is not hit unless the `if` clause is true. In other words, a breakpoint on line 25 is really a break on the `}`, not on the `else {`. The same behavior applies when the `else {` statement is on the next source line.

**Breakpoints and For Loops and While Loops**

The code generated for a C 'for' statement has three parts: the initialization; the body of the loop; and the increment, test, and branch. The initialization part and the increment, test, and branch are different parts of code, but are both associated with the 'for' statement itself. For example consider:

```
99: for (i = 0; i < 9; i++) {
100:  myfunction(i);
101: }
```

A breakpoint placed on line 99 will only be hit once, because it is hit at the initialization code. The code for the increment, test, and branch is associated with line 101, not 99, as you might expect.

The same applies to 'while' loops.

**Breakpoints and Emulator Mode**

Upon entering emulator mode, the debugger removes any breakpoints it established in the target code. Removing breakpoints ensures that you can access unmodified target code. When emulator mode ends, CrossView Pro reestablishes breakpoints as necessary.

As long as you avoid the debugger's own breakpoint trap, you may establish arbitrary breakpoint conditions while in emulator mode. These will not be removed by CrossView Pro and thus remain active, however, after you exit emulator mode. If one of these breakpoints is hit during normal debugging, CrossView Pro will issue a message such as:

```
Stopped on breakpoint not set by debugger.
```
**System Startup Code**

It is possible (for example, by using the `si` command) to debug system level startup code that initializes the target environment. You should not use any global variables in CrossView Pro expressions until the data area has been initialized. CrossView Pro assertions and other CrossView Pro commands that examine C variables may deliver erroneous information or cause memory access errors if used before the C environment is established.

### 7.1.2 DATA BREAKPOINTS

A *data breakpoint* instructs the execution environment to watch a particular data address or address range and halt execution if the program reads from or writes to that address. Data breakpoints are a powerful feature for tracking the use, and possible misuse, of pointers, global variables and memory mapped I/O ports.

Data breakpoints are not available for all execution environments, please check the addendum.

When setting a data breakpoint, you can specify whether the breakpoint stops the program when data is read from, written to, or both.

Data breakpoints are implemented in hardware. As a consequence, the number of allowable data breakpoints is limited by your execution environment. A simulator does not have these restrictions. Refer to the environment-specific addendum for more information.

You may set a data breakpoint on a local variable, but only if the local variable is active. CrossView Pro notifies you when program execution passes beyond a local variable's scope, and a breakpoint set on such a variable is deleted automatically. Data breakpoints for static variables do not have this restriction.

Note that any local variables placed in registers cannot be tracked with data breakpoints. In this case, you must use an assertion. Refer to the *Assertions* section later in this chapter for more information.
7.1.3 LISTING AND JUMPING TO BREAKPOINTS

To see a listing of all of the currently defined breakpoints:

ências From the Breakpoints menu, select Breakpoints... to view the Breakpoints dialog box.

If you select a code breakpoint, you can click on the Goto button to jump to the location in the source code where the selected code breakpoint is set.

In the Command Window, enter the \texttt{lb} or \texttt{B} commands. The list appears in the Command Window.

For example entering the \texttt{B} command can result in:

\begin{verbatim}
B
0 ena CODE main (CODE:0x78) 2/2
\end{verbatim}

The breakpoint’s number (used when deleting breakpoints) is listed first, then if it is enabled or disabled, then its type: such as \texttt{CODE} for code breakpoints and \texttt{DATA} for data breakpoints. Next, CrossView Pro lists the function and/or address, its count and reset count, and finally any attached commands enclosed by \{ and \}.

\begin{center}
\textbf{FUNCTION:} View all breakpoints in the Command window.
\textbf{COMMAND:} \texttt{B}
\end{center}

CrossView Pro decrements the count each time the breakpoint is hit. When the breakpoint’s count reaches 0, CrossView Pro halts the program.

7.2 SETTING BREAKPOINTS

You may set a code or data breakpoint by:

\begin{itemize}
  \item Using the mouse to open the Breakpoints dialog box.
  \item Using the mouse in the Source Window.
  \item Using the Stack Window.
  \item Using the command line in the Command Window.
\end{itemize}
When you set a new breakpoint using the mouse, without using the Breakpoint dialog box, the type is always permanent, the count 1 and the location corresponds to the current viewing position, if the Source Window is open. These variables are described in more detail below.

**Setting Breakpoints from the Menu**

To set a breakpoint from the menu, select **Breakpoints...** from the **Breakpoints** menu to view the Breakpoints dialog box. From this dialog box, you can define several types of breakpoints.

To set a code break point at line number # of the C source, click the **Add >** button and select **Code Breakpoint...** Click the **Break At...** button, choose a C module (for example demo.c) and click the **OK** button. Now you can enter a line number to set the breakpoint at.

Click the **Advanced** button to get access to various types of breakpoints and to additional breakpoint options.

![Breakpoints dialog box](image)

**Figure 7-2: Breakpoints dialog box**

The last entry of the list is always empty. Select it to start defining a new breakpoint.

**Setting Breakpoints from the Source Window**

You can set or remove a code breakpoint directly from the Source Window by clicking on:

- The breakpoint toggle next to the source lines in the Source Window.
To set data breakpoints use the menu as described above.

**Setting Breakpoints from the Stack Window**

See the section *Up-level Breakpoints* later in this chapter.

**Setting Breakpoints from the Command Window**

You can set a code breakpoint from the Command Window using the `break code` command or the `b` command, and set a data breakpoint using the `break data` command. Several options are available after these commands.

See the `break` command in the *Command Reference* for detailed information.

For example, the following command sets a code breakpoint at the address specified by function `main`:

```
break code main
```

To set a code breakpoint at a specific source line, you can enter a breakpoint address in the form: `filename#line` after the `break` command, or you can specify a line number, followed by the `b` command and any commands you want to attach to the breakpoint. For example, to set a code breakpoint at line 51 in your source, enter:

```
break demo.c#51
```

or

```
51 b
```

If you do not specify a line number, a breakpoint will be set at the current viewing position.

---

**FUNCTION:** Set a code breakpoint.

**COMMAND:** `break [code] address [option]...`

---

**FUNCTION:** Set a code breakpoint.

**COMMAND:** `[line_number] b [commands]`
To set a data breakpoint, you must specify the `break data` command, followed by an address, followed by any commands you want to attach to the breakpoint. There are three types of data breakpoints:

- A data read breakpoint to see if a variable is read from (`break data address, access_type=r` command)
- A data write breakpoint to watch if a variable is written to (`break data address, access_type=w` command)
- A data read or write breakpoint to check if a variable is either read from or written to (`break data address, access_type=rw` command)

For example, to set a data breakpoint to watch the lowest byte in memory of the global variable `initval`, enter:

```
break data &initval, access_type=w
```

This command instructs CrossView Pro to set a data breakpoint that will halt execution if the program writes to the lowest byte in memory of the variable `initval`. Note that you have to specify the variable’s address, otherwise the variable’s value is used.

**FUNCTION:** Set a data breakpoint.

**COMMAND:** `break data address [option]...`

### 7.2.1 DATA BREAKPOINTS OVER A RANGE OF ADDRESSES

You can also use data breakpoints to watch a contiguous range of memory addresses. As with standard data breakpoints, data breakpoints over a range of addresses can be set to watch for reading, writing or both. To set a data breakpoint of this type:

**Using mouse and menu:**

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.
- Select the data breakpoint you want to edit and click the **Edit...** button, or click the **Add >** button and select **Data Breakpoint...**
- Specify a start address and click on the **Advanced** button.
• Select one of the **Type** options: break on read, write, read or write.

• Specify a length or an end address. The end address is part of the range (length is calculated from the end address and vice versa).

From the Command Window:

• Type `break data address, end_addr=end_address, access_type=r` to set a data read breakpoint over a range.

• Type `break data address, end_addr=end_address, access_type=w` to set a data write breakpoint over a range.

• Type `break data address, end_addr=end_address, access_type=rw` to set a data breakpoint for both reading and writing over a range.

For example, to ensure that the program stops if any of `recordvar`’s fields are either written to or read from:

```plaintext
break data &recordvar, end_addr=(int) &recordvar+sizeof(recordvar)-1, access_type=rw
```

**FUNCTION:** Set a data breakpoint over a range of addresses.

**COMMAND:** `break data address, end_addr=end_address [option]...
```

### 7.2.2 TEMPORARY BREAKPOINTS

Breakpoints can be: permanent or temporary. A breakpoint exists until it is manually deleted. A temporary breakpoint is automatically removed by CrossView Pro after it halts the program once.

To set a temporary breakpoint:

Follow these steps:

• Open the Source Window by selecting **Source | Source lines** from the **View** menu.

• Open the Breakpoints dialog by selecting **Breakpoints...** from the **Breakpoints** menu.

• Click on the **Add >** button and select **Code Breakpoint**...

• Enter an address in the **Break At** field and click on the **Advanced** button.
• Enable the **Remove when hit** check box in the **Behavior** field.
• Click on the **Continue** button in the Source Window when the program halts. This removes the temporary breakpoint at the viewing position and the program continues.
• Alternatively, scroll to the line that you want to stop at and click once (to establish a viewing position). From the **Run** menu, select **Run to Cursor** to continue execution until you reach this temporary breakpoint.

From the Command Window:

• Type `break code address, temporary=true` to set a temporary code breakpoint.
• Type the **C** command followed by a line number, to set a temporary breakpoint at a line number.

For example,

```
c 51
```

sets a temporary breakpoint at line 51 and resumes execution at the current execution position.

---

**FUNCTION:**  Set a temporary code breakpoint.
**COMMAND:**  `break code address, temporary=true [option]`...

### 7.2.3 BREAKPOINT NAMES

You can associate a symbolic name with a breakpoint. You can then use this name with the following commands: **break set** and **break delete**. Breakpoint names must be unique and cannot be a number or the word "all". Allowed characters are a-z, A-Z, 0-9 and '_'.

To assign a name to a breakpoint:

Follow these steps:

• From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.
• Select a breakpoint to edit and click on the **Edit...** button.
• Alternatively, click on the Add > button and select a breakpoint type to create.
• Enter the breakpoint information in the first field, for example an address.
• Enter a symbolic name in the Name field.

Use the name=name option of the break command in the Command Window.

For example,

```
break code 0x1234, name=brk_1
```

sets a code breakpoint at address 0x1234 with the name brk_1.

### 7.2.4 SETTING THE COUNT

CrossView Pro allows you to set a breakpoint’s count. The count defines how many times you encounter the breakpoint before it halts the program. For example, a breakpoint with a count of 3 means the program stops on the third hit. Each time the breakpoint is hit, CrossView Pro decrements the count. When the count reaches 0, CrossView Pro halts the program, and resets the count to the value of the reset count. The default reset count is 1.

To set a breakpoint’s count,

Follow these steps:

- From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box.
- When you add or edit a breakpoint, click on the Advanced button.
- Enter a breakpoint’s count in the Breakpoint count field.
- Enter a reset count in the Reset count field.

From the Command Window,

- Use the count= argument with the break command to set both the current count and the reset count.
- Use the curr_count= and/or reset_count= arguments with the break command to set the current count and the reset count separately.
For example, suppose you have a breakpoint set at address 0x59 of your source code. The first time the program halts at address 0x59, enter:

```
break code 0x59, curr_count=3, reset_count=4
```

This command sets the breakpoint’s count to 3 and the reset count to 4. You can observe a breakpoint’s current count and reset count when you list the breakpoints in the Command Window with the `l b` command.

---

**FUNCTION:** Set the count and reset count for a breakpoint.

**COMMAND:**

```
break type address, count=count
```

---

**FUNCTION:** Set the count and reset count for a breakpoint separately.

**COMMAND:**

```
break type address, count=count, reset_count=reset_count
```

---

### 7.2.5 SEQUENCE BREAKPOINTS

A sequence breakpoint is a special kind of breakpoint. Only if other breakpoints are hit in a specified order, the sequence breakpoint itself will hit.

To hit a breakpoint without halting the program, the breakpoint in the sequence must be specified as a *Probe point*. When a probe point is hit, the associated commands are executed and program execution is continued.

When all specified probe points are passed in the logical sequence you specified, the program stops at the last breakpoint in the sequence.

To set a sequence breakpoint:

Follow these steps:

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.
- Click on the **Add >** button and select **Sequence Breakpoint...**
• Click the Sequence... button to open the Edit Sequence Breakpoint dialog box.

• Select a breakpoint from the Available Breakpoints list box and add it to the sequence with the buttons ADD, AND or OR. Use the NOT button for a breakpoint that should not be passed. All breakpoints you add to the list must be enabled, otherwise the sequence breakpoint itself will not hit.

From the Command Window:

• Use the sequence argument of the break command with a list of breakpoints to specify the sequence.

For example,

    break sequence (0)(1 and 3)(2)

In this example, the sequence breakpoint hits when probe point 0 is hit first, then 1 and 3 are hit in any order, and finally probe point 2 is hit.

---

FUNCTION: Set a sequence breakpoint.

COMMAND: break sequence sequence [... , option]

---

7.3 DELETING BREAKPOINTS

You can delete a breakpoint directly from the source code, using the menu items, or through the Command Window. To see a list of active breakpoints, select Breakpoints... from the Breakpoints menu or use the lb command in the Command Window.

To delete a code breakpoint:

Click on the corresponding breakpoint toggle next to the source line in the Source Window. This deletes the code breakpoint and the breakpoint toggle turns green. Be aware that if more than one breakpoint was set at this position, all breakpoints are deleted.

You can also follow these steps:

• From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. This box contains a remove function.
• Select the Breakpoint from the list.
• Click the Remove button.

Use the break delete breakpoint_number | name command in the Command Window. You need to know the breakpoint’s number or name for this command.

For example, to delete the breakpoint numbered 1, enter:

```
break delete 1
```

**FUNCTION:** Delete a breakpoint.

**COMMAND:**

```
break delete breakpoint_number
break delete breakpoint_name
```

To clear all the breakpoints in the program, type:

```
break delete all
Do you want to delete all breakpoints? y
```

**FUNCTION:** Delete all breakpoints.

**COMMAND:**

```
break delete all
```

### 7.4 Enabling/Disabling Breakpoints

You can enable or disable a breakpoint directly from the source code, using the menu items, or through the Command Window. To see a list of active breakpoints, select Breakpoints... from the Breakpoints menu or use the `l b` command in the Command Window.

To enable or disable a code breakpoint:

Follow these steps:

• From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. This box contains an edit function.
On Windows:

- In the list of breakpoints toggle the check box in front of the breakpoint to enable or disable the breakpoint.

On UNIX:

- Select the breakpoint form the list.
- Click the Enable or Disable button to enable or disable a breakpoint.

Use the **break enable** or **break disable** command in the Command Window to enable or disable a breakpoint. You need to know the breakpoint’s number or name for these commands.

For example, to disable the breakpoint numbered 1, enter:

```
break disable 1
```

**FUNCTION:** Disable a breakpoint.

**COMMAND:**

```
break disable breakpoint_number
break disable breakpoint_name
```

To enable the breakpoint numbered 1, enter:

```
break enable 1
```

**FUNCTION:** Enable a breakpoint.

**COMMAND:**

```
break enable breakpoint_number
break enable breakpoint_name
```
7.5 BREAKPOINT COMMANDS

CrossView Pro allows you to attach commands to code and data breakpoints. When execution halts at a breakpoint, CrossView Pro executes the commands. Valid commands are almost any C statements and CrossView Pro commands, giving you a very powerful tool for manipulating a debugging session. To do this:

Follow these steps:

- From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.
- Select an existing breakpoint from the list and click on the **Edit...** button or click on the **Add >** button and select a type of breakpoint you want to add.
- Enter the breakpoint information in the first field, for example an address.
- Click on the **Advanced** button. Note that the button is only visible when there is more information available on the breakpoint.
- Click in the **Commands edit** area.
- Type in the commands to be executed when the breakpoint is reached.

You do not need to enclose a group of commands in brackets. However, each individual command must be delimited by a semicolon.
Type the commands, enclosed in brackets and delimited by semicolons, after `commands=` argument of the `break` command in the Command Window.

For instance, suppose you want a program to stop at a breakpoint, display a variable's value, and resume execution all in one stroke. To perform this function, you need to attach the appropriate commands to a breakpoint. Enter:

```
break code main, commands={initval;C}
```

This places a breakpoint at address `main`. When execution stops at the breakpoint, CrossView Pro displays the value of `initval` and immediately resumes execution.

If you enable the **Probe point** check box, you can omit the `C` command. This is done automatically.

You can attach almost any valid CrossView Pro commands or C statement to breakpoints. This latitude allows you to use breakpoints in powerful ways. Later on you find out how breakpoints can create patches in your program.
CrossView Pro does not check the syntax of attached commands until the breakpoint is hit.

Data breakpoints accept command lists the same way as code breakpoints. For instance, to set a data breakpoint that monitors the lowest byte in memory of the value of \texttt{initval}, enter:

\begin{verbatim}
break data &initval, access_type=w, commands={initval; C}
\end{verbatim}

Every time the program writes to the lowest byte in memory of the variable \texttt{initval}, this breakpoint halts the program, prints the value of \texttt{initval} and continues execution.

For more information on the use of attached commands, see the \textit{Patches} and \textit{Diagnostic Output and Statistical Information} sections later in this chapter.

### 7.5.1 ATTACHING CONDITIONALS TO A BREAKPOINT

You can pass standard C conditionals to a breakpoint.

For example:

\begin{verbatim}
break code demo.c#63, commands= {if (initval==17) {C}
{initval/n}}
\end{verbatim}

stops the program at line 63, checks to make sure the variable \texttt{initval} is 17, and resumes execution if it is. If \texttt{initval}'s value does not equal 17, CrossView Pro prints the value, and the program remains halted.

### 7.5.2 ATTACHING MACROS TO A BREAKPOINT

You can attach any currently defined macro to a breakpoint in a command list. For example, suppose you define a macro named \texttt{rg} that checks the value of the variable \texttt{initval}. The command to define this macro is:

\begin{verbatim}
set rg "if (initval != 17) {initval/n} {C}"
\end{verbatim}

If the value does not equal 17, the macro prints the value and halts the program. Otherwise, execution continues.

You can include this macro at any point by attaching it to a breakpoint. Entering:
break code demo.c#51, commands={rg}
break code demo.c#63, commands={rg}

this is a very efficient way to insert the macro with breakpoints at lines 51 and 63.

For more information on macros, refer to Defining and Using Macros chapter.

7.5.3 ATTACHING STRINGS TO A BREAKPOINT

You can attach strings to a breakpoint’s command list. This feature is useful for placing comments and reminders within your breakpoints. Attaching a string to a breakpoint also eliminates the need for diagnostic printf( ) statements in your compiled code.

For example, you could place a breakpoint on line 49 such as:

49 b {“Passed line 47\n”;C}

Whenever the breakpoint on line 49 is hit, CrossView Pro prints the string and continues execution.

7.6 SUPPRESSING BREAKPOINT MESSAGES

Whenever a breakpoint is hit, CrossView Pro displays in the Command Window, the name of the function, line number and file in which the breakpoint appears. You can suppress this information by setting breakpoint “silent” mode. In the silent mode, the current location is not printed out.

To set silent mode you can use the Q (for quiet) command as part of the command attached to a breakpoint definition.

Pass the Q command to a breakpoint first. For example:

51 b {Q; initval = 5}

stops the program on line 51, but does not print a message stating where the break occurred.
7.7 **UP-LEVEL BREAKPOINTS**

*Up-level breakpoints* are breakpoints set at the entrance and/or exit of functions. Basically, up-level breakpoints are code breakpoints that are directly connected to the current HLL stack handling.

To see the current HLL stack, open the Stack Window or enter the `t` command in the Command Window.

You can set up-level breakpoints via the Stack Window or in the Command Window. You cannot set up-level breakpoints in the Source Window:

- Double-click on the function in the Stack Window to install a stack breakpoint after the function call.

You can also follow these steps:

- Click on the function in the Stack Window.
- From the **Breakpoints** menu, select either **Stack Breakpoint | After Call to Function** or **Stack Breakpoint | At Function Entry**

You have the option of setting the breakpoint before (function entry) or after (up-level) a selected function.

All breakpoints set through the Stack Window are temporary by default. To make a breakpoint permanent, select **Breakpoints...** from the **Breakpoints** menu to open the Breakpoints dialog. Select the breakpoint you want to edit and click on the **Edit...** button. Click on the **Advanced>>** button and disable the **Remove when hit** check box.

In the Command Window, use the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>bU</td>
<td>Sets breakpoint <em>after</em> call to function</td>
<td>temporary</td>
</tr>
<tr>
<td>bu</td>
<td>Sets breakpoint <em>after</em> call to function</td>
<td>permanent</td>
</tr>
<tr>
<td>bB</td>
<td>Sets breakpoint <em>at beginning</em> of function</td>
<td>temporary</td>
</tr>
<tr>
<td>bb</td>
<td>Sets breakpoint <em>at beginning</em> of function</td>
<td>permanent</td>
</tr>
</tbody>
</table>
For example, suppose you have accidentally single-stepped into a function called `factorial()`. If you do not want to single step through the function, an up-level breakpoint can help you. Enter:

```
bU
```

The `bU` command sets a temporary breakpoint after return of the function. Now, instead of having to single step all the way through the function, you can start continuous execution, which stops when it hits the new breakpoint at the function’s return. Note that it makes no difference whether the function has several possible points of return; the up-level breakpoint works at all points of return. Note that when the function that contains the breakpoint is called from one of the functions that are located below it on the stack, the execution may be stopped before returning at the desired stack level, for example with recursive functions.

When setting up-level breakpoints from the Command Window, you can specify how deep in the stack the function’s address is located. For example, if you are two functions down from the `main()` program, enter:

```
2 bU
```

This command breaks when you return to the top level of the call graph.

---

**FUNCTION:** Set a temporary breakpoint after call to function.

**COMMAND:** `[stack] bU [commands]`

---

**FUNCTION:** Set a permanent breakpoint after call to function.

**COMMAND:** `[stack] bu [commands]`

---

**FUNCTION:** Set a temporary breakpoint at function entry.

**COMMAND:** `[stack] bB [commands]`
7.8 PATCHES

A patch is a means of using CrossView Pro to change the execution of your program without recompiling. Patches involve manipulating breakpoints to skip code, include code, or replace existing code with new code.

Basically, a patch is a breakpoint with certain associated commands that enable you to alter program execution. This capability is a useful debugging tool.

You can associate the commands used to patch code with a breakpoint through either the Command Window or through the Commands edit box in the Breakpoint dialog box. The examples below set breakpoints using CrossView Pro commands typed in the Command Window. You can also set breakpoints in the Breakpoints | Breakpoints... dialog. In this case the commands between the brackets are entered into the Command edit area.

7.8.1 PATCHING CODE OUT OF A PROGRAM

To patch code out of a program, you can set a breakpoint that changes the execution position. For instance, suppose you want to patch an infinite loop out of your source.

```
78:   while (loopvar)
79:   {
80:     sum = sum + 1;
81:   }
82:
83:   sum = sum + 5;
```

On line 78, place a breakpoint that jumps to line 83, effectively bypassing the loop. In the Command Window, enter:

```
78 b {g 83; C}
```
This creates a breakpoint on line 78 that does nothing more than move the execution position beyond the loop and issue a C command. Remember that the breakpoint on line 78 is hit before the C statement on that line executes.

### 7.8.2 PATCHING CODE INTO A PROGRAM

You can also patch code into a program by just including the code in the breakpoint command. For example, suppose you want to add an equation with the variable `loopvar`.

```plaintext
78: while (loopvar)
79: {
80:     sum = sum + 1;
81: }
82:
83: sum = sum + 5;
```

In the Command Window, enter:

```plaintext
78 b {loopvar = 0;C}
```

This command halts execution at line 78, adds the statement `loopvar=0` to the program, and continues execution.

### 7.8.3 REPLACING CODE IN A PROGRAM

Finally, you can combine the two techniques described above to replace code in a program. For instance, suppose you want to replace an infinite loop with new code.

```plaintext
78: while (loopvar)
79: {
80:     sum = sum + 1;
81: }
82:
83: sum = sum + 5;
```

In the Command Window, enter:

```plaintext
78 b {Q; if (sum<100) {sum++; g 78; C} {g 83; C}}
```
This command sets a breakpoint that halts execution (quietly) at line 78 and inserts an if statement into the program. If sum is less than 100, sum increments and line 78 executes again. If sum equals 100, CrossView Pro moves the execution position to line 83 (beyond the infinite loop) and resumes execution.

### 7.9 Diagnostic Output and Statistical Information

Breakpoints with attached commands allow you to report on various variables while the program executes. In the past, one inefficient method of tracking variables was to litter code with printf() statements. Using breakpoints makes that process unnecessary.

For instance, suppose you want to keep track of the variable loopvar at line 59 of a program. Install a breakpoint with the following command:

```
59 b {Q; loopvar; C}
```

The breakpoint halts the program, prints the value of loopvar, and resumes execution. The Q command suppresses the listing of where the break occurred. This breakpoint does not affect the source code and no recompilation is necessary.

Using special variables, you can also keep statistics about your program, such as how many times a line of code executes or how many times a variable is accessed.

For example, suppose you want to know how many times line 60 executes. You must define a special variable to keep track of your statistical data, and set a breakpoint to accumulate the data for you.

First, define the special variable. In the Command Window, enter:

```
$test = 0
```

This command defines the special variable $test and sets it to zero. For convenience, you can also set a breakpoint at the beginning of the program that initializes $test.

Secondly, set a breakpoint at line 60 that increments $test and continues execution every time the program hits line 60:

```
60 b {$test++ ; C}
```
7.10 ASSERTIONS

An assertion is a collection of debugger commands executed by the debugger after each program line. When you execute a program using assertions, the debugger is in assertion mode. Running the debugger in assertion mode is a way of executing continuous control of certain data.

Using assertions, you can have continuous control of certain data and stop program execution if any of the set conditions are fulfilled. In this respect, assertions are similar to data breakpoints. Assertions, however, are more versatile than data breakpoints. For instance, a data breakpoint can only detect when a variable is accessed. An assertion, on the other hand, can check that the variable’s value falls within a certain range. Also, an assertion can monitor variables whose values are kept in registers.

Each individual assertion can be activated or deactivated. In addition, you can also choose to suppress all assertions by turning off the global assertion mode.

**Opening the Assertions Dialog Box**

From the Breakpoints menu, select Assertions...

The Assertions dialog box contains scrollable lists of all defined assertions, and provides functions for defining, activating, suspending, editing and deleting assertions.

7.10.1 ASSERTION MODE

The debugger is running in assertion mode when there is at least one active assertion. A program executing in assertion mode is actually being single-stepped very quickly, to ignore breakpoints. Because the program is single-stepping, however, it runs significantly slower than at normal speed.

An Assertion Mode Active checkbox is available that activates all marked (*) assertions. Clear this option if you want to suspend all assertions temporarily. To activate marked assertions:

Open the Assertions dialog box and activate all marked assertions by enabling the Assertion Mode Active check box.
In the Command Window, enter the `A` command:

- **A a** — activates assertion mode
- **A s** — suspends assertion mode
- **A** (by itself) toggles the assertion mechanism

The Global Active state activates all assertions. Globally activating the assertion mode, however, does not change how each assertion is marked.

**FUNCTION:** Activate assertion mechanism.
**COMMAND:** `A a`

**FUNCTION:** Suspend assertion mechanism.
**COMMAND:** `A s`

**FUNCTION:** Toggle assertion mechanism.
**COMMAND:** `A`

### 7.10.2 DEFINING AN ASSERTION

To define or edit an assertion:

- From the **Breakpoints** menu, select **Assertions...** to open the Assertions dialog box.
- Click on the **New...** button to open a text edit dialog box as shown in figure 7-4 to type in commands.
Use the \texttt{a} command followed by a list of commands.

\begin{itemize}
  \item \textbf{FUNCTION:} Create an assertion.
  \item \textbf{COMMAND:} \texttt{a commands}
\end{itemize}

Assertions accept standard C statements and certain CrossView Pro commands as arguments.

An assertion usually contains a conditional. For example, suppose you want to create an assertion that watches the value of the global variable \texttt{initval} to see that it's value does not exceed a certain limit. In this case, you enter in the Assertion dialog box (or into the Command Window after the \texttt{a} command):

\begin{verbatim}
if (initval > 17) {x}
\end{verbatim}

This command creates an assertion with the condition that if \texttt{initval} exceeds 17, CrossView Pro halts the program. The \texttt{x} is a special assertion command that tells CrossView Pro to halt the program and return control to you.
Be aware that, depending on the level of optimization, variables may not exist anymore in the compiled application so you may not be able to use them in assertions. In this case, compile your application at a lower optimization level.

### 7.10.3 Editing an Assertion

To edit the contents of an assertion:

Follow these steps:

- From the **Breakpoints** menu, select **Assertions...** to open the Assertions dialog box.
- Click on the assertion to edit.
- Click on the **Edit...** button. A text edit dialog box opens allowing you to edit the assertion. Click on **OK** or **Cancel** when finished.

You must delete the specific assertion (section 7.10.5) and define a new assertion (previous section) with the desired command.

### 7.10.4 Activating and Suspending Assertions

A particular assertion is either active or suspended. A suspended assertion does not execute before every line, but it retains its definition.

You may find it helpful to use activate and suspend assertion commands in conjunction with code breakpoints, since assertions tend to slow the target program. By attaching commands to a breakpoint to activate and suspend assertions, you can turn assertions on only for certain sections of code where a particular value needs checking. This method can dramatically speed up the program.

From the **Breakpoints** menu, select **Assertions...** and double-click on the assertion’s number.

To activate or suspend an assertion from the Command Window, you must know the assertion’s number. To see a list of assertions and their assigned numbers:

- Enter `l a`, the list assertions command, in the Command Window.
To activate an assertion:

- Enter `assertion_number a a` command. For example:
  
  `2 a a` activates assertion 2

To suspend an assertion:

- Enter the `assertion_number a s` command. For example:
  
  `2 a s` suspends assertion 2

---

FUNCTION: Activate an assertion.
COMMAND: `assertion_number a a`

---

FUNCTION: Suspend an assertion.
COMMAND: `assertion_number a s`

---

### 7.10.5 Deleting Assertions

Deleting an assertion removes its definition. It is important to note the difference between suspending an assertion and deleting an assertion: deleting an assertion removes its definition for good, while suspending it retains the definition but prevents its execution.

Follow these steps:

- From the Breakpoints menu, select Assertions... to open the Assertions dialog box.
- Click on the assertion to delete.
- Click the Delete button. Click on OK or Cancel when finished.

Follow these steps:

- List the assertion numbers with `l a` command in the Command Window.
- In the Command Window, enter the assertion number followed by the `a d` command. For example:
  
  `2 a d` Deletes assertion 2.
FUNCTION: Delete an assertion.

COMMAND: assertion_number a d

7.10.6 USING ASSERTIONS

You can use assertions for almost any type of debugging task. For example, if you want to check the value of a global variable, `global_val`, during the execution of a certain function, `f()`. A data breakpoint or a straightforward CrossView Pro assertion does not suffice for this task since there is no way to make either method limited to that function’s code range. The solution lies in creating an assertion that is active only over a specific range of lines. In this case, you could solve your problem with the following steps:

```c
110: void f(void)
111: {
112:     if ( global_flag )
113:         {
114:             ++global_val;
115:         }
116:     else
117:         {
118:             global_val = g();
119:         }
120: }
```

Using the mouse and menu:

1. From the Breakpoints menu, select Assertions... to open the Assertions dialog box.

2. Click on the New... button.

3. Set up the assertion to check the value of `global_val`. Enter:

   ```
   if (global_val == 17) {x}
   ```

   This assertion halts program execution if the value of `global_val` equals 17.

4. From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint...
5. We want to establish a breakpoint at line 112, the first line of the function `f()` and attach commands to the breakpoint to activate assertion mode and continue execution. Change the **Line** number to 112. Click in the **Command** edit area and enter:

```
A a; C
```

*Activate the assertion and continue.*

6. Create an assertion whose only function is to check that the current line number is still valid for assertion mode. To do this, use the reserved special variable `$LINE`, which contains the line number of the current execution position. In the Assertions dialog box, click on **New...** and enter:

```
if ($LINE >= 120) {A s; 1 x; C}
```

If the line number exceeds 120, the program is about to leave the function `f()` and CrossView Pro deactivates assertion mode. Normally, the `x` command would make the program stop, but the non-zero value tells CrossView Pro to execute the rest of the commands in the list, in this case, `C` for continue.

You must enter all commands in the Command Window.

1. First set up the assertion you want:

```
a if (global_val == 17) {x}
```

2. Now set a breakpoint on the first line of the function `factorial()` that will activate assertion mode, and continue execution:

```
110 b {A a; C}
```

3. Now create an assertion that does nothing but make sure that the current line number is still valid for assertion mode. If the line number exceeds 120, you know you have left the function `f()` and assertion mode should be suspended.

```
a if ($LINE >= 120) {A s; 1 x; C}
```

 `$LINE` is a reserved special variable that CrossView Pro maintains containing the number of the line currently executing. If it becomes equal to 120, assertion mode is turned off. Normally, the `x` command would make the program stop, but the non-zero value 1 tells CrossView Pro to execute the rest of the commands in the list, in this case, `C` for continue.
In this manner you have created an assertion that is only active over a limited range of source lines.

### 7.10.7 GATHERING STATISTICS WITH ASSERTIONS

You can also use assertions to gather statistics about your code. For instance, you can find out how many lines of C code execute in a particular session:

```c
a {$numlines++}
```

$numlines is a user-defined special variable that increments on each line of C code. When the program stops, type:

```c
$numlines
```

and CrossView Pro gives the result. To start again, you may want to re-initialize $numlines to zero:

```c
$numlines = 0
```

Or just set a breakpoint on the first line of code to do the same.
CHAPTER 8
DEFINING AND USING MACROS

TASKING
8.1 CROSSVIEW PRO MACROS

A macro is a user-created shorthand for any sequence of CrossView Pro or C commands and expressions. Macros allow you to debug more efficient when using CrossView Pro by substituting a short string for a longer combination of words and evaluators.

You can use a macro anywhere an CrossView Pro or C expression is valid: in a breakpoint’s command list, with assertions, from the keyboard, among other places. CrossView Pro also allows you to save macro definitions, so they are always available. By passing parameters to a macro, you can create powerful and flexible macros to debug your code more efficiently.

You can use macros in the Command Window, or connect them to the graphic interface in a feature called the toolbox. You can have this toolbox visible as a CrossView Pro window and use it to execute a macro by clicking a button. You control which macros have corresponding buttons, making the toolbox easy to adapt to different situations.

8.2 DEFINING MACROS

You can create as many macros as you want:

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box and click on the New... button.

Figure 8-1: Macro Definitions
In the Command Window, use the `set` command followed by the macro’s invocation name and the list of commands. Note that the list of commands must be in (double) quotation marks. For example, the command:

```
set st "e main; R"
```

creates a macro call `st` that tells CrossView Pro to change the viewing position to be the first executable line in the function `main()` and restart the program from the beginning. Each time you enter `st` in the Command Window, CrossView Pro substitutes the lengthier list of commands in the definition.

FUNCTION: Create a macro.

COMMAND: `set name "commands"`

Note that there is no rule that the macro definition must be shorter than the commands it represents. For instance, you could substitute `break` for the `b` command, to make CrossView Pro’s command language more expressive:

```
set break "b"
```

Now instead of typing `74 b` to set a breakpoint, you can also type:

```
74 break
```

Macros defined using either the command line or the graphic interface are accessible both from the Command Window and the Toolbox.

Macros may call other macros, so it is possible to use simple macros as building blocks for more complex functionality. No macro, however, can call itself, or another macro that refers to the calling macro, since this type of action results in infinite recursion.

Because of the order in which CrossView Pro parses statements, you may not use the CrossView Pro commands `#` or `%` in a macro.
8.2.1 LISTING MACROS

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box. This dialog box contains a scrollable list of the macros.

To see the current definition of a macro:

Follow these steps:

- From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box.
- Click on the macro that you want to see.
- The Commands box shows (a part of) the macro. If you need to see more, click on the Edit... button.

Type the echo name command in the Command Window. For instance, to see the definition for the st macro:

```
echo st
  e main; C 56
```

FUNCTION: Display macro expansion.

COMMAND: `echo name`

8.2.2 REDEFINING A MACRO

If you want to change the definition of a macro:

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box. Click on the name of the macro you want to change and click on the Edit... button.

In the Command Window, use the set command again, but enter an exclamation point after the macro name. For instance, to redefine the macro st, which was defined in the example above, use the command:

```
set st! "e main; C 56"
```
Now, the \texttt{st} macro changes the viewing position and restarts program execution, placing a temporary breakpoint at line 56. Be sure you do not include a space before the exclamation point. Otherwise, CrossView Pro may interpret the \texttt{!} as the C “not” operator.

\section*{8.2.3 SAVING MACRO DEFINITIONS TO A FILE}

You can save all the macros you define in a debugging session in an external file. This way, you do not lose the definitions when the program ends.

To save macros to an external file:

Follow these steps:

\begin{itemize}
\item From the \textit{Tools} menu, select \textbf{Macro Definitions...} to open the Macro Definitions dialog box.
\item Click on the \textbf{Save as...} button. A Save Macro File dialog box opens.
\item If you want to save a file previously opened, click on the \textbf{Save} button. This saves the file without opening the Save Macro File dialog box.
\item Alternatively, you can use the \textbf{Autosave} check box. When \textbf{Autosave} is checked, all macros are saved in the 'current file' when you leave CrossView Pro.
\end{itemize}

Type the \texttt{save file} command in the Command Window. This command saves your macros to the file of your choice. For instance:

\begin{verbatim}
save macro.mac           writes all your macros to macro.mac
\end{verbatim}

\begin{tabular}{ll}
\hline
\bf{FUNCTION:} & \text{Save macros to a file.} \\
\bf{COMMAND:} & \texttt{save filename} \\
\hline
\end{tabular}
8.2.4 LOADING MACRO DEFINITIONS FROM A FILE

You can load saved macros anytime you want to re-use a definition. There is no limit to the number of times you can load macros.

To load a macro file:

Follow these steps:

- From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box.
- Click on the Load... button and select the macro file you want to load.
- Alternatively, you can use the Autoload check box. When Autoload is checked, the macros saved in the 'current file' are loaded at startup.

To reinstate your macro definitions from the Command Window, use:

< filename.mac

You must load a program before you can read a macro definition file. Autoload will be ignored when the Execute these settings at CrossView startup check box in the Load Symbolic Debug Info dialog box is not checked.

For more information on record and playback functions, see the next chapter, Command Recording & Playback.
8.2.5 DELETING MACROS

To delete a specific macro:

Follow these steps:

- From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box.
- Highlight the name of the macro.
- Click on the Delete button. To delete all the macro definitions at the same time, click on the Delete All button. CrossView Pro prompts you for confirmation.

Type the unset command in the Command Window. For example, to remove the st macro, enter:

\texttt{unset st!}

When you are removing a macro definition in this manner, you must place an exclamation point after the macro name to prevent CrossView Pro from expanding the name to its full macro definition. To update your macro definition files, issue a save command after using unset.

You can remove all existing macro definitions by entering the unset command by itself. CrossView Pro prompts you for confirmation before deleting the macros:

\texttt{unset}
\texttt{Do you want to delete all macros?y}

\begin{tabular}{ll}
FUNCTION: & Delete a macro. \\
COMMAND: & \texttt{unset name!}
\end{tabular}
8.3 MACRO PARAMETERS

Macros can accept arguments. Parameters are labelled sequentially in a macro definition: $1, $2, $3, etc. Note that $0 has no meaning. When you invoke a macro with parameters, enclose the parameters with parentheses and separate them with commas.

CrossView Pro macros can accept any number of parameters, so it is possible to create very complex command shortcuts. You may use any type of parameter when defining a macro, including integers, strings, or addresses. Note, however, that you must pass the macro the correct type at invocation.

For instance, suppose you want to set a detailed breakpoint on any number of lines and a parameter is to specify each line number on which to install a breakpoint. Defining a macro named brk, type in the Macro Definitions dialog box:

\[ $1 \ b \ {Q; \ initval; \ recordvar.a; \ if \ (initval > 1) \ \{C\}} \]

or type in the Command Window:

\[ \text{set brk "$1 \ b \ {Q; \ initval; \ recordvar.a; \ if \ (initval > 1) \ \{C\}}\"} \]

In this case, the argument $1 represents the intended line number. To use the brk macro, type:

\[ \text{brk(72)} \quad \text{From the Command Window} \]

CrossView Pro replaces every instance of $1 with the value 72. For this example, that means a breakpoint is set at line 72.
8.4 REDEFINING EXISTING CROSSVIEW PRO COMMANDS

Using macros, you can even redefine an existing CrossView Pro command.

For instance, you could redefine the breakpoint command \texttt{b} to always place a breakpoint at line 72 of your source code. To do this, enter the command:

\texttt{set b "72 b!"}

CrossView Pro now interprets the \texttt{b} command as \texttt{72 b}.

The exclamation point in the definition is necessary to prevent infinite recursion. It tells CrossView Pro to take the command literally and to not expand it into a macro definition. For example:

\texttt{66 b!}

CrossView Pro interprets this command as the standard breakpoint command and places a breakpoint at line 66, despite the macro definition for \texttt{b}.

Be sure not to have any space between the command and the exclamation point. Otherwise CrossView Pro may interpret the \texttt{!} as the C \texttt{not} operator.
8.5 USING THE TOOLBOX

The CrossView Pro toolbox, shown in figure 8-2, is controlled from the View menu. Using the Tools menu, you can configure the toolbox and define the macros for it. You can resize the toolbox to the size you want.

![CrossView Pro Toolbox](image)

*Figure 8-2: CrossView Pro Toolbox*

8.5.1 OPENING THE TOOLBOX

To open the toolbox:

- From the View menu, select **Toolbox**.

The Toolbox is a pop-up window that remains on top of the CrossView Pro Desktop while you work in other windows.

8.5.2 CONNECTING MACROS TO THE TOOLBOX

To configure the toolbox, select **Toolbox Setup...** from the Tools menu to view the Toolbox Setup dialog box, shown in figure 8-3. This dialog box displays the toolbox buttons and an alphabetized list of the current macro definitions.

To connect a macro to a toolbox button:

Follow these steps:

- Click on the button you wish to change
- Scroll through the macro list to highlight the desired function
• Click on the Assign button or press the Enter key

Note that double clicking on the macro name in the alphabetized list performs the third step automatically. The name of the new function appears on the selected button and the connection is performed.

![Toolbox Setup dialog box](image)

*Figure 8-3: Setting Up the Toolbox*

Do not assign parameterized macros to the toolbox since there is no way to pass in parameter values.

### 8.5.3 REMOVING A MACRO CONNECTION

To delete a macro definition from the toolbox:

⚠️ Follow these steps:

- From the Tools menu, select Toolbox Setup... to open the Toolbox Setup dialog box.
- Select the desired button.
- Click Clear.

This deletes the macro definition from the toolbox.
CHAPTER 9

COMMAND RECORDING & PLAYBACK
9.1 RECORDING COMMANDS

CrossView Pro lets you save a series of CrossView Pro commands to the file of your choice. This is record mode. You can re-load a saved file to repeat parts of debugging tasks or replay a debugging session (up to the point where you left the last time).

Record mode means that all CrossView Pro commands from the keyboard, mouse or menu are recorded to a disk file. The debugger can read this file and execute the commands as if they were entered into the Command Window. This is called playback mode, see more about playback mode later in this chapter.

Record and playback modes can never be active at the same time.

You can record CrossView Pro commands and/or Emulator commands. When recording on CrossView Pro command level, all commands that you type in the Command Window, as well as the CrossView Pro command language equivalents of dialog actions and menu selections are saved in a file. When you (also) want to record commands entered in the Emulator Command Window, you can record them in a separate dialog or combine them with the CrossView Pro commands.

From the Command Window you control record mode using either the mouse or keyboard commands. To start or setup recording:

From the menu system:

- From the Tools menu, select Record | CrossView... to open the Record CrossView dialog box, or select Record | Emulator... to open the Record Emulator dialog box.

  The Record dialog box contains an Automatically at CrossView startup check box. If you select this check box the debugger enters record mode at every startup.

- Enter the name of the file in the Command file: edit field, or click on the Browse... button to select an existing file. The default filename extension is .cmd.

- Optionally, select Include emulator commands in the Record CrossView dialog. In this case all recorded emulator commands are also recorded, preceded by the "o" command.

- Click on the OK button to save the current settings into the initialization file xvw.ini for following debugging sessions.

- Click on the Start button to start recording.
Enter the > command with the name of the file to start recording. For example, enter:

>session.cmd

After you invoke this command, CrossView Pro saves every executed command, whether using the mouse or manually typed into the Command Window, to the file session.cmd.

---

**FUNCTION:** Save CrossView Pro commands to a file.

**COMMAND:** >filename

---

**FUNCTION:** Save CrossView Pro commands to a file and force flushing.

**COMMAND:** >!filename

---

**FUNCTION:** Save CrossView Pro and emulator commands to a file.

**COMMAND:** >@filename

---

**FUNCTION:** Save emulator commands to a file.

**COMMAND:** >#filename

---

### 9.1.1 ENTERING COMMENTS

Every command, whether typed into the Command Window or the result of a mouse or menu action goes into the recording file. To add comments to a file recording CrossView Pro commands, enclose text typed in the Command Window with C comments delimiters, “/*” and “*/”. When logging emulator commands, refer to your emulator documentation for the appropriate comment characters.
9.1.2 SUSPEND RECORDING

This function acts like the pause button on a tape recorder: the recording mechanism stays in place, but suspends temporarily. CrossView Pro does not save to file any commands you enter while you suspend recording, but the file remains open and ready to accept input. To suspend recording:

From the Tools menu, select Record | CrossView... or select Record | Emulator... Click on the Suspend button.

In the Command Window, use the >f or >#f command (for “false”).

**FUNCTION:** Suspend recording CrossView Pro commands.
**COMMAND:** >f

**FUNCTION:** Suspend recording emulator commands.
**COMMAND:** >#f

9.1.3 RESUME RECORDING

This function is the counterpart of the suspend recording function. CrossView Pro resumes adding commands to the current record file. Any new command you enter appears in the file; they do not affect the commands already saved.

From the Tools menu, select Record | CrossView... or select Record | Emulator... Click on the Resume button to resume recording.

In the Command Window, use the >t or >#t command (for “true”).

**FUNCTION:** Resume recording CrossView Pro commands.
**COMMAND:** >t
FUNCTION: Resume recording emulator commands.

COMMAND: >#t

9.1.4 CHECK RECORDING STATUS

If at any point you do not remember whether recording is on or off, check by:

From the Tools menu, select Record | CrossView... or select Record | Emulator... If record mode is active, the Stop button is enabled. If the Start and OK buttons are enabled, record mode is off.

Enter the > command in the Command Window.

This command shows the status of the recording and logging mechanism. For example, if you enter > you might see:

>  
Output logging is OFF  
Command recording is ON  
Emulator command recording is OFF  
Target communication logging is OFF

The > command gives you the status for the different recording mechanisms. Output logging and target communication logging are described below.

9.1.5 CLOSE FILE FOR RECORDING

Closing a file for recording differs from suspending recording in that when you close a file, you may not add any more commands to it. If you were to start recording again using the same filename, the old commands in the file would be deleted. (Note that this does not exclude editing the file manually by some other means, since the file is saved as ASCII text.)

From the Tools menu, select Record | CrossView... or select Record | Emulator... Click on the Stop button to stop recording.
Enter the \texttt{>c} or \texttt{>#c} command to close the file.

\begin{itemize}
  \item \textbf{FUNCTION:} Close command recording file.
  \item \textbf{COMMAND:} \texttt{>c}
\end{itemize}

\begin{itemize}
  \item \textbf{FUNCTION:} Close emulator command recording file.
  \item \textbf{COMMAND:} \texttt{>#c}
\end{itemize}

\section*{9.1.6 COMMAND RECORDING EXAMPLE}

For example, consider the following command sequence (from the Command Window):

\begin{verbatim}
>session.cmd

initial
p 12

>f
l b
sum

>t
/* This is a comment! */

>c
\end{verbatim}

This series starts with a command to record to a file named \texttt{session.cmd}. The blank line above represents a carriage return. After the last command, \texttt{c}, if you were to view this file, it contains:

\begin{verbatim}
initial
p 12
/* This is a comment! */
\end{verbatim}

The saved command file contains simply the commands, without any output. Note that commands entered while recording was suspended (\texttt{l b} and \texttt{sum}) do not appear in the file. Carriage returns are not recognized as commands.
9.2 PLAYING BACK COMMAND FILES

Once you have recorded a set of CrossView Pro commands, you can play them back to recreate a debugging session or repeat often-used sequences. Running the debugger while reading commands from a file is playback mode.

Remember that for a file to be played back, it can only contain CrossView Pro or emulator commands. For this reason, screen output files cannot be used in playback mode. Refer to the Recording Commands section earlier in this chapter for more information.

As with recording, the Command Window controls playback mode. To playback a command file:

Follow these steps:

1. From the Tools menu, select Playback | CrossView... to open the CrossView Playback dialog box, or select Playback | Emulator... to open the Emulator Playback dialog box.

You can choose to playback either CrossView Pro commands or Emulator commands. Open the Emulator Command Window if the playback file contains commands sent directly to your emulator.

2. Type the playback filename or use the Browse... button to select the file. The default filename extension is .cmd.

In the Playback dialog box, you have two additional options: Playback at XVW startup and Continuous playback. CrossView Pro enters playback mode automatically when you start the debugger if you click on the Playback at XVW startup check box in the Playback dialog box. The entire playback file executes if you enable the Continuous playback check box.

3. Click on the Execute button to start the playback.

In the Command Window, use the < or <<filename command to playback CrossView Pro commands.

On the command line of CrossView Pro give the option -T filename to start CrossView Pro in transparency mode and playback emulator commands. This is not available for all execution environments.
9.2.1  SETTING THE TYPE OF PLAYBACK

Enable the **Continuous playback** check box in the CrossView Playback dialog box to turn on continuous playback of commands.

In the Command Window, there are two commands for the type of playback. The `<filename>` command starts playback. Commands are read from a file and executed without any stop. For example:

```
<session.cmd  
load and execute all the commands
```

The `<<` command causes CrossView Pro to playback commands one at a time, similar to single-stepping through code. For example:

```
<<session.cmd  
read a command from the file.
```

Clicking the **Execute** button or pressing the **Enter** key executes the next command.

---

**FUNCTION:**  Play back a file of CrossView Pro commands.
**COMMAND:**   `<filename`

---

**FUNCTION:**  Play back a file of CrossView Pro commands, one command at a time.
**COMMAND:**   `<<filename`

---

9.2.2  CALLING OTHER PLAYBACK FILES

A playback file can call another playback file in the course of its execution.

When CrossView Pro creates a command file, it saves all commands in their textual form, whether entered by the mouse or as text. You must edit this file to use the `<` and `<<` commands.
When the debugger reaches a < or << command in a playback file, playback execution switches to the new file and returns to the original file (nested calls). The first playback file determines the type of playback: continuous or single step.

9.2.3 QUITTING PLAYBACK MODE

Playback mode stops automatically when CrossView Pro reaches the end of the command file. If you want to end playback mode before this point, click the Halt button.

9.3 COMMAND LINE BATCH PROCESSING

CrossView Pro supports command line batch file processing, but CrossView Pro will halt if a modal dialog is encountered or if the target program contains an endless loop. The command line option --timeout=n_seconds switches CrossView Pro to a different mode of operation, without the two drawbacks mentioned above.

In order to process files in batch mode you have to do the following:

1. Create a temporary directory.
2. Start CrossView Pro from this temporary directory. For Windows XP/2000 you can create a separate icon or shortcut to start CrossView Pro, which has the working directory (Start in:) set to the temporary directory.
3. Close all CrossView Pro windows except the Command Window.
4. Exit CrossView Pro (with Save desktop and target settings enabled).

You now have generated an xvw.ini file with minimal GUI overhead.

5. Save the xvw.ini file and remove the temporary directory.

For each batch run of CrossView Pro you have to do the following:

1. Create a temporary directory.
2. Copy the saved xvw.ini file to the temporary directory.
3. Create a command file in the temporary directory.
The following command file `session.cmd` loads the `.abs` file, downloads the code, runs the code and exits.

```
N hello.abs               load the symbols
dn                         download the program
__EXIT bi                 set a breakpoint at the exit point
R                           run the program
$pc                       optional: show the program counter
q y                        exit CrossView Pro
```

where `hello.c` contains

```
#include <stdio.h>

void main()
{
    printf("Hello World!\n");
}
```

4. Copy the `.abs` file to the temporary directory. This is needed because CrossView Pro changes its working directory when the `N` command is used.

5. The following line executes CrossView Pro in batch mode and waits for it to finish:

Windows XP/2000:

```
start /wait c:\c166\bin\xfw166 --timeout=120 -tcfg sim166.cfg -p session.cmd -R session.log
```

UNIX:

```
xfw166 --timeout=120 -tcfg sim166.cfg -p session.cmd -R session.log
```

This command must be issued in the temporary directory! After the execution has ended, the file `session.log` contains a transcript of the commands.

6. Save the output files and clean up (or remove) the temporary directory. This must be done because the `xvw.ini` file has been modified now. If CrossView Pro would be started again in the temporary directory, the file `session.cmd` would be executed again.

The `--timeout=n_seconds` command activates the batch operation mode of CrossView Pro. It causes CrossView Pro to terminate when the specified
amount of time has elapsed, which is crucial in batch processing: if a program does not terminate, the timeout will terminate CrossView Pro, so that the next program in the batch can be executed. CrossView Pro will also terminate in the batch mode if a modal dialog pops up, since this requires user interaction to continue. Before CrossView Pro exits, the text in the dialog will be written to the log file. A special case of this dialog is the ‘End of program reached’ dialog. For this reason, the line __EXIT has to be added to the .cmd file, so it is possible to do some things (for example, read registers modified by a machine code program) after the program is finished. If the breakpoint at __EXIT is absent, CrossView Pro immediately exits after having executed the R command, so any consecutive commands will be ignored.

9.4 LOGGING

Logging means that all output text to a particular window is saved in a file for later use. Two windows allow logging:

- Command Output Window (upper part of the CrossView Command Window)
- Emulator Output Window (upper part of the Emulator Command Window)

"GDI Accesses" can also be logged. This is the information transferred between CrossView Pro and the Debug Instrument (DI).

You can control logging from the Tools menu or from the Command Window.

You can also determine the status of each logging function:

From Tools menu, select Log | Command Input/Output..., Log | CrossView-Emulator I/O... or Log | CrossView-GDI Accesses...

If a logging function is is active, the Stop button is enabled. If the Start and OK buttons are enabled, logging is off.

Enter the >>, >& or *> command in the Command Window.

Each type of logging is described in the following section.
The Emulator Output Window is primarily a diagnostic tool. It should be used wisely, since it generates substantial amounts of output, the format of which is emulator dependent. For emulators that have an ASCII interface, the actual command/response dialogue will be displayed. For emulators with a binary interface, CrossView Pro will generate a record of function calls with their associated input and output parameters. This also applies to the GDI Accesses output logging.

### 9.4.1 Setting Up Logging

To setup logging:

From the menu system:

- From **Tools** menu, select **Log | Command Input/Output...**, **Log | CrossView-Emulator I/O...** or **Log | CrossView-GDI Accesses...** to open the appropriate dialog box.
- Type in the name of the log file or use the **Browse...** button to select a filename. The default filename extension is `.log`.

Each Log dialog box has an **Automatically at CrossView startup** check box. This check box instructs CrossView Pro to start recording the output of a particular window or information stream upon starting up of CrossView Pro.

- Click on the **OK** button to save the current settings into the initialization file `xvw.ini` for following debugging sessions.
- Click on the **Start** button to start logging.

You can open up a log file for CrossView Command Output by using the `>>`*filename* command as in:

```
>>screen.log
```

You can force flushing by using the `>>!`*filename* command as in:

```
>>!screen.log
```

You can open up a log file for Emulator Output by using the `&`*filename* command as in:

```
>&target.log
```
You can force flushing by using the `>&! filename` command as in:

`>&!target.log`

You can open up a log file for GDI accesses output logging by using the `>* filename` command as in:

`>*gdi.log`

You can force flushing by using the `>*! filename` command as in:

`>*!gdi.log`

---

**FUNCTION:** Save CrossView Pro commands and command window output to a file.

**COMMAND:** `>>filename`

---

**FUNCTION:** Force flushing of CrossView Pro commands and command window output to a file.

**COMMAND:** `>>!filename`

---

**FUNCTION:** Log target communications.

**COMMAND:** `>&filename`

---

**FUNCTION:** Force flushing of target communication logging.

**COMMAND:** `>&!filename`

---

**FUNCTION:** Log GDI accesses.

**COMMAND:** `>*filename`
FUNCTION: Force flushing of GDI accesses logging.

COMMAND: \*filename

9.4.2 RECORDING COMMANDS AND LOGGING SCREEN OUTPUT

It is possible to have command recording, command output logging and target communication logging on at the same time. That is, you can have one file recording just the CrossView Pro commands, and another file concurrently recording both the commands and the computer responses. Refer to the previous section for information on command record files.

Since the Command Window log file contains both your commands and the computer responses, you cannot use it in playback mode.

9.4.3 COMMAND WINDOW LOG FILE EXAMPLE

For example, if you entered the following commands:

```
>>screen.log
initval
l a
```

The output file, screen.log, contains:

```
> initval
initval = 0
> l a
no assertions
```

9.4.4 SUSPENDING AND RESUMING OUTPUT LOG

You can resume and suspend the Logging process from the menu or from the Command Window:

From **Tools** menu, select **Log | Command Input/ Output...**, **Log | CrossView-Emulator I/O...** or **Log | CrossView-GDI Accesses...** to select the appropriate dialog box.
To suspend logging:

- Click on the **Suspend** button.

- In the Command Window, use the `>>f` command for suspending the logging of the Command Output Window. Type `>&f` to suspend the Emulator Output Window. Type `>*f` to suspend GDI accesses logging. After you issue this command, CrossView Pro does not save all subsequent commands and their computer responses.

To resume logging:

- Click on the **Resume** button.

- In the Command Window, use the `>>t` command to resume logging the Command Output Window. Type `>&t` to resume the Emulator Output Window. Type `>*t` to resume GDI accesses logging. After you issue this command, CrossView Pro saves all subsequent commands and their computer responses.

---

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Suspend output logging (logging is false).</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><code>&gt;&gt;f</code></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Resume output logging (logging is true).</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><code>&gt;&gt;t</code></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Suspend target logging (logging is false).</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><code>&gt;&amp;f</code></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Resume target logging (logging is true).</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><code>&gt;&amp;t</code></td>
</tr>
</tbody>
</table>
FUNCTION: Suspend GDI accesses logging (logging is false).
COMMAND: *f

FUNCTION: Resume GDI accesses logging (logging is true).
COMMAND: *t

9.4.5 CLOSING THE OUTPUT LOG FILE

To close the output file:

From Tools menu, select Log | Command Input/ Output..., Log | CrossView-Emulator I/O... or Log | CrossView-GDI Accesses... to select the appropriate dialog box. Click on the Stop button to stop logging.

Enter the >>c or >&c command in the Command Window to close the Command Output and Emulator Output log files. These commands end the recording for the currently specified output log file.

FUNCTION: Close output log file.
COMMAND: >>c

FUNCTION: Close target log file.
COMMAND: >&c
9.5 STARTUP OPTIONS

When starting up CrossView Pro you may immediately start recording or playing back files. For instance,

```
xfw166 fact -p session
```

plays back the commands in the file `session`. A `-P` option single-steps through each command, prompting you for a return after each command. You can also start recording:

```
xfw166 fact -r session
```

This command records all your commands (just like the `>` command) to the file `session`, while:

```
xfw166 fact -R session
```

logs your commands and screen output to the file `session` (just like the `>>` command).

You can also use the **Automatically at CrossView startup** option in the Record, Playback, and Log dialogs to immediately start recording, playback or logging at CrossView Pro startup.

You can also enter record and playback files via EDE. From the **Project** menu, select **Project Options...** Expand the **CrossView Pro** entry and select **Logging**. Enter your record and playback filenames.
9.6 CROSSVIEW PRO COMMAND HISTORY MECHANISM

CrossView Pro stores the command history in the list box of the Command Window.

You can select a command from the history list by clicking on it or jumping with the <Tab> key to the history listing and using the arrow keys.. The command appears in the edit field of the Command Window. You may edit the command if you want.

To execute the command, click on the **Execute** button.

If you do not want to edit the command, double-click on the selected command in the list box to execute the command, or hit the **<Return>** key.
CHAPTER 10

I/O SIMULATION

TASKING
10.1 INTRODUCTION

The CrossView Pro Terminal windows provide an interface to exchange data with the application on the target. You can use the following I/O simulation types for this purpose.

File I/O (FIO)

With File I/O you can connect actions to a probe point. Probe points are breakpoints that do not update the graphical user interface (GUI) and when they are hit, connected actions are performed and execution continues. The actions are in this case I/O actions to a file and/or a terminal window.

File System Simulation (FSS)

With FSS you can use standard stream I/O function calls like printf() in your source, to test I/O to and from the target system or simulator.

Debug Instrument I/O (DIO)

If you have a debug instrument that supports it, the debug instrument can perform input and output using GDI callback functions.

10.2 I/O STREAMS

You can setup I/O streams with the I/O Simulation Setup dialog. There is virtually no limit on the number of streams that can be opened or created. Each type of I/O stream (FIO, FSS, DIO) has its own numbering:

- FIO 0,1,2,...,k
- FSS 0,1,2,...,m
- DIO 0,1,2,...,n

You can map multiple streams to one terminal window.

For File I/O you can use the ios_ commands to open or close a FIO stream on the command line. Streams can be opened manually or are opened at the first call or operation that accesses a specified I/O stream (for Debug Instrument I/O handling). For FSS the target application can open streams with fopen() or open() calls and close streams with fclose() or close() calls.
Streams can be mapped to a terminal window and/or a file that is NOT the terminal log file. If a stream is mapped to a terminal window and a file the output will go to the terminal window and also to the file. In case of input the input will be read from the file. The read input will be echoed on the connected terminal window.

I/O streams opened by FSS are closed when end of program is reached or if a program reset occurs. I/O streams opened by CrossView Pro will be rewound. The windows to which the streams are mapped remain open.

In the I/O Simulation Setup dialog you can connect an I/O stream to a terminal window before the stream is opened by specifying the stream type, filename and terminal window name.

10.2.1 SETTING UP FILE I/O STREAMS

You can set up an input or output stream. For input you may specify either a file or the keyboard, for output either a file or the screen. Each stream has its own identifying number.

You can also specify the format of the stream’s values. The default is character, but you may want to use hexadecimal or octal values when directing data to or from a file.

To setup a File I/O stream:

From the menu system:

- From the Settings menu, select I/O Simulation Setup... to open the I/O Simulation Setup dialog box.
- Open the File I/O tab to setup a File I/O stream.
- Select the Configure... button. This opens the File I/O Configuration dialog.
- In the Probe point list box, select an existing probe point or press the New... button to set a new probe point. The Breakpoints dialog appears.
- In the Stream list box, select a stream or press the New... button to create a new stream. Select a new stream and click OK.
- Enter the Address and Length (in minimum addressable units, MAU) of the memory location you want to read from or write to.
- Optionally, enable the Use hexadecimal format check box when you want the data to be interpreted as a hexadecimal value.
• Choose the Direction: **Input** if the stream must provide input to the application, or **Output** if the stream must be an output stream.

• Click on the **Apply** button to accept the contents and enter another configuration or click on the **OK** button to close this dialog box.

Enter the **ios_open** or **ios_wopen** command in the Command Window to open a File I/O stream.

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a File I/O stream</td>
<td><strong>ios_open</strong> [&quot;file&quot;,[mode],[r],[xvw_variable]]</td>
</tr>
</tbody>
</table>

Enter the **ios_read** or **ios_write** command in the Command Window to read from or write to a File I/O stream.

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read from a File I/O stream</td>
<td><strong>ios_read</strong> {stream</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write to a File I/O stream</td>
<td><strong>ios_write</strong> {stream</td>
</tr>
</tbody>
</table>

To read 1 MAU hexadecimal value from file **mydata.dat** and store it at address 0x100, type:

```plaintext
ios_read "mydata.dat",0x100,1,x
```
10.2.2 REDIRECTING I/O STREAMS

In the I/O Simulation Setup dialog you can connect an I/O stream to a terminal window before the stream is opened or you can redirect an existing stream to a file and/or terminal window.

To redirect an I/O stream to a file and/or terminal window:

From the menu system:
- From the Settings menu, select I/O Simulation Setup... to open the I/O Simulation Setup dialog box.
- In the Connection tab select the I/O stream you want to change and select the Redirect... button.
- In the Connection Configuration dialog enter a filename and/or a terminal window name.
- Click OK to accept the changes and close the dialog.

Enter the ios_open or ios_wopen command in the Command Window to open a File I/O stream.

To disconnect an I/O stream from a file and/or terminal window:

From the menu system:
- From the Settings menu, select I/O Simulation Setup... to open the I/O Simulation Setup dialog box.
- In the Connection tab select the I/O stream you want to change and select the Redirect... button.
- In the Connection Configuration dialog erase the filename and/or terminal window name.
- Click OK to accept the changes and close the dialog.

Enter the ios_close command in the Command Window to close a File I/O stream.

---

FUNCTION: Close a File I/O stream
COMMAND: ios_close {stream | "file"}
To disable/enable an I/O stream:

From the menu system:

- From the **Settings** menu, select **I/O Simulation Setup...** to open the I/O Simulation Setup dialog box.
- In the **Connection** tab clear the check box in front of the I/O stream you want to disable. Set the check box to enable the stream.

Disabling a File I/O stream means that I/O actions will not be honored. Writing is not passed to the output file, and reading does not result in new data being placed in the target buffer.

### 10.3 FILE SYSTEM SIMULATION

File system simulation enables the application on the target board to use system calls (such as open, read, write) that are handled by the host system file I/O services. These files can be read directly from the host system, and output can be written to a file on the host system or in a CrossView Pro window. File system simulation is available for all execution environments.

The File System Simulation feature redirects I/O to a Terminal Window if the filename `FSS_window:window_name` is used in the "open" call, `window_name` is the name of a Terminal Window.

You can specify a root directory for FSS. CrossView Pro will search for the file from the root directory downwards. You can do this in the I/O Simulation Setup dialog, by entering a directory name in the **FSS root directory** field of the **Options** tab. This setting is saved in the `xvw.ini` file. Another possibility is to set a temporary resource by specifying the command line option `--fss_root_dir="path"` on CrossView Pro startup.

You can redirect File System Simulation streams to a file or another stream. Redirection to a file can be needed when a stream is only mapped to a window and you want it to be mapped to a file also.

Redirection can be used for scripting purposes, using the **FSS** command.

\[
\text{FSS}\ \{<\ |\ >\}\{\&\text{stream}\ |\ \"file\"\}
\]
For example,

\[ \text{FSS 2>&1} \]
\[ \text{FSS 1<&4} \]
\[ \text{FSS 4<"data.txt"} \]
\[ \text{FSS 3>"data.txt"} \]

The first example will redirect output of stream 2 to stream 1. The second example will retrieve input for stream 1 from stream 4. The third example will retrieve input for stream 4 from file "data.txt". The fourth example will redirect output of stream 3 to file "data.txt".

Disabling an FSS stream means in effect connecting the stream to /dev/null or NUL, causing writes to go into oblivion, and reads to return EOF.

10.3.1 FILE SYSTEM SIMULATION LIBRARIES

The low-level I/O functions such as \_open(), \_close(), \_read() and \_write() are implemented in the C library to use File System Simulation. These functions redirect high-level I/O calls such as printf() and scanf() type functions through CrossView Pro’s FSS feature, allowing you to perform stdin, stdout and stderr I/O by just using these standard C library functions.

The libraries have been optimized to only attach the file I/O routines if the application actually uses file I/O. This includes the exit() routine, that must close all opened streams before returning to the debugger. The default I/O streams stdin, stdout and stderr are opened on the fly whenever file I/O is used; this behavior is transparent to the user. It is no longer necessary to inform CrossView Pro about the use of any streams.

For more information see the section C Library Interface Description in the C Cross-Compiler User’s Manual.
10.4 DEBUG INSTRUMENT I/O

If you have a debug instrument that supports it, the debug instrument can perform input and output using GDI callback functions. The Debug Instrument I/O (DIO) stream number is passed as parameter to these callbacks. The output can be redirected to DDE (Windows only). The first access to a DIO stream will create a new terminal window and the title of the window will be "DIO x", where x is the number of the used stream. No new window will be created if the used stream is already mapped to a terminal window. You can use the I/O Streams Terminal Map dialog to map one or more streams to one window.
10.5 THE TERMINAL WINDOW

If you direct I/O simulation to the screen, CrossView Pro displays the output in the terminal window. Similarly, if you direct input from the keyboard; whatever you input appears in the appropriate terminal window. See section 4.6.8, *Terminal Window* for more information.

10.5.1 TERMINAL WINDOW KEYBOARD MAPPINGS

The following keyboard mappings, being both control codes and escape sequences, are supported by the VT100-like terminal mode of the terminal windows:

<table>
<thead>
<tr>
<th>Key</th>
<th>Character Sequence and/or Decimal Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backspace</td>
<td>8d</td>
</tr>
<tr>
<td>TAB</td>
<td>9d</td>
</tr>
<tr>
<td>DEL</td>
<td>127d</td>
</tr>
<tr>
<td>ESC</td>
<td>27d</td>
</tr>
<tr>
<td>Insert</td>
<td>ESC [ 2 ~</td>
</tr>
<tr>
<td>Prev/Page Up</td>
<td>ESC [ 5 ~</td>
</tr>
<tr>
<td>Next/Page Down</td>
<td>ESC [ 6 ~</td>
</tr>
<tr>
<td>Arrow Up</td>
<td>ESC [ A</td>
</tr>
<tr>
<td>Arrow Right</td>
<td>ESC [ B</td>
</tr>
<tr>
<td>Arrow Left</td>
<td>ESC [ C</td>
</tr>
<tr>
<td>Arrow Down</td>
<td>ESC [ D</td>
</tr>
</tbody>
</table>

*Table 10-1: General Keyboard Mappings*
**Display Control**

The VT100-like terminal mode of the terminal windows comprises the following control codes and escape sequences for displaying:

<table>
<thead>
<tr>
<th>ASCII Code</th>
<th>Decimal Value</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BELL</td>
<td>7</td>
<td>Ring the bell</td>
</tr>
<tr>
<td>BS</td>
<td>8</td>
<td>Move cursor one position back</td>
</tr>
<tr>
<td>TAB</td>
<td>9</td>
<td>Move cursor to next tab stop</td>
</tr>
<tr>
<td>LF</td>
<td>10</td>
<td>Move cursor one line down</td>
</tr>
<tr>
<td>CR</td>
<td>13</td>
<td>Move cursor to start of line</td>
</tr>
<tr>
<td>ESC</td>
<td>27</td>
<td>Start escape sequence (see below)</td>
</tr>
</tbody>
</table>

*Table 10-2: Control Codes*

**Escape Sequences**

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC D</td>
<td>Cursor one line down (scrolls if already at last line)</td>
</tr>
<tr>
<td>ESC E</td>
<td>Cursor one line down and to left margin (scrolls)</td>
</tr>
<tr>
<td>ESC M</td>
<td>Cursor one line up (scrolls if already at top line)</td>
</tr>
<tr>
<td>ESC [ n1 A</td>
<td>Cursor n1 lines up</td>
</tr>
<tr>
<td>ESC [ n1 B</td>
<td>Cursor n1 characters right</td>
</tr>
<tr>
<td>ESC [ n1 C</td>
<td>Cursor n1 characters left</td>
</tr>
<tr>
<td>ESC [ n1 D</td>
<td>Cursor n1 lines down</td>
</tr>
<tr>
<td>ESC [ H</td>
<td>Cursor home</td>
</tr>
<tr>
<td>ESC [ n1 ; n2 H</td>
<td>Move cursor to (n1,n2) with n1=row, n2=col</td>
</tr>
</tbody>
</table>

*Table 10-3: Cursor Motion*

Parameters *n1* and/or *n2* may be left out, in which case a value of 1 is assumed.
### Table 10-4: Erasing

For example, to clear the entire screen in the C programming language, you can enter:

```c
printf("\033[\H\033[2J");
fflush(stdout);
```

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ESC \ [ J$</td>
<td>Clear screen from cursor till bottom-right</td>
</tr>
<tr>
<td>$ESC \ [ p1 \ J$</td>
<td>0: Clear screen from cursor till bottom-right</td>
</tr>
<tr>
<td></td>
<td>1: Clear screen from top-left till cursor</td>
</tr>
<tr>
<td></td>
<td>2: Clear entire screen</td>
</tr>
<tr>
<td>$ESC \ [ K$</td>
<td>Clear line from cursor till end</td>
</tr>
<tr>
<td>$ESC \ [ p1 \ K$</td>
<td>0: Clear line from cursor till end</td>
</tr>
<tr>
<td></td>
<td>1: Clear line from begin to cursor</td>
</tr>
<tr>
<td></td>
<td>2: Clear entire line</td>
</tr>
</tbody>
</table>

### Table 10-5: Inserting and Deleting

Parameter $n1$ may be left out, in which case a value of 1 is assumed.
Escape Sequence | Operation
--- | ---
*ESC* [ m | Turn off all attributes

---

*ESC* [ n1 m | 0: turn off all attributes 1: bold 4: underline 5: blinking 7: reverse 8: invisible 22: turn off bold 24: turn off underline 25: turn off blinking 27: turn off reverse 28: turn off invisible

Table 10-6: Character Attributes

Multiple parameters may be specified simultaneously:

\[ \text{ESC} \ [ n1 \ ; \ \ldots \ ; \ nN \ m \]

Some attributes or combinations of attributes are mapped to a regular standout mode.

Parameters may be left out, in which case a value of 0 is assumed.

---

Escape Sequence | Operation
--- | ---
*ESC* [ 12 l | Local echo on

---

*ESC* [ 12 h | Local echo off

---

*ESC* [ ? 7 h | Wrap around on

---

*ESC* [ ? 7 l | Wrap around off

---

*ESC* [ ? 25 h | Cursor on

---

*ESC* [ ? 25 l | Cursor off

---

*ESC* [ ? 92 l | Enquire after the window’s size

Response: \[ \text{ESC} \ [ \ ? \ \text{rows, columns} \ c \]

Table 10-7: Miscellaneous
11.1 TRANSPARENCY MODE

Transparency mode allows you to communicate directly with the execution environment. Most of the time CrossView Pro will handle all the low level communications, freeing you to concentrate on the high level C code. Depending on the type of execution environment, however, you may have to enter transparency mode to set up the execution environment when the machine is first turned on.

To enter transparency mode:

From the View menu, select Command | Emulator.

All commands entered in the Emulator Command Window are passed directly to the execution environment.

To exit transparency mode:

From the View menu, select Command | CrossView.

In CrossView Pro, you can pass a string directly to the execution environment without leaving CrossView Pro with the o command:

```
o map
```

This passes the command map directly to the execution environment, while you remain in CrossView Pro. Naturally you will have to learn your execution environment’s command set to make use of the o command.

| FUNCTION: | Pass a command to the execution environment. |
| COMMAND:  | o string                                    |

Do not issue one-shot transparency commands that result in large output (or otherwise require intervention other than a carriage return to terminate output). Instead, enter transparency mode first, then issue the command.

You may also enter transparency mode upon startup with the -T option. See the section on startup options.
11.2 RTOS AWARE DEBUGGING

CrossView Pro supports RTOS (Real-Time Operating System) aware debugging for various kernels. Since each kernel is different, the RTOS aware features are not implemented in the CrossView Pro executable, but in a library (RADM: RTOS aware debugging module) that will be loaded at run-time by CrossView Pro. The amount of windows and dialogs and their contents is kernel dependent.

CrossView Pro for the C166/ST10 supports an OSEK RADM (osek_radm.dll) according to the OSEK standard. You have to create your own OSEK Run Time Interface (ORTI) and specify this file to CrossView Pro. CrossView Pro supports ORTI specifications v2.0 and v2.1.

EDE

From the Projects menu, select Project Options... Expand the CrossView Pro entry and select RTOS Aware Debugging Module. Select OSEK and specify the name of the ORTI file, or select User Defined and specify your RADM DLL name.

CrossView Pro

Within the CrossView Pro’s Target Settings dialog (Target | Settings...), select the CrossView Pro configuration you will use by selecting a "Target configuration". These target configuration files are normal ASCII text files. The name of the shared library that contains the kernel aware code can be specified in the target configuration. The "radm" configuration item specifies the name of the shared library that contains the kernel aware code.

The syntax of a target configuration file is:

```
[! comment] field : field-value
```

*field* one of the defined keywords

*field-value* the value assigned to the field

*comment* optional comment

Empty lines, lines consisting of only white space are allowed. Comments start at an exclamation-sign (!) and end at the end of the line.

The line for the shared library that supports RTOS aware code could be:

```
radm: yourrtos.dll
```
Or you can specify the RADM filename on the CrossView Pro command line with the following option:

```
--radm=osek_radm.dll
```

You can specify the ORTI filename on the CrossView Pro command line with the following option:

```
--orti=ORTI-filename
```

The OSEK RADM adds an OSEK/ORFI menu to CrossView Pro that has several items (each description in the notation ’<text>‘ is represented in the syntax of the OSEK Run Time Interface file):

- **OSEK implementation name** (if reading of the ORTI file succeeded)

  The OSEK implementation name is specified with <name> in the `<declaration_section>` of the ORTI file.

  For each `<declaration_spec>` a sub menu item will be created with the name represented for `<object>`. When selecting an object item a window will appear with all objects from the `<information_section>` for the specified `<object>`. The new created window always contains the Object column and then the columns represented in the `<object_decl_list>` of the specified object.

- **Info Messages**

  This menu item lists all expressions from the ORTI file that could not be evaluated. This could be an expression within the `<declaration_section>` represented in the `<enum_value_list>`. However evaluating the expressions from the objects in the `<information_section>` also could have problems. The problems could occur when the expression is to difficult to be evaluated or when one of the variables of the expression is not available when the symbolic debug info is loaded.

  When an expression could not be evaluated it results into ’N.A.’ for the specified window object entry item. When the expression could be evaluated but the enumerated type could not be found or the specified type could not be converted correctly this will result into ’n.a.’ for the specified window object entry item.
So, there are two situations:

n.a. : Expression could be evaluated but could not be converted correctly at current moment. This expression will not occur in the list when the menu item ‘Info Message’ is selected.

N.A. : Expression could not be evaluated and will not change until the ORTI file is updated with a valid expression.

For the second situation you can type the expression in the command window and CrossView Pro will show a message box with the reason why the expression could not be evaluated.

- About RADM

  This menu item shows the supported OSEK/ORTI version and the RADM version.

### 11.3 COVERAGE

You can only use this feature if it is supported by the execution environment (see the addendum).

When the application program is executed as a result of a command such as StepInto or Continue, CrossView Pro traces all memory access, i.e. memory read, memory write and instruction fetch. Through code coverage, executed and not execute areas of the application program can be found. Areas of unexecuted code may exist in case of programming errors or simply dead code which could be eliminated. Alternatively, your program input or your test set is incomplete. It may not cover all paths in the program.

Data coverage allows you to verify which memory locations, i.e. which variables, are accessed during program execution. Additionally, stack and heap usage can be shown.

To enable/disable coverage:

From the **Tools** menu, select the **Coverage** checked menu item.

When the menu item is checked, coverage is enabled. Select the menu item again to disable coverage.

Type the `ce` or `cd` command on the command line:
### ce

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable coverage.</td>
<td>ce</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable coverage.</td>
<td>cd</td>
</tr>
</tbody>
</table>

Two dialogs are present to give you coverage information. The code coverage dialog shows the percentage of executed code within application, module and function scope. Code coverage information can also be displayed in the Source Window. The data coverage dialog shows the data access of HLL variables in the executed program. Data coverage can also be displayed in the Memory Window. The coverage dialogs can be opened via the **Tools** menu.

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>List coverage information to output window or file.</td>
<td>covinfo [[all</td>
</tr>
</tbody>
</table>

You can display code coverage information in the Source Window by clicking on the **Coverage** button in the Source Window. In this case an extra column appears to the right of the breakpoint toggles (to the left of the source line). For each source code line that is executed (*covered*), the source line is marked. The not executed lines are not marked. CrossView Pro has special commands to move the cursor to the next or previous covered or uncovered line:

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move cursor to next covered line.</td>
<td>nC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>COMMAND</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move cursor to next uncovered line.</td>
<td>nU</td>
</tr>
</tbody>
</table>
FUNCTION: Move cursor to previous covered line.
COMMAND: pC

FUNCTION: Move cursor to previous uncovered line.
COMMAND: pU

You can display data coverage information in the Memory Window by clicking on the Code Coverage button in the Memory Window. Besides the current value of memory locations, the memory window also displays whether memory locations have been accessed during program execution. An application program may read from, write to, or fetch an instruction from a memory location. Of course all combinations may be legal. Although writing data to a memory location from which an instruction has been fetched is suspicious. All types of access, read, write, fetch or combinations of these, can be shown using different foreground and background colors. The color combination used to show "rwx" access are specified in the Desktop tab of the File | Options... menu item. It is advised to change the background color if instructions are fetched from a memory location, and to change the foreground color to show read and write access.

11.4 PROFILING

![Info Icon]
You can only use this feature if it is supported by the execution environment (see the addendum).

Profiling allows you to perform timing analysis on your software. Two forms of profiling are implemented in CrossView Pro. Both forms of profiling are fully implemented in the CrossView Pro debugger. You do not have to recompile your source code to enable the profiling features.
11.4.1 FUNCTION PROFILING

Function profiling, also called cumulative profiling, gives timing information about a particular function or set of functions. The time spent in functions called by the function being profiled is included in the timing results. Within the Cumulative Profiling Setup dialog you select one or more functions to be profiled. The gathered profile is shown in the Cumulative Profiling Report dialog. For each function the number of calls, the minimum/maximum/average and total time spent in the function are shown. Also, the relative amount of time consumed by a function in respect to the time consumed by the application is shown.

Function profile data is gathered whenever the program is executed using the Continue command (not single stepped). Function profiling can be supported if the execution environment provides a clock that starts and stops whenever execution starts and stops. Basically function profiling is implemented by using a special type of breakpoint. Breakpoints are inserted at the function entry address and all it's return addressed. Whenever execution stops due to a profile-breakpoint hit, CrossView Pro will read the clock, update the internal profile tables, and restart execution.

To specify the functions to be profiled:

From the Tools menu, select Cumulative Profiling Setup...

Type the cproinfo command on the command line:

    cproinfo add main

To view the profiling results:

From the Tools menu, select Cumulative Profiling Report...

Type the cproinfo command on the command line:

    cproinfo
FUNCTION: List cumulative profiling results to output window or file, or add or remove functions from the list of profiled functions.

COMMAND: `cpproinfo [all][filename] | {add | remove} function`

### 11.4.2 CODE RANGE PROFILING

*Code range profiling* presents timing information about a consecutive range of program instructions. CrossView Pro displays the time consumed by each statement, C or assembly, in the source window. The timing data can be displayed in three different formats: absolute, relative to program, and relative to function. To change the display format: position the cursor on the profile column and click the right mouse button. Select the appropriate format from the popup menu.

Next to the source window, the profile report dialog (**Tools | Profiling Report...**) shows the time spent in each function. The time consumed by functions called from the function being profiled is not included in the displayed time.

FUNCTION: List profile information to output window or file.

COMMAND: `proinfo [all | module_or_function_name][filename]`

Code range profiling data is gathered whenever the program is executed. It does not matter if the program executes due to a continue, step-over or step-into command. Code range profiling heavily relies on special profiling features in the execution environment. Normally code range profiling is only supported by instruction set simulators.

To enable/disable profiling:

![Tip] From the **Tools** menu, select the **Profiling** checked menu item.

When the menu item is checked, code range profiling is enabled. Enabled means that the execution environment starts gathering profiling data. Select the menu item again to disable profiling.
Type the **pe** or **pd** command on the command line:

**pe**

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Enable profiling.</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><strong>pe</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FUNCTION:</th>
<th>Disable profiling.</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND:</td>
<td><strong>pd</strong></td>
</tr>
</tbody>
</table>

Select the **Profiling** button in the Source Window to display profile data in the Source Window. If profiling is not enabled, this button also starts gathering of profiling data.

Normally both function and code range profiling will slow down the execution speed of the application being debugged. Therefore, switch off profiling whenever the timing information is not required.

### 11.5 DATA ANALYSIS

CrossView Pro incorporates an advanced signal analysis interface designed to enable developers to monitor signal data more critically and thoroughly. This feature is useful when developing signal processing software for application areas such as communication, wireless and image processing.

The Data Analysis window (as shown in figure 4-15) is used for this purpose. This window is opened as result of processing a data analysis script (CXL script) and is only updated on user request. TASKING provides scripts for standard signal analysis such as x-t plotting, x-y plotting, FFT power spectrum, FFT waterfall, combined FFT power spectrum and phase, and eye diagram. However, the programmer can write CXL scripts and process the data in the format he desires.

Refer to the CXL syntax specification in Appendix B, *CrossView Extension Language (CXL)*, for details.
Four processes are associated with the graph window:

7. Get raw data
8. Transform data
9. Generate representation
10. Draw

The *get raw data* process retrieves data from the target and stores the data at the host system in one or more CrossView Pro internal acquisition data buffers. Since these buffers reside on the host system it is possible to maintain a history of data.

The *transform data* process takes the raw data as input, processes it, and the result of the transformation, a set of $(x, y)$ pairs, is saved in the processed data buffer associated with a window. Since the transformations are described in CXL (CrossView eXtension Language) the user can program the data transformation that is of most interest for him. For example, an FFT power spectrum would produce *(frequency, power)* pairs.

The *generate representation* process takes data from the processed data buffer, $(x, y)$ pairs, as input and generates a display list. This process scales the data according to the given display window size. This process is coded in CXL. So, in addition to the scripts provided by TASKING, the user can write his own representation processes. For example, an FFT power spectrum is usually represented by a bar graph.

The *drawing engine* process takes the display list as input and produces the graph that is displayed in the Data Analysis window. The drawing engine is part of the CrossView Pro executable and cannot be configured by the user.

A clear separation between data transformation (the transform data process) and data presentation (generate representation process) has been made to increase the reusability of complex data presentation scripts.

Once the scripts are written (a number of frequently used operations are supplied), the following three steps must be made in order to display data:

1. Set the display mode for the desired window using the `graphm` command. For example,

   ```
   graphm "demo","show_x_t.cxl"
   ```
"demo" will be shown in the title bar of the window. It is also the name used to refer to the window.

2. Retrieve data from the target into a buffer using the `memget` command. For example,

```
memget ((int []) 0x0)[${i}],128,$buffer
```

$i$ is the "iterator" to walk 128 times through the expression (Note: the retrieved elements are assumed to be equidistantly placed in memory) and store the results in $buffer$.

Optionally the buffer contents can be appended to another buffer using the `bufa` command, in order to maintain a (limited) history. For example,

```
bufa $all_data,$buffer,1024
```

3. Transform the buffer contents to displayable data using the `graph` command. For example,

```
graph "demo","x_t.cxl",$buffer,0,1
```

For details of the arguments provided to `x_t.cxl`, see below. Now a used buffer can be freed using the `bufd` command (if the target data is not to be used anymore).

Steps 1. and 2. can be repeated as many times as desired. The display mode can be changed at any time by issuing a `graphm` command for the window to be changed. Using the `graphp` command, a window can be positioned anywhere on the screen.

### 11.5.1 Supplied Data Analysis Window Scripts

The following scripts and commands are described for completeness. Normally, you will not use the commands directly, because they are automatically invoked when you click OK in the Data Analysis Window Setup dialog.

For some `graphm` scripts both x- and y-axis can be user specified. If the limits are not specified or low >= high, then autoscaling is used.
**X-T plotting**

An x-t plot is the most straightforward way of displaying data. Data is taken from one buffer, each value is taken as the x value and the t value is increasing linearly. It is displayed as a graph the way it is found in the buffer (memory). The layout of the scales and the form of the graph (line, bar, dot) can be selected as shown below.

1. Generating window data pairs:

   ```
   graph "win_title", "x_t.cxl", $buffer, t_offset, t_increment
   ```

   generates (t, x) pairs: (t_offset + i * t_increment, $buffer[i]). The generated data is attached to the specified window.

2. Setting the display mode:

   ```
   graphm "win_title", "show_x_t.cxl" [low_x, high_x] [low_y, high_y]
   ```

   displays lines drawn between successive coordinates specified by the window data pairs.

   ```
   graphm "win_title", "show_cross.cxl" [low_x, high_x] [low_y, high_y]
   ```

   displays 'x's at the coordinates specified by the window data pairs.

   ```
   graphm "win_title", "show_plus.cxl" [low_x, high_x] [low_y, high_y]
   ```

   displays '+s at the coordinates specified by the window data pairs.

   ```
   graphm "win_title", "show_bars.cxl" [low_x, high_x] [low_y, high_y]
   ```

   displays bars at the coordinates specified by the window data pairs. The x-coordinates are expected to be equidistant.

**X-Y plotting**

An x-y plot takes values from two buffers, one from each at a time. The first is interpreted as the x-value, the second as the y-value of a point to display. No further processing is done on these values. The most common display mode is 'x's or '+s (`show_cross.cxl`, `show_plus.cxl`, see previous description) to give a scattergram. The values can also be interconnected in order (`show_x_y.cxl`) to create Lissajous-like displays.

1. Generating window data pairs:

   ```
   graph "win_title", "x_y.cxl", $x_buffer, $y_buffer
   ```
2. Setting the display mode:

```
graphm "win_title", "show_x_y.cxl" [ low_x, high_x [ low_y, high_y ] ]
```

draws lines from all \((x[i], y[i])\) to \((x[i+1], y[i+1])\). When autoscaling is active, some space is reserved on both x- and y-axis.

**FFT power spectrum**

The FFT power spectrum plot takes a buffer of arbitrary size to compute the power of all frequencies present in the signal (in decibels). If the buffer size is not a power of two, it will expand its input set to the next higher power and augment it with zeroes. To handle non-recurrent data correctly, several window functions can be applied in the process. If no reference level is given the maximum level is calculated and set to be 0 dB. The usual display mode is bars, although all x-t display methods can be used. The horizontal axis is in frequency steps, the vertical axis in decibels.

1. Generating window data pairs:

```
graph "win_title", "fft.cxl", $buffer, filter_index, frequency_step, ref_level
```

generates pairs \((i \times frequency\_step, \log\_power[i])\). The \(filter\_index\) specifies one of the following FFT windowing functions:

- 0  rectangular
- 1  triangular
- 2  Hanning
- 3  Blackman-Harris

\(ref\_level\) is the 0 dB reference level.

2. For displaying the generated pairs, any of the x-t plotting display scripts can be used. "show_bars.cxl" is recommended.

**Multi FFT power spectrum ("waterfall")**

The multi FFT power spectrum displays a chronological series of FFT power spectra. This diagram is also known as FFT waterfall. The FFT power spectrum plot takes a buffer of arbitrary size and splits it up in a number of frames of size \(2^{\text{two}\_\text{exp}}\). You can specify the overlap between successive frames. The overlap can be negative indicating gaps between successive frames. For each frame, the power (in decibels) of all frequencies present in the signal is computed.
1. Generating window data pairs:

```
graph "win_title", "multi_fft.cxl", $buffer, filter_index, frequency_step, two_exp, overlap, ref_level]
```

generates pairs (i * frequency_step, log_power[i]). The filter_index specifies one of the following FFT windowing functions:

- 0 rectangular
- 1 triangular
- 2 Hanning
- 3 Blackman-Harris

\(2^{two\_exp}\) is the width of one single frame in number of input samples. \(two\_exp\) must be a value between 2 and 14 (inclusive). If the input buffer does not contain enough samples to fill the last frame, the frame is completed with zeros.

\(overlap\) is the number points shared by successive frames. When negative, a ‘gap’ will occur between processed points. The first sample taken from the input buffer of frame \(N\) is equal to the first sample of frame \(N + 2^{two\_exp} - overlap\). \(overlap\) must be smaller than \(2^{two\_exp}\).

\(ref\_level\) is the 0 dB reference level.

2. For displaying the generated pairs, the display script 
"show_multi_bars.cxl" is required.

**Multi FFT power spectrum in lines**

Displays the same multi FFT power spectrum, but now in lines instead of bars. Here a 3D graph is shown. The script name is 
show_multi_lines.cxl.
Multi FFT power spectrum in lines and grid

Displays the same multi FFT power spectrum as the multi lines spectrum. Now each point on a curve is interconnected with a point with the same x-coordinate of the previous graph. What you see here is a ‘grid’ with the values. The script name is show_multi_grid.cxl.

Use of colors in Multi FFT power spectrum

For all three graphm scripts show_multi_bars.cxl, show_multi_lines.cxl and show_multi_grid.cxl an optional third parameter can be added to set the color offset value. This allows you to create a dynamic display in which the color of each curve remains the same. The color offset can range from 0 to the maximum number of colors, and the maximum number of colors is the number of curves to be plotted. When the color offset exceeds the number of colors, the modulo will be taken; if it is negative it will be set to zero. The colors selected for the curves are spread evenly over the color spectrum. The number of colors can also be set as an (optional) fourth parameter of the script.

An example of a command file for a running script can be:

/* INITIALIZE */
rst /* Rerun the program when the script is executed */
$fast_mode=2 /* If on the simulator, go to fast mode */
s /* Step to the main() routine to allow access */
/* to the output[] array. */
memget output[$i],256,$t /* It’s clear now. */
bufa $f,$t,4096 /* Construct an empty time domain history */
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
bufa $f,$t,4096
$color=0 /* Initialize the $color variable to track the graphs */

/* DEFINE THE TIME DOMAIN WINDOW */
graphp "Output time domain",50,25,716,295 /* set window position */
graphm "Output time domain","show_x_t.cxl" /* set draw method */
graph "Output time domain","x_t.cxl",$t,0,1 /* use the ‘t’ buffer */

graph_clear_updates "Output time domain"
/* Set ‘Output time domain’ window update actions: */
graph_add_update "Output time domain",memget output[$i],256,$t /* Get new time domain data from output[] into $t buffer */
graph_add_update "Output time domain",graph "Output time domain","x_t.cxl",$t,0,1 /* This command recalculates and redraws the window */
SPECIAL FEATURES

/* DEFINE THE FREQUENCY DOMAIN WINDOW */
graphp "Output freq domain",50,350,716,295
/* set window position */
graphmn "Output freq domain","show_multi_grid.cxl",-120,5,($color)
/* set draw method */
graph "Output freq domain","multi_fft.cxl",$f,0,1,256
/* use the 'f' buffer */

graph_clear_updates "Output freq domain"
/* Set 'Output freq domain' window update actions: */
graph_add_update "Output freq domain", bufa $f,$t,4096
/* Add new data to buffer, max size 4096 (purging oldest) */
graph_add_update "Output freq domain", $color = ($color+1) % 16
/* 4096/256 = 16 graphs, increment color offset to follow */
graph_add_update "Output freq domain", graphmn "Output freq
domain","show_multi_grid.cxl",-120,5,($color)
/* Use the graphmn command to avoid double redraws */
/* Place $color in braces to avoid confusion with buffers */
graph_add_update "Output freq domain",graph "Output freq
domain","multi_fft.cxl",$f,0,1,256
/* This command recalculates and redraws the window */

/* PLACE COMPLEX BREAKPOINT, HAVE IT UPDATE THE GRAPHICAL DATA WINDOWS */
main#141 bi { update! "Output time domain"; update! "Output freq
domain"; C }
/* CONTINUE RUNNING THE PROGRAM */
C

For passing the parameter $color, the command interpreter requires parentheses around it, otherwise it is interpreted as a buffer.

**Combined FFT power spectrum and phase**

The combined FFT power spectrum and phase plot adds a display of the phase of each component to the FFT power spectrum. The phase is normalized between -180 degrees and +180 degrees. To display both features of the input data a special display script must be used (show_fft_pairs.cxl).

1. Generating window data pairs:

```graph "win_title", "fft_pairs.cxl", $buffer, filter_index, freq_step[,ref_level]
```

The `filter_index` specifies one of the following FFT windowing functions:

- 0 rectangular
- 1 triangular
- 2 Hanning
- 3 Blackman-Harris
ref_level is the 0 dB reference level.

2. Setting the display mode:

For displaying the generated display list, the display script "show_fft_pairs.cxl" is required.

```
graphm "win_title", "show_fft_pairs.cxl" [min_power, max_power]
```

**Eye diagram**

The eye diagram is a recurrent x-t plot. The input data is not processed, but the time parameter is reset when the signal crosses the trigger level, and also after a specified interval (wrap_limit). After crossing trigger_level, retriggering is suppressed during the trigger_hold_off next data values. The eye diagram uses the X-t plot method and exploits the feature of suppressing the fly-back of the displayed line.

1. Generating window data pairs:

```
graph "win_title", "eye.cxl", $buffer, wrap_limit [, t_increment [, t_offset [, trigger_level [, trigger_hold_off]]]]
```

2. Setting the display mode:

```
graphm "win_title", "show_x_t.cxl" [low_x, high_x [, low_y, high_y]]
```

displays lines drawn between successive coordinates specified by the window data. If \( x[i+1] < x[i] \) (going back in time), no line is drawn from \((x[i], y[i])\) to \((x[i+1], y[i+1])\), which can be regarded as the fly-back suppression in an oscilloscope.

### 11.6 PROGRAM A FLASH DEVICE

With CrossView Pro you can download an application file to FLASH memory. Before you download the file, you must specify the type of FLASH devices you use in your system and the address range(s) used by these devices.
There are two ways you can program a FLASH device. CrossView Pro can program the FLASH device through target memory read/write accesses (host-target communication), or alternatively CrossView Pro can download a FLASH programming monitor to the target to execute the FLASH programming algorithm (target-target communication). The second method is faster, however you use temporary target memory to store the FLASH programming monitor and you have to specify a temporary data workspace for interaction between CrossView Pro and the FLASH programming monitor.

Most flash devices require a sequence of memory accesses to set the device in programming mode. These accesses must occur in a given time interval. So, if the interface between CrossView Pro and the target is rather slow (for example an RS-232 interface) you can better choose to download a FLASH programming monitor (do not use target memory accesses).

The **Use target memory accesses to program flash devices** check box in the Flash Setup dialog specifies the type of access to the FLASH device.

**To setup a FLASH device**

**From EDE:**

1. From the **Project** menu, select **Project Options**...

   *The Project Options dialog appears.*

2. Expand the **Application | FLASH Setup** entry.

3. Specify **On-Chip Flash** or specify an **External Flash Chip**.

**From CrossView Pro:**

1. From the **Target** menu, select **FLASH Setup**...

   *The FLASH Setup dialog appears.*

2. Click **Add...** to specify a FLASH device.

   *The Add FLASH Device dialog appears.*

3. In the **Device type** box, double-click on the name of the manufacturer of the device.

4. Select a flash device.
5. Click on the **Base address** edit field and enter the start address of the memory range that will be covered by the FLASH device.

6. In the **Chip width** field select the width of the FLASH device.

7. In the **Number of chips** field, enter the number of FLASH devices that are located in parallel. For example, if you have two 8-bit devices in parallel attached to a 16-bit data bus, enter 2.

8. Click **OK**.

   *The FLASH Setup dialog appears again and the new device is shown in the list.*

9. Specify the data workspace address used by the FLASH programming monitor. This address may not conflict with the addresses of the FLASH devices.

10. Click **OK**.

   *The FLASH device is now known to CrossView Pro.*

![Command Icon] Type the **fa** and **fw** commands on the command line, for example:

   ```
   fa  AM29F040,0xFFE00000,8,2
   fw  0x10000
   ```

---

**FUNCTION:** Add a FLASH device  
**COMMAND:**  
`fa device_name,base_address,chip_width[,nr_of_chips]`

---

**FUNCTION:** Specify FLASH programming monitor workspace  
**COMMAND:**  
`fw [address]`

---

**To flash an application file**

1. From the **File** menu, select **Load Symbolic Debug Info...** or **Download Application...**

   *The Load Symbolic Debug Info dialog or Download Application dialog appears.*
2. Specify the name of the application you want to debug/download and flash into a FLASH device.

3. Select **Enable flash** if you want to start the flash programming when you click **Load**.

4. Click **Load**.

   *CrossView Pro downloads the application file and flash programming starts.*
11.7 BACKGROUND MODE

Background mode is a feature for running the application under debug and CrossView Pro at the same time. This allows you to monitor the target application using CrossView Pro, while the application is running. Depending on the target hardware and/or debug instrument connected to CrossView Pro, target execution can even be real-time.

Since CrossView Pro’s monitoring of the target hardware must be non-intrusive, not all functions of the debugger are enabled while running in background mode.

You can only use this feature if it is supported by the execution environment (see the addendum).

11.7.1 CONFIGURATION

CrossView Pro can be instructed to automatically refresh one or more windows of the debugger periodically while running in background mode. You can use the Background Mode Setup dialog for specifying the desired set of windows to be refreshed.

From the Settings menu, select Background Mode Setup... to open the Background Mode Setup dialog.

A distinction has been made between updating the Source lines window and updating the Disassembly window. Updating the Disassembly window may be too time-consuming, so you may want to disable its updating in Background mode, while still keeping the Source lines window up-to-date when that is displayed on screen.

Use the u command to toggle the updating of windows in background mode.

FUNCTION: Toggle update of window in background mode.

COMMAND: [interval] u [d|k|r|cd|ck|cr|s|a|mem|t]
The following windows can be updated in background mode:

- **d** (Data), **k** (Stack), **r** (Register),
- **s** (Source), **a** (Assembly), **mem** (Memory), **t** (Trace)

Initially only the data window will be updated. CrossView Pro repeatedly looks at the execution environment to react on changes. It pseudo-simultaneously looks for user commands from the keyboard (or from the playback file), and periodically it updates the windows.

If all windows would be updated the update frequency would drop. That is why you can toggle a switch for each window. To toggle the updating of the register window, you can type:

```
xvw% u r
```

If the switch for a window is 'on', it will be updated, otherwise it will be skipped.

You can also specify a new update interval.

Without arguments, CrossView Pro displays all windows updated periodically plus the update interval.

Notice that simulated I/O is done through 'invisible' breakpoints, and these must be handled inside the loop. Hence, if updating the windows takes a lot of time (many monitor commands), it will also slow down simulated I/O.

### 11.7.2 Manual Refresh

If you have windows which you do not want to refresh periodically, you can disable them in the Background Mode Setup dialog’s refresh list, and refresh these windows manually.

From the **View** menu, select **Background Mode** and select one of the refresh options.

Use the **ubgw** command.
**FUNCTION:** Update the appropriate window when the target runs in the background.

**COMMAND:** `ubgw [ s | a | k | r | d | mem | t | all ]`

Section *Refresh Limitation* in this chapter.

### 11.7.3 ENTERING BACKGROUND MODE

To run a program in background mode:

*From the Run menu, select Background Mode | Run in Background*

*Type the CB command on the command line.*

**FUNCTION:** Run a program in background mode.

**COMMAND:** `[count] CB [linenumber]`

This will start the application under debug to run continuously (as with the C command), and switch CrossView Pro from Halted to Background Mode. *count* is assigned to the breakpoint at the current execution position as the number of times to hit this breakpoint before execution to stop. *linenumber* specifies the source line to place a temporary breakpoint.

The mouse pointer changes to an arrow with a small watch face underneath. This indicates that CrossView Pro is now in background mode. Some commands are treated a little different in this mode, because they can otherwise influence the running program badly. Commands that need information from the stack (like `bu`, `bu`, `bb` or `bB`) are not allowed because that information is not reliable. Other commands require great care, for example the o command.

For example if you type the g while in background mode you will see:

```
xvw% g 56
Command "g" is not allowed while the emulator is running in background.
```
11.7.4 LEAVING BACKGROUND MODE

You can leave Background Mode in three ways:

1. Stop the target immediately:

   From the Run menu, select **Background Mode | Halt Target**

   Enter the `st` command:

   ```shell
   xvw% st
   ```

2. Let CrossView wait for the target to stop:

   From the Run menu, select **Background Mode | Wait for Target to Stop**

   To wait for a breakpoint, you can use the `wt` command:

   ```shell
   xvw% wt
   ```

3. A program running in background mode also stops when it encounters a breakpoint.

   **FUNCTION:** Stop a program in background mode.
   **COMMAND:** `st`

   The `wt` command behaves just as if you have typed the `C` command. CrossView Pro returns with a prompt, after the program hits a breakpoint. However, there is an interesting difference with the `C` command. If you push the Halt button, it returns with the background prompt. The program that runs in the execution environment continues without interruption.

   **FUNCTION:** Wait for the running process to stop
   **COMMAND:** `wt`
11.7.5 THE STACK IN BACKGROUND MODE

While the execution environment runs in background, CrossView Pro does not allow the use of information that comes from the stack. The reason is that the running program must be stopped in order to get consistent information from the stack. Stopping (and afterwards continuing) the program conflicts with the "real-time" nature of the background mode.

If there is a need for it, you can make a macro that performs the desired operations.

11.7.6 LOCAL AND GLOBAL VARIABLES

In background mode you can continuously monitor variables. However, realize that local variables (in CrossView Pro variables are called 'local' if they reside on the stack) cannot be monitored. Instead you will see "unknown name". Global variables have a fixed address, so CrossView Pro knows where to get their contents from.

If you are very anxious to see local variables you can first get an address and then use that address to monitor the contents. For example:

```
$adr_sum = &sum
m *(adr_sum)/x4
```

In this example `sum` is a long (4 bytes). You must be sure that `sum` remains at that address while the program is running.

The values you get this way are only valid under specific conditions. Local variables from the function `main` normally meet these conditions.

11.7.7 REFRESH LIMITATION

While running the application in the background mode, the automatic refresh functionality may not be able to keep up with all the debugging information produced by the running target. Typically, the collected information will be correctly displayed and automatically updated in the current open views and no information will be lost. You might lose the debugging information when scrolling these views during the background mode. The reason is that either CrossView Pro does not run fast enough or the communication with the target hardware is not handled fast enough by the operating system.
The information that cannot be processed by CrossView Pro within the specified update interval, is displayed as either '<unknown>' or dashes. The way the lost information is displayed depends on the internal communication level within CrossView Pro where the information is lost. Information lost during communication with the target hardware is displayed as '<unknown>'. Information lost by CrossView Pro while processing and interpreting this information, is displayed as dashes.

On the next automatic or manual update, all debugging information in the currently open views is automatically updated. All visible '<unknown>' values and dashes are replaced with their actual values as produced by the running target.

11.7.8 ASSERTIONS

CrossView Pro automatically suspends assertions with the CB command.
Here are a few notes about debugging in special situations:

12.1 DEBUGGING ASSEMBLY LANGUAGE

Just as with C sources, you can debug assembly language programs or modules. The `s`, `S` and `si` commands single step through the assembly source. You may place code breakpoints on assembly language instructions with the `bi` command.

For additional information on debugging assembly code, see `$autosrc`, `$mixedasm` and `$symbols` in the `Reserved Special Variables` table in section 3.4.

There is a restriction on debugging assembly language code:

- Assembly language subroutines cannot be called from the command line.

12.2 DEBUGGING MULTIPLE PROGRAMS

You probably have only one linked and located absolute object file that describes the whole system load. However, for various reasons, you may want to build your system load by linking and locating into several files. The debugger can handle the symbols from only one load module in one absolute object file at a time. Consequently, if there are several absolute files or several load modules within one absolute file, you will have to change the context from one to another explicitly. Use the `N` command or the Load Symbolic Debug Info dialog to load the appropriate symbols. This does not disturb the state of the target system.

You can also download the image part of another absolute object file (using the `dn` command), without leaving the debugger.
This chapter contains a summary of all CrossView Pro commands, followed by a complete description of each command.

13.1 CONVENTIONS USED IN THIS CHAPTER

Each CrossView Pro command has a particular syntax, that is, the form it must take for CrossView Pro to recognize it. To help you learn the syntax of each command, this chapter uses a special notation to describe the syntax of each command. Consider the following example:

    ios_read {stream | "file"},address,number_of_maus[,x]

Command items in bold font are the actual command keywords typed from the keyboard. In the example above, **ios_read** is in bold font since you must type it exactly as shown.

Items in *italics* are names of the command part. Here *stream* is in italics, since you must substitute the appropriate value for stream. The Description section for each command describes what kinds of values should be substituted for italicized terms.

Expressions in [brackets] are optional items you may include in a particular command. In this example, *x* is not necessary for the **ios_read** command to work. Usually if you omit an optional expression, CrossView Pro uses a default value.

The | symbol means or. For instance, *(stream | "file")* means a stream number or a filename between double-quotes (but not both) can be used in the command.
13.2 COMMANDS: SUMMARY

13.2.1 VIEWING COMMANDS

- `^[format]`: Display contents of preceding memory location.
- `exp`: Print value of expression using /n format.
- `exp @ format`: Print address of expression `exp` in format `format`.
- `exp/format`: Print value of expression `exp` in format `format`.
- `line`: Move viewing position to line `line`.
- `clear`: Clear the Command Output Window.
- `number ct`: Display a source-level trace corresponding to the last number of machine instructions executed. This command is not available for all execution environments.
- `number ct i`: Display a disassembled assembly-level trace corresponding to the last number of machine instructions executed. This command is not available for all execution environments.
- `number ct r`: Display a raw trace corresponding to the last number of trace frames. This command is not available for all execution environments.
- `e [func | file]`: Enter function `func` or file `file` or view current viewing position.
- `stack e`: Enter function using stack address.
- `[addr] ei`: View current viewing position or view instruction at address `addr`.
- `f ["printf-style-format"]`: Change default address display format.
- `gus {on | off}`: Suppress or reactivate CrossView Pro window updating.
- `L`: Synchronize the viewing position with the execution position. Print current file, function and line number.
l {a|b|d|f|g|k|l|m|p|r}s [string]  
List assertions, breakpoints, directories, files, globals, kernel state data, labels (on module scope), all labels, memory map (of application code sections), procedures, registers, special variables, symbol tables. If given, only those starting with string.

l [func]  
List all parameters and locals of function func. Without a function, this command lists all parameters and locals of the current function in view.

l stack  
List all parameters and locals of function at depth stack.

nC  
Move viewing position to next covered line.

nU  
Move viewing position to next uncovered line.

opt [option [= value]]  
List or set option value. Without an argument, list all option values.

[line] P [exp]  
Print exp lines of source starting at line line, include machine addresses.

[line] p [exp]  
Print exp lines of source starting at line line.

pC  
Move viewing position to previous covered line.

pU  
Move viewing position to previous uncovered line.

[exp] T  
Trace the stack for exp number of levels, list local variables.

[exp] t  
Trace the stack for exp number of levels, printing active functions and parameters passed.

td  
Disable tracing.

te  
Enable tracing.

13.2.2 CODE AND DATA MONITORING

cd  
Disable, turn off, gathering of coverage information.

ce  
Enable, turn on, gathering of coverage information.
covinfo [[all | module_or_function_name][filename]]
   List coverage info.

cproinfo [all|filename] | {add | remove} function
   List cumulative profiling info or add or remove functions
   from the list of profiled functions.

dis address [, {address | #count} [,i]]
   Disassemble a range of memory.

dump address [, {address | #count} [, [style [width]] [, filename [,a]]]]
   Dump a memory range.

M
   Display list of monitored expressions in the Command
   window.

m exp
   Monitor the expression exp.

num m d
   Remove monitored expression labeled num.

addr_start mcp addr_end, addr_dest
   Memory copy.

addr mF exp[,exp]...
   Single fill memory address addr with expressions.

addr_start mf addr_end, exp[,exp]...
   Fill memory address range with expressions and repeat the
   pattern until the end address of the memory region is
   reached.

addr_start ms addr_end, exp[,exp]...
   Search memory address range for a given pattern.

pd
   Disable, turn off, profiling.

pe
   Enable, turn on, profiling.

proinfo [[all | module_or_function_name][filename]]
   List profiling info.
13.2.3 DATA ANALYSIS

**bufa** \( \text{target\_buffer\_name,added\_buffer\_name[size\_limit]} \)
Add the contents of buffer \( \text{added\_buffer\_name} \) to buffer \( \text{target\_buffer\_name} \).

**bufd** \( \text{buffer\_name} \)
Discard the specified buffer.

**graph** \( \text{"window","script"[arg]} \)
Create Data Analysis window and execute CXL script.

**graphm** \( \text{"window","script"[arg]} \)
Set the representation script for the window specified.

**graphmn** \( \text{"window","script"[arg]} \)
Similar to the **graphm** command, but without an update of the graph window.

**graphp** \( \text{"window",left\_top\_x,left\_top\_y,width,height} \)
Position the named window at the specified screen coordinates.

**graph_add_update** \( \text{"window",command} \)
Add \( \text{command} \) to the sequence of update commands for the specified window.

**graph_clear_updates** \( \text{"window"} \)
Clear the update commands associated with the specified window.

**graph_close** \( \text{"window"} \)
Close the specified window.

**graph_debug** \( \text{expression} \)
Enable the "graphical data window debugging mode", showing all communication between the scripts and the windows in the command window.

**memget** \( \text{expr,count,buffernname} \)
Retrieve symbolically specified data from the target system and store the data in the acquisition buffer.

**rawmemget** \( \text{address,type,count,buffernname [interleave]} \)
Retrieve data from the target system and store the data in the acquisition buffer.
update "window"
Update the window specified.

13.2.4 EXECUTION CONTROL COMMANDS

A [a | s] Toggle state of assertion mechanism.

a cmds Create a new assertion with the command list cmds.

exp a {a | d | s}
Activate, delete, suspend assertion exp.

B List all breakpoints.

[line] b [cmds]
Set breakpoint at source line line, and associate command list cmds with breakpoint.

[stack] bb [cmds]
Set breakpoint at beginning of function at stack level stack and associate command list cmds.

[stack] bB [cmds]
Set temporary breakpoint at beginning of function at stack level stack and associate command list cmds.

[number] bc [count] [reset_count]
Set breakpoint count and reset_count for breakpoint with number number.

count bCYC [cmds]
Set temporary breakpoint after the specified cycle count and associate command list cmds.

count bcyc [cmds]
Set breakpoint after the specified cycle count and associate command list cmds.

exp bD {r | w | b} exp2 [cmds]
Set a data range breakpoint (between addresses exp and exp2) read (r), write (w) or both read and write (b), and associate command list cmds. This command is not available for all execution environments.
exp bd {r | w | b} [cmds]
Set a data breakpoint, read (r), write (w) or both read and write (b) at address exp, and associate command list cmds. This command is not available for all execution environments.

num bdis
Disable code breakpoint.

num bena
Enable code breakpoint.

[addr] bl [cmds]
Set temporary breakpoint at machine instruction and associate command list cmds.

[addr] bi [cmds]
Set breakpoint at machine instruction and associate command list cmds.

count bINST [cmds]
Set temporary breakpoint after count machine instructions and associate command list cmds.

count binst [cmds]
Set breakpoint after count machine instructions and associate command list cmds.

break [type] where [, option]...
Universal breakpoint command. Several types of breakpoints are available. The meaning of where depends on the selected type. Breakpoint options must be separated by commas.

time bTIM [cmds]
Set temporary breakpoint after time number of seconds and associate command list cmds.

time btim [cmds]
Set breakpoint after time number of seconds and associate command list cmds.

[stack] bU [cmds]
Set a temporary up-level breakpoint at stack level stack and associate command list cmds.

[stack] bu [cmds]
Set up-level breakpoint at stack level stack and associate command list cmds.
[exp] C [line]  Continue execution from current value of program counter. If
line is specified, execution continues up to that line.
Breakpoint’s count is set to exp.

[exp] CB [line]  Continue execution in background from current value of
program counter. If line is specified, execution continues up
to that line. Breakpoint’s count is set to exp.
This command is not available for all execution
environments.

cxl ”script”  Execute a CXL script.

cxl_reset [”script”]  Reset all variables of all CXL scripts or of a specific CXL
script.

D  Delete all breakpoints.
Dy  Delete all breakpoints without prompt for confirmation.

[number] d  Delete breakpoint number.

cpu eC  Start execution on the current CPU and switch to cpu.
[cpu] ec  Select CPU or show current CPU number.

g line  Go to the specified line in the current procedure.

address gi  Go to the specified address.

if (exp) {cmds} [{cmds}]  Conditionally execute commands.

prst  Reset program counter.
Q  Report breakpoint quietly.
q [y]  Quit debugger (do not save desktop settings).
q s  Save current desktop settings and quit debugger.
R  Reset program counter and start execution.
rst  Reset target system to initial conditions.

[exp] S  Single step for exp lines, step over function calls.
\[\text{[exp]} \text{ s} \quad \text{Single step for exp lines, step into function calls.}\]
\[\text{[exp]} \text{ Si} \quad \text{Single machine step for exp machine instructions, step over subroutine calls.}\]
\[\text{[exp]} \text{ si} \quad \text{Single machine step for exp machine instructions, step into subroutine calls.}\]
\[\text{st} \quad \text{Stop the execution of the target immediately.}\]
\[\text{This command is not available for all execution environments.}\]
\[\left[\text{interval}\right] \text{ u | d | k | r | s | a | mem | t} \quad \text{Toggles updating of the appropriate window when the target runs in the background. You can specify the update interval, in seconds. If interval is zero, never update automatically. This command is not available for all execution environments.}\]
\[\text{ubgw} \left[\text{s | a | k | r | d | mem | t | all}\right] \quad \text{Refresh the appropriate window, or all open windows, when the target runs in the background. This command is not available for all execution environments.}\]
\[\text{use [path]...} \quad \text{Clear source directory search path or use the specified path to search for source files.}\]
\[\text{wt} \quad \text{Wait for the completion of the target.}\]
\[\text{This command is not available for all execution environments.}\]
\[\text{[exp]} \text{ x} \quad \text{Force an exit from assertion mode. If exp is non-zero, finish executing command list of the current assertion.}\]

### 13.2.5 RECORD & PLAYBACK

\[<\text{file}] \quad \text{Play back commands from file.}\]
\[<<\text{file}] \quad \text{Play back commands with single step from file.}\]
\[>\text{file}] \quad \text{Record CrossView Pro commands in file.}\]
\[>{\text{t|f|c}]} \quad \text{Set recording file status, true (t), false (f) or closed (c).}\]
> Report status of command recording mechanism.

>\#file Record emulator commands in file.

>\#{t|f|c} Set emulator recording file status, true (t), false (f) or closed (c)

>@file Record CrossView Pro and emulator commands in file.

>@{t|f|c} Set CrossView Pro/emulator recording file status, true (t), false (f) or closed (c)

>>file Log commands and screen output in file.

>>{t|f|c} Set logging file status, true (t), false (f) or closed (c)

>> Report status of command and screen output logging mechanism.

>&file Log host-to-target communication in file. Not available for all execution environments.

>&{t|f|c} Turn target communication logging on (t), off (f) or close (c) log file. Not available for all execution environments.

>& Report status of target communication logging mechanism. Not available for all execution environments.

>*file Log GDI accesses in file.

>*{t|f|c} Set GDI accesses log file status, true (t), false (f) or closed (c)

### 13.2.6 MACROS

**echo string** Display macro expansion of string.

**save file** Save current macros to file.

**set** Display all macros.

**set macro ”cmds”** Define macro macro as command list cmds.

**unset** Delete all macros.
unset macro!
    Delete definition of macro macro.

macro!
    Prevent expansion of macro.

13.2.7 INPUT/OUTPUT SIMULATION

ios_open ["file",[mode][,[r]][,$xvw_variable]]]
    Open a CrossView Pro File I/O stream.

ios_wopen [["terminal_window"],[,$xvw_variable]]
    Open a CrossView Pro File I/O stream and map the stream to a terminal window.

ios_close {stream | "file"}
    Close a CrossView Pro File I/O stream.

ios_read {stream | "file"},address,number_of_maus,[x]
    Read binary data from a File I/O stream. Optionally, interpret the read data as hexadecimal values.

ios_readf {stream | "file"},"format",expression
    Formatted read from a File I/O stream (scanf).

ios_write {stream | "file"},address,number_of_maus,[x]
    Write binary data to a File I/O stream. Optionally, interpret the data as hexadecimal values.

ios_writef {stream | "file"},"format",expression
    Formatted write to a File I/O stream (printf).

ios_rewind {stream | "file"}
    Move File I/O file pointer to the beginning of the file.
13.2.8 FILE SYSTEM SIMULATION

FSS \{ < | > \} \{ &stream | "file" \}
Redirec to or from a stream or file.

FSS_stdio_open filename, rwdirection, streamnumber
Redirect the output of a stream to a file.

FSS_stdio_close streamnumber
Close the specified stream.

13.2.9 TARGET SYSTEM CONTROL

dcmp [file[,number_of_bits][,d]]
Compare an application file with the memory contents and display differences.

dn
Download the image part of the current absolute file, specified when CrossView Pro was invoked or loaded with the N command.

dn file
Download the image part of the absolute file file.

fa device_name, base_address, chip_width[,nr_of_chips]
Add FLASH device to list of configured FLASH devices.

fc device_number
Check the manufacturer and device identifiers of a FLASH device.

fd device_number
Delete FLASH device.

fl
List FLASH devices.

fp device_number
Get protection status of a FLASH device.

fpe device_number
Protect FLASH device.

fpd device_number
Unprotect FLASH device.
fw [address]  
Specify workspace address of FLASH programming monitor.

load [file]  
Load symbol table of file in CrossView Pro and download the image part to the target. This is a combination of N and dn.

N [file]  
Load symbol table of file in CrossView Pro.

n [addr]  
Set code address bias (for overlays) to addr. If no address is given, then display the current bias.

o [cmd]  
Enter transparency mode (exit with ctrl-D). If cmd is present, pass cmd to the execution environment. Not available for all execution environments.

! [command-line]  
Execute shell command command-line or invoke new shell.

13.2.10 SAVE AND RESTORE TARGET STATE

This feature is only available when it is supported by the debug instrument.

di_state open state_name  
Open the state with the specified state_name.

di_state save state_name, number  
Save the state of the debug instrument with the specified state_name and number.

di_state restore state_name, number  
Restore the state of the debug instrument with the specified state_name and number.

di_state close state_name, delete  
Close the state with the specified state_name. delete can be 1 to delete the state or use 0 to keep the state.

13.2.11 HELP COMMANDS

I  
Print information about debugger state.
13.2.12 SEARCH COMMANDS

Z  Toggle case sensitivity in searches.

/\[string\]  Search forwards in source file for string. If string is not present, perform previous search again.

?\[string\]  Search backwards in source file for string. If string is not present, perform previous search again.

"string"  Print string.

13.3 COMMANDS: DETAILED DESCRIPTIONS

The rest of this chapter provides the detailed descriptions of the CrossView Pro commands.
expression

Function

Print the value or address of an expression.

From the Data menu, select Evaluate Expression... Enter an expression and optionally select a display format. You may set up a monitor, which instructs the debugger to evaluate a particular expression each time the program stops, from the Source Window by selecting text there and by clicking on the Watch Expression button.

Enter the expression in the Command Window. You may specify in which format you want CrossView Pro to display the answer.

Description

In the Command Window, the syntax for this command is:

\[
\text{exp} \mid /\text{format} \mid @\text{format}
\]

Print the value or address of exp with format format. A / (slash) is used to print the value of exp and a @ (commercial at) is used to print the address of exp. If format is not supplied, the natural (/n) format of the expression is used.

Formats have the syntax:

\[
[count] style [size]
\]

count is the number of times to apply the format style and defaults to 1. style may be one of:

\[
a \ c \ D \ O \ U \ X \ d \ o \ u \ x \ E \ F \ G \ e \ f \ g \ i \ n \ P \ p \ s \ t
\]

See Chapter 6, Accessing Code and Data, and section 3.5 Formatting Expressions in Chapter 3, Command Language, for details on each of the format styles.

size indicates the number of bytes to be formatted. Rather than a number for the integer type styles, size can also be: c for char, s for short, i for int, and l for long.

The default action, if no modifier is specified, is to print the value of exp using the /n (normal) format.
Be careful with one letter variable names, as they may be taken as an CrossView Pro command rather than as a variable. If an expression begins with a variable that might be mistaken for a command, then eliminate any white space between the variable and the first operator. For example: use h=9 instead of h = 9.

To display the value of a variable that has the same name as an CrossView Pro command you must use the natural format modifier. For example: to print the value of the variable C, use C/n.

Variables may be altered as a side effect of evaluation of exp. See the example below.

Example
To set variable aux to t times 8, type:

```
aux = t++*8
```

As a side effect the variable t is post-incremented. If you type:

```
$s\_aux = func(t,s)
```

CrossView Pro will set special variable $s\_aux to the result of the function call to func with the variables t and s passed as parameters. If you type:

```
$s\_aux/x4
```

Print the value of the special variable $s\_aux as four hex bytes; you could also use: $s\_aux/x1.
## line

### Function
Display the C source line numbered \( line \) in the current source file.

1. From the **Edit** menu, select **Find Line...** Enter the line number and click on the **Find** button. Alternately, you may click on the desired source line in the Source Window.

2. Enter the line number in the Command Window. The syntax is:

   \[
   line
   \]

### Description
The current viewing position becomes \( line \).

### Example
To display the twelfth line in the current source file, type:

\[
12
e, p, P
\]
**string**

*Function*

Echo a string to the terminal.

- Enter the string to the Command Window.

*Description*

A string may contain standard C escapes, such as \n for a newline. The syntax for a string in the Command Window is:

"*string*"

*Example*

This function can be useful for labelling breakpoints. For example, to insert a breakpoint at line 12 and have a message printed when that line is reached, enter:

```
12 b {"At the twelfth line\n"; C}
```

When CrossView Pro reached line 12, the message “At the twelfth line” will be printed and the program will continue. If you only type:

"*Debug*"

CrossView Pro will simply echo the word “Debug.”

Q, *expression*
Function

Instruct CrossView Pro to interpret a command literally, ignoring any macro definitions of the same name. Also, enter a shell command.

The syntax for this command is:

\[ \text{[string]} \] !

or:

! [string]

Description

This command is useful whenever string should be treated literally and not as a potential macro invocation. It can be used, for example, in executing an CrossView Pro command whose name has been defined as a macro.

Example

To enter the host environment under a new shell, type:

!  

To execute the host date command, type:

!date

To execute the CrossView Pro command b instead of the macro named b, type:

b!

set, unset, echo, save
Function
Search down (forward) for a string.

To search for a string in the Source Window, select **Search String...** from the **Edit** menu and select the **up** radio button. To repeat your search click on the **Find Next Text String** button.

The command line syntax is:

```
/ [ string ]
```

Description
The search begins with the line after the current line. If the string is found the viewing position is changed to the line containing the string. The execution position is not affected. If you do not specify a string to search for, CrossView Pro will look for the most recent specified string.

Searches wrap around to the beginning of the file. Regular expressions are not recognized.

Example
To look for the next occurrence of **Random** in the current file, beginning with the line after the current line, type:

```
/Random
```

? Z
Function

Search up (backward) for a string.

To search for a string in the Source Window, select select **Search String...** from the **Edit** menu and select the **down** radio button. To repeat your search click on the **Find Next Text String** button.

The command line syntax is:

```
? [ string ]
```

Description

The search begins with the line before the current line. If string is found, the current line is changed to point to the line containing the string. The execution position is not affected. If you do not specify string, CrossView Pro searches for the previously-specified string again.

Searches wrap around to the end of the file. Regular expressions are not recognized.

Example

To look for the previous occurrence of Random in the current file, beginning with the line above the current line, type:

```
?Random
```

```
/, Z
```
Function

Continuous command playback. Read commands continuously from a file.

To setup command playback, select **Playback | CrossView...** from the **Tools** menu. Enable the **Continuous playback** check box and click on the **Execute** button.

The command line syntax is:

```
< file
```

Description

All the commands in *file* will be read and executed. If a playback file contains either a `<` or `<<` command, playback switches to the newly specified file and returns to the original file. The first playback file determines the type of playback: continuous or single step.

Record and playback options can also be specified via command line parameters.

If the execution of commands from the playback file is interrupted with the **Halt** button, CrossView Pro will begin reading the remainder of commands in file using single step playback (see the `<<` command.)

Example

To read and execute the commands found in the file *command.cmd*, type:

```
<command.cmd
```

```
<<, >, I
```
Function

Single-step command playback.

To setup command playback, select **Playback | CrossView...** from the **Tools** menu. Disable the **Continuous playback** check box and click on the **Execute** button.

The command line syntax is:

```
<<file
```

Description

Commands will be played back one at a time. Each command will be loaded sequentially into the entry field of the Command Window. The command can then be edited and executed. If a playback file contains either a `<` or `<<` command, playback switches to the newly specified file and returns to the original file. The first playback file determines the type of playback: continuous or single step.

The carriage return will execute the current command and stop at the next one.

If a playback file contains either a `<` or `<<` command, playback switches to the newly specified file and does not return to the original file. Record and playback options can also be specified via command line parameters.

Example

To read and execute the commands found in the file `command.cmd`, type:

```
<< command.cmd
```

`<, >, I`
**Function**

Record CrossView Pro commands to a file.

To start recording or toggle the state of the command recording mechanism, select **Record | CrossView...** from the **Tools** menu. Type or select a file to record commands in and click on the **Start** button to start recording. To suspend recording click on the **Suspend** button. To resume recording click on the **Resume** button. To stop recording click on the **Stop** button.

The command line syntax is (note that the greater than sign must be typed as shown):

```
> [ ! ] [ file | t | f | c ]
```

**Description**

CrossView Pro will start recording commands in a file if `file` is specified, otherwise, turn recording on (t), off (f), or close (c) the recording file. Specifying a different file while recording is on will cause the old output file to be closed and all successive commands will be sent to the new file. If no arguments are given, the state of the recording mechanism will be displayed.

The optional '!' forces flushing of the output after every write.

The commands recorded can be played back by using the `<` or `<<` command. It is possible to have a command recording file and a screen output recording file to be open concurrently. The file is also closed as a side effect of the `q` command.

Commands issued to the emulator under transparency mode are not recorded.

Files may not be named: t, f or c.

**Example**

To set (or change) the command recording file to `command.cmd` and turn command recording on, type:

```
> command.cmd
```
To suspend recording commands, type:

> f

To resume recording the commands to the recording file, type:

> t

To stop recording commands and close the file, type:

> c

To display the state of the recording mechanism, type:

> 

>> , >&, <, <<, I, q
Function

Record CrossView Pro and emulator commands to a file.

To start recording or toggle the state of the command recording mechanism, select **Record | CrossView...** from the **Tools** menu. Type or select a file to record commands in, select **Include emulator commands** and click on the **Start** button to start recording. To suspend recording click on the **Suspend** button. To resume recording click on the **Resume** button. To stop recording click on the **Stop** button.

The command line syntax is (note that the greater than sign must be typed as shown):

```bash
>@[ ! ] [ file | t | f | c ]
```

Description

CrossView Pro will start recording commands in a file if `file` is specified, otherwise, turn recording on (`t`), off (`f`), or close (`c`) the recording file. Specifying a different file while recording is on will cause the old output file to be closed and all successive commands will be sent to the new file. If no arguments are given, the state of the recording mechanism will be displayed.

The optional `!` forces flushing of the output after every write.

The commands recorded can be played back by using the `<` or `<<` command. It is possible to have a command recording file and a screen output recording file to be open concurrently. The file is also closed as a side effect of the `q` command.

Commands issued to the emulator under transparency mode are also recorded, but each command is preceded by the `o` command.

Files may not be named: `t`, `f` or `c`.

Example

To set (or change) the command recording file to `command.cmd` and turn command recording on, type:

```bash
>@command.cmd
```
To suspend recording commands, type:

>`@f`

To resume recording the commands to the recording file, type:

>`@t`

To stop recording commands and close the file, type:

>`@c`

> , >#, >>, >& , <<, I, q
Function

Record emulator commands to a file.

To start recording or toggle the state of the command recording mechanism, select Record | Emulator... from the Tools menu. Type or select a file to record commands in and click on the Start button to start recording. To suspend recording click on the Suspend button. To resume recording click on the Resume button. To stop recording click on the Stop button.

The command line syntax is (note that the greater than sign must be typed as shown):

>`# [ ! ] [ file | t | f | c ]`

Description

CrossView Pro will start recording emulator commands in a file if file is specified, otherwise, turn recording on (t), off (f), or close (c) the recording file. Specifying a different file while recording is on will cause the old output file to be closed and all successive commands will be sent to the new file. If no arguments are given, the state of the recording mechanism will be displayed.

The optional '!' forces flushing of the output after every write.

The emulator commands recorded can only be played back by selecting Playback | Emulator... from the Tools menu. It is possible to have a command recording file and a screen output recording file to be open concurrently. The file is also closed as a side effect of the q command.

Files may not be named: t, f or c.

Example

To set (or change) the emulator command recording file to emu.cmd and turn command recording on, type:

>`# emu.cmd`
To suspend recording emulator commands, type:

`>f`

To resume recording the emulator commands to the recording file, type:

`>t`

To stop recording emulator commands and close the file, type:

`>c`

> , >>, >&, <, <<, I, q
Function

Log Command Window screen output. All Command Window input and output will be saved to a file.

To create a log of Command Window screen output, select Log | Command Input/Output... from the Tools menu. Type or select a file to log to and click on the Start button to start logging. To suspend logging click on the Suspend button. To resume logging click on the Resume button. To turn off logging click on the Stop button.

The command line syntax is:

```
>> [ ! ] [ file | t | f | c ]
```

Description

Start logging the commands typed and their output in a file if file is specified, otherwise, turn logging on (t), off (f), or close (c) the log file. Specifying a different file while logging is on will cause the old output file to be closed and all successive Command window output will be sent to the new file. If no arguments are given, the state of the recording and logging mechanism is displayed.

The optional '!' forces flushing of the output after every write.

Because output is logged as well as commands, files logged using >> cannot be played back like those recorded with the > command.

It is possible to have both a command recording file and a screen output logging file open concurrently. The log file is also closed as a side effect of the q command. Log files may not be named: t, f or c.

Example

To set (or change) screen output recording file to the file screen.log and turn screen output recording on, type:

```
>>screen.log
```

To suspend recording the screen output, type:

```
>>f
```
To resume recording the screen output in the recording file, type:

`<<<t`

To stop recording the screen output and close the file, type:

`<<<c`

To display the state of the recording mechanism, type:

`<<<`
Function

Log communications between debugger and emulator.

To save debugger/emulator communications, select Log | CrossView-Emulator I/O... from the Tools menu. Type or select a file to log to and click on the Start button to start logging. To suspend logging click on the Suspend button. To resume logging click on the Resume button. To turn off logging click on the Stop button.

The command line syntax is:

```
>& [ ! ] [ file | t | f | c ]
```

Description

Start host-to-execution environment communication logging in a file if file is specified; otherwise, turn logging on (t), off (f), or close (c) the log file. This feature is most often used to diagnose problems with CrossView Pro itself.

The optional '!' forces flushing of the output after every write.

The commands captured cannot be played back the way commands recorded by the > command can. The log file is also closed as a side effect of the q command.

Not available for all execution environments.

Example

To open the file out.log and put the following host-to-emulator communications in this file, type:

```
>&out.log
```

To suspend logging communications in the log file, type:

```
>&f
```

To resume logging communications in the log file, type:

```
>&t
```
To stop logging communications and close the file, type:

```
>&c
>, >>, q
```
**Function**

Log GDI accesses.

To save GDI accesses, select Log | CrossView-GDI Accesses... from the Tools menu. Type or select a file to log to and click on the Start button to start logging. To suspend logging click on the Suspend button. To resume logging click on the Resume button. To turn off logging click on the Stop button.

The command line syntax is:

```
>* [!] [file | t | f | c]
```

**Description**

Start GDI accesses logging in a file if file is specified; otherwise, turn logging on (t), off (f), or close (c) the log file. This feature is most often used to diagnose problems with the Debug Instrument.

The optional '!' forces flushing of the output after every write.

The commands captured cannot be played back the way commands recorded by the > command can. The log file is also closed as a side effect of the q command.

**Example**

To open the file gdi.log and start logging GDI accesses in this file, type:

```
>*gdi.log
```

To stop logging GDI accesses and close the file, type:

```
>*c
```

>`>, >>, q
Function
Display contents of preceding memory location based on the size of the last data item displayed.

The command line syntax is:

```
^ [ format ]
```

Description
Use previous format or `format`, if supplied. Formats have the syntax:

```
[count] style [size]
```

`count` is the number of times to apply the format `style` and defaults to 1. `style` may be one of:

```
 a c D O U X d o u x E F G e f g i I n P p s t
```

See Chapter 6, *Accessing Code and Data*, and section 3.5 *Formatting Expressions* in Chapter 3, *Command Language*, for details on each of the format styles.

`size` indicates the number of bytes to be formatted. Rather than a number for the integer type styles, `size` can also be: `c` for char, `s` for short, `i` for int, and `l` for long.

This command is most often used in combination with `exp/format` to look at the value of some variable or memory location.

Example
To display the variable `aux` as two octal values of length two, type:

```
^ aux/2o2
```

To show the eight bytes before `aux` in hexadecimal format, next type:

```
^2x4
```

`expression`
**A**

**Function**

Toggle the state of the assertion mode.

To activate or suspend assertion mode, select **Assertions...** from the Breakpoints menu, and enable or disable the **Assertion Mode Active** check box.

The command line syntax is:

\[
A \ [ \ a \ | \ s \ ]
\]

**Description**

Activate (\(A \ a\)) or suspend (\(A \ s\)) overall state of the assertion mechanism. If no operand is given, toggle the state.

**Example**

To activate the assertion mechanism, type:

\[
A \ a
\]

To suspend the assertion mechanism, type:

\[
A \ s
\]

To toggle the state of the assertion mechanism, simply type:

\[
A \ a
\]
a

Function
Define or modify an assertion.

From the Breakpoints menu, select Assertions... to open the Assertions dialog box. Click the New... button to define an assertion. Select an assertion and click the Edit... button to modify an assertion.

The command line syntax is:

\[
\text{exp a } \{ \text{a | d | s} \}
\]

\[ \text{a cmds} \]

Description
The a command is used to invoke two different commands. The syntax for each command is distinct. The first version allows modification of the state of the assertion specified by the expression exp. (The assertion can be activated (a a), deleted (a d) or suspended (a s).) The second version creates a new assertion with the given command list cmds. Using the mouse, you can create a new assertion or toggle the state of an existing one from the Assertions dialogue box.

Suspended assertions continue to exist, but are not active. Deleted assertions must be explicitly redefined in order to be made active again.

The commands for every active assertion are executed after every source statement is executed. The x command in an assertion command list forces an exit from assertion mode.

This command is not allowed when the target runs in the background.

Example
To suspend assertion 3, type:

\[ 3 \text{ a s} \]

To delete assertion 1, type:

\[ 1 \text{ a d} \]
To set an assertion to stop the program when global variable \texttt{myvar} exceeds 3, type:

\begin{verbatim}
  a  if (myvar > 3) {x}
\end{verbatim}
**B**

**Function**

List all of the currently defined breakpoints.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box.

The command line syntax is:

```
B
```

**Description**

Breakpoints are listed with numbers associated with them. These numbers can be used to delete individual breakpoints.

```
break, b, bb, B, bi, bi, bu, bU, R, C, D, l
```
Function

Set a code breakpoint.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Add Code Breakpoint dialog. Enter the name of the source module or click the Break At... button to select a source module and enter a line number.

Alternatively, you can set a code breakpoint directly in the source by clicking on a green breakpoint toggle next to the source line.

The command line syntax is:

```
[line] b [commands]
```

Description

You can attach a list of CrossView Pro commands with the breakpoint. If no line is given, set the breakpoint at the current viewing position.

When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the b command.

Example

To set a breakpoint at the current line, type:

```
b
```

To set a breakpoint at line 10 that will list all global variables and halt execution, type:

```
10 b {l g}
```

`break, bd, bD, bdis, beena, bb, bB, bi, bt, bti, bti, bu, bU, Q`
**bB**

**Function**

Set a temporary breakpoint at the beginning of a function.

In the Stack Window, click on the desired function and select **Stack Breakpoint | At Function Entry** from the **Breakpoints** menu.

The command line syntax is:

```
[ stack ] bB [ cmds ]
```

**Description**

The function is designated by the stack level `stack`. If no function is specified, CrossView Pro uses the current function (stack level 0), and associates the list of CrossView Pro commands `cmds` with the breakpoint.

Breakpoints set in the Stack Window are always temporary, meaning they will be deleted after the first time you reach them. A breakpoint set in this manner will not be visible in the Source Window.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the `bB` command.

This command is not allowed when the target runs in the background.

**Example**

To set a temporary breakpoint at the beginning of the current function which prints a stack trace, type:

```
bB {T}
```

To set a temporary breakpoint at the beginning of the function whose stack number is 2, type:

```
2 bB
```

**break, b, bb, bd, bD, bi, bt, bti, btI, bu, bU, Q**
**bb**

**Function**

Set a permanent breakpoint at the beginning of a function.

In the Stack Window, click on the desired function and select **Stack Breakpoint | At Function Entry** from the **Breakpoints** menu. To make the stack breakpoint permanent, select **Breakpoints...** from the **Breakpoints** menu, select the desired breakpoint and click on the **Edit...** button. The Edit Code Breakpoint dialog appears. Click on the **Advanced>>** button and disable the **Remove when hit** check box.

The command line syntax is:

```
[ stack ] bb [ cmds ]
```

**Description**

Set a breakpoint at the beginning of the function designated by the stack level `stack`. Otherwise, use the current function (stack level 0), and associate the list of CrossView Pro commands `cmds` with the breakpoint.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the `bb` command.

This command is not allowed when the target runs in the background.

**Example**

To set a breakpoint at the beginning of the current function, which prints a stack trace, type:

```
bb {T}
```

To set a breakpoint at the beginning of a function whose stack number is 2, type:

```
2 bb
```

`break, b, BB, bd, BD, bi, bi, bt, bti, bti, bu, bU, Q`
bc

Function
Set a breakpoint’s count and reset count.

From the Breakpoints menu, select Breakpoints... , select the breakpoint for which you want to set the count and reset count and click on the Edit... button. The Edit Code Breakpoint dialog appears. Click on the Advanced button and enter a breakpoint count.

The command line syntax is:

```
[ number ] bc [ count ] [ reset_count ]
```

Description
Set the count and reset_count for the breakpoint with breakpoint number number. When no arguments are given, the breakpoint at the current viewing position is set to a count of 1 and a reset count of 1. If no breakpoint is present at the current viewing position, the message "No such breakpoint" appears.

Each time a breakpoint is hit, CrossView Pro decrements the count. When the count reaches 0, execution is halted and the count is reset to the reset_count.

This command is not allowed when the target runs in the background.

Example
To set a breakpoint’s count and reset count to 1 for the breakpoint at the current viewing position, type:

```
bc
```

To set the count to 3 and the reset count to 4 for the breakpoint whose breakpoint number is 2, type:

```
2 bc 3 4
```

break, C
**bCYC**

**Function**
Set a temporary cycle count breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Cycle Breakpoint...** to open the Add Cycle Breakpoint dialog. Click the **Advanced** button and enable the **Remove when hit** check box.

The command line syntax is:

```
count bCYC [cmds]
```

**Description**
Set a temporary breakpoint after the specified cycle `count`. `count` can be any expression evaluating to a number. The list of CrossView Pro commands `cmds` are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bCYC** command.

**Example**
To set a temporary breakpoint after 4 clock cycles and list all global variables, type:

```
4 bCYC {l g}
```

**break, b, bcyc, bINST, binst, bTIM, btim, D**
bcyc

Function
Set a permanent cycle count breakpoint.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Cycle Breakpoint... to open the Add Cycle Breakpoint dialog. Enter a cycle count and click the OK button.

The command line syntax is:

\[ \text{count bcyc [cmds]} \]

Description
Set a permanent breakpoint after the specified cycle count. \text{count} can be any expression evaluating to a number. The list of CrossView Pro commands \text{cmds} are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bcyc command.

Example
To set a cycle count breakpoint after 4 clock cycles and list all global variables, type:

\[ 4 \text{ bcyc \{l g\}} \]

\text{break, b, bCYC, bINST, binst, bTIM, btim, D}
Function

Set a read and/or write data breakpoint over a range of addresses.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Data Breakpoint... to open the Add Data Breakpoint dialog. Enter an address or click the Address... button to select a symbol to use as the address. Click the Advanced button. Enter an address in the End adress field or click the Browse... button to select a symbol to use as the end address. Click the OK button to add the data breakpoint.

The command line syntax is:

```
exp1 bD { r | w | b } exp2 [cmds]
```

Description

Set a read, write, or both (read and write) data breakpoint in the address range `exp1` to `exp2` and associate the list of CrossView Pro commands `cmds` with the breakpoint.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bD command.

If `exp1` is the address of a local (stack) variable, the function in which it was declared must be currently active on the stack. If the local variable corresponding to a data breakpoint goes out of scope due to a return from the function in which it is currently active, the data breakpoint will be removed and a message will be printed telling the user that the variable is no longer active.

Not available for all execution environments.

Example

To set a data breakpoint that includes the entire structure `rec1`, type:

```
&rec1 bD r (int)&rec1+sizeof(rec1)-1
```
This breakpoint will be hit only if any address in the range of addresses is read from.

To set a data breakpoint for the address range 10 to 10f hex (256 bytes) that will list all global variables, type:

```
0x10 bd b 0x10f {lg;}
```

This breakpoint will be hit if any memory locations within the range 10-10f hex are either read from or written to.

```
break, b, bb, bB, bd, bi, bi, bt, bti, bti, bu, bU, Q
```
**bd**

**Function**

Set a read and/or write data breakpoint at an address.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Data Breakpoint...** to open the Add Data Breakpoint dialog. Enter an address or click the **Address...** button to select a symbol to use as the address. Click the **OK** button to add the data breakpoint.

The command line syntax is:

```
exp  bd  { r | w | b }  [cmds]
```

**Description**

Set a read, write or both (read and write) data breakpoint at the address specified by *exp* and associate the list of CrossView Pro commands *cmds* with the breakpoint.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bd** command.

If *exp* corresponds to a local (stack) variable, the function in which it was declared must be currently active on the stack. If the local variable corresponding to a data breakpoint goes out of scope due to a return from the function in which it is currently active, the data breakpoint will be removed and a message will be printed telling you that the variable is no longer active.

Not available for all execution environments.

**Example**

To set a breakpoint at the variable count which will all be hit only if the variable is read from memory, type:

```
&count bd r
```
Note that the breakpoint only acts on the lowest byte in memory of this variable.

To set a breakpoint at address 10 hex that will list all global variables, type:

```
0x10 bd b {l g}
```

This breakpoint will be hit if address 10 hex is either read from or written to.

```
break, b, bb, bB, bD, bi, bt, bti, btl, bu, bU, Q
```
**bdis**

**Function**

Disable code breakpoint.

ɐ From the *Breakpoints* menu, select *Breakpoints...* On Windows toggle the check box in front of the breakpoint to enable or disable the breakpoint. On UNIX select the breakpoint and click the *Enable* or *Disable* button.

ɐ The command line syntax is:

```
number bdis
```

**Description**

Disable the code breakpoint associated with the given *number*.

This does not delete the code breakpoint. It disables the code breakpoint until you enable it again with the *bena* command.

This command does not work on data breakpoints, only on code breakpoints.

**Example**

To disable code breakpoint number 3, type:

```
3 bdis
```

Break, b, bena, D
bena

Function
Enable code breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** On Windows toggle the check box in front of the breakpoint to enable or disable the breakpoint. On UNIX select the breakpoint and click the **Enable** or **Disable** button.

The command line syntax is:

```
number  bena
```

Description
Enable the code breakpoint associated with the given `number`, which was previously disabled by the `bdis` command.

This command does not work on data breakpoints, only on code breakpoints

Example
To enable code breakpoint number 3, type:

```
3  bena
```

**break, b, bdis, D**
**bl**

**Function**

Set a temporary low-level breakpoint at a machine instruction.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Code Breakpoint...** to open the Add Code Breakpoint dialog. Edit the **Break At...** field. In the Advanced dialog enable the **Remove when hit** check box.

The command line syntax is:

```
[addr] bI [cmds]
```

**Description**

Set a temporary breakpoint at the machine instruction at address `addr`, or the current viewing position’s address if `addr` is not specified; the list of CrossView Pro commands `cmds` are executed when the breakpoint is hit.

Make sure that `addr` is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bI** command.

**Example**

To set a temporary breakpoint at the current viewing position’s address, type:

```
bI
```

To set a temporary breakpoint at address 100 that will print the addresses of the next five source statements, type:

```
100 bI {P 5}
```

**break, b, bb, bB, bd, bD, bi, bt, bti, btI, bu, bU, Q**
bi

Function

Set a permanent low-level breakpoint at a machine instruction.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Add Code Breakpoint dialog. Edit the Break At... field. In the Advanced dialog disable the Remove when hit check box.

Alternatively, you can place a breakpoint in the intermixed window or assembly window by double clicking on the desired instruction.

The command line syntax is:

\[[addr] bi [cmds]\]

Description

Set a permanent breakpoint at the machine instruction at address \(addr\), or the current viewing position’s address if \(addr\) is not specified; the list of CrossView Pro commands \(cmds\) are executed when the breakpoint is hit.

Make sure that \(addr\) is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the bi command.

Example

To set a breakpoint at the current viewing position’s address, type:

\[bi\]

To set a breakpoint at address 100 that will print the addresses of the next five source statements, type:

\[100 bi \{P 5\}\]
**bINST**

**Function**

Set a temporary instruction count breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Instruction Breakpoint...** to open the Add Instruction Breakpoint dialog. Type a value in the **Instruction count** field and enable the **Remove when hit** check box in the Advanced dialog.

The command line syntax is:

```
count bINST [cmds]
```

**Description**

Set a temporary breakpoint after the specified `count` number of machine instructions have been executed. `count` can be any expression evaluating to a number. The list of CrossView Pro commands `cmds` are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the `bINST` command.

**Example**

To set a temporary breakpoint after execution of 5 instructions and list all global variables, type:

```
5 bINST {l g}
```

**break, b, bCYC, bcyc, binst, bTIM, btim, D**
binst

Function

Set a permanent instruction count breakpoint.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Instruction Breakpoint... to open the Add Instruction Breakpoint dialog. Type a value in the Instruction count field and disable the Remove when hit check box in the Advanced dialog.

The command line syntax is:

\[ \text{count binst [cmds]} \]

Description

Set a permanent breakpoint after the specified count number of machine instructions have been executed. count can be any expression evaluating to a number. The list of CrossView Pro commands cmds are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the binst command.

Example

To set a permanent breakpoint after execution of 5 instructions and list all global variables, type:

\[ 5 \text{ binst } \{l \ g\} \]

break, b, bCYC, beyc, bINST, bTIM, btim, D
**break**

**Function**

Universal breakpoint command.

From the Breakpoints menu, select Breakpoints... to add/remove/enable/disable breakpoints.

The general command line syntax is:

```
break [type] where [, option]...
```

**Description**

This is a universal breakpoint command.

type can be one of: code | data | instructions | cycles | time | sequence | set | delete | enable | disable. The type can be abbreviated. So, t | ti | tim | time are the same. When the type field is not specified the type defaults to code.

Depening on the type field the where field will evaluate to an address, count, name, breakpoint number or a sequence.

The available options are listed below.

**Code breakpoints**

Syntax:

```
break code address [, option]...
```

address can be any expression evaluating to an address.

**Data breakpoints**

Syntax:

```
break data address [, option]...
```

address can be any expression evaluating to an address.
In the document, it seems there is a misunderstanding. The content provided appears to be about command-line instructions for setting breakpoints, which are typically used in debugging tools to halt program execution at specific points. However, the text seems to be referring to programming syntax and not to natural language content. Here is a corrected and more naturally written version of what could be intended:

**Instruction count breakpoints**

Syntax:

```
break instructions count [, option]...
```

*count* can be any expression evaluating to the number of instructions.

**Cycle count breakpoints**

Syntax:

```
break cycles count [, option]...
```

*count* can be any expression evaluating to the number of cycles.

**Timer breakpoints**

Syntax:

```
break timer time [, option]...
```

*time* can be any expression evaluating to a time value. Depending on the setting of the *timer_unit* option this value is in seconds or timer ticks (default is in seconds).

**Sequence breakpoints**

Syntax:

```
break sequence sequence [, option]...
```

*sequence* is a combination of breakpoints.

**Set/change breakpoint attributes**

Syntax:

```
break set bp_number | bp_name [, option]...
```

*bp_number* is the breakpoint number. If the breakpoint has a name (*bp_name*) you can use this name instead of a number.
Delete breakpoint attributes

Syntax:

\[
\text{break delete } bp\_number \mid bp\_name \mid \text{all } [, \text{option}]...
\]

*bp_number* is the breakpoint number. If the breakpoint has a name (*bp_name*) you can use this name instead of a number.

Enable/disable breakpoints

Syntax:

\[
\text{break enable } bp\_number \mid bp\_name
\]
\[
\text{break disable } bp\_number \mid bp\_name
\]

*bp_number* is the breakpoint number. If the breakpoint has a name (*bp_name*) you can use this name instead of a number.

Options

- **name=str**
  Change/set the name of a breakpoint. Note that when a name of a breakpoint which name is used in a sequence is changed the name in the sequence is not automatically changed.

- **temporary=[bool]**
  Single shot breakpoint, temporary breakpoints are deleted after they are hit.

- **enabled=[bool]**
  Enable or disable a breakpoint.

- **curr_count=expr**
  Set current count.

- **reset_count=expr**
  Set reset count.

- **count=expr**
  Set current and reset count of a breakpoint.
access_type=r | w | rw

Set the access type of a data breakpoint: read (r), write (w) or read/write (rw).

addr=expr

Set the (start)address for a code or data breakpoint.

value=expr

set the value for a data breakpoint.

method=hardware | software | none

Set the breakpoint method.

probe_point=bool

Treat the breakpoint as a probe point. When a probe point is hit, the associated commands are executed and program execution is continued. Probe points do not update CrossView Pro windows.

size=expr

Length of a data or code breakpoint (end_addr = begin_addr+size-1).

end_addr=expr

The end address of a range is inclusive.

end_value=expr

The end value is inclusive.

value_is_absolute=bool

For instructions and cycles breakpoints only, the specified value is an absolute count, breakpoint will hit when count has value, otherwise repeat every number of instructions.

commands={ commands }

Set breakpoint commands.

timer_unit=seconds | ticks

The specified timer value is in seconds or ticks.
bool

1 | 0 | true | false

True/false, case insensitive.

expr

Appropriate CrossView expression.

Example

To set a code breakpoint at an address range, type:

break code code:0x10, end_addr=code:0x1f

To set a code breakpoint at an address range by specifying a size, type:

break code:0x10, size=0x10

To set a code breakpoint with a name, type:

break code:0x10, name=brk_1

To disable the breakpoint with name brk_1, type:

break dis brk_1

To set a cycle count breakpoint and treat the value as an absolute count, type:

break cycles 1000, value_is_absolute

Chapter 7, Breakpoints.
**bt**

**Function**

Set a task aware code breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Code Breakpoint...** to open the Code Breakpoint dialog. Fill in the **Task ID** field.

The command line syntax is:

```
[line] bt "TaskId" [cmds]
```

**Description**

Set a task aware code breakpoint at the specified source *line* and associate the list of CrossView Pro commands *cmds* with the breakpoint. If no line is given, set the breakpoint at the current viewing position. The **TaskId** is the identification of the task as displayed in the Tasks Window or specified by the **lk** command.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next, any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bt** command.

**Example**

To set a breakpoint for task 4 at the current viewing position, type:

```
bt "4"
```

To set a breakpoint for task 4 at line 10, which lists all global variables, type:

```
10 bt "4" {l g}
```

**break, b, bb, bB, bd, bD, bi, bI, bti, btI, bu, bU, l, Q**
Function

Set a temporary low-level task aware breakpoint at a machine instruction.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Code Breakpoint dialog. Edit the Break At... field and fill in the Task ID field. In the Advanced dialog enable the Remove when hit check box.

The command line syntax is:

\[ \text{[addr]} \ btl \ "\text{TaskId}" \ [\text{cmds}] \]

Description

Set a temporary task aware breakpoint at the machine instruction at address \textit{addr}, or the current viewing position's address if \textit{addr} is not specified; the list of CrossView Pro commands \textit{cmds} are executed when the breakpoint is hit. The \textit{TaskId} is the identification of the task as displayed in the Tasks Window or specified by the \texttt{l k} command.

Make sure that \textit{addr} is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The \texttt{Q} command can be used to suppress the output from the \texttt{btl} command.

Example

To set a temporary breakpoint for task 4 at the current viewing position’s address, type:

\texttt{btl "4"}

To set a temporary breakpoint for task 4 at address 0xF00 and print the message, type:

\texttt{0xF00 btl "4" {"breakpoint triggered:\naddress 0xF00, task 4"}}

\texttt{break, b, bb, bB, bd, bD, bi, bi, bt, bti, bu, bU, l, Q}
bti

Function

Set a permanent low-level task aware breakpoint at a machine instruction.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Code Breakpoint... to open the Code Breakpoint dialog. Edit the Break At... field and fill in the Task ID field. In the Advanced dialog disable the Remove when hit check box.

The command line syntax is:

\[ addr \ bti \ "TaskId" \ [cmds] \]

Description

Set a permanent task aware breakpoint at the machine instruction at address \( addr \), or the current viewing position’s address if \( addr \) is not specified; the list of CrossView Pro commands \( cmds \) are executed when the breakpoint is hit. The TaskId is the identification of the task as displayed in the Tasks Window or specified by the \( \text{l k} \) command.

Make sure that \( addr \) is the start address of a machine instruction, otherwise the results are unpredictable. When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The \( Q \) command can be used to suppress the output from the bti command.

Example

To set a breakpoint for task 4 at the current viewing position’s address, type:

\[ \text{bti "4"} \]

To set a breakpoint for task 4 at address 0xF00 and print the message, type:

\[ 0xF00 \ bti \ "4" \ \{"breakpoint triggered: address 0xF00, task 4"\} \]

break, b, bb, bB, bd, bD, bi, bI, bt, btI, bu, bU, l, Q
**bTIM**

**Function**
Set a temporary time breakpoint.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click the **Add >** button and select **Timer Breakpoint...** to open the Add Timer Breakpoint dialog. Enter a value in the **Time** field and enable the **Remove when hit** check box in the Advanced dialog.

The command line syntax is:

\[ time \texttt{bTIM} [\texttt{cmds}] \]

**Description**
Set a temporary breakpoint after the specified **time** (in seconds). **time** can be any expression evaluating to a number. The list of CrossView Pro commands **cmds** are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted; the breakpoint is then removed. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The **Q** command can be used to suppress the output from the **bTIM** command.

**Example**
To set a temporary breakpoint after 0.5 seconds and list all global variables, type:

\[ 0.5 \texttt{bTIM} \{l g\} \]

**break, b, bCYC, bcyc, bINST, binst, btim, D**
btim

Function

Set a permanent time breakpoint.

From the Breakpoints menu, select Breakpoints... to open the Breakpoints dialog box. Click the Add > button and select Timer Breakpoint... to open the Add Timer Breakpoint dialog. Enter a value in the Time field and disable the Remove when hit check box in the Advanced dialog.

The command line syntax is:

\[ \text{time } \text{btim} \ [\text{cmds}] \]

Description

Set a permanent breakpoint after the specified time (in seconds). time can be any expression evaluating to a number. The list of CrossView Pro commands cmds are executed when the breakpoint is hit.

When the breakpoint is hit, execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the btim command.

Example

To set a permanent breakpoint after 0.5 seconds and list all global variables, type:

\[ 0.5 \ \text{btIM} \ \{1 \ g\} \]

break, b, bCYC, bcyc, bINST, binst, bTIM, D
Function

Set a temporary up-level breakpoint (to finish the function at a specific stack level).

In the Stack Window, double-click on the desired function. Alternately, you can click on the desired function in the Stack Window and select **Stack Breakpoint | After Call to Function** from the **Breakpoints** menu.

The command line syntax is:

```
[ stack ] bu [ commands ]
```

Description

This command sets a temporary up-level breakpoint immediately after the call to the function designated by the stack number `stack`, otherwise the currently viewed function is used. Associate the list of CrossView Pro commands `commands` with the breakpoint.

When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The `Q` command can be used to suppress the output from the **bu** command.

Breakpoints set in the Stack Window are always temporary, meaning they will be deleted after the first time you reach them. A breakpoint set in this manner will not be visible in the Source Window.

This command is not allowed when the target runs in the background.

Example

To set a temporary up-level breakpoint immediately after the call to the currently viewed function, type:

```
bu
```

To set a temporary up-level breakpoint immediately after the call to the function at stack level 2, type:

```
2 bu {1}
```
After stopping, this command will cause CrossView Pro to print out the function’s local variables and arguments.

\textbf{break, b, bb, bB, bd, bD, bi, bI, bt, bti, bti, bu, Q}
bu

Function

Set a permanent up-level breakpoint (to finish the function at a specific stack level).

Click on the desired function in the Stack Window and select Stack Breakpoint | After Call to Function from the Breakpoints menu. To make the stack breakpoint permanent, select Breakpoints... from the Breakpoints menu, select the desired stack breakpoint and click on the Edit... button. The Edit Code Breakpoint dialog appears. Click on the Advanced>> button and disable the Remove when hit check box.

The command line syntax is:

```
[ stack ] bu [ commands ]
```

Description

Set a permanent up-level breakpoint immediately after the call to the function designated by the stack number `stack`, otherwise the currently viewed function is used. Associate the list of CrossView Pro commands `commands` with the breakpoint.

When the breakpoint is hit execution is halted. By default the current execution position, function, line number, and source statement are displayed. Next any commands associated with the breakpoint are executed. The Q command can be used to suppress the output from the `bu` command.

This command is not allowed when the target runs in the background.

Example

To set a temporary up-level breakpoint immediately after the call to the currently viewed function, type:

```
    bu
```

To set an up-level breakpoint immediately after the call to the function at stack level 2 and, after stopping, print out the local variables and arguments of that function, type:

```
    2 bu {1}
```
break, b, bb, bB, bd, bD, bi, bI, bt, bti, btI, bU, Q
bufa

Function

Append the contents of one buffer to another buffer.

The command line syntax is:

```bash
bufa target_buffer_name,added_buffer_name[size_limit]
```

Description

Add the contents of buffer `added_buffer_name` to buffer `target_buffer_name`. If `size_limit` is specified, buffer `target_buffer_name` will be trimmed down to the specified size (keeping `size_limit` elements of the tail of the buffer).

Example

To append the contents of `$buffer` to buffer `$all_data`, and keep the last 1024 elements, type:

```bash
bufa $all_data,$buffer,1024
```

bufd, graph, memget.

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
**bufd**

**Function**

Free a used buffer.

The command line syntax is:

```
bufd buffer_name
```

**Description**

Discard the specified buffer (if the target data is not to be used anymore).

**Example**

To discard buffer `$buffer`, type:

```
bufd $buffer
```

`bufa, graph, memget`.  
Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
**C**

**Function**
Continue using the current value of the program counter.

In the Source Window, click on the **Run/Continue** button. You can also select **Run** from the **Run** menu.

The command line syntax is:

```
[ exp ]  C  [ line ]
```

**Description**

If `exp` is specified and you are stopped at a breakpoint, then the breakpoint count is set to this value. If `line` is specified, a temporary breakpoint is set at that line number. Note that this temporary breakpoint will overwrite any existing breakpoint at that line.

The **C** command can be used in the command lists of breakpoints to resume execution automatically.

This command is not allowed when the target runs in the background.

**Example**

To continue execution from the current target program counter, type:

```
C
```

To set the breakpoint’s count to 4 and continue, type:

```
4  C
```

To set a temporary breakpoint at line 52 and continue, type:

```
C  52
```

**break, bc, g, R, CB**
**CB**

**Function**
Continue execution in background using the current value of the target program counter.

The command line syntax is:

\[ \text{exp} \text{ CB } [\text{line}] \]

**Description**
If \(\text{exp}\) is specified and you are stopped at a breakpoint, then the breakpoint count is set to this value. If \(\text{line}\) is specified, a temporary breakpoint is set at that line number. Note that this temporary breakpoint will overwrite any existing breakpoint at that line.

The **CB** command can be used in the command lists of breakpoints to resume execution automatically.

This command is not allowed when the target runs in the background.

Not available for all execution environments.

**Example**
To continue execution from the current target program counter, type:

\[ \text{CB} \]

To set the breakpoint’s count to 4 and continue, type:

\[ 4 \text{ CB} \]

To set a temporary breakpoint at line 52 and continue, type:

\[ \text{CB } 52 \]

\text{g, R, C, st, wt}
**cd**

**Function**

Disable, turn off, gathering of coverage information.

From the **Tools** menu, select **Coverage** if this item was set.

The command line syntax is:

```
!cd
```

**Description**

If coverage is supported by your version of CrossView Pro, this command disables the coverage system. Normally, you should disable coverage if you are not interested in the coverage results, as this will often improve the performance of the execution environment.

**Example**

To disable coverage, type:

```
!cd
```

```
!ce, nC, nU, pC, pU
```
ce

Function
Enable, turn on, gathering of coverage information.

From the Tools menu, select Coverage if this item was not set.

The command line syntax is:

ce

Description
If coverage is supported by your version of CrossView Pro, this command enables the coverage system. Normally, you should disable coverage if you are not interested in the coverage results, as this will often improve the performance of the execution environment.

Example
To enable coverage, type:

ce

cd, nC, nU, pC, pU
clear

**Function**
Clear the Command Output Window.

The command line syntax is:

```
clear
```

**Description**
Use this command if you want to clear the output window part of the Command Window.

**Example**
To clear the Command Output Window, type:

```
clear
```
covinfo

Function
List coverage information.

From the Tools menu, select Code Coverage..., make your changes and select the Update button.

The command line syntax is:

```
covinfo [[all | module_or_function_name][filename]]
```

Description
If coverage is supported by your version of CrossView Pro and coverage is enabled, this command lists the coverage information. Without arguments (same as all) this command lists the coverage information of all modules and functions.

Instead of listing the results you can also save the results in a file with extension .cov.

Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example
To list the coverage information of all modules and functions to the output window, type:

```
    ce
covinfo
```

To list coverage information of function main to the output window, type:

```
covinfo main
```

To list coverage information of all modules and functions in file hello.cov, type:

```
covinfo all,hello.cov
```

`cd, ce, proinfo`
cproinfo

Function

List cumulative profiling results or add or remove functions from the list of profiled functions.

From the Tools menu, select Cumulative Profiling Setup..., make your changes and click the OK button. Select Cumulative Profiling Report... to see the cumulative profiling report.

The command line syntax is:

```
cproinfo [all[/filename] | {add | remove} function]
```

Description

If profiling is supported by your version of CrossView Pro and profiling is enabled, this command lists the cumulative profiling results. Without arguments (same as all) this command lists the cumulative profiling information of all functions.

Instead of listing the results you can also save the results in a file with extension .cpr.

Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example

To list the cumulative profiling results of all functions to the output window, type:

```
pe
 cproinfo
```

To dump cumulative profile information of all functions in file hello.cpr, type:

```
cproinfo all,hello.cpr
```

To add function main to the list of profiled functions, type:

```
cproinfo add main
```
To remove function `main` from the list of profiled functions, type:

```bash
cproinfo remove main
```

`proinfo, pd, pe`
ct

Function

Display a C-execution trace.

From the View menu, select Trace | Source Level. The Trace Window displays the most recently executed lines of code every time program execution is stopped. CrossView Pro automatically updates the Trace Window each time execution is halted, as long as the window is open.

The command line syntax is:

\[ \text{number ct} \]

Description

Display a C-execution trace in the Command window, corresponding to the last number of machine instructions executed. Since the ct command relies on the emulator's trace buffer, the ct command will not be implemented on some emulators.

For each executed line of code, the Trace Window displays:

- The name of the source file
- The name of the function
- The line number and corresponding source code

The window shows all the code executed since the the last time the program halted.

This command is not allowed when the target runs in the background.

Not available for all execution environments.

Example

To display, in the Command window, the last C statements (corresponding to the last ten machine instructions) executed, type:

\[ 10 \text{ ct} \]

ct i, ct r
**ct i**

**Function**

Display a disassembled trace.

From the **View** menu, select **Trace | Instruction Level**. The Trace Window displays the most recently executed lines of code every time program execution is stopped. CrossView Pro automatically updates the Trace Window each time execution is halted, as long as the window is open.

The command line syntax is:

\[ \text{number } \text{ct i} \]

**Description**

Display a disassembled trace in the Command window, corresponding to the last **number** of machine instructions executed.

Since the **ct i** command relies on the emulator's trace buffer, the **ct i** command will not be implemented on some emulators (or implemented differently).

This command is not allowed when the target runs in the background.

Not available for all execution environments.

**Example**

To display in the Command window the last 20 disassembled instructions executed, type:

\[ 20 \text{ ct i} \]

**ct, ct r**
ct r

**Function**

Display a raw trace.

From the View menu, select Trace | Raw. The Trace Window displays the most recently executed lines of code every time program execution is stopped. CrossView Pro automatically updates the Trace Window each time execution is halted, as long as the window is open.

The command line syntax is:

```
number ct r
```

**Description**

Display a raw trace in the Command window, corresponding to the last number of trace frames. This command merely shows the contents of the emulator's trace buffer.

Since the ct r command relies on the emulator's trace buffer, the ct r command will not be implemented on some emulators.

This command is not allowed when the target runs in the background.

Not available for all execution environments.

**Example**

To display in the Command window the last 20 trace frames, type:

```
20 ct r
```

ct, ct i
Function

Execute a CXL script.

The command line syntax is:

```
cxl "script"
```

Description

Execute CXL script `script`. The filename of the CXL script must be enclosed in double quotes.

For use with simulation scenarios, you can supply the `cxl` command to a cycle count probe point.

Example

To execute CXL script `myscript.cxl`, type:

```
cxl "myscript.cxl"
```

Refer to Appendix B, *CrossView Extension Language (CXL)*, for details on the CXL syntax.
cxl_reset

Function
Reset variable of one or all CXL scripts.

The command line syntax is:

```
cxl_reset ["script"]
```

Description
Reset all variables of the CXL script `script` that are executed. The filename of the CXL script must be enclosed in double quotes. If you omit the `script` argument, CrossView Pro resets all variables of all scripts.

For use with simulation scenarios, you can supply the `cxl_reset` command to a cycle count probe point.

Example
To reset all variables that are executed by the CXL script `myscript.cxl`, type:

```
cxl_reset "myscript.cxl"
```

Refer to Appendix B, *CrossView Extension Language (CXL)*, for details on the CXL syntax.
**D**

**Function**

Delete all currently defined breakpoints.

From the **Breakpoints** menu, select **Breakpoints...** to open the Breakpoints dialog box. Click on the **Remove All** button.

The command line syntax is:

```
D[y]
```

**Description**

**D** deletes all currently defined breakpoints. **Dy** does not ask for confirmation.

**break, B, d**
**Function**

Delete a specific breakpoint.

To delete a code breakpoint directly from the C source, click on the red breakpoint toggle next to the corresponding, source line in the Source Window.

Otherwise, select **Breakpoints...** from the **Breakpoints** menu to open the Breakpoints dialog box. Select the breakpoint you want to remove and click on the **Remove** button.

The command line syntax is:

\[ \text{[ number]} \ d \]

**Description**

Delete the breakpoint associated with the given **number**. If no number is given, delete the breakpoint at the current line. If there is no breakpoint at the current line, a **B** command will be executed to display all breakpoints.

Whenever a breakpoint is deleted the remaining breakpoints are renumbered starting at 0.

**Example**

To delete a breakpoint at the current line, type:

\[ d \]

To delete breakpoint number 3, type:

\[ 3 \ d \]

**break, b, bb, bB, bd, bD, bi, bI, bt, bti, btl, bu, bU, B, D**
dcmp

Function

Compare a file with the downloaded application.

From the File menu, select Compare Application... Specify an application file and click on the Compare button.

The command line syntax is:

```
dcmp [file[,number_of_hits][,d]]
```

Description

Compare an application file with the memory contents and display differing memory addresses or addresses and values. If you have already loaded an application you can invoke this command without specifying a file name. You can limit the number of differences by specifying a number_of_bits. The value 0 means there is no limit on the number of differences.

This command is not allowed when the target runs in the background.

Example

To compare the currently loaded application, there is no limit on the number of differences and the contents of differing memory addresses are not displayed, type:

```
dcmp
```

To compare the currently loaded application and stop when the number of differences equals 10, type:

```
dcmp ,10
```

To compare the currently loaded application there is no limit on the number of differences and display the contents of differing memory addresses, type:

```
dcmp ,,d
```
To compare file `test.abs`, stop if the number of differences equals 5 and display the contents of differing memory addresses, type:

```
dcmp "test.abs",5,d
```
**di_state**

**Function**
Open, save/restore, close a debug instrument state.

From the Target menu, select Save/Restore Target State...

The command line syntax is:

```
  di_state open state_name
  di_state save state_name, number
  di_state restore state_name, number
  di_state close state_name, delete
```

**Description**
Before a state can be saved, restored or closed it must be opened first. To open a state use the `di_state open state_name` command. When opened successfully the name is added to the available state names list.

With the `di_state save` command you can now save the state of the debug instrument with the specified `state_name` and `number`. With `di_state restore` you can restore a previously saved state of the debug instrument with the specified `state_name` and `number`.

Use `di_state close` to close a state. The `delete` flag can be 1 to delete the state or use 0 to keep the state.

This feature is only available when it is supported by the debug instrument.

**Example**
To open and save a state, type:

```
  di_state open S1
  di_state save S1, 0
```

To restore a state, type:

```
  di_state restore S1, 0
```
dis

Function

Disassemble a range of memory.

⚠️ From the View menu, select Source | Disassembly or Source | Source and Disassembly to open the Disassembly or Source and Disassembly window respectively.

💡 The command line syntax is:

```
  dis address [, {address | #count} [,i]]
```

Description

Disassemble a range of memory. The output is interleaved with source lines when i is specified. You can enter valid expressions as well for address and count.

Example

To disassemble 4 instructions starting at 3 bytes behind the start address of the function main, type:

```
  dis main+3,#4
```

To disassemble memory for (initval+1) instructions, starting at the address of the function main, type:

```
  dis main+3,#initval+1
```

To disassemble from 0x2000 up to and including the instruction at 0x2100 and also interleave C source lines of any function resident in that memory range, type:

```
  dis 0x2000,0x2100,i
dump, expression
```
**dn**

**Function**
Download a file.

From the **File** menu, select **Download Application...** to download the image part of the file to the execution environment.

The command line syntax is:

```
dn [file]
```

**Description**
Download the image part of the specified *file* to the execution environment. If no *file* is specified, use the file specified when CrossView Pro was invoked, and from which the symbolic information was read during startup, or the file specified in either the **N** command or the Load Symbolic Debug Info dialog.

Downloading a file only copies an image part into target memory. It will not cause CrossView Pro to re-read symbolic information.

This command is not allowed when the target runs in the background.

**Example**
To download the current file, type:

```
dn
```

To download the IEEE file *demo.abs*, type:

```
dn demo.abs
```

To download the hex file *test.hex*, type:

```
dn test.hex
```

I, N
dump

Function
Dump a range of memory.

From the View menu, select Memory | New to open a Memory Window.

The command line syntax is:

```
dump address [, [address | #count] [, [style width]] [, filename [,a]]]
```

Description
The dump command can dump memory as hexadecimal data or as C variables. You can enter valid C expressions as well for address and count. You can also dump Motorola S records or Intel hex records. Also, you can specify a filename in which the dump is to be written or appended.

style can be one of:

```
acDouxEFGefgnPpRrstm
```

Style I dumps Intel hex and style M specifies Motorola S records output. See Chapter 6, Accessing Code and Data, and section 3.5, Formatting Expressions, in Chapter 3, Command Language, for details on each of the other format styles. The R and r style are only available for targets that support the fractional type.

Mind the following:

- the commas are required
- the addresses can also be C expressions
- default width is MAU (usually byte) sized words
- additional style M: Motorola S records
- additional style I: Intel hex
- a semicolon is a command terminator
- the dump is end address INclusive

Example
To dump the first byte of the function main., type:

```
dump main
```
To dump the first 10 bytes of the function `main` as Motorola S records in the file `main.sre`, type:

```
dump main,main+10,M,main.sre
```

To dump the first 5 bytes of the function `main` as 1 string, type:

```
dump main,main+10,M,main.sre,a
```

To append the first 5 bytes of the function `main` as 1 string, type:

```
dump main,,c5
```

To dump the resulting value bytes of 'the address of `main` binary anded with 3', type:

```
dump main+1,#main&3
```

`dis, expression`
Function

Establish viewing position

From the File menu, select Open Source... to view a file. In the Source Window, click on the Find Symbol button to find a function, or select Find Symbol... from the Edit menu.

In the Stack Window click once on the function to be examined.

The command line syntax is:

```
  e [ file | function ]
  stack e
```

Description

The e option invokes two distinct commands. The first version establishes the viewing position to be the first line of file, the first executable line of the function function or the current viewing position if no argument is given.

The second version establishes the viewing position to be the line at stack level stack in the stack trace. (See the t command.)

The stack e command is not allowed when the target runs in the background.

The L command is equivalent to 0 e.

Example

To view the function main, type:

```
e main
```

To view the test file test.c, type:

```
e test.c
```

To view the call site of the current function, type:

```
0 e
```
To view the line at stack level 3, type:

```
3 e
```

? /, ci, L, p, P, t
**Function**
Start execution on current CPU and switch to another CPU.

The command line syntax is:

```
cpu_number  eC
```

**Description**
Start execution on the current CPU and switch to CPU `cpu_number`.

This command can only be issued when the currently selected CPU is in debug mode.

**Example**
To start execution on the current CPU and select the CPU indicated by number 1, type:

```
1  eC
```

```
eC
```
**Function**

Select a CPU or show current CPU number.

The command line syntax is:

```
[cpu_number] ec
```

**Description**

The `ec` command allows you to select a CPU in your current Execution Environment if your target has multi-CPU support.

This command can only be issued when the currently selected CPU is in debug mode.

**Example**

To view the current CPU selection, type:

```
ec
```

To select the CPU indicated by number 1, type:

```
1 ec
```

```
eC
```
echo

Function
Display the definition of a macro name without executing the macro.

From the Tools menu, select Macro Definitions... to view the definition of a macro.

The command line syntax is:

```
echo  text
```

Description
Perform macro expansion on text without executing. This allows you to see how a macro is expanded. It is particularly informative when macros call other macros.

Example
If you type:

```
echo macro(3)
```

CrossView Pro will display the expansion of `macro(3)`.

`set`, `unset`, `save`, `!`
**ei**

**Function**

Establish viewing position at a specified address.

From the **Edit** menu, select **Find Address...**

The command line syntax is:

```
[addr]  ei
```

**Description**

The **ei** command establishes the viewing position to be at the instruction specified.

This command is useful for viewing some code in the assembly window, without changing the program counter, since the execution position is not changed.

**Example**

To view the current viewing position, type:

```
ei
```

To view the instruction at address 0x100, type:

```
0x100  ei
```

? / e, L, p, P, t
et

Function
Select the specified task’s context.

In the Tasks Window click once on the task to be examined.

The command line syntax is:

```
et "TaskId"
```

Description
Select the specified task’s context. The `TaskId` is the identification of the task as displayed in the Tasks Window or specified by the `lk` command.

The current execution position, function, line number, and source statement are displayed. All other windows, except for the Kernel Windows, are updated accordingly.

Subsequent CrossView Pro commands use the context of the selected task. For example, the `t` command shows a stack trace of the selected task.

Example
To select task 4, type:

```
et "4"
```

l
Function

Set default address printing format

The command line syntax is:

```
f [ "printf-style-format" ]
```

Description

Set the default address printing format, using a `printf` format specification.

If there is no argument, the format defaults to `%x`, which prints an address in hexadecimal.

This command is intended to allow users to see memory addresses in decimal, octal or a format of their choosing.

Example

To display addresses in octal, type:

```
f "%o"
```

To display addresses in hex, type:

```
f expression
```
fa

Function
Add a FLASH device.

From the Target menu, select FLASH Setup...
Click Add... to specify a FLASH device.

The command line syntax is:

```plaintext
fa device_name;base_address;chip_width[;nr_of_chips]
```

Description
Add a flash device to the list of configured flash devices. This command also checks whether the device address range overlaps with already configured flash devices. `device_name` is a unique name for the flash device. `base_address` is the start address of the memory range that will be covered by the flash device. `chip_width` is the width of the flash device in bits. `number_of_chips` is the number of flash devices you want to use in parallel.

Example
To add flash device AM29F040 with base address 0xFFE00000, chip width 8 and number of chips 2, type:

```plaintext
fa AM29F040;0xFFE00000;8;2
```

As a result 16 bits can be accessed in one memory-read cycle.

To add flash device AT29C010 with base address 0x2000000, chip width 8 and default number of chips 1, type:

```plaintext
fa AT29C010;0x2000000;8
```

fc, fd, fl, fw
**fc**

**Function**
Check a FLASH device.

From the **Target** menu, select **FLASH Setup**...
Click **Check ID**.

The command line syntax is:

```
fc device_number
```

**Description**
Check the manufacturer and device identifiers of a flash device. Each device has a unique manufacturer and device identification value. With this command you can check if the flash device on the target board matches the device you have selected.

The manufacturer value is 0x01 for AMD devices and 0x1F for Atmel devices. The device identifier value of the AMD flash device AM29F040 is 0xA4. The `fc` command first checks the manufacturer identification. If this succeeds, the device identification is checked. If the retrieved identifiers do not match, this command issues an error. If the flash device on the target board can be identified it will report the name of this flash device.

Use the `fl` command to see a numbered list of flash devices.

**Example**
To check the manufacturer and device id of flash device number 1, type:

```
fc 1
```

`fa, fd, fl, fp, fw`
Function
Delete a FLASH device.

From the Target menu, select FLASH Setup...
Select a device and click Remove.

The command line syntax is:

```
fd device_number
```

Description
Delete a flash device from the list of configured flash devices.
Use the fl command to see a numbered list of flash devices.

Example
To delete flash device number 0, type:

```
fd 0
```

fa, fc, fl
fl

Function
List FLASH devices.

From the Target menu, select FLASH Setup...

The command line syntax is:

fl

Description
List the configured flash devices. You can use the Number in other CrossView Pro flash commands.

Example
To list the flash devices, type:

fl

This results for example in the following list:

<table>
<thead>
<tr>
<th>Number</th>
<th>Device name</th>
<th>Address</th>
<th>Width</th>
<th>Chips</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>AM29F040</td>
<td>0xFFE00000</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>1</td>
<td>AT29C010</td>
<td>0x2000000</td>
<td>8</td>
<td>1</td>
</tr>
</tbody>
</table>

fa, fc, fd, fp, fpe, fpd
Function

Get protection status of a FLASH device.

From the Target menu, select FLASH Setup...
Select a device and click Protection -> Get status.

The command line syntax is:

\texttt{fp \textit{device\_number}}

Description

Get the protection status of the specified flash device. A flash device that supports a protection mechanism can be protected or not. Use the \texttt{fpe} or \texttt{fpd} command to enable or disable the protection.

Use the \texttt{fl} command to see a numbered list of flash devices.

Example

To get the protection status of flash device number 0, type:

\texttt{fp 0}

\texttt{fl, fpe, fpd}
**fpd**

**Function**

Unprotect a FLASH device.

From the **Target** menu, select **FLASH Setup...**
Select a device and click **Protect -> Disable**.

The command line syntax is:

```
fpd device_number
```

**Description**

A flash device that supports a protection mechanism can be protected or not. With this command you can disable (clear) the protection.

Use the **fl** command to see a numbered list of flash devices.

**Example**

To unprotect flash device number 0, type:

```
fpd 0
```

**fl, fp, fpe**
**Function**

Enable protection of a FLASH device.

From the **Target** menu, select **FLASH Setup**...
Select a device and click **Protection -> Enable**.

The command line syntax is:

```
fpe device_number
```

**Description**

A flash device that supports a protection mechanism can be protected or not. With this command you can enable (set) the protection.

Use the `fl` command to see a numbered list of flash devices.

**Example**

To protect flash device number 0, type:

```
fpe 0
```

`fl, fp, fpd`
FSS

**Function**

File System Simulation redirection.

The command line syntax is:

```
FSS { < | > }{&stream | "file"}
```

**Description**

Redirect a File System Simulation stream to a file or another stream. Redirection to a file can be needed when a stream is only mapped to a window and you want it to be mapped to a file also.

**Example**

To redirect the output of stream 2 to stream 1, type:

```
FSS 2>&1
```

To retrieve input for stream 1 from stream 4, type:

```
FSS 1<&4
```

To retrieve input for stream 4 from file "data.txt", type:

```
FSS 4<"data.txt"
```

To redirect the output of stream 3 to file "data.txt", type:

```
FSS 3>"data.txt"
```

Section 10.3, *File System Simulation* in Chapter I/O Simulation.
FSS_stdio_close

Function

Close a stream previously opened by FSS_stdio_open.

The command line syntax is:

FSS_stdio_close  streamnumber

Description

Close the stream indicated by streamnumber.

Example

To close stream 1, type:

FSS_stdio_close  1

FSS_stdio_open.

Section 10.3, File System Simulation in Chapter I/O Simulation.
FSS_stdio_open

Function
Redirect the output of a stream to a file.

The command line syntax is:

FSS_stdio_open   filename,rwdirection,streamnumber

Description
Redirect the stream indicated by streamnumber to the file filename. rwdirection can be an r for read-only, w for writable, or rw for read/write.

Example
To redirect stream 1 (output, so w for writable) to the file myfile.out, type:

FSS_stdio_open   myfile.out,w,1

The following command is used to close the stream.

FSS_stdio_close  1

FSS_stdio_close.
Section 10.3, File System Simulation in Chapter I/O Simulation.
**fw**

**Function**
Specify workspace address of FLASH programming monitor.

From the **Target** menu, select **FLASH Setup...**
Specify the **Flash workspace address**.

The command line syntax is:

```
fw [address]
```

**Description**
You can specify to CrossView Pro to download a FLASH programming monitor to the target to perform the actual flashing. With the **fw** command you specify the data workspace address used by the FLASH programming monitor. This address determines the data address only and the code address has a fixed location.

The flash workspace has a size of 0x1100 bytes and is used for interaction between CrossView Pro and the flash monitor.

Without any address the **fw** command shows the current flash workspace address value.

Note that the address you specify must not be in the memory range of the FLASH devices.

**Example**
To specify the load address of the data used by the flash programming monitor on address 0x10000, type:

```
fw 0x100000
```

To show the current flash programming monitor address settings., type:

```
fw
```

```
fa, fc, fl
```
**g**

**Function**

Change the program counter to a new execution position.

Click on a source line and select **Jump to Cursor** from the **Run** menu.

The command line syntax is:

`g line`

**Description**

This command changes the program counter so that `line` becomes the current execution position. `Line` must be a line in the current function.

This command changes only the program counter. It does not cause the target to begin execution.

Exercise caution when changing the execution position. Oftentimes, each line of C source code is compiled into several machine language instructions. Moving the program counter to a new address in the middle of a series of related assembly instructions is sometimes risky. Moreover, even though you change the program counter, registers and variables may not have the expected values if parts of the code are bypassed.

This command is not allowed when the target runs in the background.

**Example**

To change the program counter so that the next instruction to be executed corresponds to line 127, type:

`g 127`

C, gi, R
**gi**

**Function**

Change the program counter to a new execution position.

Click on a source line and select **Jump to Cursor** from the **Run** menu.

The command line syntax is:

```
address gi
```

**Description**

This command changes the program counter so that *address* becomes the current execution position.

This command changes only the program counter. It does not cause the target to begin execution.

Exercise caution when changing the execution position. The **Jump to Cursor** menu item is not available in the source lines window mode to prevent problems by skipping pieces of C code which are required to be executed. Moving the program counter to a new address in the middle of a series of related assembly instructions is sometimes risky. Moreover, even though you change the program counter, registers and variables may not have the expected values if parts of the code are bypassed.

This command is not allowed when the target runs in the background.

**Example**

To change the program counter so that the next instruction to be executed corresponds to address 0x0800, type:

```
0x0800 gi
```

C, g, R
graph

Function

Create Data Analysis window and execute CXL script.

The command line syntax is:

```
graph "window","script",[arg]...
```

Description

Create Data Analysis window window and execute CXL script script. The display list produced by the script is shown in the specified window. Arguments arg are passed as global variables to the script. Each argument is treated as an expression. Arguments starting with a "$" refer to an acquisition buffer. In all other cases arg is evaluated as an expression and will be casted to type double.

If for example register $R1 should be passed as argument to the script you must write "0+$R1" to avoid that $R1 is recognized as an acquisition buffer.

Example

To transform the contents of buffer $buffer to displayable data in window demo using CXL script x_t.cxl, type:

```
graph "demo","x_t.cxl",$buffer,0,1
```

bufa, graphm, graphp, memget.

Section 11.5, Data Analysis, in Chapter Special Features.
graph_add_update

Function

Add a command to the sequence of update commands.

For the supplied scripts only. From the Settings menu, select Data Analysis Window Setup... Enter a new window name and click New. Click Configure... to open the Data Analysis Window Setup dialog.

The command line syntax is:

```
graph_add_update "window",command
```

Description

Set the sequence of update commands for Data Analysis window window manually. These update commands are executed when the Update button on the Data Analysis window is pressed or when the update command is issued.

Prior to adding update commands, you have to remove all update commands with the graph_clear_updates command.

Example

To retrieve data and show it in window demo, type:

```
graph_clear_updates "demo"
graph_add_update "demo",memget data[$i],100,$buffer
graph_add_update "demo",graphm "demo","show_x_t.cxl"
graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1
update "demo"
```

Section 11.5, Data Analysis, in Chapter Special Features.
graph_clear_updates

Function
Clear the sequence of update commands.

The command line syntax is:

    graph_clear_updates "window"

Description
Clear the sequence of update commands for Data Analysis window window. This is needed prior to adding new update commands with the graph_add_update command.

Example
To retrieve data and show it in window demo, type:

    graph_clear_updates "demo"
    graph_add_update "demo",memget data[$i],100,$buffer
    graph_add_update "demo",graphm "demo","show_x_t.cxl"
    graph_add_update "demo",graph "demo","x_t.cxl" ,$buffer,0,1
    update "demo"

graph_add_update, update.
Section 11.5, Data Analysis, in Chapter Special Features.
**graph_close**

**Function**

Close a Data Analysis window.

The command line syntax is:

```
graph_close "window"
```

**Description**

With the `graph_close` command you can close the named `window`.

**Example**

To close window `demo`, type:

```
graph_close "demo"
```

`graph`, `graphm`.

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
graph_debug

Function

Debug Data Analysis graph window.

The command line syntax is:

```
graph_debug expression
```

Description

If `expression` evaluates to a non-zero value, this value is an ORed value of two flags:

- 1 (bit 0) the "graphical data window debugging mode" will be enabled, showing all communication between the scripts and the windows in the command window. This can be useful when developing scripts.
- 2 (bit 1) When errors occur during script processing, these errors are logged to the command window. The total error count (per script) is now shown in a popup window rather than logged in the command window. The errors themselves remain logged in the command window.

Other bits (when `value & 3` equals zero, for example 4) are ignored and treated like zero. No parameters result in value 1. A value of zero turns off all debugging.

`graph, graphm, graphmn`

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
**graphm**

**Function**

Set Data Analysis window display mode.

The command line syntax is:

```
graphm "window","script"[arg]...
```

**Description**

The `graphm` command sets the representation `script` for the specified `window`. Depending on the script, the arguments may vary.

Several scripts are supplied with the product that you can use with the `graphm` command. See section *Supplied Data Analysis Window Scripts* in Chapter *Special Features* for more information.

**Example**

To set the display mode for window `demo` using CXL script `show_x_t.cxl` and show "demo" in the title bar of the window, type:

```
graphm "demo","show_x_t.cxl"
```

`bufa, graph, graphp, memget`

Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
graphmn

**Function**
Set Data Analysis window display mode.

The command line syntax is:

```
graphmn "window","script"[arg]...
```

**Description**
The `graphmn` command works similar to the `graphm` command, but it does not update the graph window. This can be useful where a `graph` and a `graphm` command are followed by each other, preventing the redrawing of the same graphics twice.

**Example**
To set the display mode for window `demo` using CXL script `show_x_t.cxl` and show "demo" in the title bar of the window, type:

```
graphmn "demo","show_x_t.cxl"
```

`bufa`, `graph`, `graphp`, `memget`.
Section 11.5, *Data Analysis*, in Chapter *Special Features*. 
graphp

Function

Position Data Analysis window on the screen.

The command line syntax is:

```
graphp "window",left_top_x,left_top_y,width,height
```

Description

With the `graphp` command you can position the named `window` at the specified screen coordinates.

Example

To put window `demo` at position (0,0) on the screen with a size of 100x100, type:

```
graphp "demo",0,0,100,100
```

`graph`, `graphm`.

Section 11.5, *Data Analysis*, in Chapter *Special Features*.
**gus**

**Function**
Suppress or reactivate window updating.

The command line syntax is:

```
gus {on | off}
```

**Description**
With **gus on** the GUI updating suppress feature is enabled. This means that the graphical windows are no longer updated. To reactivate the window updating use the **gus off** command.

**Example**
To suppress the updating of CrossView windows, type:

```
gus on
```
Function

Print out information about the state of CrossView Pro.

The command line syntax is:

```
I
```

Description

Print out information about the state of CrossView Pro, including: the CrossView Pro version number, the execution environment version information, the name of the program being debugged (and the number of its files and functions), the state of the assertion mechanism, the state of output recording, the state of command recording, the state of target communication recording and the state of search case sensitivity.

The state of the assertion mechanism tells how many assertions have been defined and whether the overall assertion mechanism is active or suspended; it does not tell whether any individual assertions are active or suspended.

```
I, a, A, >, >>, >& Z
```
if

Function
Conditional command execution.

The command line syntax is:

```
if ( expression ) { cmds } [ { cmds } ]
```

Description
If `expression` evaluates to a non-zero value, execute the first group of commands. Otherwise, the second group of commands, if present, will be executed. This command is nestable.

Leave a space between `if` and `exp`. `if(a==b)` parses as a function call. The `if` statement is used primarily within breakpoint command lists.

Example
If you type:

```
if (a=b) {5t} {C}
```

CrossView Pro will trace back five levels on the stack if `a` is equal to `b`. Otherwise, CrossView Pro will continue.

The command line:

```
if (wait>1000) {wait;1 r}
```

will print the value of `wait` and list all registers if the value of `wait` exceeds 1000.
ios_close

Function
Close a File I/O stream.

From the Settings menu, select I/O Simulation Setup... Select a stream in the Connections tab and click on the Delete button.

The command line syntax is:

\texttt{ios\_close} \{stream | "file"\}

Description
You can specify either a filename or a stream number.

Example
To close stream number 1, type:

\texttt{ios\_close 1}

To close file data.txt and close 1 stream that is mapped to this file, type:

\texttt{ios\_close "data.txt"}

Only 1 stream is closed, even if multiple streams are attached to this file. The command displays which stream number has been closed.

\textbf{ios_open, ios\_wopen}
ios_open

Function
Open a File I/O stream.

From the Settings menu, select I/O Simulation Setup... Open the File I/O tab and click on the Configure... button. Attach a stream (with a file) to a probe point.

The command line syntax is:

```
ios_open ["file", [mode], [r], $xvw_variable]]
```

Description
This command is useful to connect a file to a stream at the command line of CrossView. CrossView returns a stream number which is opened with this command in the $xvw_variable and displays it too.

The filename is optional. When the filename is omitted and such a newly opened stream receives data and is not shown in any opened terminal window a new window will be opened that interacts with this stream.

Furthermore the mode can be specified when a I/O stream is opened: read, write or append:

- **r**  Open file for reading. The file pointer is positioned at the beginning of the file.
- **r+** Open file for reading and writing. The file pointer is positioned at the beginning of the file.
- **w**  Truncate file to zero length or create file for writing. The file pointer is positioned at the beginning of the file.
- **w+** Open file for reading and writing. The file is created if it does not exist, otherwise it is truncated. The file pointer is positioned at the beginning of the file.
- **a**  Open file for writing. The file is created if it does not exist. The file pointer is positioned at the end of the file.
- **a+** Open file for reading and writing. The file is created if it does not exist. The file pointer is positioned at the end of the file.
All modes can have a 'b' appended, indicating binary access. The 'b' can be positioned before or after the '+'. This mode affects the `ios_read` and `ios_write` commands. The `ios_read` command writes host data to target memory. In binary mode MAUs (minimum addressable units) are filled with a number of bytes that fits in 1 MAU. For example, a MAU with a size of 24 bits will be filled with 24/8= 3 bytes. Otherwise the least significant 8 bits of a MAU will be filled with 1 byte and the highest 16 bits will be filled with zeros. The `ios_write` command writes target memory to the host. In binary mode for each MAU the number of bytes to be written equals the number of bytes that fits in 1 MAU. For a MAU size of 24 bits CrossView Pro will write 3 bytes to the host. If the mode is not binary CrossView Pro will write the least significant 8 bits (1 byte) of each MAU to the host.

CrossView Pro opens all files by default in `w+` mode, overwriting the opened file if it already exists.

The optional 'r' specifies to rewind to the beginning of the file when the end of file is reached.

`$xvw_variable` is a user special variable in CrossView Pro which holds the value of the newly opened stream number. This variable can also be used in the read and write commands to read from or write to the file.

**Example**

To open a new File I/O stream, type:

```
ios_open
```

To open file `data.txt` and assign the new stream number to `$ios_nr`, type:

```
ios_open "data.txt",,,$ios_nr
```

To open file `data.txt` in read-only mode and wrap around when end of file is reached, type:

```
ios_open "data.txt",r,r,$ios_nr
```

`ios_wopen, ios_close, ios_read, ios_write`
ios_read

Function
Read binary data from an I/O stream.

The command line syntax is:

ios_read {stream | "file"},address,number_of_maus[,x]

Description
You can specify a File I/O stream number or a filename. address is the memory location where the read data will be stored. number_of_maus is the length of the data to be read in MAUs (minimum addressable units).

The optional ',x' specifies that the read data should be interpreted as hexadecimal values. The hexadecimal format is a whitespace separated (no TAB) hexadecimal string without the 0x prefix.

If the stream was opened in binary mode (see ios_open), MAUs are filled with a number of bytes that fits in 1 MAU. For example, a MAU with a size of 24 bits will be filled with 24/8= 3 bytes. Otherwise the least significant 8 bits of a MAU will be filled with 1 byte and the highest 16 bits will be filled with zeros.

Example
To read 16 minimum addressable units from stream 4, type:

ios_read 4,0x100,16

To read from stream $istrm 1 MAU hex value, type:

ios_read $istrm,0x100,1,x

ios_readf, ios_write, ios_open
ios_readf

Function

Formatted read from an I/O stream (scanf). Store the data at the location defined by the expression.

The command line syntax is:

```plaintext
ios_readf {stream | "file"},"format",expression
```

description

You can specify a File I/O stream number or a filename. format is a format specifier as used in the scanf C library function. expression can be any CrossView Pro expression.

Valid format specifiers are:

- `%d` Decimal.
- `%x` Hexadecimal (without 0x prefix).
- `%c` Char.
- `%s` String.
- `%f` Float.

Example

To read a hex value from stream 4 and store it the value of program variable ch1, type:

```plaintext
ios_readf 4,"%x",ch1
```

To read a hex value from stream 4 and store it in register R2, type:

```plaintext
ios_readf 4,"%x",$R2
```

To read two hex values from stream $istrm and assign them to program variable ch1 and target register R2, type:

```plaintext
ios_readf $istrm,"%x %x",ch1,$R2
```

ios_read, ios_write, ios_open
**ios_rewind**

**Function**
Move File I/O file pointer to the beginning of the file.

From the **Settings** menu, select **I/O Simulation Setup**... Open the **File I/O** tab and click on the **Configure**... button. Attach a stream to a probe point. In the New Stream dialog enable the **Wrap around** check box.

The command line syntax is:

```
ios_rewind {stream | "file"}
```

**Description**
With **ios_rewind** the file pointer is moved to the beginning of the file.

**Example**
To move the file pointer of the file connected to stream 4 to the beginning of the file, type:

```
ios_rewind 4
```

To move the file pointer of the file connected to stream $istrm to the beginning of the file, type:

```
ios_rewind $istrm
```

To move the file pointer to the beginning of file *my.txt*, which is connected to a stream, type:

```
ios_rewind "my.txt"
```

**Electrosoft**

**ios_read, ios_write, ios_open**
**ios_wopen**

**Function**

Open a File I/O stream and map the stream to a terminal window.

From the Settings menu, select **I/O Simulation Setup**... Open the File I/O tab and click on the **Configure...** button. Attach a stream (which is only connected to a terminal window) to a probe point.

The command line syntax is:

```
ios_wopen ["terminal_window"],[xvw_variable]
```

**Description**

When the name matches the name of an existing terminal window the newly opened stream is mapped to this terminal window.

`$xvw_variable` is a user special variable in CrossView Pro which holds the value of the newly opened stream number. This variable can also be used in the read and write commands to read from or write to the `terminal_window`.

You can close the opened stream with **ios_close**.

**Example**

To create a new terminal window and map the newly created stream to it. The name of the new terminal window will be like `#x`, type:

```
ios_wopen ,$ios_nr
```

To open a new stream and if there is a terminal window with the name "My terminal” map stream to it, otherwise create a new terminal and name it "My terminal”, type:

```
ios_wopen "My terminal",$ios_nr
```

**ios_open, ios_close**
**ios_write**

**Function**

Write binary data to an I/O *stream*.

The command line syntax is:

```
ios_write {stream | "file"}, address, number_of_maus[,x]
```

**Description**

You can specify a File I/O stream number or a filename. *address* is the memory location where the data will be read from. *number_of_maus* is the length of the data to be written in MAUs (minimum addressable units).

The optional ‘,x’ specifies that the data should be interpreted as hexadecimal values. The hexadecimal format is a whitespace separated (no TAB) hexadecimal string without the 0x prefix.

If the stream was opened in binary mode (see *ios_open*), for each MAU the number of bytes to be written equals the number of bytes that fits in 1 MAU. For a MAU size of 24 bits CrossView Pro will write 3 bytes to the host. If the mode is not binary CrossView Pro will write the least significant 8 bits (1 byte) of each MAU to the host.

**Example**

To write 16 minimum addressable units to stream 4, type:

```
ios_write 4,0x100,16
```

To write 1 MAU hex value to stream $ostrm, type:

```
ios_write $ostrm,0x100,1,x
```

`ios_read`, `ios_writef`, `ios_open`
**ios_writef**

**Function**

Formatted write to an I/O stream (printf).. The data is obtained from the C expression, for example a variable.

The command line syntax is:

```
ios_writef {stream | "file"},"format",expression
```

**Description**

You can specify a File I/O stream number or a filename. *format* is a format specifier as used in the printf C library function. *expression* can be any CrossView Pro expression.

Valid format specifiers are:

- `%d` Decimal.
- `%x` Hexadecimal (without 0x prefix).
- `%c` Char.
- `%s` String.
- `%f` Float.

**Example**

To write the hex value of program variable ch1 to stream 4, type:

```
ios_writef 4,"%x",ch1
```

To write the hex value of register R2 to stream $ostrm, type:

```
ios_writef $ostrm,"%x",$R2
```

To write the hex values of program variable ch1 and target register R2 to stream 4, type:

```
ios_writef 4,"%x %x",&ch1,$R2
```

ios_read, ios_write, ios_open
Function

Synchronize the viewing and execution positions.

To synchronize the positions manually, click on the Find PC button in the Source Window or select Find PC from the Edit menu.

The command line syntax is:

```
L
```

Description

This command synchronizes the viewing and execution positions. It also lists the current file, function and line number of the current program counter. The viewing position is always moved to match the execution position.

The L command is synonymous with a 0 e command and does not affect the execution position.

This command is not allowed when the target runs in the background.

Example

To synchronize the viewing and execution positions, then list current file, function, and line number, type:

```
L
e, l
```
Function

List.

In general, the dialog box in which you define a feature also contains a list.

The command line syntax is:

```
ll { a | b | d | f | g | k | l | L | m | p | r | s | S } [string]
ll [func]
ll stack
```

Description

In the first case above, list one of the following: assertions, breakpoints, directories, files, globals, kernel state data, labels (on module scope), all Labels, memory map (of application code sections), procedures, registers, special variables, Symbol tables. If string is present, then list only those items that start with string.

In the second case, list the values of all parameters and locals of the function func. Without a function, this command lists all parameters and locals of the current function in view.

In the third case, list all parameters and locals of the function at depth stack.

The lf and lm commands also show the address of the modules' first procedure. The lm command is identical to lf, list files, but the list of files is sorted on ascending segment addresses. func must be a function on the stack or the current function.
For configurations that support real-time kernels, the `lk` command can have one of the following arguments (`lk` is the same as specifying `lk t`):

- `t`  - Display tasks.
- `m`  - Display mailboxes.
- `q`  - Display queues.
- `p`  - Display pipes.
- `s`  - Display semaphores.
- `e`  - Display events.
- `h`  - Display HISRs (High-level Interrupt Service Routines)
- `si` - Display signals.
- `ti` - Display timers.
- `pm` - Display partition memory.
- `dm` - Display dynamic memory.
- `r`  - Display resources.
- `misc` - Display miscellaneous information.

**Example**

To list defined assertions and the state of the assertion mechanism, type:

```
  l a
```

To list all locals and parameters of the current function, type:

```
  l p
```

Data is displayed using the normal (`/n`) format. To list all the parameters and locals of the function `fcn`, type:

```
  l fcn
```

To list queue information for the current tasks (only if your configuration supports it), type:

```
  l k q
```
load

Function

Load a program’s symbol file and download the image part.

From the File menu, select Load Symbolic Debug Info... This dialog allows you to specify the file.

The command syntax is:

\texttt{load [filename]}

Description

This command performs the N and dn commands successively.

Downloading a file only copies the image part into target memory (dn). It will not cause CrossView Pro to re-read symbolic information (N). The load command does both.

This command is not allowed when the target runs in the background.

Example

To load the symbol table of file demo.abs in CrossView Pro and download the image part, type:

\texttt{load demo.abs}

\texttt{dn, N}
**M**

**Function**
List the data currently being monitored.

Refer to the Data Window. Each time the program stops, the debugger evaluates all monitored expressions and displays the results in the Data Window.

The command line syntax is:

```
M
```

**Description**
List all C expressions being monitored by CrossView Pro. The listing associates a unique number with each expression. This number is used to specify the deletion of monitored data.

```
m
```
**Function**
Monitor (watch) an expression. (Also delete a monitor.)

From the Source Window, double-click on an expression. A new monitor is created in the Data Window or the Expression Evaluation dialog is opened if the Bypass Expression Evaluation Dialog check box in the Data Display Setup dialog is not set. If the latter is the case, click on the Add Watch button to create a new monitor in the Data Window. To remove an existing monitor, select the monitor in the Data Window and click on the Delete Selected Data Item button.

The command syntax is:

```
m exp
number m d
```

**Description**
The `m` command has two distinct functions. The first monitors the given expression. The second deletes the monitoring of the expression specified by `number`.

Data monitoring takes place whenever the program stops execution, that is, for a breakpoint, assertion, single step, or user interrupt (`ctrl-C`). In window mode, the values of all currently monitored data are displayed in the Data window. Each piece of monitored data has a unique identifying number that is used when deleting it.

**Example**
To monitor the value of the variable `myvar`, type:

```
m myvar
```

To monitor the address of variable `myvar`, type:

```
m &myvar
```

To monitor the element `alpha+1` of `array`, type:

```
m array[alpha+1]
```
To delete expression number 2 of the monitored data, type:

```
2 m d
```

M, b, a, s, R, C
**mcp**

**Function**

Memory copy.

From the Memory Window, click on the **Copy Memory** button to open the Copy Memory dialog. Enter the start address and the end address (inclusive) of the memory region you want to copy. Enter the destination address and click on the **OK** button.

The command syntax is:

```
addr_start mcp addr_end, addr_dest
```

**Description**

The `mcp` command copies a block of target memory starting at address `addr_start` to destination address `addr_dest`. The size of the memory block is defined as: `addr_end - addr_start + 1`. The data item located at address `addr_end` is included in the copy.

If your target supports multiple memory spaces then it is legal to copy data between different memory spaces. Of course `addr_start` and `addr_end` must be located in the same memory space. This command does not have any effect on code breakpoints.

**Example**

To copy the contents of variable `buf` to address `0x200`, type:

```
&buf mcp &buf+sizeof(buf), 0x200
```

`mF, mf`
memget

Function

Retrieve data from the target into a buffer.

The command line syntax is:

```
memget expr,count,buffer_name
```

Description

The `memget` command is used to retrieve data from the target system and to store the data in the acquisition buffer `buffer_name`. Data in the acquisition buffer is of type `double`. CrossView Pro will automatically handle data conversion based upon the type of expression `expr`.

Expression `expr` contains the iterator "$i" which initially starts at 0 and increments to `count-1`.

Notation convention:
"expr<$i{n}>" means "expr in which all instances of "$i" are substituted by "n"."

To correctly retrieve the data from the target CrossView Pro needs to know the start address, the size of the data elements, and the number of items to fetch. The number of items to fetch from the target is specified by `count`. The following algorithm is used to fill the acquisition buffer:

```c
addr0 = (char *) &expr<$i{0}>
addr1 = (char *) &expr<$i{1}>
delta = addr1 - addr0
elem_size = sizeof(expr<$i{0}>)
type = C-type(expr<$i{0}>)
for (i = 0; i < count; i++)
{
    value = read elem_size MAUs from address addr0 + (i * delta)
    buffer[i] = convert_to_double(type, value);
}
```
Example

1. C structure access.

    struct
    {
        double re,
            im;
        int f;
    } data[100];

    To store the data[\(x\)].re values into acquisition buffer \(a\):

    \texttt{memget data[\(i\)].re,100,\(a\)}

    To store the data[\(x\)].im values into acquisition buffer \(b\):

    \texttt{memget data[\(i\)].im,100,\(b\)}

2. Memory access.

    To retrieve 18 integer values from memory starting at address 0x100 and store these in acquisition buffer \(\texttt{buffer}\):

    \texttt{memget ((int[]) 0x100)[\(i\)],3*6,\texttt{buffer}}

\textbf{bufa, bufd, graph, rawmemget.}

Section 11.5, \textit{Data Analysis}, in chapter \textit{Special Features}. 
mF

Function
Memory single fill.

From the Memory Window, click on the Fill Single Memory Address button to open the Single Fill Memory dialog. Enter the start address the memory region you want to fill. Enter one or more expressions separated by commas and click on the OK button.

The command syntax is:

```
addr mF expr [,expr]...
```

Description
The mF command fills target memory with data. The value defined by expr is written to address addr in target memory. Multiple exprs separated by commas may be entered. Each expr is written to a subsequent MAU.

If your target supports multiple memory spaces then addr may refer to any memory space.

If the sizeof a given expr occupies more than one MAU, only the least significant MAU will be written to memory. This command does not have any effect on code breakpoints.

Example
To store value 0x12 at memory location 0x400 and value 0xAB at location 0x401, type:

```
0x400 mF 0x12, 0xAB
```

mcp, mf
**Function**

Memory fill, repeating the specified pattern until the specified region is filled.

From the Memory Window, click on the **Fill Memory** button to open the Memory Fill dialog. Enter the start address and end address (inclusive) of the memory region you want to fill. Enter one or more expressions separated by commas and click on the **OK** button.

The command syntax is:

```
addr_start mf addr_end, expr [expr]...
```

**Description**

The **mf** command fills a block of target memory with a pattern. The memory region starting at address `addr_start` and ending at address `addr_end` is filled with the pattern defined by `exp [exp]`. Multiple `exp`s separated by commas may be entered. Each `exp` is written to a subsequent MAU.

The specified pattern is repeated until the end address of memory region is reached.

If your target supports multiple memory spaces then `addr` may refer to any memory space.

If the sizeof a given `exp` occupies more than one MAU, only the least significant MAU will be written to memory. This command does not have any effect on code breakpoints.

**Example**

To store values `0x01` and `0x02` at succeeding memory locations in the range `0x400` to `0x404`, type:

```
0x400 mf 0x404, 0x01, 0x02
```
The result of this command is:

```
address: 0x400 0x401 0x402 0x403 0x404
value:    1   2   1   2   1
```

mcp, mf
Function

Memory search.

From the Memory Window, click on the **Find Memory** button to open the Search Memory dialog. Enter the start address and end address (inclusive) of the memory region you want to search. Enter one or more search patterns separated by commas and click on the **OK** button.

The command syntax is:

```
addr_start ms addr_end, expr [,expr]...
```

Description

The `ms` command searches for a pattern within a block of target memory. The memory region starting at address `addr_start` and ending at address `addr_end` (inclusive) is searched for the pattern defined by `expr [expr]`. Multiple `exp`s separated by commas may be entered. Each `exp` corresponds to a subsequent MAU.

If your target supports multiple memory spaces then `addr` may refer to any memory space.

This command does not have any effect on code breakpoints.

Example

Suppose the memory range `0x400` to `0x4ff` was filled using the following commands:

```
0x400 mf 0x4ff, 0
0x400 mf 0x404, 1, 2
```

To search for the values `0x01` and `0x02` at memory locations in the range `0x400` to `0x4ff`, type:

```
0x400 ms 0x4ff, 0x01, 0x02
```

The result of this command is:

```
FOUND pattern at 0x400
FOUND pattern at 0x402
```
mcp, mF, mf
**Function**

Load a program’s symbol file.

From the **File** menu, select **Load Symbolic Debug Info...** This menu item allows you to specify the file.

The command syntax is:

```
N [[path]filename[.abs]]
```

**Description**

Load the symbol table of the specified file in CrossView Pro. If no filename is given, the file being debugged is reloaded. In this case only the breakpoints set by the user are removed. Monitors, I/O simulation streams, assertions and CrossView Pro local variables remain active.

If a new file (different filename) is loaded, all breakpoints, monitors, I/O simulation streams, assertions and CrossView Pro local variables are removed.

If a path is supplied, CrossView Pro changes its current directory according to the specified path. In case a relative search path to source files was provided at startup time, CrossView Pro will search relative to the new working directory.

This command is automatically executed during CrossView Pro startup when a filename was given on the command line. Use the **dn** command to send the associated executable code to the target.

**Example**

To load the symbol table of file `demo.abs` in CrossView Pro, type:

```
N demo.abs
dn
```
## `n` Command

### Function
Set address bias

From the **File** menu, select **Load Symbolic Debug Info...** In the Load Symbolic Debug Info dialog you can edit the **Code address bias** field.

The command syntax is:

```
  n [ addr ]
```

### Description
Set address bias of overlay files to `addr`. If no address is given, then display current bias.

If a program is to be loaded at a different address than that indicated in the linked and located (absolute object) file, then the address information in the debugger’s symbol file will be incomplete, since it does not know where the program is actually going to be loaded. This command will normalize the addresses by adding the bias to every address.

### Example
To add a bias of 1000 to every address in the code, type:

```
  n 1000
```

To display the current bias, type:

```
  n
```
nC

Function
Set the viewing position to the next covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

nC

Description
If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the next block of statements that have been executed while the program was running on the target.

Example
To move the cursor to the next executed block, type:

nC

nU, pC, pU
nU

Function
Set the viewing position to the next not covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

nU

Description
If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the next block of statements that have not been executed while the program was running on the target.

Example
To move the cursor to the next not executed block, type:

nU

nC, pC, pU
Function

Enter emulator mode.

From the View menu, select Command | Emulator. If you know the emulator-level command language, you can communicate directly with the emulator from this window.

The command line syntax is:

\texttt{o string}

Description

Pass \texttt{string} to emulator and show the emulator response.

The \texttt{o} command lets you communicate with the emulator directly via emulator commands.

Do not issue one-shot transparency emulator commands that result in large output (or otherwise require intervention other than a carriage return to terminate output). Instead, enter transparency mode first, then issue the command.

Example

To send the string \texttt{map} to the emulator, type:

\texttt{o map}
opt

Function
Set or display specific options.

Option values can be changed in various dialogs and menus.

The command line syntax is:

```
opt [ option_name [= option_value]]
```

Description
If no arguments are passed, all options with their current value are listed. By specifying an option’s name, the current value of that option is displayed. By specifying an option name followed by a valid value, the option is set to that new value.

The options are a sub-set of CrossView’s so-called ”special variables”. See Chapter 3, Command Language, for a list of all special variables.

Example
To display all options, type:

```
opt
```

To disable mixing of disassembly code and source lines in the assembly window, type:

```
opt mixedasm=off
```
P

Function

Print source lines, including machine addresses.

In the Source Window, the machine address of the line at the current viewing position is displayed in the address field in the upper left corner.

The command line syntax is:

\[ \text{line} \ P \text{exp} \]

Description

Print \text{exp} \ lines of source starting at line \text{line}, including machine addresses. If \text{exp} is omitted, print one line. If \text{line} is omitted, start from the current viewing position.

Example

To print source lines 4, 5, 6, 7 and 8 (displaying machine addresses) of the current source file, type:

\[ \text{4 P 5} \]
p

Function
Print source lines.

C source is displayed in the Source Window.

The command line syntax is:

\[ \text{line} \ p \ \text{exp} \]

Description
Print exp lines of source starting at line line. If exp is omitted, print one line. If line is omitted, start from the current viewing position.

Example
To print source lines 4, 5, 6, 7 and 8 of the current source file, type:

\[ 4 \ p \ 5 \]
Function
Set the viewing position to the previous covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

pC

Description
If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the previous block of statements that have been executed while the program was running on the target.

Example
To move the cursor to the previous executed block, type:

pC

nC, nU, pU
**pd**

**Function**
Disable, turn off, profiling.

From the **Tools** menu, select **Profiling** if this item was set.

The command line syntax is:

```
pd
```

**Description**
If profiling is supported by your version of CrossView Pro, this command disables the profiling system. Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

**Example**
To disable profiling, type:

```
pd
pe
```
Function
Enable, turn on, profiling.

From the **Tools** menu, select **Profiling** if this item was not set.

The command line syntax is:

```
pe
```

Description
If profiling is supported by your version of CrossView Pro, this command enables the profiling system. Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example
To enable profiling, type:

```
pe
```

```
pd
```
proinfo

Function
List profiling results.

From the Tools menu, select Profiling Report...
Make your changes and select the Update button.

The command line syntax is:

\[ \text{proinfo } [[\text{all} \mid \text{module_or_function_name}]][\text{filename}] \]

Description
If profiling is supported by your version of CrossView Pro and profiling is enabled, this command lists the profiling results. Without arguments (same as all) this command lists the profiling information of all modules and function.

Instead of listing the results you can also save the results in a file with extension .pro.

Normally, you should disable profiling if you are not interested in the profiling results, as this will often improve the performance of the execution environment.

Example
To list the profiling results of all modules and functions to the output window, type:

pe
proinfo

To list profile information of function main to the output window, type:

proinfo main

To list profile information of all modules and functions in file hello.pro, type:

proinfo all,hello.pro

cproinfo, pd, pe
**Function**

Reset the application being debugged to initial conditions. That is, set the program counter to the start address of the application.

From the **Run** menu, select **Reset Application**.

The command line syntax is:

```
prst
```

**Description**

The program counter is set to the start address of the application being debugged. This command does NOT perform a hardware reset of the target system. That is, no registers are modified except for the program counter.

This command is not allowed when the target runs in the background.

**R, rst**
pU

**Function**

Set the viewing position to the previous not covered block of statements.

Use the scroll bar and click on the desired line.

The command line syntax is:

```
pU
```

**Description**

If code coverage is supported by your version of CrossView Pro, this command enables you to skip to the previous block of statements that have not been executed while the program was running on the target.

**Example**

To move the cursor to the previous not executed block, type:

```
 pU
```

```
nC, nU, pC
```
Function

Quiet breakpoint reporting.

The command line syntax is:

Q

Description

If this appears as the first command in a breakpoint’s command list, the debugger does not make the usual announcement of:

function: line number: source file

when the breakpoint is hit.

The purpose of this command is to allow quiet breakpoint reporting. For example, to check the value of a variable without cluttering the screen with text.

Example

If you type the following:

21 b {Q; var1}

CrossView Pro will set a breakpoint at line 21. When that breakpoint is hit, CrossView Pro will print the value of var1, but will not print the current function, line number, and source file.
### q

**Function**
Quit a debugging session.

- From the **File** menu, select **Exit**.
- The command line syntax is:
  
  \[ q \ [ s \ | \ y ] \]

**Description**
CrossView Pro will prompt you if you really want to quit if you do not specify anything. Note that the current desktop settings are NOT saved then!

Typing `q s` saves the current desktop settings and quits the debugger without confirmation.

Typing `q y` does not save the current desktop settings and quits the debugger without confirmation.

Inside a command line procedure call it will just quit from this.

When the target runs in the background CrossView Pro will first stop the target.
Function

Reset program and begin execution from initial conditions.

From the **Run** menu, select **Reset Application** and then **Run**.

The command line syntax is:

```
R
```

Description

Reset the application being debugged and begin execution from initial conditions. The program counter is set to the start address of the application being debugged. This command does NOT perform a hardware reset of the target system. That is, no registers are modified except for the program counter.

This command is not allowed when the target runs in the background.

```
C, g, prst
```
**rawmemget**

**Function**
Retrieve data from the target into a buffer.

The command line syntax is:

```
rawmemget address,type,count,bufferno [interleave]
```

**Description**
The `rawmemget` command is used to retrieve data from the target system and to store the data in the acquisition buffer `bufferno`. Data in the acquisition buffer is of type `double`. CrossView Pro will automatically handle data conversion based upon the `type` of the data. It reads `count` elements of type `type` from the target starting at address `address` into the buffer.

`interleave` indicates the distance between successive elements. The default value is `sizeof(type)`.

**Example**
To retrieve 18 integer values from memory starting at address 0x100 and store these in acquisition buffer `$buffer`:

```
rawmemget 0x100,int,3*6,$buffer
```

`bufa, bufd, graph, memget`.
Section 11.5, *Data Analysis*, in chapter *Special Features*. 
rst

Function
Reset target system to initial conditions.

From the Run menu, select Reset Target System.

The command line syntax is:
rst

Description
The target is initialized according to the power-up sequence for the processor. Almost all registers, including the system stack pointer and program counter are initialized.

A target system reset may have undesired side effects. To be sure that the application code is correct, a download must be performed after a target system reset.

This command is not allowed when the target runs in the background.

t, prst
Function

Single step C statements, stepping over function calls.

To step over a function, click on the Step Over button in the Source Window. You can also select Step Over from the Run menu. Check the Step Mode menu item in the Run menu: Source line step must be selected.

The command line syntax is:

\[ \text{[ exp ] S} \]

Description

If you try to step over a call to a function which contains a breakpoint (or which calls another function with a breakpoint) then the breakpoint will be hit.

Stepping over a function means that CrossView Pro treats function calls as a single statement and advances to the next line in the source. This is a useful operation if a function has already been debugged or if you do not want to take the time to step through a function line by line.

When multiple statements are present on one line, they are all executed by this single step.

This command is not allowed when the target runs in the background.

Example

To step one C statement, type:

\[ \text{s} \]

To step five C statements, type:

\[ \text{5 s} \]

C, s, si, Si
S

Function

Single step C statements, stepping into function calls

To step into a function (single step), click on the Step Into button in the Source Window. You can also select Step Into from the Run menu. Check the Step Mode menu item in the Run menu: Source line step must be selected.

The command line syntax is:

\[ \texttt{[exp]} \texttt{s} \]

Description

Single step exp (default is 1), C statements, stepping into function calls.

Stepping into a function means that CrossView Pro enters the function and executes its prologue machine instructions halting at the first C statement. When the end of the function is reached, CrossView Pro brings you back to the line after the function call. The debugger changes the source code file displayed in the Source Window, if necessary.

This command is not allowed when the target runs in the background.

Example

To step one source instruction, type:

\[ \texttt{s} \]

To step five source instructions, type:

\[ \texttt{5 s} \]

C, S, si, Si
save

Function
Save macros.

From the Tools menu, select Macro Definitions... to open the Macro Definitions dialog box. From this dialog box, you can save macros with the Save button. To save macro definitions in a file other than the current one, click on the Save as... button.

The command line syntax is:

```
save file
```

Description
Save all currently defined macros in the specified file. This file is in the format of a sequence of set commands, and thus can be loaded by reading it as a playback file. See the < and << commands.

An existing save file with the same name will be overwritten.

Example
To save the definitions of the currently defined macros in the file mac.sav, type:

```
save mac.sav
```

```
set, unset, echo, !, <, <<
```
**set**

**Function**

Definition and display of macros.

To create a macro, select **Macro Definitions...** from the **Tools** menu. Click on the **New...** button and add a new macro.

The command line syntax is:

```
set [ name [ "cmds" ] ]
```

**Description**

The set command allows for definition and display of macros. If *name* and *cmds* are supplied, a macro entry is made associating the *name* with the commands. If only *name* is supplied, the body of the specified macro is displayed.

If no arguments are supplied the names of all currently defined macros are displayed. Macro definitions must contain the body of the macro in double quotation marks.

Macros may take arguments. In the body of a macro formal arguments are referred to as `$n`, where `n` is the argument number starting from 1.

It is important to understand that macro expansion takes place for all names. Therefore, if you wish to pass the name of an existing macro to a command, such as **set**, you must escape it with '!', to keep CrossView Pro from expanding the name.

**Example**

To display the names of all currently defined macros, type:

```
set
```

To display the body of the macro named *macro*, type:

```
set macro!
```

To define *macro* to be a macro which lists the registers then enters the function given by its first argument, type:

```
set macro "l r; e $1"
```
To invoke this macro, you might type, for example:

\begin{verbatim}
macro(main)
unset, echo, save, !
\end{verbatim}
**Si**

**Function**
Single step machine instructions, stepping over subroutine calls

From the **Run** menu, select **Step Mode | Instruction step**. Then click on the **Step Over** button in the Source Window, or select **Step Over** from the **Run** menu.

The command line syntax is:

\[ [ \text{exp} ] \text{ Si} \]

**Description**
Single step \text{exp} (default is 1) machine instructions, stepping over subroutine calls.

If you try to step over a call to a subroutine which contains a breakpoint (or which calls another subroutine with a breakpoint) then the breakpoint will be hit.

The next instruction to be executed is shown as a disassembled instruction, not as a C statement.

This command is not allowed when the target runs in the background.

**Example**
To step one machine instruction, type:

\textbf{Si}

To step five machine instructions, type:

\textbf{5 Si}

\textbf{C, s, S, si, R}
**si**

**Function**
Single step machine instructions, stepping into subroutine calls

From the **Run** menu, select **Step Mode | Instruction step**. Then click on the **Step Into** button in the Source Window, or select **Step Into** from the **Run** menu.

The command line syntax is:

```
[ exp ] si
```

**Description**
Single step $exp$ (default is 1), machine instructions, stepping into subroutine calls.

The next instruction is shown as a disassembled instruction, not as a C statement.

This command is not allowed when the target runs in the background.

**Example**
To step one machine instruction, type:

```
si
```

To step five machine instructions, type:

```
5 si
```

C, s, S, Si, R
**st**

**Function**
Stop the execution of the target immediately.

The command line syntax is:

```
st
```

**Description**
This command stops the running process immediately.

Not available for all execution environments.

CB, wt
Function

Stack trace with local variables

The command line syntax is:

\[ \text{[ exp ] T} \]

Description

Produce a trace of functions on the stack and show local variables. Only the first \( \text{exp} \) levels of the stack trace will be displayed. If \( \text{exp} \) is omitted, all of the levels of the stack trace (up to 20) will be printed.

This command works independently of the Stack Window.

This command is not allowed when the target runs in the background.

Example

To print out a stack trace of 20 levels with corresponding local variables, type:

\[ \text{T} \]

To print out the top five levels of the stack trace with corresponding local variables, type:

\[ 5 \text{ T} \]

\[ e, l, t \]
t

Function

Stack trace.

From the View menu, select Stack. The Stack Window shows the current situation in the stack after the program has been stopped. It displays the following information for each stack frame:

- The name of the function that was called
- The value of all input parameters to the function
- The line number in the source code from which the function was called

The command line syntax is:

\[ [ \text{exp} ] \ t \]

Description

Produce a trace of functions on the stack.

exp specifies the number of levels of the stack trace to be displayed. If omitted, up to 20 levels of the stack trace will be printed.

Each stack level shown in the Stack Window is displayed with its level number first. The levels are numbered sequentially from zero. That is, the lowest/last level in the function call chain is always assigned zero.

This command is not allowed when the target runs in the background.

Example

To print out a stack trace of 20 levels, type:

\[ t \]

To print out the top five levels of the stack trace, type:

\[ 5 \ t \]

\[ e, l, T \]
td

**Function**
Disable, turn off, trace.

From the **Tools** menu, select **Trace** if this item was set.

The command line syntax is:

```
  td
```

**Description**
If trace is supported by your version of CrossView Pro, this command disables tracing (both instruction level, high level and raw). Trace is automatically disabled when you close the Trace Window.

**Example**
To disable tracing, type:

```
  td
```

```
te
```
**te**

**Function**
Enable, turn on, trace.

From the **Tools** menu, select **Trace** if this item was not set.

The command line syntax is:

```
te
```

**Description**
If trace is supported by your version of CrossView Pro, this command enables tracing (both instruction level, high level and raw). Trace is automatically enabled when you open a Trace Window.

**Example**
To enable tracing, type:

```
te
```

```
```
u

Function
Toggle the updating of the appropriate window when the target runs in the background.

The command line syntax is:

\[ \text{[interval]} \ u \ \text{[d|k|r|s|a|mem|t]} \]

Description
The following windows can be updated:

- **d** (Data), **k** (Stack), **r** (Register),
- **s** (Source), **a** (Assembly), **mem** (Memory), **t** (Trace)

With \textit{interval} you can specify the update interval (in seconds). If \textit{interval} is zero, no window is automatically updated.

The updating of the Data Window is ON at startup, the others are OFF.

If all windows are being updated and/or many monitor commands are active it will increase the load on the communication between CrossView Pro and the target.

This command is not available if the background mode is not supported (check the addendum).

Example
To toggle the updating of the Register Window, type:

\[ \text{u} \ \text{r} \]

To toggle the updating of the Source Window, type:

\[ \text{u} \ \text{s} \]

To disable period updating, type:

\[ 0 \ u \]

CB, ubgw
ubgw

Function
Update the appropriate window when the target runs in the background.

From the View menu, select **Background Mode** and select one of the refresh options.

The command line syntax is:

```
ubgw [ s | a | k | r | d | mem | t | all ]
```

Description
The following windows can be updated:

- **s** (Source), **a** (Assembly), **k** (Stack), **r** (Register), **d** (Data), **mem** (Memory), **t** (Trace), **all** (all open windows)

Without an argument, the **ubgw** command refreshes all windows selected by the background mode (u command).

The **ubgw all** command refreshes all open windows.

This command is not available if the background mode is not supported (check the addendum).

Example
To update the Source Window, type:

```
ubgw s
```

To update the Memory Window, type:

```
ubgw mem
```
**unset**

**Function**
Delete a macro definition.

From the **Tools** menu, select **Macro Definitions...** to open the Macro Definitions dialog box. Highlight the name of the macro and click on the **Delete** button.

The command line syntax is:

```
unset [ name !]
```

**Description**
The **unset** command deletes a macro. If *name* is supplied, the specified macro is deleted. If no arguments are supplied, all currently defined macros are deleted after CrossView Pro confirms your intent.

It is important to understand that macro expansion takes place for all names. Therefore if you wish to pass the name of a macro to a command, for example **unset**, you must escape it with `!`, to keep from expanding the name.

**Example**
To delete all macros, type:

```
unset
```

CrossView Pro will first ask for confirmation. To delete all the macro definitions at the same time, click on the **Delete all** button in the Macro Definitions dialog box.

To delete the macro named **macro**, type:

```
unset macro!
```

**set, echo, save, !**
update

Function
Update a Data Analysis window.

⚠️ Click on the **Update Data Analysis Window** button in a Data Analysis window.

📖 The command line syntax is:

```plaintext
update "window"
```

Description
Update Data Analysis window *window* by issuing a sequence of update commands. These update commands were added with the **graph_add_update** command.

⚠️ When you use the **update** command in a complex breakpoint, you should append a ‘!’ character to prevent early macro expansion.

Example
To retrieve data and show it in window *demo*, type:

```plaintext
graph_clear_updates "demo"
graph_add_update "demo",memget data[$i],100,$buffer
graph_add_update "demo",graphm "demo","show_x_t.cxl"
graph_add_update "demo",graph "demo","x_t.cxl","buffer",0,1
update "demo"
```

To update window *demo* as part of a complex breakpoint, type:

```plaintext
0x100 bi {update! "demo"}
```

**graph_add_update, graph_clear_updates.**

Section 11.5, *Data Analysis*, in chapter *Special Features*. 
**use**

**Function**
Change source directories run-time.

From the **Target** menu, select **Settings...** to open the Target Settings dialog box. Click on the **Configure...** button and specify the names of the directories containing your source files. Relative paths are allowed.

The command line syntax is:

```
use [ path ]...
```

**Description**
The **use** command changes the source directories. Without a *path* this command empties the search path, except for the path . (current directory). If one or more *paths* are supplied, this command adds the, semicolon separated, paths to the list of searched directories. Relative paths are allowed.

**Example**
To clear the source directory path, type:

```
use
```

To search for source files in the directory `/project/src` and in the `src` directory relative to your current directory, type:

```
use /project/src;../src
```
**wt**

**Function**

Wait for the completion of the target.

The command line syntax is:

```
wt
```

**Description**

This command can only be used if the target runs in the background mode.

This command waits for the running process to stop.

Waiting can be interrupted by typing `ctrl-C`. The target continues to run without interruption. It could be that some informational messages from the target are displayed in the command window. They can be ignored.

Not available for all execution environments.

`CB, st`
Function

Force an exit from assertion mode.

The command line syntax is:

```
[ exp ] x
```

Description

Normally this command stops execution immediately, but if `exp` is present and its value is non-zero, then CrossView Pro finishes executing the entire command list of the current assertion.

Example

To define an assertion to stop the program when the value of global variable `myvar` exceeds 10, type:

```
a if (myvar > 10) {x}
```

To define an assertion to suspend the assertion mechanism and continue program execution when global variable `myvar` exceeds 10, type:

```
a if (myvar > 10) { A s; 1 x; C}
```

`a, A, l`
Z

Function

Toggle case sensitivity in searches

From the **Edit** menu, select **Search String...** to open the Search String dialog box. This dialog contains the **Case Sensitive** check box.

The command line syntax is:

```
Z
```

Description

Toggle case sensitivity in searches. The initial state of this toggle depends on information in the currently loaded absolute file. Use the **I** command to find out the state of the case sensitivity.

This command affects everything: file names, function names, variables and string searches.

```
/, ?
```
14.1 WHAT THIS CHAPTER COVERS

The following is a list of common user error messages, and some suggested ways to solve the problem.

CrossView Pro is a complex program running on several hosts. From time to time, slight differences between the documentation and the program’s operations do occur. The list of errors presented below and the suggested remedies may not be, therefore, entirely comprehensive.

If you get a message that begins with "XVW Error" or "XVW Fatal Error" please contact TASKING technical support for help.

14.2 ERROR MESSAGES

(in alphabetical order):

"member-name" is not defined for "enum enum"

You cannot assign or compare an enum type with a name that is not in the enumeration's members. Try casting the enum to a different type.

'save' must have a filename; type 'help save' for more information

The save command requires a file to be supplied. Note: if the supplied file name already exists, it will be overwritten.

*** Fatal XVW error

CrossView Pro has detected a error which it can not handle. If information is displayed, you may be able to detect the source of the error and correct it. Otherwise, if the message persists, please contact TASKING Technical Support.

0xvalue is an invalid value. The register register is unchanged.

The value supplied is incorrect for the specified register. Verify that both the value and the register are correct and retry.

Adding 2 pointers not allowed

You cannot add two pointers together in an expression. If you intended to add to a pointer, make sure that the argument is a value, not another pointer.
Address not allowed for '! or ~ or % operator'

The "Not", "One's complement", and "Modulus" operators cannot be used with an address. If you intended to perform the operation on the contents of the address, please be sure to dereference the pointer.

Addresses not allowed in '* or / operator'

The multiply and divide operators cannot be used with address data. If you intended to perform the operation on the contents of the address, please be sure to dereference the pointer.

Addresses not allowed in 'bitwise logical or logical or shift operators'

Bitwise logical (&, ^, or |), logical (&& or | |), and shift (<< >>) operators only work on data, not addresses. If you intended to perform the operation on the contents of the address, please be sure to dereference the pointer.

Attempt to set breakpoint at invalid address

The memory location is not available. If the memory location is not out of the target chip’s range, you may need to map the target system’s memory to allow access to this location.

Bad argument to the command command

The argument you have given to the si0 or f command is not allowed. Refer to the Command Reference chapter, for allowable arguments and their meanings.

Bad assertion number: number

The number number is not a valid assertion number. List assertions with the la (list assertions) command to determine which assertion numbers are valid.

both expressions must be addresses for 'relational operator'

If one of the expressions is an address type, both expressions for relational operators (<, <=, >, >=, ==, and !=) must be address types. Retry with both expressions as either addresses or arithmetic types.

Breakpoint is (or at the address of) an CrossView internal breakpoint. It can not be deleted.

You may not install a breakpoint over an CrossView Pro internal breakpoint. See Breakpoints and Assertions chapter for more information.
com return code=code

The MS-DOS version of CrossView Pro received a status condition from the monitor communication channel which it can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

command takes no arguments.

The command command needs no arguments. Refer to the Command Reference chapter, for the command syntax.

Can not open file (file)

CrossView Pro could not open the file file. Check the spelling of file and check that the file is in the correct directory. You should also check the permission of file. With MS-DOS, check the CONFIG.SYS file for the maximum number of open files allowed. Increase the number and reboot if necessary.

Can not output to input stream

An attempt was made to output to an input stream. The most common case is incorrectly setting up your simulated i/o streams. Correct and retry.

Can not scroll that window

The window you have tried to scroll is not scrollable. Examine your choice of window and/or your choice of windowing commands.

Can’t define macro: out of space

There is not enough host memory to add your macro. Eliminate one or more unused macros before adding a new one.

Can’t expand macro: out of space

There is not enough host memory to expand your macro. Eliminate one or more unused macros before adding a new one.

Can’t monitor data: out of space

CrossView Pro cannot add any more variables or expressions to monitor. You must delete one or more variables or expressions before adding any more.
Can’t open **logfile-name** as log file

CrossView Pro could not open the specified host-to-target system communications logfile. Check the spelling of **logfile-name** and that **logfile-name** is in the correct directory. Check permissions of **logfile-name**. With MS-DOS, check the **CONFIG.SYS** file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host Operating System.

Can’t open **output-file-name** as output file

CrossView Pro could not open the specified output file. Check the spelling of **output-file-name** and that **output-file-name** is in the correct directory. Check permissions of **output-file-name**. With MS-DOS, check the **CONFIG.SYS** file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.

Can’t open **playback-file-name** as playback file

CrossView Pro could not open the specified playback file. Check the spelling of **playback-file-name** and that **playback-file-name** is in the correct directory. Check permissions of **playback-file-name**. With MS-DOS, check the **CONFIG.SYS** file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.

Can’t open **record-file-name** as record file

CrossView Pro could not open the specified recording file. Check the spelling of **record-file-name** and that **record-file-name** is in the correct directory. Check permissions of **record-file-name**. With MS-DOS, check the **CONFIG.SYS** file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.

Can’t open file ‘**file**’

CrossView Pro could not open the specified file. Check the spelling of **file** and that **file** is in the correct directory. Check permissions of **file**. With MS-DOS, check the **CONFIG.SYS** file for the maximum number of open files allowed. Increase the number and reboot if necessary. Make sure the filename is valid for the host operating system.
Can’t perform trace, out of memory

There is not enough host memory to support tracing. Reduce memory demands and retry again. If the problem persists, please contact the TASKING Technical Support staff for assistance.

Can’t set breakpoint; either the current file has no symbols, or line line# is not inside any procedure in the current file.

CrossView Pro was unable to set the breakpoint that you specified. First check the location of line line# and verify that it is in the current procedure being debugged. If it is within the current procedure, then you may need to compile/assemble/link/locate for debugging. Refer to chapter Overview for details.

Can’t start a new process. Feature not implemented.

Your host system does not support shell commands. Any attempt to issue shell commands will cause this message to be displayed.

Can’t write to a read-only SFR.

The SFR register is a read-only register. It can not be set or altered.

Cannot allocate memory for symbol table

Allocating memory for storing the symbol table failed. Remove some tasks from memory or add more memory to your computer system.

Cannot allocate symbol table memory buffers

The symbol table is too large for CrossView Pro. You may need to selectively compile with the -g switch only those files and procedures that most interest you.

Cannot allow that combination of operand(s) and operator

The operand(s) is/are incompatible for this type of operation. For example, you may not add two structures. Please verify the operation and data types you are using.

Character constant is missing ending ’

Character constants must be delimited with single quotes. Example: ’a’.
Command 'command' not allowed while emulator running in background

The target is running, this command is not allowed unless the target is stopped. See the st command.

couldn’t error-message

VMS is reporting a condition that CrossView Pro can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Data already being monitored "task-id":'symbol'

The variable or expression symbol is already being monitored by CrossView Pro. You do not need to enter it again.

Display format required

The display command expected an output format option that was not supplied. See chapter Command Language for valid format options and their meanings.

Double not allow in ’% or ~ operator’

You may not use the one’s complement or modulus operators on double floating point types.

Double not allow in ’bitwise operator’

You may not use bitwise operators (&, ^ and |) on double floating point types.

ERROR: you must enter ?,i,r,d

CrossView Pro’s line editor only supports the following commands: ?-help, i-insert, r-replace, d-delete, and <cr> to execute command.

Establish a file context first.

The command executed requires an active file. Verify the file you specified to CrossView Pro on start up.

Establish a procedure context first

The command executed requires an active procedure. Either execute the command from within a procedure, or give a procedure name as an argument to the command.
Exiting procedure call state

An unknown system signal caused the end of a command line function call.

Expecting stream number

The following forms of the `sio` command expect a stream number:

```
stream sio {i | o} {file | screen}
stream sio d
stream sio p prompt
```

Expression garbaged

The symbol table contains a type that is unknown to CrossView Pro. Please verify that you are using the compiler and utilities supplied to you. If the condition persists, please contact the TASKING Technical Support staff for assistance.

`file` has already been edited, going to NEW file

The command executed requires that the file be edited only once. A new file has been created.

failed to allocate the SIO tables

Entries for recording simulated input/output information could not be allocated due to lack of host memory. Please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Float not allowed in `% or ~ operator’

You may not use the modulus or one’s complement operators on floating point types. Change the data type to an appropriate type, for example, integer.

Float not allowed in ’bitwise or shift operator’

You may not use the bitwise (&, ^, or |) or shift (>>, or <<) operators on floating point types. Change the data type to an appropriate type, for example, integer.

Framing Error on COM port `number`

The host computer detected a data frame communication error on COM port `number`. Check the host and target communication set up as well as line connections. If the problem persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.
**I can’t put something that big in the child process**

The size of the expression exceeds the buffer size needed to spawn a child process. Be sure you have linked `end.c` in your application. This module implies space for CrossView Pro in your execution environment. Refer to section *Building Your Executable* in chapter *Overview*. If this condition persists, please contact the TASKING Technical Support staff for assistance.

**I don’t have symbols for this procedure**

You will need to re-compile, assemble, link and locate with the proper debugging options before using this command. See section *Building Your Executable* in chapter *Overview* for details.

**I have no source file for this address**

The program counter holds an address which is outside all the address ranges that CrossView Pro knows about. This may happen if program execution has reached a file that was not compiled with the `-g` generate debug symbols switch.

**I need a linenumber**

The `g` command requires a line number. Enter a line number and the command will be executed.

**Illegal address for Emulator Hardware Breakpoint**

The address specified is out of emulator hardware breakpoint memory range. Verify the address and retry.

**Illegal argument ("0") to 'p' command**

You must specify a number greater than 0 for the `p` command, which prints the specified number of lines.

**Illegal argument to 'command' command: 'argument'**

You have passed an illegal argument to the specified command. Refer to chapter *Command Reference* for legal arguments.

**Illegal argument to ct: 'argument'**

You have passed an illegal argument to the C-trace command. Refer to chapter *Command Reference* for legal arguments.
**Illegal data monitor command**

You have passed an illegal argument to the `m` data monitor command. Legal commands are:
- `m exp` to set up monitoring
- `id m d` to delete monitoring of a specific expressions
- `m d` to delete monitoring of all expressions

**Illegal third arg to set: 'argument'**

The `set` command may have only two arguments: the name by which the macro is known and the command string to be executed when the macro is invoked. Enclose the command string in quotes, separating the individual commands with semicolons. Refer to chapter *Command Reference* for more information.

**Improper floating point format length**

You have specified a format length that is inconsistent with floating numbers. Legal lengths are 4 and 8 bytes.

**Improper integer format length**

You have specified a format length that is inconsistent with integer numbers. Legal length are 1, 2, and 4 bytes. You may also choose `b`, `s`, or `l` for 1, 2, and 4 byte integers.

**Improper string format length**

You have specified a format length that is inconsistent with character strings. Choose a positive number.

**Input buffer overflow**

CrossView Pro is over-running the input buffer. Contact your system administrator to either increase the input buffer or lower the communication line baudrate.

**Input communications buffer overflow on COM port**

CrossView Pro is over-running the input buffer. Contact your system administrator to either increase the input buffer or lower the communication line baudrate.
Input from stdin longer than \texttt{max-input-size} characters: \texttt{input-string}

Command truncated

The input data is longer than the input buffer, therefore the data was truncated at \texttt{max-input-size}. Try to reduce the input data and/or commands.

Internal error while setting an instruction level breakpoint

If this error condition persists, please contact the TASKING Technical Support staff for assistance.

Invalid assertion maintenance command

You have entered an illegal assertion command. Valid commands are:

- \texttt{a a} to activate assertions
- \texttt{a d} to delete assertions
- \texttt{a s} to suspend assertions

Invalid value for uplevel break.

You have entered an illegal value for an uplevel break. The form of the command is \texttt{exp bU} or \texttt{exp bU}, where \texttt{exp} determines how many returns from functions should occur before the break. Execute the \texttt{t} command to find out how many levels down in the stack you are, then choose an appropriate value for the uplevel break. See chapter \textit{Command Reference} for more information.

Invoking procedure calls not allowed while emulator is running in the background

The target is running, this command is not allowed unless the target is stopped. See the \texttt{st} command.

Macro Expansion error: expansion looping

CrossView Pro looped 50 times while trying to expand this macro without completing the expansion. Check the logic of the macro arguments. It may need to be corrected or simplified.

Macro Expansion error: expansion too large

The macro expansion exceeds 200 commands. The macro must be simplified.
Macro Expansion error: missing '(
  See the command reference page or use the help command to review macro command syntax.

Macro Expansion error: missing ')'
  See the command reference page or use the help command to review macro command syntax.

Macro Expansion error: missing ','
  See the command reference page or use the help command to review macro command syntax.

Macro Expansion error: not enough args
  See the command reference page or use the help command to review macro command syntax.

Macro Expansion error: out of space
  There is not enough memory to expand the macro. Eliminate one or more unused macros before adding a new one.

Maximum trace size is: max-trace-size
  CrossView Pro can perform C tracing only up to max-trace-size source lines. Choose a number less than max-trace-size with the ct command.

Missing { after if command
  The required format for the if command is: if exp {commands}

Missing file name or 'screen'
  The sio command was missing a required parameter for setting up a simulated i/o stream. See chapter Command Reference for command definition and format.

Missing format character
  You did not specify a display format type with your command. Either remove '/' from the command, or add a format character.

Missing prompt string
  You did not specify a prompt string with the sio command. Either remove p from the sio command, or add a prompt string.
Must supply 'b' or 'f'

The color command requires a value of f for foreground or b for background to modify the screen color.

Must supply 'r', 'w' or 'b'

Both the data range (bD) and data (bd) breakpoint commands require the type of data modification to generate a break condition. Use r for read, w for write, and b for both read/write. Please see chapter Command Reference for more information.

Must supply data to be monitored

You did not specify a variable or expression to the m monitor command. Please provide a variable or expression to be monitored, for example, m myvar.

Must supply second address with bD command.

The bD command requires two addresses. Either specify an upper limit if you want to break anywhere in memory range, or use the bd command if you want to break on an individual address.

Negative /baudrate value ignored. (VAX)

or

Negative baud rate (-S) value ignored.

The baudrate specified was a negative value. Please specify a legal value or use the default.

Negative /TIMEOUT value ignored. (VAX)

or

Negative timeout interval (-I) value ignored.

The time out value specified was negative. Please specify a legal timeout value or use the default.

No child process

The CrossView Pro internal data structure containing user information about child processes is not as expected. Please contact the TASKING Technical Support staff for assistance.

No current file

Undefined special variable, $file; probably due to debugging where no symbols are present.
**No current line number**

Undefined special variable, $line; probably due to debugging where no symbols are present.

**No current procedure**

Undefined special variable, $proc; probably due to debugging where no symbols are present.

**No host memory**

There is not enough space in memory to execute this command. Check whether you have unnecessary processes running in the background or resident in memory.

**No host memory for command**

There is not enough space in memory to execute this command. Check whether you have unnecessary processes running in the background or resident in memory.

**No macros to save; file not created**

CrossView Pro found no macros to save, therefore the `save` command did not create a file.

**No Match – pattern**

CrossView Pro did not find the specified `pattern` in its search of this file. Check your spelling or case-sensitivity. Use the `Z` command to toggle case-sensitivity if necessary.

**No memory space**

There is not enough host memory to execute this command. Check whether you have unnecessary processes running in the background or resident in memory.

**No more hardware breakpoints available**

The target system uses hardware breakpoints to support the data breakpoint function. To continue, you must explicitly delete a data breakpoint before placing a new one.

**No more room for directories (> max-dir-size)**

You can reference no more that `max-dir-size` directories for source files.
No more SIO windows, I/O to command window.

Only four SIO streams can be displayed simultaneously in the SIO window. Subsequent SIO streams’ output will be displayed in the command window.

No name of symbol file specified

CrossView Pro cannot deduce the name of a symbol file. No filename was given to the N command and no symbol file was currently loaded.

No playback name specified

Give the name of the playback file to be used for this session.

No process

CrossView Pro only allows one process to be debugged at the same time.

No such breakpoint

The breakpoint number was incorrect. List breakpoints with the lb command to find the correct breakpoint.

No such field name "name" for "<structure | union> name"

The field name is not recognized for the specified structure or union. Check the spelling of field name. The /t format will show you the names and types of a particular structure’s or union’s fields.

No Such Line

CrossView Pro can not find the specified line number in any of its known files. Please check the source window or a source listing for legal line numbers.

No such procedure, "name".

CrossView Pro does not recognize name as a procedure name. Check the spelling and whether the file was compiled/assembled/linked/located for debugging. Check that the file is in the appropriate directory.

No such procedure or file name: procedure

CrossView Pro does not recognize procedure as a procedure or file name. Check the spelling and whether the file was compiled/assembled/linked/located for debugging. Check that the file is in the appropriate directory.
**No such PSW register state**
Check register name and selected target.

**No such register**
The target processor does not have a register with that name.

**No such sr reg state**
Check register name and selected target.

**No such stream**
The stream you tried to delete does not exist. Check the stream number, correct, and retry.

**No symbols – unable to determine end-of-procedure**
CrossView Pro has no symbol information for this procedure. To facilitate debugging this procedure, you must compile, assemble, link and locate with the appropriate switches. Refer to the *Overview* chapter for details.

**No symbols available in active procedures.**
To get symbol information you must compile, assemble, link, and locate with the appropriate switches. Refer to the *Overview* chapter for details.

**No symbols for that procedure**
To get symbol information you must compile, assemble, link, and locate with the appropriate switches. Refer to the *Overview* chapter for details.

**No User or System special variable matches prefix name**
The *string* argument of the `ls` command did not match any user or system special defined variables. Check spelling and case-sensitivity and retry. You may also enter `ls` to print out all the user and system special defined variables.

**Not enough memory available to start up windows. Either use the –nw (no window) option or remove resident programs from memory.**
CrossView Pro has detected that there is not enough host memory to execute the windowing software. You may need to use the `–nw` option to start up CrossView Pro in line mode. Check whether you have unnecessary processes running in the background or resident in memory.
Not enough memory to execute shell command.
The attempt to create a child process for the shell command failed due to the lack of host memory. Check whether you have unnecessary processes running in the background or resident in memory.

Not enough memory to start window mode
CrossView Pro has detected that there is not enough host memory to execute the windowing software. You may need to use the `-nw` option to start up CrossView Pro in line mode. Check whether you have unnecessary processes

Not enough space
CrossView Pro has detected a general error due to lack of host memory. Check whether you have unnecessary processes running in the background or resident in memory.

Not in known territory. Could not set breakpoint.
CrossView Pro’s current location is not in a file or procedure that it knows about. The breakpoint request can not be performed.

Not in window mode
The command issued requires CrossView Pro windows to be active. Use the `WW` command and repeat the previous command.

Not that many levels active on the stack.
A stack level was specified that does not exist. Execute the `t` command to determine levels on the stack. See chapter Command Reference for more information.

Oops called with sig = signal-number
CrossView Pro has received a signal that it can not handle. Continuing from this point may result in a fatal process condition. If this condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Placement of the breakpoint handler must be in one of the restart vectors. Choose a value from 0 to 7.
Try again. (Hit <cr> to exit)?
The specified placement for the breakpoint handler was not valid for this target. CrossView Pro is requesting a valid location.
**Procedure "name" is not active on the stack.**

The procedure *name* was not found on the current stack. Execute the *t* command to list functions which are active on the stack.

**Procedure 'name' is not at that stack depth**

The procedure *name* was not found on the specified stack. Execute the *t* command to list functions which are active on the stack.

**Procedure "procedure" is not active**

The procedure *procedure* was not found on the current stack. Execute the *t* command to list functions which are active on the stack or *lp* for list of procedures known to CrossView Pro.

**Program not completely loaded**

An error occurred during loading a symbol file. Check what cause the problem (illegal filename or file format). You may retry to load a symbol file.

**Prompt too long (> max-number)**

Choose a prompt of no more than *max-number* characters.

**Ran out of memory reading symbol file into memory**

Reduce the size of the symbol file by re-compiling only the "interesting" files with the *-g* debug switch.

**Read I/O request could not be queued**

VMS detected an error for a read I/O queue which CrossView Pro can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

**Readprompt I/O request could not be queued**

VMS detected an error for a read I/O queue which CrossView Pro can not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

**Redo: line too large**

Limit line length to fewer than 256 characters.
Result type too large for command line call.

A command line function call must pass the result back in a register. The specified function does not. You cannot call functions whose return value is greater than an integer, for instance floating point types and structures.

Result type undefined

Type casting from the expression or variable to the result type was not possible.

Second address smaller then first

When specifying a range of addresses for a data breakpoint, the second address must be higher than the first.

Sim I/O request too long (>max-number bytes)

The I/O request exceeds the maximum length.

Simulated I/O stream out of range

Choose a stream value between 0 and 7.

Sorry, the ”v” command is not supported on this host

No visual editor is available on this host.

Stream already active

Either choose another stream, or deactivate this one before re-assigning it.

String constant is missing ending ”

String constants must be delimited with double quotes: ”

Subtracting 2 pointers not allowed

You cannot subtract two pointers in an expression. If you intended to subtract from a pointer, make sure that the argument is a value, not another pointer.

Symbol file is either unreadable or too short

The symbol file is not an absolute IEEE-695 file, or the file format is not correct, or the file is not an IEEE-695 file at all.
Symbol file is not formatted correctly
   The symbol file is not intended for the type of microprocessor you are using.

Symbol not in current procedure
   There is no symbol by this name in the current procedure. Check the spelling of the symbol name.

The 'command' command accepts no args
   The command command does not accept any arguments. See chapter Command Reference for more information on command.

The window would be too large; Total lines must not be greater than max-size
   The window size options specified would create a window that would have exceeded the screen size. Retry with corrected window size options.

There is insufficient information to do a structure dump
   CrossView Pro cannot uniquely identify the structure or part of the structure to be dumped.

There is no associated source.
   The program counter holds an address which is outside all the address ranges that CrossView Pro knows about. This may happen if program execution has reached a file that was not compiled with the -g debug switch.

There is no available source line for the current address. $pc= address
   CrossView Pro is reporting that the current position has no associated source line. This may happen if you are trying to debug a routine that was not compiled with -g debug switch or are trying to debug a runtime library routine.

This does not appear to be a struct or a union
   The data entered is not recognizable as a structure or union. Check the specified variable.
Timed read I/O request could not be queued

VMS reported a condition on a timed read i/o request that CrossView Pro could not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Too many args to unset: 'argument'

You may specify only one macro at a time, for example, unset name, or you may remove all macros at once with unset.

Too many assertions (>max-number)

The maximum number of assertions allowed is max-number as shown in the error message. Remove a previous assertion before trying to add one, or reinvoke CrossView Pro with the -a option to increase the maximum number of assertions.

Too many breakpoints (> max_number)

The maximum number of breakpoints allowed is max-number as shown in the error message. You must explicitly delete a breakpoint before adding any new ones. Alternatively, you could re-invoke CrossView Pro with the -b option to increase the maximum number of breakpoints.

Too many locals (> max-number)

Eliminate some existing locals or reinvoke CrossView Pro with the -s switch to increase the number of locals allowed.

Too many modules

The symbol file describes an application that was constructed from more than 1818 modules.

Too many processes (> max-number)

CrossView Pro allows only one process to be debugged.

Too many streams (> max-number)

The maximum number of I/O streams, max-number, has been reached. You must eliminate an I/O stream before adding a new one.

Trace size is required

The required format of the command is exp ct, where exp is the number of statements to trace. Re-enter the command with a value for exp.
Type ’r’, to run program from power-on conditions or ’c’ to continue with current program pointer

This is to inform you that command r is not implemented and that you should used r or c.

Type of command-line-expression is too complex

The command line function returns a data type that CrossView Pro cannot handle. An example would be a function returning a structure.

Unexpected breakpoint type ’type’

CrossView Pro has encountered a breakpoint with an unknown type attribute. Verify the previous break commands and re-try. If the condition persists, please contact the TASKING Technical Support staff for assistance.

Unknown command ‘command’ (<number>)

CrossView Pro does not recognize command, and has echoed the command number for Technical Support purposes. Please check the spelling and retry. If the condition persists, please contact the TASKING Technical Support staff for assistance.

Unknown data monitor id ’number’

The monitor number number that you tried to delete does not exist. Use the M command to list currently monitored variables.

Unknown data size

Valid data sizes are 1, 2, 4, or 8 bytes.

Unknown display mode

See chapter Accessing Code and Data, for a list of display mode options.

Unknown name ’name’

Variable name is not in scope or is undefined.

Unknown procedure ”name”.

The function name does not exist in any file that CrossView Pro knows about. The file containing name may not have been compiled with the -g debug switch.
**Unknown macro 'name'**

CrossView Pro does not recognize the macro name as given. Please check the spelling. You may list all current macros by using the `set` command with no arguments, or display the Macro window for currently defined macros.

**Unknown window**

CrossView Pro does not recognize the window name as given. See chapter *Command Reference* for valid window arguments.

**Unsupported format type (parameter)**

Supported types are **c** (character), **x** (hex), and **o** (octal).

**Value number is not defined for this enum.**

The member specified was not part of the enumerated set. Please check the spelling and verify that the correct enum was used.

**Value exceeds depth of stack.**

A stack level was specified that does not currently exist. Please check the value and retry. Check the stack window for valid stack levels, or execute a `t` command (trace stack) to determine the depth of the stack.

**VMS error : cannot establish handler for signals**

CrossView Pro on VMS could not establish proper error handlers. If the condition persists, please contact the TASKING Technical Support staff for assistance.

**VMS error : cannot establish pasteboard**

CrossView Pro on VMS can not establish the running environment. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

**VMS error : cannot establish virtual keyboard**

CrossView Pro on VMS can not establish the running environment. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.
VMS error code = number \ Attempt to get message text fail.

CrossView Pro on VMS received an error while attempting to provide an error diagnostic message from the host error message library. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Warning: NULL pointer dereference

The expression contained a null pointer dereference. Check the expression for possible errors, or verify that the pointer should in fact be null.

Warning: pointer dereference with invalid segment selector.

The pointer is addressing invalid memory and the dereference may report unexpected data results. Check the initialization of the pointer or verify that it has been set correctly.

Warning: too few parameters.

The command given was not invoked with the proper number of arguments. CrossView Pro will supply the command with defaults which may or may not produce the result you expected.

Warning: Using file-b instead of file-a

CrossView Pro could not find file-a, or file-a’s status was such that CrossView Pro could not use it. If file-b is not correct, check file-a spelling and its directory.

Warning: X=Y: X is x-size bytes and Y is y-size bytes

The assignment of two different size variables may cause unexpected results. Please correct the condition if possible. This condition is common when assigning string variables where string y is shorter than string x.

Warning: X=Y: X is x-size words and Y is y-size words

The assignment of two different size variables may cause unexpected results. Please correct the condition if possible. This condition is common when assigning string variables where string y is shorter than string x.
Warning: CrossView comment terminated by end of command line

source-command-line

The playback file has a comment that was not terminated. It is by default terminated, but if the next line was the continuation of the comment, then unexpected results may occur. Please terminate comment strings on each line to avoid this warning.

Windows not enabled; use WW to enable

The command issued can only be used when windows are enabled.

Write I/O request could not be queued

CrossView Pro received a condition that it could not handle. If the condition persists, please contact your system administrator, or call the TASKING Technical Support staff for assistance.

Write-only register. Value may not be valid.

CrossView Pro set a write-only register but has no way of verifying the correctness of the register contents.

Wrong storage class for data breakpoint

You may not set a data breakpoint at the address of a register variable or special variables.

CrossView could not disassemble the emulator's trace buffer because the address information in the buffer is incorrect.

The trace buffer may be corrupted. Re-check the commands leading to this condition, and retry. If the condition persists, please contact the TASKING Technical Support staff for assistance.

XVW error – message

or

XVW Fatal error – message

These messages are generated by internal conditions that should not normally occur. The message is usually encrypted and should be brought to the attention of the TASKING staff. Please contact the TASKING Technical Support staff for assistance.
XVW:main – Cannot continue, incomplete initialization.

CrossView Pro’s initialization was interrupted and could not be completed. Please re-start CrossView Pro, and if the condition persists, contact the TASKING Technical Support staff for assistance.

You can’t goto a line outside of the current procedure

The specified line number is outside the current procedure. Change the line number to one within the procedure or enter the correct procedure before executing this command.

You may not assign from a host system string/array

The expression given performs an assignment that CrossView Pro can not perform at this time.

You may not assign from a void function

The expression attempts to assign a variable from a void function. Please check the return value of the function and verify that you are referencing the correct function.

You may not assign more than max-size bytes to a special variable

An attempt was made to assign greater than the maximum number of bytes to a special variable. Check the expression for errors, and check the variable’s spelling.

You may not assign to a constant

The value of a constant cannot be changed. Check the name that you have specified.

You may not mix assignment of a scalar and an aggregate

An attempt was made to assign incompatible types of data. Please check the data types and retry.

You need to supply a program name.

CrossView Pro requires a program name to debug on the invocation line.
15.1 WHAT THIS CHAPTER COVERS

This chapter defines terms common to CrossView Pro and source-level embedded systems debugging. Italicized items in definitions are also glossary entries.

15.2 GLOSSARY TERMS

A

absolute file. The IEEE-695 file (.abs) that contains symbolic debug information and the final executable code of the target system.

active window. The window last selected by the user in CrossView Pro that commands operate on as a default. An active window’s title appears in a different color (on color monitors) or inverse video (on monochrome).

assertion. A command or set of commands to be executed before every line of source code, assessing the application state on validity. Assertions are especially useful in tracking down hard to find bugs when other methods fail. Individual assertions may either be active or suspended. See also assertion mode.

assertion mode. A mode of CrossView Pro operation under which assertions will be executed. Before CrossView Pro executes a source line of code, it assesses all assertions active. Since CrossView Pro is single stepping, breakpoints will not be effective. As long as there is at least one assertion active, CrossView Pro operates in assertion mode. A program running in assertion mode will be stopped when an asserted command executes the x (exit assertion mode) command.

B

background mode. A target dependent feature in CrossView Pro that lets the execution environment run and at the same time allows you to enter a reduced set of CrossView Pro commands, for example to monitor memory contents.
bias. A value added to program code addresses to tell CrossView Pro where the application has actually been loaded into memory. The bias can be set in the Load Application dialog or with the -n startup option.

breakpoint. A mechanism for stopping target program execution, for example at a particular line of code (see code breakpoint), when a memory address is accessed (see data breakpoint), or at a return from a function (see up-level breakpoint). There are two general kinds of breakpoints. Hardware, which the emulator or on-chip debug support sets in its circuitry, and software, which are special instructions placed in user code. Since the number of simultaneous hardware breakpoints is limited in number, CrossView Pro uses both kinds by default. Other types of breakpoints are for example instruction count breakpoint, cycle count breakpoint, timer breakpoint and sequence breakpoint. See also probe point.

breakpoint window. A CrossView Pro dialog displaying all breakpoints, and any attached commands.

C-trace window. A CrossView Pro window keeping a record of the most recently executed C or machine statements.

cache. Some microprocessors keep a copy of the most recently executed instructions in on-chip memory to speed-up execution.

code breakpoint. A breakpoint that halts program execution when a particular line of code is reached. A code breakpoint can have a command list. A breakpoint can be set on a line of source code or at the address of a machine instruction. See also count.

code coverage. See coverage.

command window. A CrossView Pro window that gives access to CrossView Pro via a command line interface with history.

command list. A series of CrossView Pro commands and/or C (assignment) statements attached to a code or data breakpoint, executed when the breakpoint is hit.

count. The number of times a breakpoint must be hit to finally stop execution. Breakpoints are created with a count of 1. The C command may be used to change the count of a breakpoint.
coverage. With code coverage the source line is marked for each source code line that is executed. Through code coverage you can find executed and non-executed areas of the application program. Data coverage allows you to verify which memory locations, i.e. which variables, are accessed during program execution. Additionally, you can see stack and heap usage. The availability of this feature depends on the execution environment.

cycle count breakpoint. A breakpoint that halts program execution after a specified number of CPU cycles. A cycle count breakpoint can have a command list.

current function. The function that is currently being executed. The current function is always at level 0 on the stack. Also stored in the CrossView Pro special variable $PROCEDURE.

d

data breakpoint. A breakpoint that halts program execution when a particular memory address (or an address within a particular range) is written to, read from, or both. A data breakpoint may have a command list and a count.

data coverage. See coverage.

data monitoring. CrossView Pro allows you to monitor expressions and variables in the Data window. CrossView Pro updates their values whenever execution stops.

data window. A CrossView Pro window displaying the values of monitored expressions.

diagnostic output. Program output designed for debugging purposes. With CrossView Pro, probe points and data monitoring can be used for diagnostic output, eliminating the need for intrusive and annoying printf calls compiled into code.

disassembly window. A CrossView Pro window showing a part of the disassembled program space. It also displays other information such as the current execution position, viewing position and installed breakpoints.

dot operand. The period character "." used in an expression to represent the last value CrossView Pro calculated. The dot operand is useful as shorthand.
**embedded system.** Computer(s) executing an application program built to run in (semi) real-time. An embedded system usually is part of a larger, non-computer system, hence the term "embedded." The TASKING product line is designed for embedded systems programming.

**emulator.** A device used to monitor and control various aspects of a microprocessor's operation. An emulator usually is built around two chips, the target microprocessor and a controlling chip. The controller chip can start and stop the target chip's program execution, and can examine and change registers and memory. An emulator can be connected via a probe to a hardware prototype to fully emulate the behavior of the target chip. See ROM monitor.

**execution position.** The source line to be executed next. See viewing position.

**File System Simulation (FSS).** A facility to redirect all C library file I/O operations on the target, to the host system via CrossView Pro. File system simulation is often used to provide input to an application for which no hardware I/O is available yet and to log test results.

**format.** The manner in which CrossView Pro displays addresses and data; for instance, hexadecimal, character and octal are different formats. You may include special format codes when specifying variables.

**hardware breakpoint.** See breakpoint.

**help window.** A window explaining the use of CrossView Pro windows and dialogs and summarizing the syntax and function of CrossView Pro commands.

**history mechanism.** A facility for modifying and executing previous CrossView Pro commands.
**host system.** The computer system on which CrossView Pro is run. The host system is connected to the target system, usually with an RS-232 cable.

**image part.** This is the downloadable part of the absolute file that contains the executable code of the target program. See also **absolute file**.

**instruction count breakpoint.** A breakpoint that halts program execution when a number of instructions have been executed. An instruction count breakpoint can have a command list.

**interrupt key.** The key that interrupts ongoing processes. On many systems this is `ctrl-C`.

**I/O Simulation.** A technique to intercept input and output for debugging purposes. I/O Simulation is often used for testing a program before the actual input and output hardware devices are present. See also **stream**.

**local variable.** A variable that can only be referenced from within its defining function.

**low-level breakpoint.** A code breakpoint placed on an individual machine instruction. Low-level breakpoints can be set with the **break code address** command.

**macro.** A user-created shorthand for a CrossView Pro command sequence. Macros can accept parameters and can be saved to a file.

**main().** The function where a C program’s execution begins. See also **system startup code**.

**MAU.** See **minimum addressable unit**.
**memory map.** The configuration of an emulator’s memory that specifies which addresses are read-only, and which addresses are read/write. With many emulators, you must first set up a memory map before using CrossView Pro, for example via transparency commands.

**minimum addressable unit.** For a given processor, the amount of memory located between an address and the next address. It is not necessarily equivalent to a word or a byte. Abbreviated **MAU**.

**monitoring.** See data monitoring.

**object language.** A representation for target machine instructions, with the ability to represent either relocatable or absolute address locations.

**on-line help.** A complete summary of all CrossView Pro commands and individual descriptions available while CrossView Pro is running.

**on-line tutorial.** A playback file supplied with CrossView Pro that demonstrates CrossView Pro’s capabilities.

**output buffer.** The location in memory where CrossView Pro directs I/O simulation output. See also **I/O Simulation**.

**patch.** A technique to alter program flow (without recompiling the source code) with CrossView Pro commands and/or C expressions. With CrossView Pro, it is possible to use breakpoints to alter program flow by patching in new code or moving the execution position around existing code.

**pop-up window.** A window that appears in certain situations that overlaps the current display. Pop-up windows usually contain information (like a command definition) that need not be continuously displayed.

**probe.** A part of an emulator that can be inserted in place of the target chip in the actual embedded systems hardware.

**probe point.** A special kind of breakpoint. When a probe point breakpoint is hit, the associated commands are executed and program execution is continued.
profiling. For each source code line that is executed, the timing information is given.

quiet command. A Q instruction at the start of the command list of a breakpoint suppressing the default display of function: line number: source file.

record & playback. The ability to save CrossView Pro commands (and, if desired, Command window output) to a file. CrossView Pro can play back simple text files consisting solely of CrossView Pro commands.

register window. A CrossView Pro window showing the contents of the target microprocessor’s registers.

reserved special variables. Special variables ($LINE, $PROCEDURE, $FILE) whose values CrossView Pro maintains to reflect the current status of the debugging session. See also special variables.

ROM monitor. A program which supervises or controls, at an elementary level, the overall operation of an embedded system. Because of the limited hardware features of most boards containing ROM monitors, some CrossView Pro features may not be supported. See also emulator.

RS-232 cable. A cable that exchanges asynchronous data between the host and target systems.

scope. The extent to which a variable can be referred to. Global variables are always in scope; local variables are only in scope when their defining function is the current function.

select. To make a window active.

sequence breakpoint. A breakpoint that halts program execution when breakpoints are hit in a specified sequence. A sequence breakpoint can have a command list.
**single stepping.** Executing a source statement or a machine instruction then halting. Single stepping lets you observe a program executing in stop-motion, to observe registers, variables and program flow.

**skidding.** When a microprocessor executes a few instructions after a data breakpoint halts execution. On some microprocessors, execution may not stop until all instructions in its pipeline have been executed. It is important to realize therefore that a target program may not halt at the precise instruction where the data breakpoint occurred.

**software breakpoint.** See **breakpoint**.

**source level debugger.** A debugger capable of correlating source code and variable names with object code. CrossView Pro is a source level debugger.

**source window.** A CrossView Pro window displaying the high-level language program code. It also displays such information as the current execution position, viewing position and installed breakpoints.

**special variable.** A variable independent of the target program that CrossView Pro maintains for the user's benefit. Special variables start with a $ and are defined when first mentioned. CrossView Pro also maintains **reserved special variables** that contain information about the state of the debugging session.

**stack depth.** The level that a particular return address from a function resides on the stack. The current function is always at stack depth zero.

**stack traceback.** An operation in which CrossView Pro reads the return addresses and passed parameters off the stack to reconstruct program flow.

**stack window.** A CrossView Pro window showing the function calls on the stack, with the values of the parameters passed to them.

**startup options.** Special command line switches passed to CrossView Pro when the debugger is first loaded. These options control items such as the number of assertions allowed, or can perform various actions such as to start recording screen output to a file.

**stream.** A particular input or output data path for I/O simulation. Per method, File System Simulation, File I/O or Debug Instrument I/O, a unique stream numbering scheme is used.

**switches.** See **startup options**.
symbolic debugger. A type of debugger generally limited to dealing with
global, non-dynamic variables. Symbolic debuggers know nothing of the
data types; they translate global names and global subroutines into
addresses. See also source level debugger.

symbol information. The necessary information for CrossView Pro to
correlate object code with source code. The symbol information is part of
the absolute file. See also absolute file.

system startup code. A run-time library routine written in assembly
language source that initializes the target environment before calling
main(). See also main().

target communication. The low-level communication between the host
and the target system. For the most part, CrossView Pro handles target
communications, allowing the programmer to concentrate on the
high-level information.

target microprocessor. The chip on which the target program runs.

target system. The targeted microprocessor where the embedded
application runs.

terminal window. A CrossView Pro window containing all the input and
output streams directed to the screen. CrossView Pro can display several
windows at a time.

timer breakpoint. A breakpoint that halts program execution after a
specified number of seconds or timer ticks. A timer breakpoint can have a
command list.

trace buffer. A target-resident buffer that contains the most recent
instructions executed by the target microprocessor. CrossView Pro uses this
buffer to deduce a C-trace.

transparency mode. The mode in which CrossView Pro passes user
input directly to the emulator. Transparency mode is often used when
setting up memory maps.
U

**up-level breakpoint.** A code breakpoint set at the return from a function at a specified stack depth.

V

**viewing position.** The line of source code currently being viewed. This line contains the dashed line cursor. Some commands operate by default on the viewing position. The viewing position and the execution position are initially the same, but you may adjust each individually.
APPENDIX A

INTERPROCESS COMMUNICATION

TASKING
1 COM INTERFACE

1.1 INTRODUCTION

CrossView Pro provides a COM object interface on MS-Windows platforms. The purpose of the COM object interface is to make the command-line interface of the command window available to the outside world. Simultaneously, a callback mechanism is provided which allows the outside world to tap into events that occur within CrossView Pro (for example a breakpoint hit message). This is achieved by a COM connection point interface to which multiple programming languages can connect.

The CrossView Pro COM object can be used in programming languages like Python, Visual C++ or Visual Basic. Applications that are COM clients can also make full use of the CrossView Pro COM object interface. COM is a binary reusable object technology, linked tightly to MS-Windows. COM is closely related to ActiveX and Automation. ActiveX consists of a set of predefined interfaces to be implemented in a COM object and used to create plugable GUI components. Automation is a similar set of predefined COM interfaces, but with a wider range of applications than ActiveX.

1.2 USING THE COM OBJECT INTERFACE

1.2.1 RUN-TIME ENVIRONMENT

The CrossView Pro COM object executes as an out-of-process server. Only one client per instantiated CrossView Pro COM object can connect. Each CrossView Pro executable has a unique identification (so-called UUID or GUID), independent of the version number. This is especially important for Visual Basic which stores the TypeLib UUID. This requires recompilation if the UUID changes across different versions of the same CrossView Pro executable.

1.2.2 COMMAND LINE OPTIONS

To prevent initialization dialogs at CrossView Pro startup (for example a dialog to specify which CPU type you use), you can use several command-line options which you can specify via the Init() method.
Use the following options instead of startup dialogs:

- **-tcfg file** Specifies a target configuration file which contains, among other things, the GDI module to be loaded among other things. This overrules the filename specified in **xvw.ini**.

- **-C cpu** Specifies the CPU type.

- **-D device_type,opt1[opt2]** Specifies communications parameters such as communication port and baud rate.

- **-G path** Specifies the startup directory for CrossView Pro.

- **-ini** Specifies the xvw.ini file.

Section 4.4, *Startup Options* in Chapter *Using CrossView Pro*

### 1.2.3 STARTUP DIRECTORY

The startup directory of CrossView Pro determines where the **xvw.ini** file is written. When CrossView Pro is invoked via its COM interface on MS-Windows, the startup directory is usually **C:\WINNT\system32**. You can change the location of the **xvw.ini** file with the **-G** command line option. This feature is useful when you are using two different CrossView Pro instances simultaneously.
1.3 COM INTERFACES

The following interfaces are provided with CrossView Pro:

*ICommandLine*

Default interface; provides CrossView Pro command interpreter access.

*ICommandLineEvents*

Connection point; provides the events output stream of CrossView Pro. Works as a callback.

1.3.1 ACTIVATING THE COM OBJECT

Command line options are passed to CrossView Pro via the `Init()` method. It is necessary to call the `Init()` method before you can use the CrossView Pro COM object. CrossView Pro does not start as COM object, until after you have actually called the `Init()` method. If you do not need to pass any options, invoke `Init()` with an empty string.

Registering the server

Before you can use the COM object, you must register it in the MS-Windows Registry. Run CrossView Pro from the command line as follows:

```
xfw166 -RegServer
```

Similarly, you can remove the COM object from the Registry:

```
xfw166 -UnregServer
```

To avoid the popup message when registering, two more command line options are available that are useful when you use batch files:

```
-RegServerS   Same as -RegServer, but without message
-UnregServerS Same as -UnregServer, but without message box
```
1.3.2 METHODS

This section lists the methods that are supported by the CrossView Pro COM object's default interface 'ICommandLine'. The data types and return values are expressed as COM base types. For example, BSTR is a wide-character UNICODE string type, which is the same type as Visual Basic strings.

Init()

```c
void Init(BSTR CommandLineOptions)
```

Passes command line options to the CrossView Pro COM. It is necessary to call the Init() method before you can use the CrossView Pro COM object. If you do not need to pass any options, invoke Init() with an empty string.

**CommandLineOptions**

The string with the command line options. The options are written as on a regular command line.

The list of supported command-line options can be found in the CrossView Pro User Manual.

See Section 4.4, Startup Options in Chapter Using CrossView Pro for a complete overview of all available command line options.

Execute

```c
BOOLEAN Execute(BSTR Command, long SequenceNumber, BSTR *Result)
```

Passes a command to CrossView Pro, executes it and returns TRUE or FALSE after the command has been executed.

**Command**

The command to be executed by CrossView Pro.

**SequenceNumber**

A number that is unique for each command. You can use this number to distinguish the output in the events stream. If you do not use this, specify a value of 0.
Result The textual output of the command window, encapsulated in an annotated format. See CmdAnnotatedOutput in section 1.4 Events for the format description. Specify NULL if you do not want any output.

Returns: TRUE on success, FALSE on error.

ExecuteNoWait

BOOLEAN ExecuteNoWait(BSTR Command, long SequenceNumber)

Queues a command for execution and returns TRUE of FALSE after the command has been passed but before it is executed.

Command The command to be executed by CrossView Pro.

SequenceNumber A number that is unique for each command. You can use this number to distinguish the output in the events stream. If you do not use this, specify a value of 0.

Returns: TRUE if the command is successfully passed, FALSE on error.

Halt

void Halt(void)

Halts the execution of the current command.

1.3.3 IMPLEMENTATION DETAILS

A multi-threading (MTA) type of apartment is used with a free-threading model, for example, ThreadModel=Free. However, each CLSID can have its own distinct ThreadingModel. Only one client can connect to a COM object instance of CrossView Pro. Each next CoCreateInstance() will result in a new CrossView Pro COM object instance being created.

Be aware that DLLs are not supposed to call CoInitialize themselves. Once the concurrency model for a thread is set, it cannot be changed. A call to CoInitialize on an apartment that was previously initialized as multithreaded will fail and return RPC E CHANGED MODE.
Typically, the COM library is initialized on a thread only once. Subsequent calls to `CoInitialize` or `CoInitializeEx` on the same thread will succeed, as long as they do not attempt to change the concurrency model, but will return `S_FALSE`. To close the COM library gracefully, each successful call to `CoInitialize` or `CoInitializeEx`, including those that return `S_FALSE`, must be balanced by a corresponding call to `CoUninitialize`. However, the first thread in the application that calls `CoInitialize(0)` or `CoInitializeEx(COINIT_APARTMENTTHREADED)` must be the last thread to call `CoUninitialize()`. If the call sequence is not in this order, then subsequent calls to `CoInitialize` on the STA will fail and the application will not work.

Because there is no way to control the order in which in-process servers are loaded or unloaded, it is not safe to call `CoInitialize`, `CoInitializeEx`, or `CoUninitialize` from the `DllMain` function.

So, take care when establishing more CLSIDs in a GDI module.

### 1.4 EVENTS

CrossView Pro provides an events source, into which a client can tap via a COM connection point. Examples of events are "reporting which breakpoint has been hit" and "symbols have been loaded". Currently the following events are defined. Each event is terminated by a newline character. Prepare your client for new events, basically by ignoring unrecognized ones.

**CommandInterpreterBusy**

The debugger’s command interpreter is executing a command line, or a GUI operation is in progress. A command line can comprise multiple target execution commands, so arbitrary Running and Stopped events may occur before the command line has been finished. An example for using this event is the disabling of menu entries in your tool.

You can send multiple `CommandInterpreterBusy` events without the `CommandInterpreterReady` counterpart. New commands can be send to the debugger after this event has been issued, but they will be queued until the debugger is ready for new command input.
Interprocess Communication

**CommandInterpreterReady**
The entire command line or GUI operation has either been executed completely or aborted. You can send multiple CommandInterpreterReady events without the CommandInterpreterBusy counterpart.

**CommandCanceledByUser**
The entire command line or GUI operation has been canceled by the user, usually via the Halt button.

In case of DDE, the CrossView Pro command queue will be emptied. The command queue of all other IPCs, for example COM, will be preserved. This has been designed for the multi-core debugger which relies on commands -submitted by the multi-core debug system- always being executed, even if the user hits the Halt button.

Note that every command can be canceled this way, even when asking a variable’s value. Often no value will be returned at all, because Halt aborted the evaluation.

**HaltButtonPressed**
Tells that the user has pressed the Halt button. This is necessary because in CrossView Pro Halt means stop executing the current command line. If an external client needs to know this too, the Halt button must be reported explicitly. If not, only when the Halt button actually is hit during a command line execution, cancellation is the case, and reported via an event. If the command line just finished, nothing is being done, so needs to be canceled, hence no cancellation is reported either.

An example would be a client interpreting breakpoint hits and issuing continue commands to resume execution. If the halt button should also stop the client from doing this, the HaltButtonPressed event must be used.

**Running**
Started executing the target.

**RunningInBackground**
Started target execution in background mode. This is usually a mode in which a restricted set of operations can be performed, for example read from a memory location.

**Stopped cause**
Stopped target execution. The cause is reported. Possible causes:
STEP

A single step of any kind was finished. Be aware that when using single-step, the debugger does not report any breakpoints the program counter arrives at.

BREAKPOINT "name"

Breakpoint name was hit. This includes cycle breakpoints, time elapsed or number of instructions types. Breakpoints that the user has set are reported as well. Nameless breakpoints are reported using as name #number#, where number is the CrossView Pro administration number. If no name or number is known, NAMELESS BREAKPOINT will be used.

ASSERTION number

Assertion number was hit.

UNKNOWN The process has stopped. The cause is unknown or cannot be described with one of the previous reasons. One of the causes may be that the user pressed the Halt button. More causes may be added in the future.

Reset

Hardware reset command has been executed by the debugger.

ResetProgram

Software reset of the program command has been executed by the debugger.

ViewedLineNrChanged number

The line being displayed changed to the specified one. If the source window is closed, or the cursor is not in a file but somewhere in assembly, this event will not be sent.

SourceFileChanged "filename"

The debugger displays an other source file. An empty file name "" will be sent if no source is being displayed at all.

DidLoadSymbols "filename"

The symbols of an application have been loaded.
**DidAddSymbols "filename"**

An application’s symbols have been added to the ones already present.

**DidDownloadImage "filename"**

The code and data image of an application has been downloaded into target memory.

**DestroyedAllSymbols "filename"**

The symbol table of the application `filename` has been destroyed.

**BreakpointsChanged**

The list of breakpoints changed (for example when a breakpoint was added).

**AssertionsChanged**

Either the list of assertions or assertion mode changed (for example when an assertion was added). Note that the assertion numbering can be entirely altered when an assertion is removed.

**MenuEntrySelected "id-string"**

The menu entry `id-string` was selected by the user. Only menu entries created with the `AddDDEMenuEntry` or `AddCOMMenuEntry` command are reported.

**CmdAnnotatedOutput</n> annotated-output**

Provides the command window output in an annotated form.

The first line indicates the error status and says OK, ERROR or NOT EXECUTED. The second line has the form `SEQ:sequence_number`, where the sequence number is either 0 or the number specified with the command. Although the sequence number is optional (it may be omitted in some commands) this line is always present. The next lines are either output or error messages. A label indicates the type (OUTPUT or ERROR) and the number of lines that follow.
Example

ERROR
SEQ: 9284
OUTPUT: 1
Hello World
ERROR: 1
No such name: xy

The reason behind this event is the inevitable merging of all data streams into one when TCP/IP server is provided next to for example the DDE server.

Quit

The debugger is about to terminate. This is not necessarily the last event. nor is it guaranteed that a CommandInterpeterReady event was send before. The quit event may not be send at all, due to technical restrictions.

1.5 COM EXAMPLES

1.5.1 PYTHON EXAMPLES

To use COM objects for Python, you must first install the Python interpreter and the Win32COM extensions. You can use the Python interpreter distributed with the TASKING EDE. Or you can download the Python interpreter from \texttt{http://www.python.org} (May 2001) or use \texttt{win32all.exe} from \texttt{http://aspn.activestate.com/ASPN/Downloads/ActivePython/Extensions/Win32all} (May 2001).

Synchronous Calls

Replace all occurences of \texttt{Xfw\langle targ\rangle} in the example below by the name of your CrossView Pro executable to make the text applicable.

\begin{verbatim}
# # Example without events callback #
#
import win32com.client
# Python 1.4 requires \texttt{"import ni"} first.
\end{verbatim}
class Xfw<targ>:
    "Xfw<targ> via COM wrapper class"
    def __init__(self, cmdline_options = ""):
        try:
            self.COMObject.Init(cmdline_options)
        except Exception,e:
            print '(Is the Xfw<targ> COM object installed,
            using "xfw<targ>.exe -RegServer"?)'
            raise e

    def Execute(self, text, sequence_number = 0):
        result = self.COMObject.Execute(text, sequence_number)

        # convert Unicode to Python string
        retval = (result[0], str(result[1]))

        return retval

    def test_xfw<targ>_com_object():
        xvw = Xfw<targ>(r"-sd c:\testdir")

        (success, result) = xvw.Execute("echo Hello from Python")
        print "received", result

        (success, result) = xvw.Execute("l d")
        print "success=",success
        print result
        (success, result) = xvw.Execute("++$hoi")
        print result
        (success, result) = xvw.Execute("++$hoi")
        print result
        (success, result) = xvw.Execute("++$hoi")
        print result
        del xvw

        if __name__ == "__main__":
            test_xfw<targ>_com_object()
**Events Callback**

#
# Example with Events callback
#

```python
import win32com.client
# Python 1.4 requires "import ni" first.
import win32ui
import re

seen_ready_event = 0

class xvw_events:
    def OnCrossViewEvent(self, strUnicode):
        global seen_ready_event
        print "CrossViewEvent: " + str(strUnicode)
        if (re.match("CommandInterpreterReady.*", str(strUnicode))):
            seen_ready_event = 1

class Xfw<targ>:
    def __init__(self, cmdline_options = ""):  
        self.COMobject.Init(cmdline_options)

    def Execute(self, text, sequence_number = 0):
        result = self.COMobject.Execute(text, sequence_number)

        # convert Unicode to Python string
        retval = (result[0], str(result[1]))

        return retval

if __name__ == "__main__":
    xvw = Xfw<targ>("-sd testdir1")

    print xvw.Execute("'hello Python';$hoi++")

    while seen_ready_event == 0:
        win32ui.PumpWaitingMessages(0, -1)

    print "terminating"

    del xvw
```
**Python Makepy Utility**

In the examples above Python will load the type info dynamically from the COM object. This is called ‘dynamic’ binding or ‘late’ binding in PythonCOM jargon. However, PythonCOM also provides a mechanism to generate a Python module which contains this type info and thus speeds up the loading process. This is called early binding in the PythonCOM package.

Python uses the makepy utility to support early-bound automation. Makepy is a Python script that translates the COM type library to a Python module which wraps the COM object’s interfaces. Once you use the makepy utility, early binding for the objects is automatically supported. There’s no need to do anything special to take advantage of the early binding.

Advantages:

- Method invocation is faster.
- Constants defined in the type library are available via the COM interface module.
- It allows much better support for advanced parameter types. Especially parameters declared by COM as BYREF can only be used with makepy wrapped objects.

Disadvantages:

- The makepy wrapper script depends on the COM object to be wrapped by makepy. Generation can be automated.
- The module that is generated by makepy, can be large. The file generated for Microsoft Excel for example, is about 800 Kb.

To speed up starting a Python script that loads the CrossView Pro COM object, you can generate a Python module with `makepy.py`:

```
cd ...\python20\win32com\client
python makepy.py ...\xfw\<targ>.exe
```

This script will place a module in the `win32com\gen_py` subdirectory.

1.5.2 VISUAL BASIC EXAMPLES

Replace all occurrences of Xfw<targ> in the example below by the name of your CrossView Pro executable to make the text applicable.

**Synchronous Calls**

This example demonstrates plain commands being executed in CrossView Pro, without receiving any events from CrossView Pro.

```vba
Dim Xvw As Object
Dim Result As String

' here we invoke the PowerPC \xvw{}
' replace xfw<targ> by your executable name
Set Xvw = CreateObject("Xfw<targ>.CommandLine")
Call Xvw.init(""

Call Xvw.Execute("I", Result, 0)
MsgBox Result

End
```

**Events Callback**

Visual Basic provides a special feature, WithEvents, to connect to the connection point of a COM interface. It is also available in VBA 5.0. You must use WithEvents in a variable declaration. There is a catch, however: you can only use it in a class module (including form modules) and it must appear in the declaration section. You cannot declare a variable using WithEvents in the body of a procedure. For this example, first select Xfw<targ> type library in the Project References dialog:

1. In Microsoft Word or Microsoft Excel, start the Visual Basic editor and go to Tools|References or:

   In Visual Basic, go to Project|References.

   Note that VBA differs from VB. See the Word example for VBA.

2. Search and check the CrossView COM Interface Type Library entry.
Interprocess Communication

Option Explicit

Public WithEvents Xvw As Xfw<targ>

Private Sub Form_Load()
    Dim Result As String
    Set Xvw = CreateObject("Xfw<targ>.CommandLine")
    Call Xvw.Init(""
    Call Xvw.Execute("echo Hello", Result, 0)
End Sub

Private Sub Xvw_CrossViewEvent(ByVal EventText As String)
    MsgBox "Called back with: " & EventText
End Sub

1.5.3 WORD EXAMPLES

Here is an example of connecting to CrossView Pro PowerPC. It starts Xfw<targ> and shows all messages that CrossView Pro sends to Word. Visual Basic for Applications provides a special feature, WithEvents, to connect to the connection point of a COM interface. You must use WithEvents in a variable declaration. There is a catch, however: You can only use it in a class module (including form modules) and it must appear in the declaration section. You cannot declare a variable using WithEvents in the body of a procedure.

Replace all occurrences of Xfw<targ> in the example below by the name of your CrossView Pro executable to make the text applicable. To add the example to Word:

1. Start the Visual Basic editor and go to Tools|References
2. Search and check the CrossView COM Interface Type Library entry
3. Insert a class module, via the menu bar: Insert|Class Module
4. Change its name to clsXfw<targ> in the properties pane
5. Paste the following text:
Appendix A

INTERPROCESS COMMUNICATION

',
' Class module clsXfw<targ>
',
'Option Explicit

'members
Public WithEvents oXfw<targ> As Xfw<targ>

Private Sub Class_Initialize()
End Sub

Private Sub oXfw<targ>_CrossViewEvent(ByVal strEvent As String)
    MsgBox strEvent
End Sub

6. Insert a module, via the menu bar: Insert|Module

7. Paste the following text:

',
' Module testXfw<targ>
',
'Option Explicit

Dim oXfw<targ>1 As New clsXfw<targ>

' run automatically when your Addin loads
' and your Addin will automatically load when Word loads.
Public Sub AutoExec()
    Set oXfw<targ>1.oXfw<targ> = New Xfwppc
    call oXfw<targ>1.oXfw<targ>.Init(""")
End Sub
1.5.4 EXCERPT OF THE MIDL DEFINITION

The 'ICommandLine' interface is dual, the 'ICommandLineEvents' connection point interface is not. Replace all occurrences of \texttt{Xfw<targ>} in the example below by the name of your CrossView Pro executable to make the text applicable.

\begin{verbatim}
interface ICommandLine
{
    HRESULT Init([in] BSTR CommandLine);

    HRESULT Execute([in] BSTR Command,
        [in] long SequenceNumber,
        [out] BSTR *Result,
        [out, retval] VARIANT_BOOL *Ok);

    HRESULT Halt(void);
    HRESULT ExecuteNoWait([in] BSTR Command,
        [in] long SequenceNumber,
        [out, retval] VARIANT_BOOL *Ok);
};

library CrossViewLibXfw<targ>
{
    dispinterface _ICommandLineEvents
    {
        methods: void CrossViewEvent([in] BSTR);
    };

coclass Xfw<targ>
{
    [default] interface ICommandLine;
    [default, source] dispinterface _ICommandLineEvents;
};
}
\end{verbatim}
2 DDE SERVER INTERFACE

2.1 INTRODUCTION

CrossView Pro offers an Interprocess Communications (IPC) option using the Microsoft Windows Dynamic Data Exchange (DDE) interface for external control of CrossView Pro. The DDE interface offers direct access to the CrossView Pro command interpreter. Via the DDE interface you can execute every CrossView Pro command that you can access via the regular CrossView Pro command window, and retrieve the output produced by the executed command.

2.2 DDE ITEMS AND TOPICS

DDE function calls always return, whether they succeed or fail. They do not report application command errors. Retrieve and interpret the cmdoutput item or cmdannotatedoutput item to check for errors.

Help

Topic
System

Item
Help

Operations
Request, Advise

Description
Returns a brief overview of the topics and items in ASCII text format.
cmdoutput

Topic
  Command

Item
  cmdoutput

Operations
  Request, Advise

Description
  Retrieves all command window output of the last executed command via the Command topic. This item empties itself after it has been requested.
cmdannotatedoutput

Topic
Command

Item
cmdannotatedoutput

Operations
Request, Advise

Description
The first line indicates the error status and says OK, ERROR or NOT_EXECUTED. The second line has the form SEQ:sequence_number, where the sequence number is either 0 or the number specified with the execext command. Although the sequence number is optional (it may be omitted in some commands) this line is always present. The next lines are either output or error messages. A label indicates the type (OUTPUT or ERROR) and the number of lines that follow.

Example
ERROR
SEQ: 9284
OUTPUT:1
Hello World
ERROR:1
No such name: xy
**execext**

**Topic**
Command

**Item**

`execext::options::string`

**Operations**

Execute

**Description**

Passes the specified string without interpreting it to CrossView Pro’s command interpreter (see also Command\cmdannotatedoutput). The `execext:` prefix is part of the entire command string: it makes a distinction between the various commands. For example `exec`, `execext` or `halt`, received via the Command topic.

**Options**

- `wait=yesno`  
  *yesno* is 1 or 0. If you specify `wait=1` is, the `execext` command blocks the DDE transaction until CrossView Pro has finished executing the command. Issue the `Halt` command in this case via a second conversation. Be aware of the time limitation imposed by the DDE interface. It can wait for a period of 25 days. Use `exec` combined with either waiting for an Advise on the `cmdoutput` item, or with interpreting the event item to handle very long lasting commands. When you do not specify a value, 1 is assumd by default.

- `seq=number`  
  A unique number to identify a command's specific result in the stream of events output via the event item. See the `event` item and `cmdannotatedoutput` item for more details.

- `silent=yesno`  
  *yesno* is 1 or 0. If 1, the command window output will be suppressed. See section 2.5.5 *Using CrossView Pro as Pure Server* for the `gus` command. When you do not specify a value, 1 is assumd by default.

**Example**

```
execext::seq=424564,wait::echo test
```
exec

**Topic**
Command

**Item**
exec

**Operations**
Execute

**Description**
Passes the specified string without interpreting it to CrossView Pro’s command interpreter (see also Command\cmdoutput).

A major difference with regular MS-Windows applications is the immediate acknowledge of a command, before it has been completed. This is because the sender does not have to wait for the answer and can perform other tasks meanwhile. For example, you are able to issue a `halt` command to stop the debugger.

To simulate wait-till-completion command execution, wait until the cmdoutput item is assigned to the command’s output via an Advisory link event, or interpret the event item.

The `exec:` prefix is part of the entire command string: it makes a distinction between the various commands. For example, `exec`, `execext` or `halt`, received via the Command topic.
halt

**Topic**
Command

**Item**
halt

**Operations**
Execute

**Description**
Forces CrossView Pro to stop target execution. You can issue the command via a second conversation.
**event**

**Topic**

Command

**Item**

event

**Operations**

Advise

**Description**

Reports event occurrences to the client, asynchronously. An event is reported by a string. To ensure capturing all events, use an Advise link. CrossView Pro only keeps the last event.

Request is not meant to be used; it can only be used after establishing an Advise link.
result

**Topic**
Command

**Item**
result: *name*

**Operations**
Execute

**Description**
The *name* that you specify provides a serve as DDE requestable item to obtain a message which describes the reason why a DDE command failed to execute. It does not return the CrossView Pro error message. It is always deleted after it has been requested.

The **result**: prefix is part of the entire command string; it makes a distinction between the various commands. For example, **exec**, **execext** or **halt**, received via the Command topic.

### 2.3 DDE EVENTS

#### 2.3.1 PACKET FORMAT

Each event is wrapped in a record and one DDE message contains one or more of these records. This means that multiple events can be received simultaneously in one DDE transaction. This is done because DDE can lose ("combines") events when XTYPF ACKREQ mode is selected, and because this channel will be redirected to TCP/IP in the future for portable IPC support in CrossView Pro.

To handle events with more than one line, a header (not a newline) is used to distinguish between the individual events. The header format is:

```
EVENT: number-of-characters<newline>
```

So you must always split events that arrive in one DDE message. An example of such a multi-event DDE message is:
EVENT: 27
SourceFileChanged "demo.c"
EVENT: 23
ViewedLineNrChanged 93
EVENT: 27
Stopped BREAKPOINT "input"
EVENT: 24
CommandInterpreterReady
EVENT: 79
CmdAnnotatedOutput
OK\r
OUTPUT:1\r
Error breakpoint name 'input' is not unique!\r

For an overview of all available events, see section 1.4 Events

2.4 CROSSVIEW PRO DDE SPECIFIC OPTIONS AND COMMANDS

2.4.1 COMMAND LINE OPTIONS

--ddeservername=name

This command line option specifies a unique DDE server name. This way it is easier to distinguish between multiple instances of the same debugger.

If you do not use this option, the server name is the name of the CrossView executable. To distinguish between multiple DDE servers with the same name, you must connect to all DDE servers using DdeConnectLists() and obtain distinguishing information.

2.4.2 COMMANDS

With regard to DDE support, the following commands are available enhance integration support.

AddDDEMenuEntry

Syntax:

AddDDEMenuEntry "label","id-string" [AlwaysEnabled]
Creates a menu entry with given *label* and *id-string*. The label also specifies the path from the main menu bar, for example:

\[
\text{AddDDEMenuEntry } "\text{Options|CaseTool|Configure..."},
\text{ "config-menu-entry"
}\]

An entry cannot be removed or replaced once it has been created. Neither is there support for enabling or disabling entries via this interface, this is somewhat problematic, since we are communicating across an asynchronous interface, so the disable may not be executed immediately.

*AlwaysEnabled* is either 1 (true) or 0 (false, default). CrossView Pro by default disables the menu entry when the command window disallows entering a command, for example when running an application.

To define the shortcut character of a menu entry, place a ‘&’ before the character. The shortcut character will be underlined. To add a separator line in the menu, start the next menu entry with a ‘+’. The separator line will precede this menu entry. For example:

"&Options|&CaseTool|+&Reset"

### 2.5 EXAMPLES

#### 2.5.1 EVALUATING AN EXPRESSION

To get the value of an expression, pass it to the command interpreter. The syntax of the returned value is:

\[
\text{identifier} = \text{value}
\]

The *value* can even be a complete structure or union. For example, execute via the Command topic:

```
execext:main
```

The returned string could look like:

```
main = 0x0
```
2.5.2 READING TARGET MEMORY

You can retrieve target memory either via requesting a variable’s value, or with the dump command. The dump command can dump both byte (MAU) sized hex values or C type values, for example long or double. The resulting output must be interpreted to get the values.

The basic syntax of the returned values for plain MAU size hex dumps is:

\[ \text{address: value value ASCII-dump} \]

The basic syntax of the returned values for formatted dumps is:

\[ \text{address = value value} \]

For example, execute via the Command topic a hex dump command:

\[ \text{execext:dump main,#16} \]

The returned text could be:

\[ 0x2000: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 ....... \]

For example, execute via the Command topic a formatted dump command, requesting 16bit integers:

\[ \text{execext:dump data1,#16,d2} \]

The returned text could be:

\[ 0x2000 = 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 \]
\[ 0x2010 = 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 \]

The number of values per line differs. This depends on both the size and type of the values, as well as the architecture of the processor that is connected to the debugger.
2.5.3 WRITING INTO TARGET MEMORY

To write to target memory, use one of the following three methods.

1. Assign a value to a variable.

2. Use one of the the mF or mf commands.
   
   For example, the following stores the byte (MAU) sized values 1 2 3 4 5 in memory starting at memory location 0x2000.
   
   \[0x2000 \text{ mF } 1, 2, 3, 4, 5\]

3. Write into memory using a type cast.
   
   For example:
   
   \[*(\text{long}*)0x2000 = 0x12345\]
2.5.4 REQUESTING CURRENT FILE AND LINE NUMBER

To determine the location of the source window cursor position, request the following special variables:

$FILE  The file in which the source window cursor position is. If the position is outside any file, the error message 'No current file' is returned.

$PROCEDURE  The name of the function in which the source window cursor position is. If the position is outside any function, the error message 'No current function' is returned.

$LINE  The line number of the cursor in the source window. If the position is outside any file, the error message 'No current line' is returned.

You can also use the command ‘ls’ to get all special variables, including the ones above. If a variable is not set, it is not included in the list, or set with the error message as described above.

To make sure the cursor is at the current execution position, precede the L command before requesting the variable. For example, issue:

   L; $FILE; $PROCEDURE; $LINE

Error messages appear when a variable fails.

To obtain the current execution positions, you can also interpret the result of the L command directly.

2.5.5 USING CROSSVIEW PRO AS PURE SERVER

To have CrossView Pro act as server only, updating windows can be turned off with the command gus on. This inhibits all windows from being updated, except for the command window. Note that also the GUI does not refresh anymore.

Also the execext:silent=1:... command via DDE inhibits the command window output.
APPENDIX

CROSSVIEW EXTENSION LANGUAGE (CXL)
1 INTRODUCTION

The CXL language is used for scripting, specifically for the data analysis window and simulation scripts. From CXL only limited access is possible to the CrossView Pro data. Usually CXL scripts are bound to a CrossView Pro command, such as a graph command or a cycle breakpoint with a cxl command.

The CXL syntax is derived from the C syntax, the basic differences from C are:

- No preprocessor, so no defines.
- Only "/" comments.
- No structs or unions, so the operators "." and "->" are not supported.
- No type definition
- No enums
- No switch statement.
- No casts allowed. Casts are performed automatically (like in C).
- No ? : operator allowed.
- Blocks must not be empty ("1;" is the minimal expression).
- No ‘main’, all the script code is to be enclosed within a '{' and '}' pair.
- Function prototypes and function definitions can be nested, but must be preceded by the keyword "sub". They can be used anywhere in the source. Following the scope rules, a function declaration hides a previous definition when it is defined.
- Single statements after a flow control statement (if, else, for, while) should always be between braces.
- Initializers in declarations are not allowed.
- Modifiers such as signed, unsigned, register and static are not supported.
- Floating point numbers below 1 should always be preceded by a zero. For example, the number .15 is treated as invalid, this should be 0.15.

Furthermore, the syntax is like the C syntax.
Example:

```cxl
{  
    sub void p(function f)
    {  
        outd(f());
        outc(’\n’);
    }

    sub int h() { return 1; }

    {  
        //This is the “main” entry point
        p(h);
        sub int h() { return 2; }
        p(h);
    }
}
```

This example would print the following output in the command window:

```
1
2
```

## 2 THE SYNTAX OF CXL

A CXL script always starts with an open brace '{' and ends with a closing brace '}':

```cxl
{  
    // script here  
}
```

There is no "main" function in a CXL script, the script just starts after the first open brace.

Comments start with a // and end at the end of the line. Comments are allowed anywhere in the script, including before the first brace and after the last brace. The C style comments /* */ are not allowed.
Within scripts, blocks can be defined and nested, just like in C:

```c
{
    ...
    {
        ...
        {
            ...
        }
    }
}
```

Each block starts a new scope level for variables. Blocks must not be empty ("1;" is the minimal expression).

There is no preprocessor like in C, so you cannot use C preprocessor directives such as defines.

The control flow statements 'if', 'else', 'while' and 'for' are supported, just like in C. The statements after the control flow statement must always be included between braces. For example, the following expression is not allowed:

```c
if (x < 0 )
    x = 0;
```

it should be written as

```c
if (x < 0 )
{
    x = 0;
}
```

The switch statement, the goto statement and labels are not supported.
2.1 VARIABLES

Variable declarations must be done at the beginning of a block, before starting the actions. All variables are initialized to zero. Variables cannot be initialized at declaration, which means that the following is not allowed:

```c
int cyclebreak = 100;
```

Instead you should use:

```c
int cyclebreak;
... possible other declarations ...
cyclebreak = 100;
```

Variables declared at the highest level are global and keep their value between the script invocations. The `cxl_reset` command and the program reset of CrossView Pro will reset these variables to zero. Variables at other levels and in functions are initialized to zero every time the block or function is executed.

Modifiers such as `signed`, `unsigned`, `register` and `static` are not supported. Type definitions like in C with the `typedef` keyword are not supported. The enumerated type (`enum`) is not supported.

2.2 BASE TYPES

CXL supports the following base types:

- `char`
- `int`
- `long`
- `float`
- `double`
- `string` (only allowed for parameters)
- `function` (only allowed for parameters)

Internally, `char`, `int` and `long` are treated the same, as are `float` and `double`. Since they are the same, types belonging to one group can be interchanged freely.

A function return value can be of any base type. Additionally, `void` can be used as return type for functions without a return value.
2.3 COMPOUND TYPES

CXL supports the following compound types:

- array of char
- array of int
- array of long
- array of float
- array of double

Example:

```c
{  
    char str[100];
    strcpy( str, "Hello\n" );
}
```

Structures, unions and type definitions are not part of the CXL syntax.

2.4 POINTERS

Pointer to base type is only supported for parameters and not for other variables. Pointers to variables are the result of the "address-of" (&) operator and are treated as arrays of the mentioned base type with upper-bound 1.

Example:

```c
{  
    int myval;

    sub void threetimes( int *value )
    {
        *value *= 3;
    }
    myval = 10;
    threetimes( &myval );
    printf( "%d\n", myval );
}
```

When running this script in CrossView Pro with the `cxl` command, the output in the command window will be:

```
30
```
2.5 CONSTANTS AND EXPRESSIONS

The syntax for expressions is the same as for C. The operators and operator precedence are equal. The `? :` operator is not supported.

Explicit casts are not allowed. Implicit casts are performed automatically (like in C). When explicit rounding/casts are needed, you can use the `floor()` function.

Example:

```c
floor(x)       // chopping
floor(x+0.5)   // rounding off to nearest integer
```

Floating point constants below 1 should always be preceded by a zero. For example, the number `.15` is treated as invalid, this should be `0.15`.

Strings are defined between double quotes, just like in C, and are stored with a null character at the end. Character constants are defined between single quotes, just like in C.

2.6 OPERATORS

The operators in CXL are equal to the operators and their precedence in C. Only the `? :` operator is not allowed.
2.7 FUNCTIONS

Function definitions start with the keyword "sub". Besides that, the syntax is equal to functions in C.

Example:

```c
sub int putbit( int val, int bit, int bitval )
{
    if( bitval )
    {
        val = val | (1 << bit);   // set bit
    }
    else
    {
        val = val & ~(1 << bit);  // mask out bit
    }
    return val;
}
```

Just like in C, functions defined after the call must get a function prototype before the call. Also, the prototype must be preceded by the `sub` keyword:

```c
sub int putbit( int val, int bit, int bitval );
// prototype
```

Function prototypes and function definitions can be nested, but must be preceded by the keyword "sub". They can be used anywhere in the source. Following the scope rules, a function declaration hides a previous definition when it is defined.

CXL knows a range of predefined functions. See section 3 in this Appendix.

2.8 FILE INCLUSION

CXL supports file inclusion, but in a different way than with C. The `include` statement must be used immediately before a block:

```c
include "file"
{
    ...
}
```
The included files can only contain function definitions. It is not possible just include a script fragment.

The include files are searched in the following order:

1. Directory of the CXL file that contains the include statement.
2. Current working directory.
3. The `etc\CXL` directory in the installation tree of the product.

### 3 PREDEFINED FUNCTIONS

The following sections list the predefined functions in CXL. Several functions are only useful when using CXL for scripting the data analysis window.

#### 3.1 MATHEMATICAL FUNCTIONS

CXL knows the following mathematical functions. The implementation is equal to those functions in the standard C library.

```c
double sin(double x);
double cos(double x);
double tan(double x);
double acos(double x);
double asin(double x);
double atan(double x);
double sinh(double x);
double cosh(double x);
double tanh(double x);
double log(double x);
double log10(double x);
double exp(double x);
double sqrt(double x);
double ceil(double x);
double floor(double x);
double fabs(double x);
double pow(double x, double y);
```
3.2 ARRAY AND STRING FUNCTIONS

Upperbound of an array:

long upperbound(array a);

The following string and array functions have the same implementation as in the standard C library. Replace array with one of the compound types "array of ...".

char * strcpy( char *s, string ct );
int strcmp( string cs, string ct );
char * strcat( char *s, string ct );
int strlen( string cs );
array memcpy( array s, array ct, int n );
array memset( array s, int c, int n );
int memcmp( array cs, array ct, int n );
void sprintf( string s, string format, ... );

3.3 I/O FUNCTIONS

Output to Command Window

The following functions send output to the command window:

void printf(string format, ...);

double outc(double x); -> { printf(“%c”, (int) x); return x; }
double outd(double x); -> { printf(“%ld”, (long) x); return x; }
double outf(double x); -> { printf(“%f”, x); return x; }

File I/O

The following functions are available for file I/O:

int open( string filename, string mode );

The open function opens the file filename and returns a file handle if successful, otherwise -1 is returned. The mode string determines the mode in which the file is opened. The mode string must begin with one of the following sequences:

"r" Open file for reading.

"r+" Open file for reading and writing.
"w"  Truncate file to zero length or create text file for writing.
"w+"  Open file for reading and writing.
"a"  Open file for appending (writing at end of file).
"a+"  Open file for reading and appending (writing at end of file).

The mode string can also include the letter 'b' either as a last character or as a character between the characters in any of the two-character strings described above. With the 'b' in the mode the file is treated as binary.

```c
void fclose( int handle );
```

Closes the file associated with handle.

```c
void fprintf(int handle, string format, ...);
```

Is the same as the fprintf function in C, with the difference that the first argument is a file handle and not a pointer to a stream.

```c
void fputs( int handle, string data );
```

Writes the data string to the file belonging to the handle. The handle is achieved by calling the open function.

**Set or get variable name**

The following functions are available for interaction with the application being debugged:

```c
void set( string name, double value );
```

Sets the value of the variable name in CrossView Pro. The name must be a name known at the execution point of CrossView Pro. If the name starts with a $ it is either a register name or a CrossView Pro special variable. If the name starting with a $ is not known, a new special variable is created and assigned to the value. If the name does not start with a $ and is not known by CrossView Pro, an error will be issued on the CXL line: "Evaluation of expression failed".

Example:

```c
set( "$PSW", 0 );     // set register PSW to zero
set( "x", 0x1000 );   // set variable x of the
                      // program to 0x1000
```
double get( string name );

Returns the value of a name known by CrossView Pro. This includes variable names and register names. If the name starts with a $ it is either a register name or a CrossView Pro special variable. If the name starting with a $ is not known, a new special variable is created and set to zero. If the name does not start with a $ and is not known by CrossView Pro, an error will be issued on the CXL line: "Evaluation of expression failed".

Example:

printf( "PSW = %04x\n" , get( "$PSW" ) );
printf( "x = %04x\n" , get( "x" ) );

3.4 GRAPH FUNCTIONS

CXL supports specific graph functions when passing a CXL script to a graph or graphm command.

down graph command functions

GUI interaction functions available when a script is passed to the graph command:

void add_point(double x, double y);

This function adds graph points to the acquisition buffer.

void printf(string format, ...);

The output of printf is written to the command window.

down graphm command functions

GUI interaction functions available when a script is passed to the graphm command:

void printf(string format, ...);

The output of printf is sent to the "window contents script".
printf is chosen to facilitate development and debugging graphm scripts using a host system C development environment. The C code can be very easily ported to CXL afterwards. The output is in fact a command of the drawing engine and is therefore not the same as a usual printf and not the same as printf in the graph and cxl command. Logging to the command window from a graphm script is not possible via printf.

The following drawing commands are supported:

**clear**

Clear drawing area. This is usually the first command issued in a drawing sequence.

**graph_area** *x-offset, y-offset, x-size, y-size*

printf("graph_area %d,%d,%d,%d/n", xo, yo, xs, ys)

Set graph area size. The offset determines the lower left corner of the graph area. Size is the exact number of pixels.

**axis** *xlow, ylow, xhigh, yhigh*

Define the axes ranges, for determining the cross-hair cursor coordinates (to be displayed in the cursor field and to be passed to the representation generator). The axes range up-to the top-right coordinate, which is excluded (reduces axis drawing maths, but mind axis lengths of 0). The axes are linear.

**pen_color** *color*

Set pen color. Black is the default color. The color can be specified by name or by RGB number in the form red,green,blue as decimal number for each base color for 0 to 255. E.g. 255,128,0 is orange. Valid names are:

black, red, yellow, green, blue, cyan, magenta, dkgray, gray, ltgray, white

**brush_color** *color*

Color used for filling areas. Black is the default color. See pen_color for possible colors. The value background sets the brush to the current background color which is WINDOW_BACKGROUND under Windows.
filled_rectangle \( x_1, y_1, x_2, y_2 \)

Puts a rectangle, filled with the latest set brush_color, bounded by \((x_1, y_1)\) and \((x_2, y_2)\) (both points inclusive). Coordinates are expressed in pixels. The origin is the lower left corner.

dot \( x_1, y_1 \)

Draw pixel. Coordinates are expressed in pixels. The origin is the lower left corner.

line \( x_1, y_1, x_2, y_2 \)

Draw line from \((x_1, y_1)\) up-to and including \((x_2, y_2)\). Coordinates are expressed in pixels. The origin is the lower left corner.

polygon \( x_1, y_1, x_2, y_2, \ldots, x_n, y_n \)

polyline \( x_1, y_1, x_2, y_2, \ldots, x_n, y_n \)

Puts a polyline, using the latest set pen_color, from line sections from the points \((x_1, y_1)\) to \((x_n, y_n)\), where \(n \geq 3\) (which means at least 2 lines). Coordinates are in pixels.

filled_polygon \( x_1, y_1, x_2, y_2, \ldots, x_n, y_n \)

Puts a polygon, filled with the latest set brush_color, bounded by a polygon formed by the line sections between the points \((x_1, y_1)\) to \((x_n, y_n)\) and back to \((x_1, y_1)\), where \(n \geq 3\). Coordinates are in pixels. As with \texttt{filled_rectangle}, the pen is only temporarily set to the same color as the current brush and restored when the call is finished.

filled_polygon_brush \( x_1, y_1, x_2, y_2, \ldots, x_n, y_n \)

As with \texttt{filled_polygon}, but using a separate brush and pen, that is, using the latest brush and pen color also when they are different.

text \( x, y, \text{anchor}, \"text\" \)

Draw text with its anchor at location \((x, y)\). The anchor is the point in the text string, which will get placed at the specified location. For example, anchor 7 specifies that the text must be placed such that the bottom-left side of the text is at the specified position. Coordinates are expressed in pixels. The origin is the lower left corner.
Text may include any characters, except a nil character. Double quote and backslash characters must be escaped by a backslash character. Text will be formatted using the current font settings. See below for the font info exchange between the window and the representation generator.

```c
long get_attr(string attribute);
```

Supported attributes are:

```
"draw-area-x-size"
"draw-area-y-size"
"x-scrollbar-present"
"x-scrollbar-size"
"x-scrollbar-low"
"x-scrollbar-high"
"y-scrollbar-present"
"y-scrollbar-size"
"y-scrollbar-low"
"y-scrollbar-high"
"selection-available"
"selection-start"
"selection-end"
```

```c
long get_text_attr(string attribute, string text_format, ...);
```

Supported attributes are:

```
"leading"
"ascent"
"descent"
"width"
```
**Argument passing.**

The **graph** and **graphm** commands can be given a number of arguments. These arguments are accessible as follows.

```c
long n_args;
```

The number of arguments.

```c
arg1..argN
```

with \( N = n\_args \) are added to the global scope and have type
- `double *` for buffers, type `string` for strings and type `double` for evaluated expressions.

Parsing the script will fail if a certain argument has not been provided. Evaluation of the script will fail if the type of the argument does not match its use.

For argument testing and argument retrieval the following functions are provided:

```c
long is_string_arg(long n);
long is_double_arg(long n);
long is_buffer_arg(long n);
double get_double_arg(long n);
string get_string_arg(long n);
double *get_buffer_arg(long n);
```

Numerical arguments can be retrieved by using `get_double_arg()`. In the **graphm** command, the \((x, y)\) pairs produced by a sequence of calls to `add_printf()` in the **graph** script are accessible via global variables `x` and `y` of data type "array of `double".

### 3.5 MISCELLANEOUS FUNCTIONS

For generating a random number the `rand()` function is available in CXL:

```c
int rand( void );
```
APPENDIX C

SOUND SUPPORT (MS-Windows)
You can have sound effects being played when a predefined event in CrossView Pro occurs. You can configure the sound in the Sound settings of the Control Panel of MS-Windows. Similar to assigning a sound to a system event, you can assign a sound to a CrossView Pro event.

Currently the following events are supported:

- Breakpoint hit
- File has been downloaded
- CrossView Pro has started execution
- CrossView Pro is exiting
- Run command/button
- Step command/button
- StepOver command/button
- Halt command/button
- Symbols Loaded
- Fatal (system) error occurred
- Non-fatal error

**How to add sound support**

1. Firstly all events must be specified to MS-Windows. You can do this by adding the following lines to the Registry under:
   ```plaintext
   My Computer\HKEY_CURRENT_USER\AppEvents\EventLabels\
   ```

   Use `regedit` to start the registry editor.

   ```plaintext
   snd_xvw_bphit        "XVW Breakpoint Hit"
   snd_xvw_download     "XVW Program Download"
   snd_xvw_start        "XVW Start"
   snd_xvw_exit         "XVW Exit"
   snd_xvw_run          "XVW Run"
   snd_xvw_step         "XVW Step Into"
   snd_xvw_stepover     "XVW Step Over"
   snd_xvw_stop         "XVW Stop"
   snd_xvw_syms_load    "XVW Load Symbols"
   snd_xvw_syserror     "XVW syserror"
   snd_xvw_uerror       "XVW uerror"
   ```

2. You must also add the same list of keys (without values) to
   ```plaintext
   My Computer\HKEY_CURRENT_USER\AppEvents\Schemes\Apps\.Default\
   ```

3. Now go and start the Sound settings in your Control Panel. Here you can assign a sound to each event. You can also assign None to an event, which prevents CrossView Pro from playing a sound if that specific event occurs.
4. For the sound effects to become operational, you also have to edit the `xvw.ini` file. You can do this using any editor, e.g. the Windows `notepad` command. Add the following line at an arbitrary line to your `xvw.ini` file:

```
  sound_effects: TRUE
```

It is also possible to disable the sound effects by changing this line into:

```
  sound_effects: FALSE
```

Now all sound effects are disabled.
ADDENDUM

ROM/RAM MONITOR

TASKING
1 INTRODUCTION

This addendum contains information specific for the C166/ST10 family target boards with a ROM or RAM debug monitor. A target board can be either an evaluation board or your own target board.

If you are using an evaluation board, the evaluation board’s user manual is always the first source of information; this addendum covers the evaluation board’s interaction with CrossView Pro.

2 EXECUTABLE NAME

The following CrossView Pro executable is delivered with the package (for PC with .exe extension):

xfw166 CrossView Pro Debugger for the C166/ST10

The target board connection using a serial or CAN interface is delivered as a separate DLL within the package:

dieva166.dll CrossView Pro Debugger target board connection
(for UNIX with .so extension)

3 GENERAL OPERATION

To debug your application with CrossView Pro it has to be executed in an C16x, ST10, XC16x or Super10 family hardware environment. This CrossView Pro version was designed to have full control over the following target boards:

- any board running the TASKING C166/ST10 ROM debug monitor
- any board running the TASKING C166/ST10 RAM debug monitor

The TASKING C166/ST10 ROM and RAM debug monitors are included in the package, as source code in the mon subdirectory and configured for several boards in the etc directory. The ROM debug monitor should be burned into an EPROM on the target board. The RAM debug monitor is downloaded into on-board RAM by means of the on-chip bootstrap loader.
CrossView Pro knows which resources to use for a target board by reading a target configuration file. You can select one of the target configuration files by using the `-tcfg` option or by selecting the target configuration file from the Target Settings dialog (Target | Settings...).

4 RESTRICTIONS

Facilities for hardware breakpoints, real-time kernel support and trace are absent on these evaluation boards. As a consequence, the CrossView Pro commands `bd` and `bD` for data breakpoints, the commands `bt`, `bti`, `btl`, `et` and `lt` for kernel support, and the command `ct` for C-level tracing, are not available. Due to the binary command interface between debugger and evaluation board, the `>&` command to record target communication and the `o` command for transparency mode are not available.

Profiling is only available for ICEs that support it. Contact your ICE vendor to ask if they support profiling.

Menu and dialog items related to the mentioned commands are disabled (grayed out).

When a breakpoint is set in an ATOMIC or EXTEND sequence, CrossView Pro will set a breakpoint at the first instruction after the sequence. Within an ATOMIC or EXTEND sequence ‘class A’ hardware traps are not handled. Therefore, it is not possible to set a breakpoint within a sequence, because breakpoints are set by a TRAP #2 (NMI) instruction which is a ‘class A’ hardware trap.
5 THE RAM AND ROM DEBUG MONITOR

For running and debugging an application on your target board with CrossView Pro, a debug monitor must be running on that board. The monitor used for the C16x/ST10 or XC16x/Super10 and derivatives communicates with CrossView Pro using a binary protocol via an asynchronous serial port or CAN port of the processor. This monitor can be present on the target board in an EPROM (ROM debug monitor) or can be downloaded into RAM by CrossView Pro, using the on-chip bootstrap loader (RAM debug monitor).

The CrossView Pro package contains several configurations of the ROM/RAM debug monitor and also the source and makefiles are included to build the monitor in a configuration which suites your target board.

5.1 MONITOR CONFIGURATIONS

The monitor exists in the following basic configurations for all derivatives.

- RAM debug monitor loaded using on-chip bootstrap loader (BSL)
- ROM debug monitor using dual vector table method
- ROM debug monitor using memory switch

The following sections describe these configurations.

5.1.1 RAM DEBUG MONITOR

For loading the monitor in RAM, the on-chip bootstrap loader (BSL) is used. The processor is started in BSL mode by activation of one or more of its pins during the hardware reset. See the BSL description in the CPU user’s manual for more information about activation of the on-chip BSL.

CrossView Pro detects if the CPU is in the BSL-mode by sending a null-byte to the serial channel. If the CPU is in BSL-mode it detects the baud rate from this null-byte and sends an acknowledge byte back to CrossView Pro. When this acknowledge byte matches the byte specified for the selected target board CrossView Pro knows that the CPU is in BSL-mode. If the monitor has already been loaded before and running, it answers with an acknowledge byte (0xAA) which is different from all possible BSL acknowledge bytes. Once CrossView Pro detects that the CPU is in BSL-mode it continues with the boot sequence. This boot sequence is as follows:
1. Sending boot program.

CrossView Pro sends a boot-program to the serial port (up to 960 bytes). The on-chip bootstrap code reads the first 32 bytes from serial port 0 and starts running this code. This part of the boot-program contains a small serial input loop. The small serial input loop reads the remaining part of the boot-program and continues execution. This boot-program, which now runs, is in fact a restricted monitor.

2. Initializing registers.

CrossView Pro now first sends a byte-number to identify how many registers will be sent to the boot-program to configure the registers (with a maximum of six) before the EINIT instruction in the boot-program is executed. The EINIT is required, because it causes the #RSTOUT pin to go high which may be required to indicate the hardware on the target board that initialization is done. CrossView Pro now sends a null byte so a target could now synchronize its communication port. The monitor responds with an acknowledge byte. Then CrossView Pro also sends commands for initializing registers to values as specified in the target configuration file. This way it is possible to setup a configuration for the external memory before downloading the monitor.

3. Sending monitor program.

CrossView Pro now sends the full monitor program to the target board by using the restricted command set of the boot-program.

4. Booting the monitor.

After the monitor is loaded CrossView Pro sends a GO command to the boot program and the monitor is started. This is done by means of a software reset instruction (SRST) which causes the CPU to exit the BSL-mode. The memory previously occupied by the boot-program is now free to be used by your application. After the SRST instruction it depends on the target board how the monitor is entered. When the BSL is activated using the NMI pin of the CPU, and this activation is not removed after the #RSTOUT pin went high (EINIT), an NMI interrupt will occur before the reset vector is executed. After the NMI interrupt is handled the reset vector will be executed. If the NMI pin was not used to initiate the BSL or when activation was removed on change of the #RSTOUT pin, the NMI interrupt will not occur and the reset vector is the first to be executed.
5. Initializing registers.

The values of the registers specified in the configuration file with the `einit` field are passed by the boot-program to the monitor by storing it at a location in internal RAM. This is possible because a SRST instruction does not erase the internal RAM. This way the register from the configuration file in the `einit` field could be initialized before the EINIT instruction in the monitor. The initialization of the other registers specified in the target configuration file is now done by using monitor commands.

For each execution of the user application (step and run commands) the monitor installs the NMI and serial receive interrupt vectors to jump into the monitor before the execution of the monitor is ended and the user application is started. The NMI vector is used for breakpoints and the serial receive interrupt is used to jump into the monitor on the `halt` command of CrossView Pro. Because these vectors are each time reinstalled, loading the interrupt vector table of the user application over these vectors is possible.

The `etc` directory contains several boot programs and RAM debug monitors. The target configuration files `*.cfg` (also in the `etc` directory) tell CrossView Pro which boot program and monitor can be used for a board. The boot programs and monitors are in S-Record format (S1). The filename suffix is `.sre`.

The following boot programs are available:

<table>
<thead>
<tr>
<th>Boot Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>btarget.sre</code></td>
<td>for all C16x/ST10, XC16x, Super10 derivatives. <code>target</code> can be one of 167, xc16x or ext2 respectively.</td>
</tr>
<tr>
<td><code>btargetnrb.sre</code></td>
<td>for <code>target</code> (and derivative) boards which have no RAM selected by CS0. Therefore, the monitor is not started with a software reset but with a trap #0. This implies that the <code>target</code> remains in the bootstrap mode.</td>
</tr>
</tbody>
</table>


### Boot Program Description

<table>
<thead>
<tr>
<th>Boot Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>btargetnrbe.sre</code></td>
<td>for target (and derivative) boards which have no RAM selected by CS0. Therefore, the monitor is not started with a software reset but with a trap #0. This implies that the target remains in the bootstrap mode. All registers within the einit field are not stored anymore within the internal RAM and CrossView Pro initializes all specified registers (necessary when more than six registers should be initialized without modifying the monitor sources). After initialization the EINIT instruction is executed with the monitor command EINIT. This is the most flexible boot program to initialize a target board. Use this boot program together with monitor program <code>mtargetre.sre</code>.</td>
</tr>
<tr>
<td><code>bl64nrb.sre</code></td>
<td>same as <code>bl67nrb.sre</code> but with the difference that now timer T3 is used for the BSL. Timer T3 is used when the target has only one GPT1, for example C164CI.</td>
</tr>
<tr>
<td><code>bl67a.sre</code></td>
<td>for C167 AA step with 960 byte BSL instead of 32 byte.</td>
</tr>
<tr>
<td><code>bl67snrb.sre</code></td>
<td>no RAM boot version and Phytec memory switch.</td>
</tr>
<tr>
<td><code>bi_me167.sre</code></td>
<td>for I+ME C167C board.</td>
</tr>
<tr>
<td><code>bext2f.sre</code></td>
<td>same as <code>bext2.sre</code> but with the exception that the I/O is initialized with the Fractional Divider S0FDV to get higher baud rates.</td>
</tr>
<tr>
<td><code>bext2i.sre</code></td>
<td>same as <code>bext2.sre</code> but with an extra I/O initialization after the EINIT instruction. This is necessary when the SYSCON1 clock divider does not have the default value.</td>
</tr>
<tr>
<td><code>bext2fi.sre</code></td>
<td>combination of the boot programs <code>bext2f.sre</code> and <code>bext2i.sre</code>.</td>
</tr>
<tr>
<td><code>bext2nrbi.sre</code></td>
<td>same as <code>bext2nrbi.sre</code> but with an extra I/O initialization after the EINIT instruction. This is necessary when the SYSCON1 clock divider does not have the default value.</td>
</tr>
<tr>
<td><code>bxc16xi.sre</code></td>
<td>same as <code>bext2i.sre</code> but built for the XC16x architecture.</td>
</tr>
<tr>
<td><code>bxc16xnrb.sre</code></td>
<td>same as <code>bext2nrbi.sre</code> but built for the XC16x architecture.</td>
</tr>
</tbody>
</table>

*Table Mon-1: Boot programs*
The following monitor programs are available:

<table>
<thead>
<tr>
<th>Monitor Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>m167cr.sre</code></td>
<td>for C16x/ST10 boards using CAN as communication channel.</td>
</tr>
<tr>
<td><code>m167crd.sre</code></td>
<td>for C16x/ST10 boards using CAN as communication channel, but has delay for writing new data. This delay is necessary for the CAN-dongle that does not have a queue.</td>
</tr>
<tr>
<td><code>m167mcp.sre</code></td>
<td>for C16x/ST10 boards. Copies the RAM monitor from ROM to RAM and boots with the reset vector.</td>
</tr>
<tr>
<td><code>m167cmcp.sre</code></td>
<td>for C16x/ST10 boards using CAN as communication channel. Copies the RAM monitor from ROM to RAM and boots with the reset vector.</td>
</tr>
<tr>
<td><code>m167rvh.sre</code></td>
<td>for C16x/ST10 boards. RAM monitor booting with the reset vector and Virtual output support and hardware flow control.</td>
</tr>
<tr>
<td><code>m164r.sre</code></td>
<td>for C164 boards with RAM boot with reset vector. Use T4 instead of T6 for baud rate.</td>
</tr>
<tr>
<td><code>mext2b.sre</code></td>
<td>same as <code>mext2r.sre</code> with the difference that now the new DEBUG interrupt is used for setting breakpoints so the NMI vector is now available for the user application.</td>
</tr>
<tr>
<td><code>mext2fb.sre</code></td>
<td>same as <code>mext2b.sre</code> but with the exception that the I/O is initialized with the Fractional Divider S0FDV to get higher baud rates.</td>
</tr>
</tbody>
</table>
Monitor Program | Description
--- | ---
mext2ib.sre | same as mext2b.sre with the difference that in the monitor the EINIT instruction is not executed. The target will be configured according to the settings of the user application. The monitor could become inaccessible when the configuration for the monitor (found in the .cfg file) will differ from the configuration of the user application. Look also at the 'Note for the XC16x/Super10 architectures' found at the usage description of the einit field.
mxc16xb.sre | same as mext2b.sre but built for the XC16x architecture.
mexc16xib.sre | same as mext2ib.sre but built for the XC16x architecture.

Table Mon-2: RAM debug monitor programs

The monitors are configured as follows:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor register bank</td>
<td>000FCC0h</td>
<td>000FCDFh</td>
</tr>
<tr>
<td>C16x/ST10 monitor code</td>
<td>0000200h</td>
<td>0000DFFh</td>
</tr>
<tr>
<td>C16x/ST10 monitor data</td>
<td>0000E00h</td>
<td>0000FFFh</td>
</tr>
<tr>
<td>C16x/ST10 monitor data</td>
<td>000FD00h</td>
<td>000FD4Bh</td>
</tr>
<tr>
<td>Super10 monitor data</td>
<td>000DF00h</td>
<td>000DF4Bh</td>
</tr>
<tr>
<td>Super10 monitor code</td>
<td>0C01000h</td>
<td>0C01FFFh</td>
</tr>
<tr>
<td>XC16x monitor data</td>
<td>000CF00h</td>
<td>000CFFFh</td>
</tr>
<tr>
<td>XC16x monitor code</td>
<td>0001000h</td>
<td>0001FFFh</td>
</tr>
</tbody>
</table>

Table Mon-3: RAM debug monitor configuration

These memory ranges should be reserved using the RESERVE MEMORY control while locating your application with **l166**.

Example:

```
RESERVE MEMORY( 0FCC0h TO 0FCDFh, 0200h TO 0FFFh, 0FD00h TO 0FD4Bh )
```
5.1.2 ROM DEBUG MONITOR USING DUAL VECTOR TABLE

When the monitor is burned into EPROM, the interrupt vector table should already be initialized with the RESET, NMI and serial receive interrupt vectors to be able to boot the monitor. In the dual vector table configuration all other interrupt vectors point to the user vector table in RAM. You can locate the user vector table at an address in RAM with the VECTAB( address ) control while locating the application. When the absolute output file of the locator is formatted using the ieee166 program, you should use the command line option -saddress of ieee166 to set the start address of the user program. When in CrossView Pro you should always reset first with the rst command or from the Run menu, select Reset Application.

The following S-record (S1) files for burning into EPROMS are installed in the etc directory:

m167d.sre   ROM debug monitor with dual vector table for the C16x/ST10 derivatives
mext2d.sre   ROM debug monitor with dual vector table for the Super10 architecture
mxcl6xd.sre  ROM debug monitor with dual vector table for the XC16x architecture
The ROM debug monitors with dual vector table are by default configured as follows:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor register bank</td>
<td>0FCC0h</td>
<td>0FCDFh</td>
</tr>
<tr>
<td>C16x/ST10 monitor code</td>
<td>00000h</td>
<td>00FFFh</td>
</tr>
<tr>
<td>C16x/ST10 monitor data</td>
<td>0FD00h</td>
<td>0FD8Fh</td>
</tr>
<tr>
<td>C16x/ST10 application user interrupt vector table</td>
<td>08000h</td>
<td>081FFh</td>
</tr>
<tr>
<td>XC16x/Super10 monitor code</td>
<td>0C00000h</td>
<td>0C01FFFh</td>
</tr>
<tr>
<td>Super10 monitor data</td>
<td>0DF00h</td>
<td>0DF8Fh</td>
</tr>
<tr>
<td>XC16x monitor data</td>
<td>0CF00h</td>
<td>0CF8Fh</td>
</tr>
<tr>
<td>XC16x/Super10 application user interrupt vector table</td>
<td>00000h</td>
<td>00FFFh</td>
</tr>
</tbody>
</table>

Table Mon-4: ROM debug monitor (dual vector table) configuration

The memory ranges for monitor code data and register bank should be reserved using the RESERVE MEMORY control while locating your application with **l166**. The vector table of your application should be located using the VECTAB(\textit{address}) control.

Example:

```
RESERVE MEMORY( 0FCC0h TO 0FCDFh, 0000h TO 0FFFh, 0FD00h TO 0FD8Fh )
VECTAB( 8000h )
```
5.1.3 ROM DEBUG MONITOR USING MEMORY SWITCH

In this configuration the monitor and vector table are in EPROM starting at address 0000h. When the monitor is booted, the EINIT instruction causes the RSTOUT pin of the controller be toggled. The hardware will then swap the EPROM with a RAM area and the monitor will continue execution at the new EPROM address.

For each execution of the user application (step and run commands) the monitor installs the NMI and serial receive interrupt to jump into the monitor before the execution of the monitor is ended and the user application is started. The NMI vector is used for breakpoints and the serial receive interrupt is used to jump into the monitor on the halt command of CrossView Pro. Because these vectors are each time reinstalled, locating the interrupt vector table of the user application over these vectors is possible.

The following S-record (S1) file for burning into EPROMS is installed in the etc directory:

m167s.sre ROM debug monitor for C16x/ST10 derivatives

This monitor is configured as follows:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor register bank</td>
<td>0FCC0h</td>
<td>0FCDFh</td>
</tr>
<tr>
<td>monitor code after swap</td>
<td>08000h</td>
<td>08FFFh</td>
</tr>
<tr>
<td>monitor data after swap</td>
<td>00200h</td>
<td>0027Fh</td>
</tr>
</tbody>
</table>

Table Mon-5: ROM debug monitor (memory switch) configuration

The memory ranges for monitor code, data and register bank should be reserved using the RESERVE MEMORY control while locating your application with l166.

Example:

```
RESERVE MEMORY( 0FCC0h TO 0FCDFh, 08000h TO 08FFFh, 0200h TO 027Fh )
```
5.2 RESOURCES USED BY THE DEBUG MONITORS

The system stack size is set at startup of the monitor according to the values defined in the startup code `cstart.asm` or else the size is set to 256 words. The monitor uses the same system stack area and system stack pointer as your application. When program execution returns from your application into the monitor, the monitor continues using the system stack specified by SP where your program left off. So, remember that it is possible that the system stack overflows when debugging, despite of the fact that the size of the system stack is large enough when you run your program standalone.

Initially, the system stack pointer SP is set to 0FA40H for the monitor, which makes it possible to debug the startup code in your program. The application startup code sets the definite values for the system stack pointers SP, STKOV and STKUN.

The monitors use the following resources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>C16x/ST10 monitor</th>
<th>XC16x/Super10 monitor</th>
</tr>
</thead>
<tbody>
<tr>
<td>serial port</td>
<td>S0</td>
<td>S0</td>
</tr>
<tr>
<td>interrupts used</td>
<td>NMI, S0RINT</td>
<td>S0RINT, NMI or DEBUG</td>
</tr>
<tr>
<td>system stack</td>
<td>32 words</td>
<td>48 words</td>
</tr>
<tr>
<td>internal RAM (regbank)</td>
<td>16 words</td>
<td>16 words</td>
</tr>
<tr>
<td>RAM for data</td>
<td>136 bytes</td>
<td>136 bytes</td>
</tr>
<tr>
<td>RAM/ROM for code</td>
<td>&lt; 3K</td>
<td>&lt; 3K</td>
</tr>
<tr>
<td>RAM/ROM for code</td>
<td>&lt; 3K</td>
<td>&lt; 3K</td>
</tr>
</tbody>
</table>

| CAN interface       | message 1 and 2 using ID30 and ID31 |

*Table Mon-6: Monitor resources*

The monitor uses a maximum of 16 bytes of system stack space starting from the current system stack pointer (SP) of your program (i.e. the monitor uses the system stack of your program). Initially the SP is set to 0FA40h by the monitor, which makes it possible to debug your startup code before the SP is set.

The monitor does not use any user stack space of the user application. It has its own user stack in the "RAM for data" area.
The NMI and the S0RINT interrupt cannot be used by your program. Both vectors should be located in RAM because the monitor refreshes them on exit. This is needed to be able to restart the monitor after downloading an application which overwrites the vector table.

All SFRs used by the monitor are saved on entry of the monitor and they are restored before the program is continued.

The CrossView Pro debugger sets a breakpoint by exchanging the code on the breakpoint with a TRAP #NMI instruction. When the breakpoint is hit CrossView Pro writes the original code at the breakpoint address. Therefore, the user program must be in RAM. As a consequence, the monitor may also be entered when an NMI is caused externally by a high-to-low transition at the NMI#-pin.

On entry of the monitor (e.g. after a breakpoint) all timer registers T01CON, T2CON, T3CON, T4CON, T5CON, T6CON (and T78CON for the 167) are saved and set to zero. This way the timers are stopped while the monitor is running. The timers are reloaded with the saved value before continuing with the user program.

At startup the monitor executes the DISWDT and the EINIT instruction. The DISWDT instruction disables the watchdog timer, and it cannot be enabled by the user program. The EINIT instruction causes the RSTOUT# pin to go high. This pin cannot be used by the user program.

The serial receive interrupt vector S0RINT (or S1RINT when configured for port S1) is used by the monitor to abort execution of the user program. This interrupt vector points to the start address of the monitor. If program execution needs to be aborted, the debugger sends an escape sequence to the serial port to cause an interrupt. When the interrupt is serviced by the CPU the monitor is trapped and debugging continues. The receive interrupt level for the serial port is set to the lowest priority (ILVL=1 and GLVL=0). These interrupt levels can be changed in the monitor source. See section 5.3 Rebuilding the Debug Monitors for more information. The interrupt enable bit in the program status word (PSW) is enabled in the monitor and need to stay enabled when the user program is running. Otherwise, interrupting the program from the debugger is not possible.

For the RAM debug monitor for the C16x the WR# pin and the BHE# pin are enabled at startup of the monitor. The init field in the target configuration file can be used to change the values at startup. The signal BHE# is used by the chip-select logic for the 16-bit data bus modes. Here the signal may not be disabled by the user, respectively port P3.12 may not be used as an I/O port.
5.3 REBUILDING THE DEBUG MONITORS

The monitor and boot programs are also included as source, installed in the mon subdirectory. This directory contains the following files:

- **boot.c**: the boot program for RAM debug monitor
- **boot_get.c**: input from serial port functions for RAM boot program
- **bootcom.h**: data structures to save data for the switch from boot program to monitor
- **boot.ilo**: locator invocation file for locating the bootstrap loader
- **command.c**: the command interface for ROM and RAM debug monitor
- **memcopy.c**: functionality to copy the ROM monitor into RAM and run from copied RAM
- **memcopy.h**: definitions and prototypes for memcopy.c
- **id.c**: the monitor version string routine
- **io.c**: the general low-level I/O routines for ROM and RAM debug monitor
- **iocan.c**: the CAN low-level I/O routines for ROM and RAM debug monitor
- **candef.h**: definitions for CAN, used by iocan.c and mon.c
- **ioserial.c**: the serial low-level I/O routines for ROM and RAM debug monitor
- **ioserial.h**: definitions for ioserial.c
- **vio.c**: the virtual output routines for ROM and RAM debug monitor that cannot stop the application
- **vio.h**: definitions for vio.c
- **flash_exe.c**: the flash programming monitor
- **flash_exe.h**: flash programming monitor definitions
- **flash_ptr.h**: definitions and prototype for flash setup
flash_st10f16x.c  additional flash routines for the ST10x168
flash_st10f276.c  additional flash routines for the ST10x276
trap.c          set specific monitor trap vector
trap_get.c      get specific monitor trap vector
vectabl.asm     contains the interrupt vector table for the ROM debug
                monitor with dual vector table configuration
mon.c           the mainline and startup code of ROM and RAM debug
                monitor
mon.h           definitions and prototypes
mon.ilo         locator invocation file for all configurations of the
                monitor. This file is preprocessed by the C
                preprocessor to select a configuration
mondef.h        definitions for all configurations
makefile        used to build all monitors. This makefile uses the
                makefiles in the mon167, monext2 and monxc16x
                subdirectories.

subdirectory mon167:
makefile        used to build C16x/ST10 debug monitors and boot
                programs

subdirectory monext2:
makefile        used to build Super10 debug monitors and boot
                programs

subdirectory monxc16x:
makefile        used to build XC16x debug monitors and boot
                programs

When you have the TASKING C166/ST10 C compiler version 5.0 or higher
you can rebuild the monitors. Make the mon subdirectory the current
working directory and type:

  mk166
The S-Record files (.sre) of the boot programs and monitors are created in the `mon167`, `monext2` and `monxc16x` subdirectories. If you need the Intel HEX file format (for example, for programming into flash) instead of the Motorola S record format, type:

```
    mk166 IHEX=
```

When you type

```
    mk166 clean
```

all files which can be created when building the monitors are removed.

### 5.3.1 DEBUG MONITOR CONFIGURATION

#### PARAMETERS

**Selection of serial channel**

The makefiles in the `mon167`, `monext2` and `monxc16x` subdirectories contain a variable `PORT` which selects the serial channel the monitor is build for (0 or 1). Please run a `mk166 clean` before rebuilding the monitor with a different `PORT` setting.

**Monitor serial channel interrupt and group level**

The file `mon.h` contains the settings of interrupt level (SxILVL) and group level (SxGLVL) of the serial interrupt of the monitor. When you have tasks running at a higher interrupt/group level than the monitor, you cannot break into the monitor when that task is active. In this case you should set the defines SxILVL and SxGLVL to a higher value. If you want, for example, PEC transfer to continue while the monitor is active the monitor interrupt/group level should be lower than the level of the PEC transfer.

**Memory model**

The boot program can only be translated in the medium memory model, using the special stack frame. The monitor is tuned to be translated in the small memory model. It cannot be translated in the tiny model because huge pointers are used. Translating it in the medium or large model is possible. Note that the monitor does not need to be translated in the same memory model as your application.
Memory configuration

The memory configuration depends on the values of the SYSCON, CPUCON1, VECSEG, BUSCON and ADDRSEL registers. The values for these registers can be specified with the einit and init fields for the selected target board in a target configuration file (.cfg). CrossView Pro will initialize the registers as specified just after booting the boot program and just after booting the monitor. This is not the case for the registers specified within the einit field, because they cannot be modified after execution of the EINIT instruction. For this reason CrossView Pro always sends the values as specified in the einit field before the boot program has executed the EINIT instruction. These values are passed by the boot program to the monitor by storing them in the internal memory which is not changed by a SRST instruction.

Memory layout

The memory layout of the three basic configurations of the monitor is defined in the locator invocation file mon.ilo with defines in mondef.h. The files are preprocessed by the C preprocessor to select one of the three configurations and to substitute the defined macros. The following parameters can easily be changed in the mondef.h file by changing the defines:

MON_RB_START

The start address of the monitor register bank, default 0FCC0h.

ROM_START

The start address of the monitor code in ROM.

ROM_SIZE

The monitor code size.

RAM_START

The start address of the monitor data in RAM.

RAM_SIZE

The monitor data size.
VECTAB_APP_START

The start address of the vector table of the user application for the ROM dual vector table configuration. All vectors except the reset, NMI and serial receive interrupt vectors in the monitor vector table jump to a vector table starting at this address in RAM. The default is 08000h.

VECTAB_MON_START

The start address of the monitor for the ROM dual vector table configuration.

Start up configure at NMI

C16x/ST10 derivatives can enter the bootstrap mode by activating the NMI pin in combination with another port pin. When the bootstrap program starts the monitor using the SRST instruction, the following may happen:

1. the target board has deactivated the NMI pin when the RSTOUT pin went low. Then the NMI remains deactivated when the SRST instruction causes the RSTOUT pin to go high again.

2. the target board did not deactivate the NMI pin or activated it again at the SRST instruction.

Now the NMI occurs before starting at the reset vector.

To cope with both situations the monitor module main.c uses a C preprocessor macro NMI_STARTUP. When this macro is set, an additional NMI handler is defined. This NMI handler does the startup configuration of the CPU and then returns. Then the monitor main function is executed from the reset vector.

When this macro is not set, the CPU is configured by the main function executed from the reset vector.
5.4 DEBUG MONITOR INTERFACE DESCRIPTION

This section describes the interface protocol which allows host computer debuggers to communicate with target RAM debug monitors.

5.4.1 INITIALIZATION

To initiate the connection, the host sends a null byte to the target. In case of a serial link, the target monitor measures the time between start bit and stop bit, and the monitor should appropriately set up the baud rate generator.

Then the host sends the SYNC command to synchronize host program and target monitor. The monitor should reply with the acknowledge byte: 0xAA.

Now the connection is established at monitor command interface level.

5.4.2 CONVENTIONS

command

Name of the command as used in descriptions and documentation.

Token:

Decimal code for command byte.

Parameters:

Additional data which should be supplied with the command token.

Returns:

Data returned by monitor. Hexadecimal numbers are prepended by 0x.

The data format, if applicable, is annotated between parentheses. If the format is to be applied more than once, the format is preceded or succeeded by a count number and multiplication operator. These are the data formats used:
ADDR:  4-byte address, little endian
WORD:  2-byte word, little endian
BYTE:   1 byte
STRING: set of subsequent bytes, all non-zero, terminated
      by a byte with zero value.
5.4.3 COMMAND SET

NULL

Description:
Dummy command, no action to be performed.

Token:
0 (BYTE)

Parameters:
none

Returns:
When the monitor supports the EINIT command and the command is not yet executed:
0xEE (BYTE)
otherwise:
0xAA (BYTE)
**PCTOMEM**

**Description:**
Send number of bytes from host to target. Start address and start address + count must be in the same 16K page.

**Token:**
1 (BYTE)

**Parameters:**
- start address (ADDR)
- count (WORD)
- data byte (BYTE) * count

**Returns:**
none

**MEMTOPOC**

**Description:**
Receive number of bytes from target at host. Start address and start address + count must be in the same 16K page.

**Token:**
2 (BYTE)

**Parameters:**
- start address (ADDR)
- count (WORD)

**Returns:**
- data byte (BYTE) * count
POKE

Description:
Write a 16-bit word to target. The supplied address parameter must be even.

Token:
3 (BYTE)

Parameters:
address (ADDR)
value (WORD)

Returns:
none

PEEK

Description:
Read a 16-bit word from target. The supplied address parameter must be even.

Token:
4 (BYTE)

Parameters:
address (ADDR)

Returns:
value (WORD)
REGLOAD

Description:
Receive all 16 user program General Purpose Register values from the target.

Token:
5 (BYTE)

Parameters:
none

Returns:
reg R0 value (WORD)
reg R1 value (WORD)
reg R2 value (WORD)
reg R3 value (WORD)
reg R4 value (WORD)
reg R5 value (WORD)
reg R6 value (WORD)
reg R7 value (WORD)
reg R8 value (WORD)
reg R9 value (WORD)
reg R10 value (WORD)
reg R11 value (WORD)
reg R12 value (WORD)
reg R13 value (WORD)
reg R14 value (WORD)
reg R15 value (WORD)
REGSAVE

Description:
Send 16 new user program General Purpose Register values to target.

Token:
6 (BYTE)

Parameters:
reg R0 value (WORD)
reg R1 value (WORD)
reg R2 value (WORD)
reg R3 value (WORD)
reg R4 value (WORD)
reg R5 value (WORD)
reg R6 value (WORD)
reg R7 value (WORD)
reg R8 value (WORD)
reg R9 value (WORD)
reg R10 value (WORD)
reg R11 value (WORD)
reg R12 value (WORD)
reg R13 value (WORD)
reg R14 value (WORD)
reg R15 value (WORD)

Returns:
none
MOVMEM

Description:
Copy range of target memory contents to another memory location. Source range and destination range should be in the same 16K page.

Token:
7 (BYTE)

Parameters:
src range start (ADDR)
src range end (ADDR)
dest range start (ADDR)

Returns:
0xAA (BYTE)

FILLMEM

Description:
Fill a target memory range with a specific value.

Token:
9 (BYTE)

Parameters:
start address (ADDR)
count (ADDR)
fill value (WORD)

Returns:
0xAA (BYTE)
SETUP

Description:
Set user program CSP:IP registers on target to given address value.

Token:
14 0x0E (BYTE)

Parameters:
new CSP:IP value (ADDR)

Returns:
none

VERSION

Description:
Receive the target monitor version string.

Token:
15 0x0F (BYTE)

Parameters:
none

Returns:
monitor id string (STRING)
**GO**

**Description:**
Start user program on target.

**Token:**
16 0x10 (BYTE)

**Parameters:**
none

**Returns:**
none

---

**SHOWSTAT**

**Description:**
Receive user program’s most important SFR values.

**Token:**
17 0x11 (BYTE)

**Parameters:**
none

**Returns:**
- reg CP value (WORD)
- reg IP value (WORD)
- reg CSP value (WORD)
- reg PSW value (WORD)
- reg SP value (WORD)
- reg DPP0 value (WORD)
- reg DPP1 value (WORD)
- reg DPP2 value (WORD)
- reg DPP3 value (WORD)
- reg ADCON value (WORD)
- reg STKOV value (WORD)
reg STKUN value (WORD)
reg T01CON value (WORD)
reg T2CON value (WORD)
reg T3CON value (WORD)
reg T4CON value (WORD)
reg T5CON value (WORD)
reg T6CON value (WORD)
reg T78CON value (WORD)
reg TFR value (WORD)

SYNC

Description:
Test if target monitor is alive. Monitor should return acknowledge token 0xAA.

Token:
20 0x14 (BYTE)

Parameters:
none

Returns:
0xAA (BYTE)
**MONADR**

**Description:**
Receive target memory locations where the user program resources are saved when the target monitor is running and uses these resources itself.

**Token:**
21 0x15 (BYTE)

**Parameters:**
none

**Returns:**
saved regs address (ADDR)

**ILVL**

**Description:**
Write the monitor ILVL/priority to the target. The interrupt/priority level should be 15 or lower. When the monitor should allow certain interrupt routines to continue to be served when the program is halted, this monitor interrupt/priority level should be lower than the interrupt level of the interrupt routines.

**Token:**
22 0x16 (BYTE)

**Parameters:**
interrupt level (BYTE)

**Returns:**
none
DEBUG

Description:
Receive the debug instruction that will activate the monitor when a breakpoint is encountered.
This instruction is the trap function with corresponding trap number.

Token:
25 0x19 (BYTE)

Parameters:
one

Returns:
used trap instruction (WORD)

BAUD_ZL

Description:
Internal use to calculate the baud rate oscillator frequency used on the target board.

Token:
26 0x1A (BYTE)

Parameters:
one

Returns:
multiply factor (BYTE)
baud rate zero length (WORD)
EINIT

Description:
Internal use to execute the einit instruction to initialize the target at startup.

Token:
32  0x20  (BYTE)

Parameters:
none

Returns:
none
6 THE TARGET CONFIGURATION FILE

The target configuration files (*.cfg) describe the available target boards. These files are text files and can be edited with any text editor.

Empty lines, lines consisting of only white space are allowed. Comment starts at an exclamation-sign ('!) and ends at the end of the line.

An information line has the following synopsis:

```
[! comment] field: [subfield =] field-value
```

field one of the keywords described below

subfield the usage of this part depends on the value of field, see below

field-value the value assigned to the field

comment optional comment

The fields listed in the configuration file are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of Target Settings dialog.</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the CPU present on the target board. CrossView Pro knows four types of CPUs, 167, 167mac, ext2mac and ext22mac. ‘167’ represents the extended architecture, like the C161, C163, C164, C165 and C167 families. ‘167mac’ represents the extended architecture including the MAC coprocessor, like the ST10x262 and ST10x272 families. ‘ext2mac’ represents the second extended architectures like the XC16x and Super10. ‘ext22mac’ represents the enhanced Super10 architectures.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging: ‘dieva166’ for a target board connection using a serial or CAN interface. Be aware, the name should be specified without the extension ‘.dll’.</td>
</tr>
<tr>
<td>bslack</td>
<td>The bootstrap loader identification byte of the CPU on the board. When CrossView Pro receives this byte from the board when making connection, it starts the bootstrap sequence. Please check your chip manual, chapter ‘Bootstrap loader’ for the definition of this identification byte. You can specify multiple identification bytes, by separating them with commas.</td>
</tr>
<tr>
<td>boot</td>
<td>The filename of the boot program for target boards using a bootstrap loader. CrossView Pro searches the boot program in the etc directory of the product or in the current working directory. The field can be omitted when the ROM Monitor is placed in ROM or FLASH. When this field is omitted, CrossView Pro will issue an error when the target board requests bootstrap loading.</td>
</tr>
<tr>
<td>monitor</td>
<td>The filename of the monitor program for target boards using a RAM debug monitor to be downloaded on the board using a bootstrap program. CrossView Pro searches the monitor program in the etc directory of the product or in the current working directory. The field can be omitted when the ROM Monitor is placed in ROM or FLASH. When this field is omitted, CrossView Pro will issue an error when the target board requests bootstrap loading.</td>
</tr>
<tr>
<td>flash_monitor</td>
<td>The filename of the flash programing monitor, used for flashing files (for example a ROM monitor) in an EPROM.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>flash_direct_access</td>
<td>When set to TRUE, CrossView Pro performs flash operations using target memory read/write accesses. When FALSE, CrossView Pro downloads a FLASH programming monitor to the target and executes this program to perform the flash operations.</td>
</tr>
<tr>
<td>flash_device_num</td>
<td>The FLASH device number.</td>
</tr>
<tr>
<td>flash_workspace</td>
<td>The code address where the FLASH programming monitor must be loaded.</td>
</tr>
<tr>
<td>flash_vendor0</td>
<td>The name of the FLASH device vendor.</td>
</tr>
<tr>
<td>flash_chip0</td>
<td>The name or type of FLASH device.</td>
</tr>
<tr>
<td>flash_width0</td>
<td>The width (in bits) per FLASH device.</td>
</tr>
<tr>
<td>flash_chips0</td>
<td>The number of FLASH devices used.</td>
</tr>
<tr>
<td>flash_base_address0</td>
<td>The start address of the memory range that will be covered by the FLASH device.</td>
</tr>
<tr>
<td>register_file</td>
<td>The filename of the register file (*.def) to be used for the CPU on the target. When this field is omitted CrossView Pro uses the default reg.def as register file. This register file contains debug information for CrossView Pro like which (E)SFR registers are present and at which location.</td>
</tr>
<tr>
<td>syscon</td>
<td>The initialization value for the SYSCON register. This entry is here for backwards compatibility only. The SYSCON register can now be initialized using init.syscon.</td>
</tr>
<tr>
<td>init</td>
<td>Initialize the register specified in the subfield with the value specified in field-value. The register name in subfield must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
einit | Initialize the register specified in the *subfield* with the value specified in *field-value* before the EINIT instruction is executed. Up to 6 registers can be initialized before EINIT. The register name in *subfield* must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','. 
ilvl | Specify the monitor interrupt/priority level. This level should be 15 or lower. When the monitor should allow certain interrupt routines to continue to be served when the program is halted, this monitor interrupt/priority level should be lower than the interrupt level of the interrupt routines.
reserve | The reserved memory ranges (*from* – *to*) for monitor resources. EDE uses this field to generate RESERVE MEMORY locator controls. You can specify multiple ranges by separating them with commas ','. 
reset_period | A period in milliseconds to hold the reset level at the required level.
rs232_reset_pin | The name of the RS232-pin to reset the target, for example RTS.
rs232_reset_level | The level when the reset is active.
rs232_reset_hold_level | The hold level when the reset is active.
rs232_bootstrap_pin | The name of the RS232-pin to set the target in bootstrap mode, for example DTR.
rs232_bootstrap_level | The level when the BSL pin is active.
rs232_bootstrap_hold_level | The hold level when the BSL pin is active.

*Table Mon-7: Configuration file fields*

**Notes:**
- Fields not required for the target can be omitted.
- CrossView Pro searches for the *.cfg* files in the current directory and in the *etc* directory.
The SYSCON register will always be initialized before the boot program and monitor execute the EINIT instruction.

The configuration files could have the following syscon/einit combinations:

1. syscon: 0x0080  ! configuration value for syscon
einit:    -      ! empty field, necessary for
          ! new boot/monitor program.

2. syscon: 0x0000  ! overruled value.
einit:  $syscon = 0x0080;  ! new value

3. einit:  $syscon = 0x0080;

Fields not required for the target board can be omitted.

Example of a part of the target.cfg file.

! Target board configuration file for CrossView

    title:         Ertec EVA167
    cpu_type:      167
    bslack:        0xC5,0xA5
    boot:          b167.sre
    monitor:       m167n.sre
    register_file: reg167.dat
    einit:         $syscon = 0x0000;
    init:          $addrsel1 = 0x0406, $buscon1 = 0x0680,
                    $stkov = 0xfa00;
    debug_instrument_module: dieva166
    reserve:       0x200-0xFFF,0xFC0-0xFCDF,0xFD00-0xFD4B

CrossView Pro searches for the target configuration file in the current directory and in the etc directory.

On startup CrossView Pro reads the target configuration file in memory and selects the target configuration file indicated with the -tcfg command line option or by the target configuration field of Target | Settings... dialog. This board can be selected using the filename of the target configuration file or the full name (title field) of the target board.
Note for the XC16x/Super10 architectures:
For each execution of the user application (step and run commands) the monitor installs the interrupt vectors used by the monitor. So, when the user application changes the VECSC in CPUCON1 or VECSEG the monitor could not be accessed anymore and that results into a connection loss from CrossView Pro. The configuration file should be updated for your own VECSC and VECSEG values.
The CPUCON1 could be changed by the initialization routine of the user application when the monitor program `mext2ib.sre` or `mxc16xib.sre` is used.

7 BUILDING YOUR APPLICATION

In the `start.asm` file, the define EVA must be enabled (set to 1). The EVA define is needed to force tiny model to execute with CPU segmentation enabled. This implies that interrupt behavior in non-segmented mode cannot be done. However, calls within the tiny model program are still executed as non-segmented.

For the C16x/ST10 derivatives the _EXT define must also be enabled to get C16x/ST10 startup code.

When locating your application you should reserve the memory areas used by the monitor running on your target board by using the RESERVE MEMORY control in the locator invocation. See the description of the monitor for your target board for a list of the ranges to be reserved.
8 CONNECTING TO THE TARGET BOARD

8.1 RS-232

All configurations of the monitor have an automatic baud rate detection. We recommend using a baudrate in the range 4800 to 19200 baud. By using the `-D rs232, port, baud-rate` (Execution environment `port` and communication Speed: `baud-rate`) option of CrossView Pro you can force the serial connection parameters to non-default values. You can use the Communication Setup dialog (Target | Communication Setup...) to set the `port` and `baudrate`. The set of valid parameters for PC host computers running MS-Windows is listed here:

<table>
<thead>
<tr>
<th><code>port</code></th>
<th>COM1 (default)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>COM2</td>
</tr>
<tr>
<td></td>
<td>COM3</td>
</tr>
<tr>
<td></td>
<td>COM4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><code>baud-rate</code></th>
<th>1200</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2400</td>
</tr>
<tr>
<td></td>
<td>4800</td>
</tr>
<tr>
<td></td>
<td>9600 (default)</td>
</tr>
<tr>
<td></td>
<td>19200</td>
</tr>
</tbody>
</table>

The defaults for other host computers are:

<table>
<thead>
<tr>
<th>host computer</th>
<th>port</th>
<th>baud rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>/dev/ttya</td>
<td>9600</td>
</tr>
<tr>
<td>others</td>
<td>/dev/tty00</td>
<td>9600</td>
</tr>
</tbody>
</table>

Table Mon-8: Communication defaults UNIX hosts

When your host computer can handle it, we advise you to use a baud rate of 19200 to improve debugger performance. The monitor does not operate at transmission speeds slower than 1200 bps.

After a hardware reset, the monitor or the on-chip bootstrap loader automatically detects the transmission speed by analyzing the first byte received. Therefore, when selecting a different transmission speed for CrossView Pro, be sure to reset the target board first. If you do not, you will get a connection error from CrossView Pro.
When connecting to the target board CrossView Pro first detects if a monitor is already running. If it gets a response from an on-chip bootstrap loader instead of the monitor, it will start the boot sequence. First the boot program is sent to the serial port and then the debug monitor. When for the selected target no boot or monitor program is specified in the target configuration file, CrossView Pro cannot connect to the board.

See also section 6, The Target Configuration File, in this addendum.

On a connection error during startup of CrossView Pro, CrossView Pro comes up with a window where you have the following options:

- retry to connect to the target board
- exit CrossView Pro
- change startup options, this should be used to select a different target board
- change communication parameters, this should be used when you want to select a different baud rate or communication channel

You can solve the problem that caused the error, reset the board, and click the Retry button to try connecting again.

In the midst of a debug session, whenever CrossView Pro might lose connection with the monitor, the debugger times out issues a error message in a window where you can choose to retry the last command or to exit CrossView Pro. You can reset the board and click the Retry button to reestablish the connection. When using a ROM monitor the memory contents are not affected by the reset. When the board uses a RAM debug monitor, CrossView Pro reboots the monitor using the on-chip bootstrap loader and the boot program. Some memory is overwritten at startup of the boot program and monitor and your application must be downloaded again using the download command dn or select Download Application... from the File menu.

The RAM debug monitor can only use serial port 0 of the CPU because only that port can be used by the on-chip BSL. The ROM debug monitors installed in the etc directory use port 0 by default. They should be rebuilt when port 1 has to be used.

The monitors are always configured using 8 data bit, one stop bit and no parity.
8.2 CAN (WINDOWS ONLY)

ROM/RAM monitors and configuration files are available for debugging over the CAN interface.

First a ROM/RAM monitor with CAN support must be downloaded via the RS-232 serial interface. The connection will be lost after downloading the monitor because the monitor now tries to communicate via the CAN interface whereas CrossView Pro still uses RS-232. CrossView Pro has to be restarted with CAN support options to establish the CAN connection.

1. Download the RAM/ROM monitor via the RS-232 interface:
   - From EDE select Project | Project Options... Expand the CrossView Pro entry.
   - Select the Execution Environment entry and select a target with CAN support in the Board configuration field (for example Phytec KitCON-167 using CAN debugging).
   - Select the RAM/ROM Monitor Communication Setup entry and select RS-232, a serial port (for example COM1) and a baud rate (for example 19200). The RAM/ROM monitor for the selected target will be loaded at CrossView startup.

   The command line equivalent looks like:

   \[
   \text{xvw166 \text{-D rs232,}\text{port,baud-rate \text{-tcfg kc167c.cfg}}}
   \]

   \[
   \text{port: COM1, COM2, COM3, COM4}
   \]

   \[
   \text{baud-rate: 2400, 4800, 9600, 19200, 38400, 57600, 115200}
   \]

   Configuration files are located in the etc directory of your toolchain installation directory.

2. Establish connection via CAN interface:
   - Close CrossView Pro.
   - From EDE select Project | Project Options... Expand the CrossView Pro entry.
   - Select the Execution Environment entry and select a target with CAN support in the Board configuration field (for example Phytec KitCON-167 using CAN debugging).
• Select the **RAM/ROM Monitor Communication Setup** entry and select **CAN**. Select a **CAN card manufacturer** (for example Phytec NET–CAN) and the **CAN interface card** from this manufacturer (for example pcNET–CAN).

• Select the **CAN Communication Setup** entry and select a **CAN baud rate** and a **CAN identifier**. Depending on the selected CAN interface card, select values for the other editable fields as well.

The command line equivalent looks like:

```bash
xfw166 -D can,baud-rate,identifier,0,time_out | board_segment | hardware_index | port_IO_address,interface_card_ID,port-id | net_number | interrupt_number | hardware_channel,manufacturer
-tfcg target_board.cfg
```

**baud-rate:** 
50, 125, 250, 500, 1000

**identifier:** 
Default is 30. This value is the send identifier host->target); the receive identifier target->host) is identifier+1.

**time_out:** 
tx/rx timeout of handle. Define to 0

**board_segment:** 
Board segment the interface card is using

**hardware_index:** 
Index of the hardware (slot) (0,1,...)

**port_IO_address:** 
The memory address used to access the (E)ISA card.

**interface_card_ID:** 
Vendor specific CAN host adapter. This number, in combination with the **manufacturer**, identifies a unique interface card.

**port_id:** 
PC I/O port number or I/O channel used for accessing the (E)ISA card.

**net_number:** 
Locical net number the interface card is using

**interrupt_number:** 
Interrupt number the CAN interface card is using

**hardware_channel:** 
Index of the channel (connector) (0,1,...)

**manufacturer:** 
Name of the manufacturer of the CAN interface card. Together with the **interface_card_ID**, a unique interface card is defined.
target_board: Name of the target configuration file (.cfg)

For example:

`xfw166 -D can,500,30,0,0,0,0,pcnetcan -tcfg kc167c.cfg`

### 8.3 CAN INTERFACE MESSAGES

The following messages can be displayed while CrossView Pro is communicating over a CAN interface. The CAN-\textit{idname} can be one of ESDNTCAN, IXXATVCI, PCAN, pcNETCAN or Vector.

**CAN-\textit{idname}: can't set baudrate for CAN interface**
Specify one of the following baud rates. ESDNTCAN and PCAN support: 50, 125, 250, 500, 1000. IXXATVCI supports: 10, 20, 50, 100, 125, 250, 500, 800, 1000

**CAN-\textit{idname}: can't add id-number for CAN interface**
The receive identifier is determined by the send identifier + 1. This message occurs if this addition cannot be performed.

**CAN-\textit{idname}: can't find all required CAN interface arguments**
Not all required interface arguments are specified.

**CAN-\textit{idname}: found wrong interface card number**
Specify a valid \textit{interface_card_ID} number to identify the vendor specific CAN host adapter.

**CAN-\textit{idname}: found unsupported board type**
Specify the correct number of the interface card/board type.

**CAN-\textit{idname}: can't open CAN interface**
The CAN interface could not be opened.

**CAN-\textit{idname}: can't initialize CAN interface**
The CAN interface could not initialize the Timing register.

**CAN-\textit{idname}: can't start CAN interface**
The CAN interface could not be started.
**CAN-idname: can't set acceptance-mask for CAN interface**

The CAN interface could not set the Acceptance-Mask register.

**CAN-idname: can't define transmit queue for CAN interface**

The CAN interface could not create a transmit queue.

**CAN-idname: can't define receive queue for CAN interface**

The CAN interface could not create a receive queue.

**CAN-idname: can't make assignment for CAN interface**

The CAN interface could not make the assignment/blocking of messages to the given receive queue.

**CAN-idname: can't read from CAN interface**

CrossView Pro did not receive a message from the CAN interface.

**CAN-idname: can't write to CAN interface**

CrossView Pro could not send a message to the CAN interface.

**CAN-idname: found error - ILLPARM**

The value of a parameter is invalid.

**CAN-idname: found error - ILLHW**

The pcNETCAN hardware could not be found.

**CAN-idname: found error - BUSOFF**

Bus error: the CAN controller went in a 'Bus-Off' state.

**CAN-idname: found error - BUSERROR / BUSLIGHT / BUSHEAVY**

Bus error: an error counter reached its limit.

**CAN-idname: found error - REGTEST**

An error occurred during the register test of the CAN controller.

**CAN-idname: found error - XMTFULL**

The send buffer in the CAN controller is full.
**CAN-idname: found error - QXMTFULL**

The send queue is full.

**CAN-idname: found error - RCVEMPTY**

CrossView Pro did not receive a new message from the CAN interface.

**CAN-idname: found error - QRCVEMPTY**

The receive queue is empty.

**CAN-idname: found error - OVERRUN**

The CAN controller was read too late.

**CAN-idname: found error - QOVERRUN**

The receive queue was read too late.

**CAN-idname: found error - NOVXD**

VxD not loaded, license expired.

**CAN-idname: found error - RESOURCE**

A resource (FIFO, Client, Timeout) was not available.

### 8.4 CONNECTION PROCESS MESSAGES

The following messages can be displayed while CrossView Pro is connecting to the target board.

**Connecting to 'boardname’**

This message is printed when connecting for the first time in the session to the board or when CrossView Pro did not get a response from the board and starts connection.

**Connecting: waiting for response from the target**

After detecting that the monitor is not alive CrossView Pro starts waiting for a known response from the board. This response can either be the bootstrap acknowledge byte or a 0xAA response from the monitor.
**Connecting: sending bootstrap**

CrossView Pro received the bootstrap loader acknowledge byte from the board and starts the boot sequence. The bootstrap acknowledge byte for a board is defined in the target configuration file (.cfg) with the field `bslack`.

CrossView Pro starts downloading the boot program defined in the target configuration file (.cfg).

**Connecting: Could not open S-record file**

CrossView Pro detected that no boot program file name is defined in the target configuration file (.cfg) for the selected board. Check if you selected the right board with the `-tcfg` command line option or with the Target | Settings... menu.

**Connecting: sending monitor**

CrossView Pro starts downloading the monitor program defined in the target configuration file (.cfg).

**Connecting: Target board not responding**

After the boot program was downloaded and running CrossView Pro did not get the expected response from it. See 8.5 Connection Problems for a checklist.

**Connecting: no or bad acknowledge from bootstrap loader**

While downloading the monitor CrossView Pro did not get the expected acknowledge from the boot program. CrossView Pro checks this each time a series of bytes is downloaded to the board.

When CrossView Pro is ready downloading the monitor, it gives a GO command to the boot program. The boot program then executes a SRST instruction to boot the monitor. As soon as the monitor is running it should give a response to CrossView Pro. This message is issued when CrossView Pro got no or an unexpected response. See 8.5 Connection Problems for a check list.

**Connecting: connection lost**

After CrossView Pro first detected that the monitor was running, some initial commands are executed. Before the connection is marked as established, CrossView Pro does a last check if it the monitor is really alive. This message is issued when that check fails.
8.5 CONNECTION PROBLEMS

When connection fails or errors occur, first check the following:

- check if you selected the right target board. All target boards are defined in a target configuration file (*.cfg). You can select the target board with the -tcfg option or with the Target | Settings... menu.

- check if all parameters in the target configuration file match your board:
  - if you want to boot the monitor using the on-chip bootstrap loader the bslack field must be defined, the right boot program must be defined with the boot field and the right monitor must be defined with the mon field.
  - the init field can be used to initialize several registers. These registers include bus and system configuration registers. Check if the values for these registers match your board configuration. Changing the bus mode on the board may imply that you have to modify the values for these registers.
  - the registers specified in the init field must be defined as an SFR in the register file specified with the register_file field. Check if you specified the right register file, and if this register file includes these registers.

  See also section 6, The Target Configuration File, in this addendum.

- you may have serial communication problems

  When you have serial communication problems, check the following:
  - check the serial parameters: 8 data bit, 1 stop bit, no parity, no handshake. You can set the parameters with the -D command line option or the Target | Communication Setup... dialog.
  - check whether the IRQ settings of both COM-ports do not conflict with any other device in the PC.
- check whether the target execution board loops back control flow signals decently. If not make it yourself by creating the following cable:

<table>
<thead>
<tr>
<th>host DCE</th>
<th>target DTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>signal pin D9 pin D25</td>
<td>pin D25 pin D9 signal</td>
</tr>
<tr>
<td>RTS 7 4 &gt;-- 4 7 RTS</td>
<td></td>
</tr>
<tr>
<td>CTS 8 5 &lt;-- 5 8 CTS</td>
<td></td>
</tr>
<tr>
<td>TxD 3 2 &gt;--------&gt; 2 3 TxD</td>
<td></td>
</tr>
<tr>
<td>RxD 2 3 &lt;--------&lt; 3 2 RxD</td>
<td></td>
</tr>
<tr>
<td>GND 5 7 &gt;--------&gt; 7 5 GND</td>
<td></td>
</tr>
<tr>
<td>DSR 6 6 &gt;-- 6 6 DSR</td>
<td></td>
</tr>
<tr>
<td>DTR 4 20 &lt;-- 20 4 DTR</td>
<td></td>
</tr>
<tr>
<td>DCD 1 8 &lt;-- 8 1 DCD</td>
<td></td>
</tr>
</tbody>
</table>

9 TROUBLESHOOTING THE DEBUG MONITOR

A summary of possible known causes when the monitor does not work:

connection errors

See section 8.5 Connection Problems in this addendum.

incorrect values in data or GPRs

Check if the register area of the monitor is reserved

incorrect values in some SFRs

Check if the monitor data area is reserved, the monitor saves some SFRs in this area
cannot stop execution of user program

The serial receive interrupt used to break into monitor has by default a very low interrupt level (ILVL/GLVL). If your application keeps running an interrupt with a higher interrupt level, the serial interrupt will not activate the monitor or activates it too late. The interrupt level is set this low so that if your application uses short interrupt routines, or PEC transfers at a higher level, they can continue running. This problem can be solved by rebuilding the monitor program with a higher interrupt level.
10 TARGET BOARD APPLICATION NOTES

When you invoke CrossView Pro, you have to specify which board is used with the `-tcfg cfg-filename` option (see section 6, *The Target Configuration File*). You can select the board in the Target | Settings... dialog. From the selected target board CrossView Pro knows which CPU, boot program, monitor program and register file are used.

The following table contains an overview of all supported target boards.

<table>
<thead>
<tr>
<th>Ertec GmbH</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVA165</td>
<td>b167.sre</td>
<td>m167n.sre</td>
<td>f167.sre</td>
<td>eva165.cfg</td>
</tr>
<tr>
<td>EVA167</td>
<td>b167.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>eva167.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FS FORTH Systeme</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVA167 with C167CR Demux</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>fsf_167cr_demux.cfg</td>
</tr>
<tr>
<td>EVA167 with C167CR Mux</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>fsf_167cr_mux.cfg</td>
</tr>
<tr>
<td>ST10x168</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f16x.sre</td>
<td>fsf_168.cfg</td>
</tr>
<tr>
<td>ST10x269</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>fsf_269.cfg</td>
</tr>
<tr>
<td>ST10x276</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f276.sre</td>
<td>fsf_276.cfg</td>
</tr>
<tr>
<td>ST10x280</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>fsf_280.cfg</td>
</tr>
<tr>
<td>Super10 Evaluation Board</td>
<td>bext2i.sre</td>
<td>mext2b.sre</td>
<td>fext2.sre</td>
<td>fsf_super10bo.cfg</td>
</tr>
<tr>
<td>Super10 Evaluation Board with fast baudrate</td>
<td>bext2f.sre</td>
<td>mext2fb.sre</td>
<td>fext2.sre</td>
<td>fsf_super10bo_fbd.cfg</td>
</tr>
<tr>
<td>Super10R303 Evaluation Board</td>
<td>bext2i.sre</td>
<td>mext2b.sre</td>
<td>fext2.sre</td>
<td>fsf_super10r303.cfg</td>
</tr>
<tr>
<td>Super10R303 Evaluation Board with fast baudrate</td>
<td>bext2f.sre</td>
<td>mext2fb.sre</td>
<td>fext2.sre</td>
<td>fsf_super10r303_fbd.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I+ME ACTIA</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>I+ME C167C</td>
<td>bi_me167.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>ime167c.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Infineon</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Easy Utah 161U</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>inf_161u.cfg</td>
</tr>
<tr>
<td>Easy Utah 161U with OCDS</td>
<td>-</td>
<td>m167ocds.sre</td>
<td>-</td>
<td>inf_161u_ocds.cfg</td>
</tr>
<tr>
<td>Easy Utah V1.1</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>inf_165utah.cfg</td>
</tr>
<tr>
<td>Easy Utah V1.1 with OCDS</td>
<td>-</td>
<td>m167ocds.sre</td>
<td>-</td>
<td>inf_165utah_ocds.cfg</td>
</tr>
<tr>
<td>M2 evaluation board</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>inf_sda6000.cfg</td>
</tr>
<tr>
<td>Infineon</td>
<td>Bootstrap Loader</td>
<td>Monitor</td>
<td>Flash Monitor</td>
<td>Configuration File</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>------------</td>
<td>---------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>XC161CJ (DEMUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc161cj_demux.cfg</td>
</tr>
<tr>
<td>XC161CJ (MUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc161cj_mux.cfg</td>
</tr>
<tr>
<td>XC161CJ with OCDS (single chip)</td>
<td>-</td>
<td>-</td>
<td>fx16xs.sre</td>
<td>inf_xc161cj_ocds.cfg</td>
</tr>
<tr>
<td>XC161CJ with OCDS (DEMUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc161cj_ocds_demux.cfg</td>
</tr>
<tr>
<td>XC161CJ with OCDS (MUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc161cj_ocds_mux.cfg</td>
</tr>
<tr>
<td>XC161CS (DEMUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc161cs_demux.cfg</td>
</tr>
<tr>
<td>XC161CS (MUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc161cs_mux.cfg</td>
</tr>
<tr>
<td>XC161CS with OCDS (single chip)</td>
<td>-</td>
<td>-</td>
<td>fx16xs.sre</td>
<td>inf_xc161cs_ocds.cfg</td>
</tr>
<tr>
<td>XC161CS with OCDS (DEMUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc161cs_ocds_demux.cfg</td>
</tr>
<tr>
<td>XC161CS with OCDS (MUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc161cs_ocds_mux.cfg</td>
</tr>
<tr>
<td>XC164CS (DEMUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc164cs_demux.cfg</td>
</tr>
<tr>
<td>XC164CS (MUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc164cs_mux.cfg</td>
</tr>
<tr>
<td>XC164CS with OCDS (single chip)</td>
<td>-</td>
<td>-</td>
<td>fx16xs.sre</td>
<td>inf_xc164cs_ocds.cfg</td>
</tr>
<tr>
<td>XC164CS with OCDS (DEMUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc164cs_ocds_demux.cfg</td>
</tr>
<tr>
<td>XC164CS with OCDS (MUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc164cs_ocds_mux.cfg</td>
</tr>
<tr>
<td>XC167CI (DEMUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc167ci_demux.cfg</td>
</tr>
<tr>
<td>XC167CI (MUX)</td>
<td>bxc16nxrbe.sre</td>
<td>mxc16xre.sre</td>
<td>fx16x.sre</td>
<td>inf_xc167ci_mux.cfg</td>
</tr>
<tr>
<td>XC167CI with OCDS (single chip)</td>
<td>-</td>
<td>-</td>
<td>fx16xs.sre</td>
<td>inf_xc167ci_ocds.cfg</td>
</tr>
<tr>
<td>XC167CI with OCDS (DEMUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc167ci_ocds_demux.cfg</td>
</tr>
<tr>
<td>XC167CI with OCDS (MUX)</td>
<td>-</td>
<td>-</td>
<td>fx16x.sre</td>
<td>inf_xc167ci_ocds_mux.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phytect</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>KitCON–160 with 161PI</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc161pi.cfg</td>
</tr>
<tr>
<td>KitCON–160 with 161RI</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc161ri.cfg</td>
</tr>
<tr>
<td>KitCON–161</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc161.cfg</td>
</tr>
<tr>
<td>KitCON–162 with 161CI</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc161ci.cfg</td>
</tr>
<tr>
<td>KitCON–162 with 161CS</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc161cs.cfg</td>
</tr>
<tr>
<td>KitCON–162 with 161JC</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc161jc.cfg</td>
</tr>
<tr>
<td>KitCON–163</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc163.cfg</td>
</tr>
<tr>
<td>KitCON–164</td>
<td>b164nrb.sre</td>
<td>m164r.sre</td>
<td>f167.sre</td>
<td>kc164.cfg</td>
</tr>
<tr>
<td>KitCON–165</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc165.cfg</td>
</tr>
<tr>
<td>KitCON–167</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>kc167.cfg</td>
</tr>
<tr>
<td>KitCON–167 using CAN debugging</td>
<td>b167nrb.sre</td>
<td>m167cr.sre</td>
<td>f167.sre</td>
<td>kc167c.cfg</td>
</tr>
</tbody>
</table>
## Execution Environment

<table>
<thead>
<tr>
<th>Phytec</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>KitCON-167 using PEAK-CAN-Dongle</td>
<td>b167nrb.sre</td>
<td>m167crd.sre</td>
<td>f167.sre</td>
<td>kc167cd.cfg</td>
</tr>
<tr>
<td>MicroMODUL-165</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>um165.cfg</td>
</tr>
<tr>
<td>MiniMODUL-165</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>mm165.cfg</td>
</tr>
<tr>
<td>MiniMODUL-167CR</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>mm167cr.cfg</td>
</tr>
<tr>
<td>MiniMODUL-167CS</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>phy_167cs_mm.cfg</td>
</tr>
<tr>
<td>MiniMODUL-167CW</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>mm167cw.cfg</td>
</tr>
<tr>
<td>MiniMODUL-ST10F168</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167x.sre</td>
<td>mmst10f168.cfg</td>
</tr>
<tr>
<td>NanoMODUL-164</td>
<td>b164nrb.sre</td>
<td>m164r.sre</td>
<td>f167.sre</td>
<td>nm164.cfg</td>
</tr>
<tr>
<td>phyCORE-161CS/JC/JI</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>phy_161jc_phycore.cfg</td>
</tr>
<tr>
<td>phyCORE-167</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>phy_167cs_phycore.cfg</td>
</tr>
<tr>
<td>phyCORE-ST10F168</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167x.sre</td>
<td>phy_168_phycore.cfg</td>
</tr>
<tr>
<td>phyCORE-XC161CJ</td>
<td>bxc16xnrb.sre</td>
<td>mxc16xre.sre</td>
<td>fxc16x.sre</td>
<td>phy_xc161cj_phycore.cfg</td>
</tr>
<tr>
<td>phyCORE-XC161CJ with OCDS</td>
<td>-</td>
<td>-</td>
<td>fxc16x.sre</td>
<td>phy_xc161cj_phycore_ocds.cfg</td>
</tr>
<tr>
<td>phyCORE-XC167CI</td>
<td>bxc16xnrb.sre</td>
<td>mxc16xre.sre</td>
<td>fxc16x.sre</td>
<td>phy_xc167ci_phycore.cfg</td>
</tr>
<tr>
<td>phyCORE-XC167CI with OCDS</td>
<td>-</td>
<td>-</td>
<td>fxc16x.sre</td>
<td>phy_xc167ci_phycore_ocds.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rigel Corporation</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>RMB-165</td>
<td>b167.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>rmb165.cfg</td>
</tr>
<tr>
<td>RMB-167</td>
<td>b167.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>rmb167.cfg</td>
</tr>
<tr>
<td>RMB-167CRI</td>
<td>b167.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>rm167cri.cfg</td>
</tr>
<tr>
<td>RMB-167SR</td>
<td>b167.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>rmb167sr.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STMicroelectronics</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super10 Evaluation Board</td>
<td>bext2i.sre</td>
<td>mext2b.sre</td>
<td>fext2.sre</td>
<td>evasuper10.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tara Systems</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tara Guido SDA6000</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>tara_sda6000.cfg</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TQ-Components</th>
<th>Bootstrap Loader</th>
<th>Monitor</th>
<th>Flash Monitor</th>
<th>Configuration File</th>
</tr>
</thead>
<tbody>
<tr>
<td>STK16X with TQM164C</td>
<td>b164nrb.sre</td>
<td>m164r.sre</td>
<td>f167.sre</td>
<td>tqs_164ci_tqm164c.cfg</td>
</tr>
<tr>
<td>STK16X with TQM165</td>
<td>b167nrb.sre</td>
<td>m167r.sre</td>
<td>f167.sre</td>
<td>tqs_165_tqm165.cfg</td>
</tr>
</tbody>
</table>
Table Mon-9: Supported target boards

The following sections contain application notes on several target boards.

### 10.1 ERTEC EVA165, EVA167 AND EVA167AA

The debugger has been developed and tested with EVA165 and EVA167 boards which support the on-chip bootstrap loader (BSL). These boards are using the TASKING RAM debug monitor for working with CrossView Pro.

The Ertec EVA167 manual (supplied with your evaluation board) explains how to connect your board to the host computer. For more information on connecting the target board to your host computer see also section 8, *Connecting to the Target Board*, in this addendum.

To enable the BSL of the C16x the switch S2 on the evaluation board must be set to the position "ON". Then the bootstrap loader can be activated with a hardware reset.
10.2 RIGEL RMB-165, RMB-167, RMB-167SR AND RMB-167CRI

The debugger has been tested with the the RMB-165, RMB-167, RMB-167SR and the RMB-167CRI evaluation boards of RIGEL Corporation. The TASKING boot program and monitor can be loaded and downloaded by CrossView Pro. For more information about the boot program and monitor see section 5, *The RAM and ROM Debug Monitor*.

The Hardware Manual (supplied with your evaluation board) explains how to connect your board to the host computer.

10.3 I+ME C167C BOARD

The I+ME C167C board uses the on-chip BSL to load the TASKING boot program and RAM debug monitor. Please read section 5, *The RAM and ROM Debug Monitor* of this addendum first for more information on the monitor. The following section describes some details on the configuration for the monitor for the I+ME C167C board.

10.3.1 DEBUG MONITORS

Because of the unusual memory configuration, the boot program exists in a special configuration: `bi_me167.sre`. This boot program is translated with the C preprocessor macro `I_ME_C167C` defined which enables the code to configure the memory for this board.

CrossView Pro is only tested in combination with the RAM debug monitor. For using the RAM debug monitor the on-chip BSL should be enabled with the appropriate jumper.

10.3.2 CONNECTION

The I+ME C167C board should be connected to the host computer using the D-Sub 9 female connector. The board does not loop back handshake signals decently, so when you have connection problems please read section 9 *Troubleshooting the Debug Monitor* first.
10.4 PHYTEC MM-165, MM-167CR AND MM-167CW

The debugger has been tested with the PHYTEC miniModul-165, 167CR and 167CW plugged on the baseboard. The TASKING boot program and monitor can be loaded and downloaded by CrossView Pro. For more information about the boot program and monitor see section 5, *The RAM and ROM Debug Monitor*.

The following sections describe some details on the configuration for the monitor for the MM-165, MM-167CR and MM-167CW boards.

10.4.1 BOOT PROGRAM

Because of the unusual memory configuration, the boot programs exist in a special configuration: `b167nrb.sre`. This boot program is translated with the C preprocessor macro `NORAMBOOT` defined which enables the code to start the monitor correctly. This boot program does not start the monitor with a software reset, but with a trap instruction. The reason for this way of starting the monitor is that the RAM is selected with CS1 instead of CS0. When a software reset is executed, the C16x uses CS0 to address the memory.

10.4.2 CONNECTION

For using the RAM debug monitor the mode jumper should be set to ‘1’ to select the appropriate memory configuration. The BSL should be enabled with a resistor of 10K between the P0.4 and signal ground.

The MM-165 or MM-167 board should be connected to the host computer using the D-Sub 9 female connector. The board does not loop back handshake signals decently, so when you have connection problems please read section 9 *Troubleshooting the Debug Monitor* first.
10.5 PHYTEC KC-161, KC-163, KC-164 AND KC-167

The debugger has been tested with the PHYTEC KitCon-161, 163, 164 and 167. The TASKING boot program and monitor can be loaded and downloaded by CrossView Pro. For more information about the boot program and monitor see section 5, *The RAM and ROM Debug Monitor*.

The hardware manual, delivered with the KC-16x describes how to connect the board to the host computer and how the board should be configured to enable bootstrap loading.

10.6 TQ-COMPONENTS STK16X/STK16XU STARTER KITS

The debugger has been tested with the TQ-Components TQM164C, TQM165, TQM167C and TQM167LC mini-moduls that can be put onto the starter kit STK16X and the TQM167U, TQM167UE, TQMX161U and TQMX167U mini-moduls that can be put onto the starter kit STK16XU. The mini-moduls are reset hardwired by the RS-232 serial port. With a target reset the mini-moduls are set in BSL mode and so the TASKING boot program and monitor can be loaded and downloaded by CrossView Pro. For more information about the boot program and monitor see section 5, *The RAM and ROM Debug Monitor*.
1 INTRODUCTION

This addendum contains information specific to the simulator version of CrossView Pro for the C166/ST10. The simulator uses the host memory to simulate the memory of the target. To avoid that the whole address range (up to 16MB) of these derivatives has to be allocated on the host, a memory map should be supplied to the simulator with the simulator configuration file.

2 EXECUTABLE NAME

The following CrossView Pro executable is delivered with the package (for PC with.exe extension):

xfw166 CrossView Pro Debugger for the C166/ST10

The simulator is delivered as a separate DLL within the package:

disim166.dll CrossView Pro Debugger Simulator
(for UNIX with.so extension)

3 SUPPORTED FEATURES

Except for the restrictions mentioned in section 6, the simulator version of the debugger cleanly supports the standard features of CrossView Pro, including single stepping, code breakpoints, data breakpoints, trace support, C expression evaluation and record/playback capability. The simulator disim166 logs a user definable number of addresses of the most recent instructions. The simulator disim166 also supports code coverage, profiling, background debug mode and peripheral simulation.

3.1 MAPPING MEMORY

The simulator version of the debugger can use the linker generated map file (with.map extension) to determine how much memory must be allocated from the system and how logical addresses are mapped to physical addresses. In the Load Symbolic Debug dialog, select Use map file for memory map to specify that CrossView Pro must process the application specific memory definition before a new file is loaded and/or downloaded to the target.
When you use EDE, the memory settings are automatically transferred to the debugger. All memory mappings of your applications are automatically done by the debugger.

4 PERIPHERAL SIMULATION

The C166/ST10 simulator includes peripheral simulation for a range of peripherals. With peripheral simulation and CXL scripting you can make scenarios for testing (parts of) your application before hardware is available.

4.1 PERIPHERAL SUPPORT

The simulator supports the following peripherals:

- General purpose timers
- Interrupt system
- Peripheral Event Controller
- Parallel ports
- SSC/ASC Serial ports
- Phased Locked Loop
- Watchdog Timer
- Real Time Clock
- A/D converter
- Capture Compare Unit

For XC16x/Super10, peripherals are only enabled when the alternate function is selected from the ALTSEL0Px register. When a peripheral is enabled from the ALTSEL1Px register the peripheral will not be enabled within the simulator.

SSC/ASC Serial Ports

The SSC/ASC peripherals automatically get DIO (Debug Instrument I/O) streams assigned to terminal windows. You can use these terminal windows to display and enter data from and to these peripherals. You can also redirect the terminals to read or write data to/from files. If DIO is not desired for these peripherals you can disable the DIO streams from within CrossView Pro. See section 10.4, Debug Instrument I/O for more information on DIO.
Parallel Ports

The processor pins for parallel port Px are available in CrossView Pro as a special register PORT_Px. The bits in these special registers are only effective if the DPx register is set properly.

A/D Converter

You can use the CrossView Pro special register PIN_ADCx as replacement of the A/D converter external port pin. The value of this register is the value as put on the external ADC port pin. The type of this register is floating point.

The A/D converter also requires a ground and reference voltage. The special registers PIN_VAREF and PIN_VAGND are for this purpose. The types of these registers is also floating point.

General Purpose Timers

All timers work only when there are no external inputs selected (TxUDE=0). In all cases when the transition level is used as trigger, it only works on the OTL level of the core timer.

The following four modes apply for all GPT timers.

TIMER_MODE:

All five timers T2, T3, T4, T5 and T6 can be used in this mode.

GATED_TIMER_MODE:

All five timers T2, T3, T4, T5 and T6 can be used in this mode.

COUNTER_MODE (timer concatenation):

Only the timers T2, T4 and T5 can be used in this mode when the transition comes from the corresponding OTL of the core timer. This mode is used for the concatenation of the timers.

RELOAD_MODE:

Timers T2 and T4 can be used for this mode only when the transition comes from the corresponding OTL of the core timer. Timer T6 could be reloaded with the value of CAPREL when the sfrbit T6SR is set.
4.2 SCENARIO SCRIPTING USING CXL

Before reading this section it is recommended to read Appendix B, CrossView Extension Language (CXL).

With the CrossView eXtension Language (CXL) you can set up scripts for simulation scenarios. These scenarios are usually a sequence of events supplied to the peripherals. In CrossView Pro you can achieve this by using probe points to run scripts at defined intervals.

Cycle Probe Point

When a CXL script must perform some action after every number of cycles, you will need to set a cycle probe point with the execution of a CXL script assigned. You can do this as follows in CrossView Pro:

1. From the Breakpoints menu, select Breakpoints...

   The Breakpoints dialog appears.

2. Click the Add > button and select Cycle Breakpoint...

   The Add Cycle Breakpoint dialog appears.

3. Click the Advanced >> button.

4. Now fill in the following fields:

   - **Cycle count**: The number of cycles between hitting the breakpoint and thus between the execution of the script.
   - **Name**: Just a fancy name for your breakpoint, so that you can easily recognize it in the list if more breakpoints are listed.
   - **Probe point**: Enable this check box. This makes that execution continues after the breakpoint is hit and the Commands are executed.
   - **Commands**: Supply the `cxl` command to execute the script. For example:
     
     `cxl "myscript.cxl"

     If you supply a relative path, it will be relative to the location of the absolute file (.abs) of your program.
5. Click **OK**.

6. Click **OK**.

It is also possible to set the breakpoint via the command window:

```
break CYCLES no-of-cycles, name=fancy-name, probe_point=true, commands=cxl "script-name"
```

The `no-of-cycles` is the number representing the number of cycles between each probe point hit. The `fancy-name` is the name you want to give to the probe point to recognize it easily in the breakpoint list or to be used with other commands. The `script-name` is the filename of the CXL script.

### Cycles

When writing a CXL script that is executed every number of cycles by a cycle probe point, you have to keep in mind that the simulator is an instruction set simulator. If an instruction takes more than one cycle, the simulator will never break in the middle of the instruction, but completes the whole instruction first. When the number of cycles of the cycle probe point is elapsed in the middle of an instruction, the probe point is hit after the instruction is finished and this may be a number of cycles later. So, the CXL script invoked by the probe point is not always executed exactly after the number of cycles defined with the probe point.

You have to keep this in mind when writing a CXL script that does things depending on the cycle counter. For example, it triggers a port pin every 1000 cycles and it triggers another port pin every 2000 cycles. You will have to round the cycle counter in the CXL script to get this done. This means that it is inevitable that there is an inaccuracy in the timing. An example of rounding the cycle counter:

```
long ccnt;
ccnt = floor( ( get( "$CCNT" ) / 20)) * 20;
```

In this example the script is executed by a probe point every 20 cycles.

To do something in the script every 1000 cycles, you can now for example use:

```
if( ccnt % 1000 == 0 )
{
    // actions here
}
```
The number of cycles that you fill in with the probe point is depending on the demand of your scenario. If you need a high frequency of events, a lower cycle count may be required than with a low frequency of events. Keep in mind that with lower cycle counts the script is executed more frequently, which makes the simulation slower.

As an alternative to using cycle probe points, you could also use instruction probe points. Or if you only need certain actions at defined points in your code you could use code probe points.

**CXL and Simulator Interaction**

Usually your CXL script will need some interaction with the CPU’s registers, port pins or the application’s variables. CXL supports the built-in functions `get()` and `set()` for this purpose. The C166/ST10 simulator supports special registers that represent the processor’s port pins. See the peripheral description for the names of these special registers.

Note that when supplying a register name to the `get()` and `set()` function, the name should be prefixed by a `$` to tell CrossView Pro that a register is requested.

### 4.3 PERIPHERAL EXAMPLES

The C166/ST10 product contains examples that use peripheral simulation and CXL scripting. These examples include:

- **adc** Uses the A/D converter to read a sine wave produced on the A/D converter input by CXL.
- **port** An up and down counter on the parallel port, controlled by other port pins. CXL is used to put input on the port pins and to log the counter values on the port to a file.
- **peccserial** Serial port output using PEC transfers simulation, using debug instrument I/O to display the output in CrossView Pro

You can use the examples as a starting point for writing your own CXL script.
5 TARGET CONFIGURATION FILE

The target configuration files (sim*.cfg) describe the available simulator configurations. A configuration file is a text file and can be edited with any text editor. CrossView Pro searches for the target configuration file in the current directory and in the etc directory.

On startup CrossView Pro selects the configuration indicated with the -tcfg command line option or by the Target | Settings... dialog and reads the target configuration file in memory. This configuration can be selected using the filename or the full name (title field) of the configuration.

Empty lines, lines consisting of only white space are allowed. Comment starts at an exclamation-sign (!) and ends at the end of the line.

An information line has the following synopsis:

![comment] field : field-value

field one of the keywords described below

field-value the value assigned to the field

comment optional comment

The known fields are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of the Target</td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the target CPU. CrossView Pro knows four types of CPUs, 167, 167mac, ext2mac and ext22mac. ’167’ represents the extended architecture, like the C161, C163, C164, C165 and C167 families. ’167mac’ represents the extended architecture including the MAC coprocessor, like the ST10x262 and ST10x272 families. ’ext2mac’ represents the second extended architectures like the XC16x and Super10. ’ext22mac’ represents the enhanced Super10 architectures.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>register_file</td>
<td>The filename of the register file (*.def) to be used for the CPU on the target. When this field is omitted CrossView Pro uses the default reg.def as register file. This register file contains debug information for CrossView Pro like which (E)SFR registers are present and at which location.</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging: 'disim166' for the instruction set simulator (ISS).</td>
</tr>
<tr>
<td>map_iram</td>
<td>The range where the simulator should simulate internal RAM memory. Multiple ranges can be separated by commas ','.</td>
</tr>
<tr>
<td>map_sfr</td>
<td>The range where the simulator should simulate the SFRs and/or ESFRs. Multiple ranges can be separated by commas ','.</td>
</tr>
<tr>
<td>map_ram</td>
<td>The range where the simulator should simulate external RAM memory. Multiple ranges can be separated by commas ','.</td>
</tr>
<tr>
<td>map_rom</td>
<td>The range where the simulator should simulate external ROM memory. Multiple ranges can be separated by commas ','.</td>
</tr>
<tr>
<td>psm_dll_name</td>
<td>The name of the peripheral simulation module: 'psm166'.</td>
</tr>
</tbody>
</table>

*Table Sim-1: Configuration file fields*

**Notes:**
- Fields not required for the target can be omitted.
- CrossView Pro searches for the *.cfg files in the current directory and in the etc directory.

Example of a part of the sim167.cfg file.

```
title: C167 / ST10x167 Simulator
register_file: reg167.def
debug_instrument_module: disim166
cpu_type: 167
psm_dll_name: psm166
```
With the example above, to select the SIM167 configuration the command option would be:

```bash
-tcfg sim167.cfg
```

### 6 RESTRICTIONS AND IMPLEMENTATION DETAILS

Facilities for real-time kernel support are absent in the simulator versions of CrossView Pro. As a consequence, the CrossView Pro commands `bt`, `bti`, `btI`, `et` and `lt` for kernel support, are not available. With the simulator versions the `>&` command to record target communication and the `o` command for transparency mode are not available. Also, the simulator versions of the debugger do not support command line function calling.

Menu and dialog items related to the mentioned commands are disabled.

The following CPU features are not supported in these versions of the simulator:

- Automatically clearing the upper byte when writing a byte to an SFR.
- Odd byte access traps when accessing a data/instruction word.

Other implementation details:

- CMP writes unmodified first operand back to memory: execution will break when a data write breakpoint is set on the effective address of the first operand.
- The PWRDN and IDLE instructions stop the simulation.
- Execution state counting not implemented.
- The TFR flags are implemented as follows:
  The CPU latches a ‘0’ to ‘1’ transition of a TFR flag in an internal flip flop. This flip flop is reset upon entering the trap handler. This implies that setting a TFR flag by software has no effect when it has already been set, independent of the situation. Also, a pending trap can never be canceled.
- Sequentially crossing the boundary between internal and external memory is allowed in the simulator, not in hardware.
- Explicit SP updates followed by RET, RETI, RETS, RETP or POP require a one instruction delay but not in the simulator.
• When the DIVL or DIVLU instructions results in an overflow, the contents of the MDL and MDH registers on the simulator are not the same as on the C167 (hardware). As the results are unpredictable on the overflow, the simulator fills the MDL and MDH registers with the value 0xFFFF. The simulator calculates the division as a 32-bits division. The MDL contains the truncated lower 16 bits of the result of the division and the MDH contains the truncated lower 16 bits of the result of the modulo. The V-flag is set when the result is larger than 16 bits. The N-flag is set then the highest bit of the MDL is set.

• When a breakpoint is set in an ATOMIC or EXTEND sequence, CrossView Pro will set a breakpoint at the first instruction after the sequence. Within an ATOMIC or EXTEND sequence ‘class A’ hardware traps are not handled. Therefore, it is not possible to set a breakpoint within a sequence, because breakpoints are set by a TRAP #2 (NMI) instruction which is a ‘class A’ hardware trap.
ON-CHIP DEBUG SUPPORT
1 INTRODUCTION

This addendum gives supporting information for use of CrossView Pro with the on-chip debug support (OCDS) of the Infineon Technologies architectures. Part of the OCDS concept is the JTAG debug connection, an industry standard serial connection with the MCU’s inner states. OCDS allows pervasive debugging control of the MCU.

CrossView Pro can debug with OCDS via the parallel port (LPT) or via the Device Access Server (DAS). The DAS architecture was designed by Infineon for multi-device multi-core systems with very demanding emulation requirements. The goal of the DAS architecture is to provide one single interface for all types of tools. CrossView Pro works with DAS and a USB wiggler connected to the on-board OCDS connector.

2 SUPPORTED HARDWARE

CrossView Pro supports the following hardware:

**OCDS via the parallel port**
- EASY UTAH v1.1 evaluation board with C161U or C165UTAH
- Phytec phyCore XC161CJ or XC167CI

**OCDS via the Device Access Server**
- Starterkit XC164CM Rev 20

**OCDS via the parallel port or via the Device Access Server**
- XC16Board Rev 200 with XC161CJ, XC164CS or XC167CI

3 ADDITIONAL SYSTEM REQUIREMENTS

The following are the additional system requirements:

**OCDS via the parallel port**
- One unused parallel printer port on your PC (LPT1, LPT2, or LPT3)
- Parallel printer cable (capable of high speed transfers)
- OCDS supporting architecture
- Infineon Technologies OCDS interface
**OCDS via the Device Access Server**

- OCDS supporting architecture
- One unused USB port on your PC
- Infineon Technologies USB wiggler
- Infineon Technologies DAS interface

### 4 INSTALLATION

#### 4.1 HARDWARE INSTALLATION OCDS VIA THE PARALLEL PORT

⚠️ It is strongly recommended that both the PC and the target board be powered off during the installation. It is also strongly recommended that installation of the connection follows electrostatic conventions to prevent damage to the target CPU.

1. Verify that JTAG support of the targeted OCDS interface is enabled. For example, in case of an EASY UTAH v1.1 board, check the presence of a jumper on JP7.

2. Connect the selected parallel port to the Infineon Technologies OCDS interface using a parallel printer cable.

#### 4.2 HARDWARE INSTALLATION OCDS VIA DAS

1. Connect the USB wiggler to the Infineon Technologies OCDS interface.

2. When there is an on-board wiggler disable this and use the OCDS interface connector.

#### 4.3 SOFTWARE INSTALLATION

The required CrossView Pro and GDI (Generic Debug Instrument) software is automatically installed and configured when the product is installed.

**OCDS via the Device Access Server**

- Install the DAS package from the installation CD.
4.4 CONFIGURING CROSSVIEW PRO

In CrossView Pro choose one of the OCDS target configurations, reachable from EDE. From the Project menu, select Project Options... Expand the CrossView Pro entry and select Execution Environment. In the Execution Environment field select a target board with OCDS (for example, Easy Utah 161U with OCDS via LPT).

5 OCDS BREAKPOINTS

The usage of OCDS software breakpoints is limited to 64k breakpoints. A software breakpoint is set by injecting DEBUG instructions into the memory, so software breakpoints are only possible within RAM memory.

The OCDS has a limited number of hardware breakpoints:

- 4 code breakpoints or data write breakpoints, of which you can use one for a code range breakpoint or a data range read or write breakpoint.
- or 1 data value write breakpoint

For data breakpoints, CrossView Pro always uses hardware breakpoints.

For the XC16x and XC22xx derivatives there is a CMCTR register with a bit-field 'Injection Level' that is influencing the OCDS breakpoints. When the bit-field value of the 'Injection Level' is lower than a specific interrupt level, the interrupt could not be debugged. The default value for the 'Injection Level' bit-field contains the highest value, so all interrupts could be debugged by default.
6 THE TARGET CONFIGURATION FILE

The target configuration files (*.cfg) describe the available target boards. These files are text files and can be edited with any text editor.

Empty lines, lines consisting of only white space are allowed. Comment starts at an exclamation-sign ('!') and ends at the end of the line.

An information line has the following synopsis:

\[ ![comment] field: [subfield =] field-value \]

*field* one of the keywords described below

*subfield* the usage of this part depends on the value of *field*, see below

*field-value* the value assigned to the field

*comment* optional comment

The *fields* listed in the configuration file are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>The full name of the configuration. This name will be displayed in the Target configuration field of the Target</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>cpu_type</td>
<td>The name of the CPU present on the target board. CrossView Pro knows four types of CPUs, 167, 167MAC, EXT2MAC and EXT22MAC. '167' represents the extended architecture, like the C161, C163, C164, C165 and C167 families. '167MAC' represents the extended architecture including the MAC coprocessor, like the ST10x262 and ST10x272 families. 'EXT2MAC' represents the second extended architectures like the XC16x and Super10. 'EXT22MAC' represents the enhanced Super10 architectures.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>register_file</td>
<td>The filename of the register file (*.def) to be used for the CPU on the target. When this field is omitted CrossView Pro uses the default reg.def as register file. This register file contains debug information for CrossView Pro like which (e)sfr registers are present and at which location.</td>
</tr>
<tr>
<td>debug_instrument_module</td>
<td>The name of the Debug Instrument (using GDI) used for debugging: ‘diocds166’ for target boards that use the OCDS interface via the parallel port and ‘gdi2das’ for target boards that use the OCDS interface via DAS.</td>
</tr>
<tr>
<td>RegisterFile</td>
<td>The filename of the register list file (*.dat) to be used for OCDS interface. This register file contains register information for Debug Instrument like which (E)SFR registers are present and at which location. This file must be used along with the register_file entry which contains the register information for CrossView Pro.</td>
</tr>
<tr>
<td>init</td>
<td>Initialize the register specified in the subfield with the value specified in field-value. The register name in subfield must be known by CrossView Pro, i.e., must be specified in the register file. You can specify multiple registers by separating them with commas ','.</td>
</tr>
<tr>
<td>ResetDelay</td>
<td>A delay in miliseconds for CrossView Pro after a target reset. When you use OCDS, CrossView Pro resets the target. However, CrossView Pro cannot detect if the reset is released when a capacitor is used inside the reset circuit on the board.</td>
</tr>
<tr>
<td>reserve</td>
<td>The reserved memory ranges (from - to) for OCDS monitor resources. EDE uses this field to generate RESERVE MEMORY locator controls. You can specify multiple ranges by separating them with commas ','.</td>
</tr>
</tbody>
</table>
Fields specific for the JTAG/OCDS connection via the parallel port:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>monitor</td>
<td>The filename of the monitor program for target boards using a JTAG/OCDS debug interface. When this field is omitted, CrossView Pro will issue an error. For the C165UTAH board this is the file m167ocds.sre.</td>
</tr>
<tr>
<td>JtagDriver</td>
<td>The filename of the JTAG API interface. This interface communicates with the CrossView Pro ‘diocs166’ Debug instrument (DI) on one side and the actual JTAG driver (installed as a service) on the other side. This driver actually communicates with target board via the parallel port.</td>
</tr>
<tr>
<td>PeripheralsStop</td>
<td>When set to 1, peripherals will be stopped when hitting a breakpoint. By default, peripherals will not be stopped upon a breakpoint. For the C161U/C165UTAH you should also specify the suspending peripherals within the clock control registers S0CLC, SSSCLC, GPTCLC, RTCCLC, EPECCLC, USBCLC, IOMCLC. For the XC16x you should specify the suspending peripherals in the OPSEN register.</td>
</tr>
<tr>
<td>Cable</td>
<td>JTAG cable number to the chip where the OCDS module is located. The value should always be 0.</td>
</tr>
<tr>
<td>ChipReset</td>
<td>By default the OCDS interface performs a Chip Reset with the reset pin (RSTIN) of the chip. You can disable this by setting the value to zero.</td>
</tr>
<tr>
<td>ClientValue</td>
<td>JTAG I/O mode OCDS module number. The value should always be 2.</td>
</tr>
</tbody>
</table>
Fields specific for OCDS via DAS:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DASserver</td>
<td>The name of the used DAS server, which must be run and/or installed on the connected host.</td>
</tr>
<tr>
<td>AccessPort</td>
<td>The connection to the device. For the USB server USBx means access via x and the USB of the device.</td>
</tr>
<tr>
<td>TerminateServer</td>
<td>When TerminateServer != 0, if a server is started by the debug instrument, this server is also terminated on exit.</td>
</tr>
</tbody>
</table>

Table OCDS-1: Target configuration file fields

Notes:
- Fields not required for the target can be omitted.
- CrossView Pro searches for the *.cfg files in the current directory and in the etc directory.

To be able to debug the C161U or C165UTAH via JTAG, an OCDS monitor must be placed in RAM that is loaded after each download of your program. The OCDS monitor uses only the DEBUG interrupt vector and the reserved memory area 0200h-0250h.

When debugging with OCDS via DAS, peripherals always will be stopped upon a breakpoint.

7 INFINEON BOARD OCDS INTERFACE CIRCUIT

When debugging with OCDS via the parallel port you can add the Infineon OCDS interface circuit to enable JTAG debugging with a custom target board. This circuit in effect only serves to protect the microcontroller from voltage peaks and operates as a voltage level shifter if necessary.

Halting the target also implies that servicing interrupts is inhibited.
Figure OCDS-1: Infineon OCDS Interface Electric Schematics

<table>
<thead>
<tr>
<th>Number of parts</th>
<th>Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>74HC244</td>
</tr>
<tr>
<td>11</td>
<td>10k Ohm</td>
</tr>
<tr>
<td>1</td>
<td>470 Ohm</td>
</tr>
<tr>
<td>1</td>
<td>110 Ohm</td>
</tr>
<tr>
<td>2</td>
<td>51 Ohm</td>
</tr>
<tr>
<td>7</td>
<td>82 Ohm</td>
</tr>
<tr>
<td>2</td>
<td>10 nF</td>
</tr>
<tr>
<td>1</td>
<td>LED</td>
</tr>
<tr>
<td>1</td>
<td>Schottky</td>
</tr>
<tr>
<td>1</td>
<td>DB25 Female connector</td>
</tr>
</tbody>
</table>

Table OCDS-2: Parts list
7.1 THE INFINEON JTAG CONNECTOR

Since there is no standard connector defined in the IEEE1149.1 JTAG standard specification nor an established industry standard has emerged, Infineon has defined their own standard connector for debugging purposes.

7.1.1 THE CONNECTOR LAYOUT

Mechanical

The connector is a standard 2.54mm (0.1 inch) centers.

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin 1</th>
<th>Pin 2</th>
<th>Pin 3</th>
<th>Pin 4</th>
<th>Pin 5</th>
<th>Pin 6</th>
<th>Pin 7</th>
<th>Pin 8</th>
<th>Pin 9</th>
<th>Pin 10</th>
<th>Pin 11</th>
<th>Pin 12</th>
<th>Pin 13</th>
<th>Pin 14</th>
<th>Pin 15</th>
<th>Pin 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMS</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>CPU_CLOCK</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>TDI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>TRST</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>TCLK</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Brk_IN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>TRAP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>VCC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>GND</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>OCDS_E</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Figure OCDS-2: Infineon JTAG Connector V1.2

The connector layout is similar to the connector of the USB wiggler used for debugging with OCDS via DAS.

Signal description

Table OCDS-3 contains the Infineon JTAG connector signals. The direction is specified as follows:

O = output from the CPU processor board to the debugger
I = input to the CPU processor board from the debugger
### Table OCDS-3: Signal names of the JTAG connector

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Direction</th>
<th>Pin Number</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>TDO</td>
<td>O</td>
<td>3</td>
<td>IEEE 1149.1</td>
</tr>
<tr>
<td>TDI</td>
<td>I</td>
<td>7</td>
<td>IEEE 1149.1</td>
</tr>
<tr>
<td>TMS</td>
<td>I</td>
<td>1</td>
<td>IEEE 1149.1</td>
</tr>
<tr>
<td>TCLK</td>
<td>I</td>
<td>11</td>
<td>IEEE 1149.1</td>
</tr>
<tr>
<td>TRST</td>
<td>I</td>
<td>9</td>
<td>IEEE 1149.1</td>
</tr>
<tr>
<td>Brk_IN</td>
<td>I</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Brk_OUT</td>
<td>O</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>I</td>
<td>8</td>
<td>Open collector</td>
</tr>
<tr>
<td>CPU_CLOCK</td>
<td>O</td>
<td>5</td>
<td>Optional</td>
</tr>
<tr>
<td>TRAP</td>
<td>O</td>
<td>15</td>
<td>TriCore only</td>
</tr>
<tr>
<td>OCDS_E</td>
<td>I</td>
<td>14</td>
<td>TriCore only. Must be held down during reset</td>
</tr>
<tr>
<td>GND</td>
<td>-</td>
<td>4, 6, 12</td>
<td></td>
</tr>
<tr>
<td>VCC</td>
<td>O</td>
<td>2</td>
<td>I/O ring voltage of CPU</td>
</tr>
<tr>
<td>Key</td>
<td>I</td>
<td>16</td>
<td>Mechanical key, should be driven to GND by the debugger.</td>
</tr>
</tbody>
</table>

### Voltage

All signals have the voltage of the I/O ring. The current voltages are 5 Volt, 3.3 Volt or 2 Volt VCC.

### Frequencies

The speed of the JTAG signals must not exceed 200% of the actual CPU clock speed.
7.1.2 IMPLEMENTATION CONSIDERATIONS

Pull Up’s & Down’s

The following signals should be connected to pull-up’s or pull-down’s respectively on the CPU-board.

<table>
<thead>
<tr>
<th>Signals</th>
<th>Pull-up</th>
<th>Pull-down</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCDS_E</td>
<td>10k</td>
<td></td>
</tr>
<tr>
<td>TMS</td>
<td>10k</td>
<td></td>
</tr>
<tr>
<td>TDI</td>
<td>10k</td>
<td></td>
</tr>
<tr>
<td>TRST</td>
<td>10k</td>
<td></td>
</tr>
<tr>
<td>RESET</td>
<td>10k</td>
<td></td>
</tr>
<tr>
<td>Brk_IN</td>
<td>10k</td>
<td></td>
</tr>
<tr>
<td>TCLK</td>
<td></td>
<td>10k</td>
</tr>
</tbody>
</table>

Table OCDS-4: Pull-up’s & Down’s

Clock Pin

The clock is optional since not every CPU has a Clock-out pin available. Since the clock pin is very likely to act as an antenna, it should be connected via any sort of Jumper.

If not applied, the TCLK signal should be connected to GND to enable sensing of the clock signal’s presence.

Mechanical Key Pin (no Pin)

The key pin signal should be driven by the debugger side to GND.
INDEX
Symbols

. (period) operand, 3-18
! command, 13-21
? command, 5-15, 13-23
& operator, 3-18
@format code, 3-13
--ddeservername, A-28
--timeout, 9-10
/ command, 5-15, 13-22
/format code, 3-13
^ command, 13-37
< command, 13-24
<< command, 13-25
> command, 13-26
>& command, 13-34
># command, 13-30
>@ command, 13-28
>> command, 13-36
application notes
EVA165, Mon-55
EVA167, Mon-55
EVA167AA, Mon-55
I+ME C167C, Mon-56
PHYTEC KC-161, Mon-58
PHYTEC KC-163, Mon-58
PHYTEC KC-164, Mon-58
PHYTEC KC-167, Mon-58
PHYTEC MM-165, Mon-57
PHYTEC MM-167CR, Mon-57
PHYTEC MM-167CW, Mon-57
RMB-165, Mon-56
RMB-167, Mon-56
RMB-167SR, Mon-56
target board, Mon-52
TQ-Components, Mon-58
ar166, 1-11
argument of a function, 3-9
arrays
display address of, 6-6
display character, 3-15, 6-6
viewing contents of, 3-16, 6-16
assembler, 1-11
assembly window
bhexadecimal display, 3-10
intermixed assembly, 3-10
pipeline, 3-10
source merge limit, 3-11
assertion mode, 7-28, 15-3
assertions, 1-5, 7-28, 15-3
activating, 7-28
activating and suspending, 7-31
assertion mode, 7-28
debugging with, 7-33
define or modify assertion, 13-39
defining, 7-29
deleting, 7-32
editing, 7-31
quit assertion mode, 13-189
statistics, 7-35
A
A command, 13-38
a command, 13-39
a166, 1-11
absolute file, 15-3
accelerator bar, 4-25
accelerator button, 4-12, 4-25
accessing code and data, 6-1
AccessPort, 1-24, OCDS-9
AddDDEMenuEntry, A-28
adding files to a project, 1-41
address bias, set, 13-153
addresses
in expressions, 3-18
specifying format of, 6-17
application
debugging, 1-30
executing, 1-28
toggle mode, 13-38
AssertionsChanged, A-11
autosrc, 6-19

B

B command, 13-41
b command, 13-42
b164nrb.sre, Mon-8
b167.sre, Mon-7
b167a.sre, Mon-8
b167nrb.sre, Mon-7
b167nrbe.sre, Mon-8
b167snrb.sre, Mon-8
background color, 2-5
background mode, 11-23, 15-3
assertions, 11-28
leaving, 11-26
local and global variables, 11-27
manual refresh, 11-24
refresh limitations, 11-27
running a program, 11-25
stack, 11-27
starting, 11-25
stopping a program, 11-26
updating windows, 11-23
waiting, 11-26
batch mode, 9-10
batch processing, 9-10
bB command, 13-43
bb command, 13-44
bc command, 13-45
bCYC command, 13-46
bcyc command, 13-47
bD command, 13-48
bd command, 13-50
bdis command, 13-52
bena command, 13-53
bext2i.sre, Mon-8
bext2nrb.sre, Mon-7
bext2nrbe.sre, Mon-8
bext2nrbi.sre, Mon-8
bi command, 13-54
bi command, 13-55
bi_me167.sre, Mon-8
bias, 15-4
binary constants, 3-5
binary notation, 3-4
bINST command, 13-56
binst command, 13-57
bit, 6-9
bitword, 6-15
boot, 1-20, Mon-36
boot program, Mon-16
boot programs, Mon-7
boot sequence, Mon-5
bootstrap loader (BSL), Mon-55
break command, 13-58
breakpoint toggle, 4-24, 7-4
breakpoints, 1-4, 7-1, 13-58, 15-4, Mon-15
and diagnostic output, 7-27
and multi-line statements, 7-5
and multiple statements, 7-5
and statistical information, 7-27
attaching statistical information, 7-27
code, 7-3
commands associated with, 7-19
conditionals, 7-21
count, 15-4
count of, 7-3
cycle count, 7-3, 13-46, 13-47
data, 7-7
data breakpoints over a range of addresses, 7-11
delete, 13-88
delete all, 13-87
deleting, 7-16
disable, 7-17, 13-52
emulator mode, 7-6
enable, 7–17, 13–53
for loops, 7–6
function, permanent, 13–44
instruction count, 7–3, 13–56, 13–57
list, 13–41
listing, 7–8
low-level, 15–7
name, 7–3
names, 7–13
patching code with, 7–25
permanent, 7–4
permanent low-level, 13–55
task aware, 13–65
permanent up-level, 13–70
probe point, 1–5, 7–4
quiet reporting of, 7–22
reset count, 7–3, 7–14
restrictions on OCDS, OCDS–5
sequence, 7–15
set at beginning of function, 13–43
set count, 13–45
setting, 1–28, 7–8
from command window, 7–10
from menu, 7–9
from source window, 7–9
from stack window, 7–10
setting the count of, 7–14
strings, 7–22
system startup code, 7–7
task aware
code, 13–63
permanent low-level, 13–65
temporary low-level, 13–64
temporary, 7–4, 7–12
temporary low-level, 13–54
task aware, 13–64
temporary up-level, 13–68
time, 13–66, 13–67
timer, 7–3
up-level, 7–23
while loops, 7–6
BreakpointsChanged, A–11
bslack, 1–20, Mon–36
bt command, 13–63
btI command, 13–64
btI command, 13–65
btTIM command, 13–66, 13–67
bu command, 13–68
bu command, 13–70
bufa command, 13–72
bufd command, 13–73
bx16x.sre, Mon–7
bx16xnrb.sre, Mon–7
bx16xnre.be.sre, Mon–8

C
C, character constants, 3–6
C command, 5–12, 13–74
C trace, 1–5, 13–82
C++ compiler, 1–11
c166, 1–11
Cable, 1–23, OCDS–8
cache, debugging with, 15–4
CAN, Mon–43
interface messages, Mon–45
case sensitivity, 3–20, 13–190
casting values, 3–16, 6–16
CB command, 13–75
cC166, 1–11
cd command, 13–76
ce command, 13–77
character codes, 6–14
character codes table, 3–6
character constants, 3–6
ChipReset, 1–23, OCDS–8
clear command, 13–78
ClientValue, 1–23, OCDS–8
close a file I/O stream, 13–128
CmdAnnotatedOutput, A–11
cmdannotatedoutput, A–22
cmdoutput, A–21
code breakpoints
See also breakpoints
set breakpoint, 13-42
task aware, 13-63
code coverage, 1-6
color, windows, 2-5
color offset, 11-17
color settings, 2-5
COM interfaces, A-5
COM methods
Execute, A-6
ExecuteNoWait, A-7
Halt, A-7
Init(), A-6
COM object interface, A-3
activating, A-5
events, A-8
examples, A-12
methods, A-6
using, A-3
command history, displaying recent commands, 9-19
command language, 3-1
command line, batch processing, 9-10
command line options, 4-5
Command Window, 4-22
displaying data in, 6-10
opening, 1-32
CommandCanceledByUser, A-9
CommandInterpreterBusy, A-8
CommandInterpreterReady, A-9
commands
Multiple, 3-17
syntax, 4-3
comments, 3-17
communication setup, 1-24
compare application, 1-27, 13-89
compiler, 1-11
C++, 1-11
conditional command execution, 13-127
conditional keywords, 3-19
configuration file, Mon-35, Sim-9, OCDS-6
configure CrossView Pro, 1-24
connection error, Mon-42
constants, 3-4
binary, 3-5
character, 3-6
character constants in C, 3-6
floating point, 3-5
hexadecimal, 3-4
long integer, 3-5
octal, 3-5
strings, 3-6
continue execution, 5-9
control operations, 4-39
control program, 1-11
coverage, 1-6, 11-6, 15-5
disable, 11-6, 13-76
enable, 11-6, 13-77
information, 13-79
marker, 4-24, 7-4
memory window, 4-29
next covered block, 13-154
next not covered block, 13-155
previous covered block, 13-160
previous not covered block, 13-165
source window, 4-25
covinfo command, 13-79
cp166, 1-11
cproinfo command, 13-80
CPU, reserved variable, 3-10
CPU selection, 4-7
cpu selection, 13-98, 13-99
cpu_type, 1-18, Mon-35, Sim-9, OCDS-6
creating a makefile, 1-41
CrossView
and command line options, 4-5
command files, 4-6
command language, 3-1
command line batch processing, 9-10
command reference, 13-1
commands summary, 13-4, 13-16
customizing, 4-18
desktop, 4-12
Index

executable name, Mon-3, Sim-3
features of the execution environment, Sim-3
invoking, 4-4
restrictions of execution environment, Mon-4, Sim-11
sound support, C-1
special features, 11-1
starting, 4-4
state of, 13-126
using, 4-1

CrossView Pro
before starting, 1-13
debugger, 1-13
debugging environment, 1-8
documentation, 1-7
exiting, 1-33
features, 1-3
how it works, 1-9
invoking, 1-15
output, 1-32
source level debugging, 1-8
target settings, 1-16
using windows, 1-4
windows, 1-4
CrossView Pro workspace, 1-33
ct command, 13-82
c ti command, 13-83
c tr command, 13-84
cursor, 5-3
cxl command, 13-85
CXL script, 4-38
execute, 13-85
reset variables, 13-86
supplied scripts, 11-13
syntax, B-3
CXL scripting, Sim-6
CXL syntax, B-3
array and string functions, B-11
base types, B-6
compound types, B-7
constants and expressions, B-8
file inclusion, B-9
functions, B-9
graph functions, B-13
I/O functions, B-11
mathematical functions, B-10
miscellaneous functions, B-17
operators, B-8
pointers, B-7
predefined functions, B-10
variables, B-6
cxl_reset command, 13-86
cycle count, breakpoints, 7-3

D
D command, 13-87
d command, 13-88
d166, 1-11
DAS, Device Access Server, OCDS-3
DASserver, 1-24, OCDS-9
data
displaying, 6-1
enumerated, 6-5
list data monitors, 13-141
data analysis, 11-11
add update commands, 13-118
bufa, 13-72
bufd, 13-73
clear sequence of update commands, 13-119
close window, 13-120
create window, 13-117
graph, 13-117
graph debug, 13-121
graph_add_update, 13-118
graph_clear_updates, 13-119
graph_close, 13-120
graph_debug, 13-121
graphm, 13-122
graphmn, 13-123
graphp, 13-124
clear window, 13-119
close window, 13-120
create window, 13-117
graph, 13-117
graph debug, 13-121
graph_add_update, 13-118
graph_clear_updates, 13-119
graph_close, 13-120
graph_debug, 13-121
graphm, 13-122
graphmn, 13-123
graphp, 13-124
clear window, 13-119
close window, 13-120
create window, 13-117
graph, 13-117
graph debug, 13-121
graph_add_update, 13-118
graph_clear_updates, 13-119
graph_close, 13-120
graph_debug, 13-121
graphm, 13-122
graphmn, 13-123
graphp, 13-124
clear window, 13-119
close window, 13-120
create window, 13-117
graph, 13-117
graph debug, 13-121
graph_add_update, 13-118
graph_clear_updates, 13-119
graph_close, 13-120
graph_debug, 13-121
graphm, 13-122
graphmn, 13-123
graphp, 13-124

memget, 13-145
position window, 13-124
rawmemget, 13-169
supplied scripts, 11-13
update, 13-186
update window, 13-186
Data Analysis Window, 4-37
toolbar, 4-37
data breakpoints
set at an address, 13-50
set over range of addresses, 13-48
data coverage, 4-29
data monitoring, 1-5, 15-5
removing expressions, 6-13
Data Window, 1-5, 4-30, 6-12
toolbar, 4-32
dcmp command, 13-89
DDE command line options,
--ddeservername, A-28
DDE commands, AddDDEMenuEntry,
A-28
DDE events, A-27
DDE items
cmdannotatedoutput, A-22
cmdoutput, A-21
event, A-26
exec, A-24
execext, A-23
halt, A-25
Help, A-20
result, A-27
DDE server interface, A-20
debug instrument, 13-15
save/restore state, 13-91
debug instrument I/O, 10-9
debug_instrument_module, 1-18,
Mon-36, Sim-10, OCDS-7
debugger, starting, 1-40
debugging
and optimized code, 3-7
assembly language, 12-3
code without symbols, 5-14
environment, 1-8
multiple programs, 12-3
nots about, 12-1
quitting, 1-33
source-level, 1-8
viewing source while, 1-28
debugging an application, 1-30
desktop, 4-12
DestroyedAllSymbols, A-11
development flow, 1-12
Device Access Server, OCDS-3
di_state command, 13-91
diagnostic output, and breakpoints,
7-27
diagnostics, 15-5
dialog boxes, 4-17
DidAddSymbols, A-11
DidDownloadImage, A-11
DidLoadSymbols, A-10
dis command, 13-92
disassembly memory, 13-92
disassembler, 1-11
disassembly, 6-18
window, 15-5
display, customizing, 4-18
display formats, set default, 13-103
dmp166, 1-11
dn command, 13-93
documentation, 1-7
dot operand, 6-12
download a file, 13-93
download image, 13-140
downloading, files to the execution
environment, 1-25
dual vector table, Mon-11
dump, 3-16, 6-16
dump command, 13-94
dump utility, 1-11
Dy command, 13-87
e command, 5-14, 13-96
Index

EasyCODE, 4-9
ec command, 13-98
e command, 13-99
echo command, 13-100
echo string to terminal, 13-20
EDE, 1-35
  build an application, 1-39
  load files, 1-37
  open a project, 1-37
  select a toolchain, 1-36
  start a new project, 1-40
  starting, 1-35
edit source, 4-26
ei command, 13-101
einit, 1-21, Mon-38
embedded development environment. See EDE
embedded system, 15-6
emulator communication setup, 1-24
emulator mode, 1-9
environment variable
  LD_LIBRARY_PATH, 2-3
  UIDPATH, 2-3
error messages, alphabetical listing of, 14-1
Esc key, 4-22
et command, 13-102
EVA, Mon-40
EVA165, application notes, Mon-55
EVA167, application notes, Mon-55
EVA167AA, application notes, Mon-55
evaluate expression, 13-17
event, A-26
events, A-8, A-27
  AssertionsChanged, A-11
  BreakpointsChanged, A-11
  CmdAnnotatedOutput, A-11
  CommandCanceledByUser, A-9
  CommandInterpreterBusy, A-8
  CommandInterpreterReady, A-9
  DestroyedAllSymbols, A-11
  DidAddSymbols, A-11
  DidDownloadImage, A-11
  DidLoadSymbols, A-10
  HaltButtonPressed, A-9
  MenuEntrySelected, A-11
  Quit, A-12
  Reset, A-10
  ResetProgram, A-10
  Running, A-9
  RunningInBackground, A-9
  SourceFileChanged, A-10
  Stopped, A-9
  ViewedLineNrChanged, A-10
example
  starting EDE, 1-35
  using EDE, 1-35
  using the control program, 1-42
  using the makefile, 1-45
  exec, A-24
  execext, A-23
  executable, building for CrossView, 1-35
  Execute, A-6
  ExecuteNoWait, A-7
  executing an application, 1-28
  execution control commands, summary of, 13-8
  execution environment, Mon-1, Sim-1,
    OCDS-1
    connecting to CrossView, 4-6
    downloading files to, 1-25
  execution position, 5-3
    changing the, 5-5
    definition of, 15-6
    sync with viewing position, 5-7
  exit, 4-20
  exponential notation, 3-5
  expression evaluator, 1-4
  expressions, 3-3
    C character codes, 3-6
    character constants, 3-6
    evaluating, 6-11
    evaluation precision, 3-4
    floating point constants, 3-5
    format of, 3-13
monitoring, 6-12
removing monitored, 6-13
show, 4-30
special expressions, 3-18
specifying variables in, 3-8
strings, 3-6
watch, 4-30
extension language, B-3
eye diagram, 11-19

F
f command, 13-103
fa command, 13-104
far, 6-8, 6-15
fc command, 13-105
fd command, 13-106
FFT power spectrum, 11-15
  combined with phase, 11-18
  multi, 11-15
  multi in lines, 11-16
  multi in lines and grid, 11-17
FFT waterfall, 11-15
file system simulation, 10-7, 15-6
close a stream, 13-112
libraries, 10-8
redirect output to a file, 13-113
redirection, 10-7, 13-111
summary of commands, 13-14
filenames, 2-3
fl command, 13-107
FLASH programming, 11-19
  add FLASH device, 13-104
  check FLASH device, 13-105
  delete FLASH device, 13-106
  disable protection, 13-109
  FLASH monitor workspace, 13-114
  get protection status, 13-108
  list FLASH devices, 13-107
  protect FLASH device, 13-110
flash_base_address, 1-19, Mon-37
flash_chip, 1-19, Mon-37
flash_chips, 1-19, Mon-37
flash_device_num, 1-19, Mon-37
flash_direct_access, 1-19, Mon-37
flash_monitor, 1-19, Mon-36
flash_vendor, 1-19, Mon-37
flash_width, 1-19, Mon-37
flash_workspace, 1-19, Mon-37
floating point constants, 3-5
format codes, 3-14
formats, for variables, 6-14
formatter
  a.out to IEEE-695, 1-13
  a.out to Intel Hex, 1-13
  a.out to Motorola S, 1-13
formatting expressions, 3-13
fp command, 13-108
fpd command, 13-109
fpe command, 13-110
frame pointer, 3-10
FSS
  redirection, 10-7
  summary of commands, 13-14
FSS command, 13-111
FSS_stdio_close, 13-112
FSS_stdio_open, 13-113
functions, 3-20
  listing all, 6-10
  listing local variables and parameters of, 6-23
fw command, 13-114

G
g command, 5-5, 13-115
GDI, 1-8, 9-12, 9-13
  logging, 9-13, 9-15, 9-17
getting started, 1-13
gi command, 5-6, 13-116
global variables, 3-8
glossary, 15-1
graph command, 13-117
graph_add_update command, 13-118
graph_clear_updates command, 13-119
graph_close command, 13-120
graph_clear_updates command, 13-119
graph_close command, 13-120
graph_debug command, 13-121
graphm command, 13-122
graphmn command, 13-123
graphp command, 13-124
GUI update suppress, 13-125
gus command, 13-125

H
Halt, A-7
halt, A-25
halt execution, 5-9
HaltButtonPressed, A-9
Help, A-20
help
  on-line, 1-7, 4-40
  summary of help commands, 13-15
hexadecimal disassembly, 3-10
hexadecimal notation, 3-4
history mechanism, 15-6
huge, 6-8, 6-15

I
I command, 13-126
I+ME C167C
  application notes, Mon-56
  connecting to, Mon-56
  debug monitors, Mon-56
I/O simulation, 1-5
defined, 15-7
disable streams, 10-7
enable streams, 10-7
file system simulation, 10-7
redirecting streams, 10-6
setting up streams, 10-4

terminal windows, 4-35
ieee166, 1-13
if command, 13-127
ihex166, 1-13
ilvl, Mon-38
image part, 15-7
in-situ editing, 6-7, 6-29
init, 1-21, 1-22, 1-23, Mon-37,
  OCDS-7
Init(), A-6
input/output simulation, 10-1
defined, 15-7
  summary of commands, 13-13
instruction count breakpoints, 7-3
integers, 3-4
  binary, 3-5
  hexadecimal, 3-4
integral promotion, 3-5
  long, 3-5
  negative, 3-4
  octal, 3-5
integral promotion, 3-5
intermixed source and disassembly, 6-19
interprocess communication, A-1, B-1
interrupt key, 15-7
ios_close command, 13-128
ios_open command, 13-129
ios_read command, 13-131
ios_readf command, 13-132
ios_rewind command, 13-133
ios_wopen command, 13-134
ios_write command, 13-135
ios_writef command, 13-136

J
JTAG, OCDS-3
JtagDriver, 1-22, OCDS-8
jump to cursor, 5-5
**K**
kernel support, 1-7, 11-4
keyboard mappings, 10-10
keywords, conditional, 3-193-20
KitCon, Mon-58

**L**
L command, 13-137
l command, 13-138
l166, 1-11
label, in disassembly, 6-18
language, 3-1
LD_LIBRARY_PATH, 2-3
librarian, 1-11
line command, 13-19
line numbers, 3-11
linker, 1-11
listing, 13-138
load command, 13-140
load symbol file, 13-140, 13-152
local variables, 3-7
and the stack, 3-7
auto-watch, 4-32
locator, 1-11
logging, 9-12
command window output, 13-32
commands and screen output, 9-15
debugger-emulator I/O, 13-34
debugger-GDI accesses, 13-36
description, 9-15
resume, 9-15
setting up, 9-13
start, 9-13
startup options, 9-18
stop, 9-17
summary of commands, 13-11
suspend, 9-15
long integer constants, 3-5

**M**
M command, 13-141
m command, 13-142
m164r.sre, Mon-9
m166, 1-11
m167cmcp.sre, Mon-9
m167cr.sre, Mon-9
m167crd.sre, Mon-9
m167d.sre, Mon-11
m167mcp.sre, Mon-9
m167n.sre, Mon-9
m167r.sre, Mon-9
m167re.sre, Mon-9
m167rvh.sre, Mon-9
m167s.sre, Mon-13
macro preprocessor, 1-11
macros, 1-7, 8-1, 15-7
calling other macros, 8-4
define, 13-174
defining, 8-3
delete definition, 13-185
deleting, 8-8
echo command, 13-100
expanding, 8-5
listing, 8-5
parameters of, 8-9
reading from a file, 8-7
redefining, 8-5, 8-10
save, 13-173
saving to a file, 8-6
summary of commands, 13-12
using the toolbox, 8-11
main() function, 15-7
make utility, 1-11
makefile
automatic creation of, 1-41
updating, 1-41
makepy utility, A-15
map_iram, 1-19, Sim-10
map_ram, 1-19, Sim-10
map_rom, 1-20, Sim-10
map_sfr, 1-19, Sim-10
MAU (minimum addressable unit), 15-7
mcp command, 13-144
memget command, 13-145
memory
copy, 13-144
disassembly, 13-92
displaying, 6-15
dump, 13-94
fill, 13-148
mapping, Sim-3
search, 13-150
single fill, 13-147
memory access, tracing, 1-6
memory configuration, Mon-19
memory dump, 3-16, 6-16
memory layout, Mon-19
memory map, 4-6, 15-8
memory map file, Sim-3
memory model, Mon-18
memory switch, Mon-13
Memory Window, 4-28
setup, 4-29
toolbar, 4-29
menu, 4-14
local popup, 4-15
menu bar, 4-12
MenuEntrySelected, A-11
messages
CAN interface, Mon-45
connection process, Mon-47
mext2b.sre, Mon-9
mext2d.sre, Mon-11
mext2fb.sre, Mon-9
mext2ib.sre, Mon-10
mext2n.sre, Mon-9
mext2r.sre, Mon-9
mext2re.sre, Mon-9
mF command, 13-147
mf command, 13-148
minimum addressable unit, 15-8
mk166, 1-11
Monitor
configuration parameters, Mon-18
connecting target board
CAN, Mon-43
RS-232, Mon-41
I+ME C167C, Mon-56
interface description, Mon-21
rebuild, Mon-16
resources used by, Mon-14
startup configure at NMI, Mon-20
troubleshooting, Mon-50
monitor, 1-20, 1-22, Mon-36, OCDS-8
monitor command
BAUD_ZL, Mon-33
DEBUG, Mon-33
EINIT, Mon-34
FILLMEM, Mon-28
GO, Mon-30
ILVL, Mon-32
MEMTOPC, Mon-24
MONADR, Mon-32
MOVMEM, Mon-28
NULL, Mon-23
PCTOMEM, Mon-24
PEEK, Mon-25
POKE, Mon-25
REGLOAD, Mon-26
REGSAVE, Mon-27
SETIP, Mon-29
SHOWSTAT, Mon-30
SYNC, Mon-31
VERSION, Mon-29
monitor data, 13-141
monitor programs, Mon-7
monitors, 13-142
more, 3-10
ms command, 13-150
multi FFT power spectrum, 11-15
in lines, 11-16
in lines and grid, 11-17
mxc16xb.sre, Mon-10
mxc16xd.sre, Mon-11
P

P command, 13-158
p command, 13-159
packet format, A-27
patches, 15-8
and breakpoints, 7-25
pC command, 13-160
pd command, 13-161
pe command, 13-162
performing timing analysis, 1-6
peripheral simulation, Sim-4
peripheral support, Sim-4
PeripheralStop, 1-22, OCDS-8
PHYTEC KC-161, application notes, Mon-58
PHYTEC KC-163, application notes, Mon-58
PHYTEC KC-164, application notes, Mon-58
PHYTEC KC-167, application notes, Mon-58
PHYTEC MM-165, application notes, Mon-57
PHYTEC MM-167CR
application notes, Mon-57
connecting to, Mon-57
PHYTEC MM-167CW
application notes, Mon-57
connecting to, Mon-57
pipeline, 3-10
playback, 9-8
calling other playback files, 9-9
quitting, 9-10
setting the type of, 9-9
startup options, 9-18
summary of commands, 13-11
playback mode, 1-7
continuous, 13-24
single step, 13-25
pointer, 3-16, 6-8, 6-15
display character, 3-15, 6-6
precision, evaluating expressions, 3-4
print source lines, 13-158, 13-159
probe point, 1-5, 7-4, 15-8
problems
  common, 1-34
  communicating with CrossView, 4-11
profiling, 1-6, 11-8, 15-9
code range, 1-6, 11-10
cumulative, 11-9
cumulative information, 13-80
disable, 11-10, 13-161
enable, 11-10, 13-162
function, 11-9
functions, 1-6
information, 13-163
program builder, 1-11
program counter, 3-10, 5-7, 13-74
g command (change), 13-115
pei command (change), 13-116
inside function, 3-9
program development, 1-11
program execution
  controlling, 5-1
  notes about, 5-14
program reset, 13-164
proinfo command, 13-163
project files, adding files, 1-41
prst command, 13-164
pseudo-assembly, 6-19
psm_dll_name, 1-20, Sim-10
pU command, 13-165

R

R command, 5-8, 13-168
radm, 1-18
RAM Debug Monitor, Mon-5
  booting, Mon-5
  command set, Mon-23
  configurations, Mon-5
  resources used by, Mon-14
rawmemget command, 13-169
read from an I/O stream, 13-131
formatted, 13-132
record
  commands only, 13-26
  CrossView Pro and emulator commands, 13-28
  emulator commands only, 13-30
record and playback, 9-1
definition of, 15-9
record mode, 1-7
recording
  checking status, 9-6
  close file for, 9-6
  entering comments, 9-4
  example, 9-4
  resume, 9-5
  start, 9-3
  startup options, 9-18
  stop, 9-6
  summary of commands, 13-11
  suspend, 9-5
refresh windows, 13-184
register file, 1-18, Mon-37, Sim-10, OCDS-7
Register Window, 4-27, 6-27
setup, 6-27
register_file, 1-18, Mon-37, Sim-10, OCDS-7
RegisterFile, 1-22, 1-23, OCDS-7
registers, 3-11
displaying the contents of, 6-10

Q

Q command, 13-166
q command, 13-167
quiet breakpoint recording, 13-166
Quit, A-12
quit debugger, 13-167
special variable, 3-10
reserve, 1-21, 1-23, 1-24, Mon-38, OCDS-7
Reset, A-10
reset program, 5-8, 13-164
reset target system, 13-168, 13-170
reset_period, 1-21, Mon-38
ResetDelay, 1-23, 1-24, OCDS-7
ResetProgram, A-10
resource file, 2-3
result, A-27
rewind an I/O stream, 13-133
RMB-165, application notes, Mon-56
RMB-167, application notes, Mon-56
RMB-167SR, application notes, Mon-56
ROM Debug Monitor, Mon-5
configurations, Mon-5
dual vector table, Mon-11
memory switch, Mon-13
resources used by, Mon-14
RS-232, Mon-41
rs232_bootstrap_hold_level, 1-21, Mon-38
rs232_bootstrap_level, 1-21, Mon-38
rs232_bootstrap_pin, 1-21, Mon-38
rs232_reset_hold_level, 1-21, Mon-38
rs232_reset_level, 1-21, Mon-38
rs232_reset_pin, 1-21, Mon-38
rst command, 13-170
RTOS aware debugging, 11-4
Running, A-9
RunningInBackground, A-9
scroll bar, 4-12
search
backward for string, 13-23
forward for string, 13-22
summary of commands, 13-16
searching, 5-14-5-16
for a function, 5-14
for a source line, 5-16
for a string, 5-15
serial channel, Mon-18
serial ports, 4-6
set command, 13-178
sfr, 6-15
sfrbit, 6-9, 6-15
Si command, 5-12, 13-176
si command, 5-12, 13-177
signal analysis, 4-37
sim167.cfg, Sim-10
simulation, I/O, 1-5
simulation scenarios, Sim-6
simulator, Sim-1
peripheral support, Sim-4
timer support, Sim-5
simulator configuration, selecting, Sim-9
single stepping, 1-5, 5-9-5-10
at machine level, 5-12-5-16
defined, 15-10
into, 5-10
into function calls, 13-172
into functions, 5-10
machine level into functions, 13-177
machine level over functions, 13-176
over, 5-11
over function calls, 13-171
over functions, 5-11
sizeof() function, 6-7
skidding, 15-10
sound support, C-1
source directory, change, 13-187
source level debugging, 1-8
source line, jump to, 5-16
source merge limit, 3-11
source positioning, 5-3
Source Window, 4-24
  change execution position, 5-5
  change viewing position, 5-4
  controlling program execution, 5-8–5-16
edit source, 4-26
searching in, 5-14–5-16
single stepping, 5-9
sync execution and viewing positions, 5-7
toolbar, 4-25
source window, line numbers, 3-11
SourceFileChanged, A-10
special function register, 3-11
special variables, 3-9, 15-10
  reserved, 15-9
  user-defined, 3-12
srec166, 1-13
st command, 13-178
stack, 6-20
  local variables, 3-7
  organization of, 6-20
  system, Mon-14
  user, Mon-14
stack pointer, 3-10
stack trace, 13-179, 13-180
Stack Window, 4-33, 6-21
toolbar, 4-34
start.asm, Mon-40
startup options, 4-5
  definition, 15-10
  list of, 4-7
static variables, 3-7
status bar, 4-12
stop target execution, 13-178
Stopped, A-9
storage classes, 3-7
string command, 3-18
strings, 3-6
structures
  assignment, 6-8
  viewing, 6-5
style codes, 3-14
symbol information, 15-11
symbolic disassembly, 6-18
symbols, in disassembly, 3-10
synchronize execution and viewing positions, 5-7, 13-137
syscon, 1-21, Mon-37
system stack, 6-21, Mon-14
system startup code, 15-11

T
T command, 13-179
t command, 13-180
Tab key, 4-22
target board, Mon-1, Mon-3
application notes, Mon-52
connecting
  CAN, Mon-43
  RS-232, Mon-41
connection messages, Mon-47
connection problems, Mon-49
selecting, Mon-4, Mon-39
target communication, 15-11
target configuration file, 1-17, Mon-35,
  Sim-9, OCDS-6
example, Mon-39
target program counter, 13-75
target settings, 1-16
target state, 13-15
target system, 1-8
task selection, 13-102
td command, 13-181
te command, 13-182
Terminal Window, 4-35
  keyboard mappings, 10-10
  setup, 4-36
TerminateServer, 1-24, OCDS-9
timer breakpoints, 7-3
timer support, Sim-5
title, 1-18, Mon-35, Sim-9, OCDS-6
toolbar, 4-12
  data analysis window, 4-37
data window, 4-32
memory window, 4-29
source window, 4-25
stack window, 4-34
toolbox, 8-11
TQ-Components, application notes, Mon-58
trace
  C, 13-82
disable, 13-181
disassembled, 13-83
enable, 13-182
instruction level, 6-26
raw, 6-26, 13-84
source level, 6-25
trace buffer, 15-11
Trace Window, 4-34, 6-25
  instruction level, 13-83
raw, 13-84
source level, 13-82
traceback mode, 1-5
transparency mode, 1-9, 11-3, 13-156
  and CrossView startup, 4-6
defined, 15-11
entering, 11-3
one-shot commands, 11-3
startup options, 11-3
trigraph sequence, 3-7
troubleshooting, 1-34, 4-11, Mon-50
use command, 13-187
user defined functions, 1-7
user stack, 6-21
using EDE, 1-35
variables, 3-7
  and case sensitivity, 3-20
  and scoping rules, 3-9
  casting, 3-7
  changing, 6-7
determining the size of, 6-7
  formats of, 6-14
global, 6-10
global variables, 3-8
local, 15-7
local variables, 3-7
scope, 15-9
special, 15-10
special variables, Pages, 3-9
specifying in expressions, 3-8
static variables, 3-7
user-defined special variables, 3-12
ViewedLineNrChanged, A-10
viewing position, 3-9, 5-3
  changing the, 5-4-5-7
defined, 15-12
establish, 13-96
establish at address, 13-101
sync with execution position, 5-7
u command, 13-183
ubgw command, 13-184
UIDPATH, 2-3
unset command, 13-185
update command, 13-186
update windows, 13-183, 13-184
updating makefile, 1-41
wait for target completion, 13-188
waiting, 11-26
window update
  reactivate, 13-125
  suppress, 13-125
windows, 4-21
active, 4-16, 15-3
automatic switching between source and assembly, 3-10
closing, 4-16
command window, 4-22
customizing, 4-18
data analysis window, 4-37
data window, 4-30
help window, 4-38
memory window, 4-28
opening, 4-15
pop-up, 4-38
register window, 4-27
selecting, 4-16
source positioning, 5-3
source window, 4-24
stack window, 4-33
terminal windows, 4-35
toolbox, 4-38
trace window, 4-34
workspace file (.cws), 1-33
write to an I/O stream, 13-135
formatted, 13-136
wt command, 13-188

X
x command, 13-189
X Resources, 2-4
X Widgets, CrossView Motif, 2-4
X Windows
  Motif environment, 2-3
  resources, 2-4
x-t plotting, 11-14
x-y plotting, 11-14
xfw166, 1-13
xvwedit, 4-26

Z
Z command, 13-190